DSP56xxx v3.6

CROSSVIEW PRO DEBUGGER
USER’S GUIDE

TASKING
The information in this document has been carefully reviewed and is believed to be accurate and reliable. However, Altium assumes no liabilities for inaccuracies in this document. Furthermore, the delivery of this information does not convey to the recipient any license to use or copy the software or documentation, except as provided in an executed license agreement covering the software and documentation.

Altium reserves the right to change specifications embodied in this document without prior notice.
## OVERVIEW

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Introduction</td>
<td>1-3</td>
</tr>
<tr>
<td>1.2</td>
<td>CrossView Pro’s Features</td>
<td>1-3</td>
</tr>
<tr>
<td>1.3</td>
<td>Source Level Debugging</td>
<td>1-8</td>
</tr>
<tr>
<td>1.4</td>
<td>How CrossView Pro Works</td>
<td>1-10</td>
</tr>
<tr>
<td>1.5</td>
<td>DSP56xxx Family Program Development</td>
<td>1-12</td>
</tr>
<tr>
<td>1.6</td>
<td>Getting Started</td>
<td>1-14</td>
</tr>
<tr>
<td>1.6.1</td>
<td>Before Starting</td>
<td>1-14</td>
</tr>
<tr>
<td>1.6.2</td>
<td>Setting Up the Execution Environment</td>
<td>1-14</td>
</tr>
<tr>
<td>1.6.3</td>
<td>Starting CrossView Pro</td>
<td>1-15</td>
</tr>
<tr>
<td>1.6.3.1</td>
<td>CrossView Pro Target Settings</td>
<td>1-16</td>
</tr>
<tr>
<td>1.6.3.2</td>
<td>Configuring CrossView Pro</td>
<td>1-18</td>
</tr>
<tr>
<td>1.6.3.3</td>
<td>Loading Symbolic Debug Information</td>
<td>1-19</td>
</tr>
<tr>
<td>1.6.4</td>
<td>Executing an Application</td>
<td>1-21</td>
</tr>
<tr>
<td>1.6.5</td>
<td>Debugging an Application</td>
<td>1-23</td>
</tr>
<tr>
<td>1.6.6</td>
<td>CrossView Pro Output</td>
<td>1-25</td>
</tr>
<tr>
<td>1.6.7</td>
<td>Exiting CrossView Pro</td>
<td>1-26</td>
</tr>
<tr>
<td>1.6.8</td>
<td>What You May Have Done Wrong</td>
<td>1-26</td>
</tr>
<tr>
<td>1.6.9</td>
<td>Building Your Executable</td>
<td>1-28</td>
</tr>
<tr>
<td>1.6.9.1</td>
<td>Using EDE</td>
<td>1-28</td>
</tr>
<tr>
<td>1.6.9.2</td>
<td>Using the Control Program</td>
<td>1-35</td>
</tr>
<tr>
<td>1.6.9.3</td>
<td>Using the Makefile</td>
<td>1-37</td>
</tr>
</tbody>
</table>

## SOFTWARE INSTALLATION

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Introduction</td>
<td>2-3</td>
</tr>
<tr>
<td>2.2</td>
<td>Note about Filenames</td>
<td>2-3</td>
</tr>
<tr>
<td>2.3</td>
<td>Installation for Windows</td>
<td>2-3</td>
</tr>
<tr>
<td>2.3.1</td>
<td>Requirements</td>
<td>2-4</td>
</tr>
<tr>
<td>2.4</td>
<td>Installation for UNIX Hosts</td>
<td>2-5</td>
</tr>
<tr>
<td>2.5</td>
<td>Configuring the X Windows Motif Environment</td>
<td>2-7</td>
</tr>
<tr>
<td>2.6</td>
<td>Using X Resources</td>
<td>2-8</td>
</tr>
<tr>
<td>2.7</td>
<td>Licensing TASKING Products</td>
<td>2-11</td>
</tr>
<tr>
<td>2.7.1</td>
<td>Obtaining License Information</td>
<td>2-11</td>
</tr>
<tr>
<td>2.7.2</td>
<td>Installing Node-Locked Licenses</td>
<td>2-12</td>
</tr>
</tbody>
</table>
**Table of Contents**

2.7.3  Installing Floating Licenses  ........................................ 2–13  
2.7.4  Starting the License Daemon  ...................................... 2–15  
2.7.5  Setting Up the License Daemon to Run  
        Automatically ......................................................... 2–16  
2.7.6  Modifying the License File Location  ............................. 2–17  
2.7.7  How to Determine the Hostid ....................................... 2–18  
2.7.8  How to Determine the Hostname  .................................. 2–19

**COMMAND LANGUAGE**  

3.1  Introduction ............................................................. 3–3  
3.2  CrossView Pro Expressions ........................................... 3–3  
3.3  Constants ................................................................ 3–4  
3.4  Variables ................................................................ 3–7  
3.5  Formatting Expressions .................................................. 3–14  
3.6  Operators ................................................................ 3–19  
3.7  Special Expressions ...................................................... 3–21  
3.8  Conditional Evaluation ................................................... 3–22  
3.9  Functions ................................................................ 3–22  
3.10  Case Sensitivity ............................................................ 3–23

**USING CROSSVIEW PRO**  

4.1  Introduction ................................................................. 4–3  
4.2  Using the CrossView Pro Interface .................................... 4–3  
4.3  Starting CrossView Pro ..................................................... 4–4  
4.4  Startup Options .............................................................. 4–5  
4.4.1  What You May Have Done Wrong ......................... 4–9  
4.5  The CrossView Pro Desktop .............................................. 4–11  
4.5.1  Menus .................................................................. 4–13  
4.5.1.1  Local Popup Menus .............................................. 4–14  
4.5.2  Window Operation ...................................................... 4–14  
4.5.3  Dialog Boxes .............................................................. 4–16  
4.5.4  Customizing CrossView Pro ......................................... 4–17  
4.5.5  CrossView Pro Messages .............................................. 4–19
# Table of Contents

- 4.6 CrossView Pro Windows ........................................... 4–20
  - 4.6.1 Command Window ............................................. 4–21
  - 4.6.2 Source Window ................................................. 4–23
  - 4.6.3 Register Window ............................................... 4–26
  - 4.6.4 Memory Window ................................................ 4–27
  - 4.6.5 Data Window ..................................................... 4–29
  - 4.6.6 Stack Window .................................................... 4–32
  - 4.6.7 Trace Window .................................................... 4–33
  - 4.6.8 Terminal Window ............................................... 4–34
  - 4.6.9 Data Analysis Window ......................................... 4–36
  - 4.6.10 Pop–Up Windows ............................................... 4–36
- 4.7 Control Operations for CrossView Pro ......................... 4–37
  - 4.7.1 Echoing Commands ............................................. 4–38
  - 4.7.2 Mouse/Menu/Command Equivalents ........................ 4–38
- 4.8 Using the On–line Help ........................................... 4–39
  - 4.8.1 Accessing On–line Help ....................................... 4–39
  - 4.8.2 Using MS–Windows Help ..................................... 4–39

---

**CONTROLLING PROGRAM EXECUTION**

- 5.1 Source Positioning .................................................. 5–3
  - 5.1.1 Changing the Viewing Position ............................... 5–4
  - 5.1.2 Changing the Execution Position ............................. 5–5
  - 5.1.3 Synchronizing the Execution and Viewing Positions .... 5–7
- 5.2 Controlling Program Execution .................................. 5–8
  - 5.2.1 Starting the Program .......................................... 5–8
  - 5.2.2 Halting and Continuing Execution ........................... 5–9
  - 5.2.3 Single–Step Execution ......................................... 5–9
  - 5.2.4 Stepping through at the Machine Level .................... 5–12
- 5.3 Notes About Program Execution ................................... 5–14
- 5.4 Searching through the Source Window .......................... 5–14
  - 5.4.1 Searching for a Function ..................................... 5–14
  - 5.4.2 Searching for a String ....................................... 5–15
  - 5.4.3 Jumping to a Source Line .................................... 5–16
# Table of Contents

## Accessing Code and Data

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Introduction</td>
<td>6–3</td>
</tr>
<tr>
<td>6.2</td>
<td>Accessing Variables</td>
<td>6–3</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Viewing Variables, Structures and Arrays</td>
<td>6–3</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Changing Variables</td>
<td>6–7</td>
</tr>
<tr>
<td>6.2.3</td>
<td>The I Command</td>
<td>6–10</td>
</tr>
<tr>
<td>6.3</td>
<td>Expressions</td>
<td>6–11</td>
</tr>
<tr>
<td>6.3.1</td>
<td>Evaluating Expressions</td>
<td>6–11</td>
</tr>
<tr>
<td>6.3.2</td>
<td>Monitoring Expressions</td>
<td>6–12</td>
</tr>
<tr>
<td>6.3.3</td>
<td>Formatting Data</td>
<td>6–14</td>
</tr>
<tr>
<td>6.3.4</td>
<td>Displaying Memory</td>
<td>6–15</td>
</tr>
<tr>
<td>6.3.5</td>
<td>Displaying Memory Addresses</td>
<td>6–17</td>
</tr>
<tr>
<td>6.4</td>
<td>Displaying Disassembled Instructions</td>
<td>6–19</td>
</tr>
<tr>
<td>6.4.1</td>
<td>Intermixed Source and Disassembly</td>
<td>6–20</td>
</tr>
<tr>
<td>6.5</td>
<td>The Stack</td>
<td>6–21</td>
</tr>
<tr>
<td>6.5.1</td>
<td>How the Stack is Organized</td>
<td>6–22</td>
</tr>
<tr>
<td>6.5.2</td>
<td>The Stack Window</td>
<td>6–23</td>
</tr>
<tr>
<td>6.5.3</td>
<td>Listing Locals and Parameters of a Function</td>
<td>6–25</td>
</tr>
<tr>
<td>6.5.4</td>
<td>Low-level Viewing the Stack</td>
<td>6–26</td>
</tr>
<tr>
<td>6.6</td>
<td>Trace Window</td>
<td>6–27</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Trace Window Setup</td>
<td>6–27</td>
</tr>
<tr>
<td>6.7</td>
<td>Register Window</td>
<td>6–29</td>
</tr>
<tr>
<td>6.7.1</td>
<td>Register Window Setup</td>
<td>6–29</td>
</tr>
<tr>
<td>6.7.2</td>
<td>Editing Registers</td>
<td>6–30</td>
</tr>
</tbody>
</table>

## Breakpoints and Assertions

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Introduction to Breakpoints</td>
<td>7–3</td>
</tr>
<tr>
<td>7.1.1</td>
<td>Code Breakpoints</td>
<td>7–3</td>
</tr>
<tr>
<td>7.1.2</td>
<td>Data Breakpoints</td>
<td>7–7</td>
</tr>
<tr>
<td>7.1.3</td>
<td>Listing Breakpoints</td>
<td>7–8</td>
</tr>
<tr>
<td>7.2</td>
<td>Setting Breakpoints</td>
<td>7–8</td>
</tr>
<tr>
<td>7.2.1</td>
<td>Data Breakpoints over a Range of Addresses</td>
<td>7–11</td>
</tr>
<tr>
<td>7.2.2</td>
<td>Temporary Breakpoints</td>
<td>7–12</td>
</tr>
<tr>
<td>7.2.3</td>
<td>Breakpoint Names</td>
<td>7–13</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Pages</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>7.2.4</td>
<td>Setting the Count</td>
<td>7–14</td>
</tr>
<tr>
<td>7.2.5</td>
<td>Sequence Breakpoints</td>
<td>7–15</td>
</tr>
<tr>
<td>7.3</td>
<td>Deleting Breakpoints</td>
<td>7–16</td>
</tr>
<tr>
<td>7.4</td>
<td>Enabling/Disabling Breakpoints</td>
<td>7–17</td>
</tr>
<tr>
<td>7.5</td>
<td>Breakpoint Commands</td>
<td>7–18</td>
</tr>
<tr>
<td>7.5.1</td>
<td>Attaching Conditionals to a Breakpoint</td>
<td>7–21</td>
</tr>
<tr>
<td>7.5.2</td>
<td>Attaching Macros to a Breakpoint</td>
<td>7–21</td>
</tr>
<tr>
<td>7.5.3</td>
<td>Attaching Strings to a Breakpoint</td>
<td>7–22</td>
</tr>
<tr>
<td>7.6</td>
<td>Suppressing Breakpoint Messages</td>
<td>7–22</td>
</tr>
<tr>
<td>7.7</td>
<td>Up-level Breakpoints</td>
<td>7–22</td>
</tr>
<tr>
<td>7.8</td>
<td>Patches</td>
<td>7–25</td>
</tr>
<tr>
<td>7.8.1</td>
<td>Patching Code out of a Program</td>
<td>7–25</td>
</tr>
<tr>
<td>7.8.2</td>
<td>Patching Code into a Program</td>
<td>7–26</td>
</tr>
<tr>
<td>7.8.3</td>
<td>Replacing Code in a Program</td>
<td>7–26</td>
</tr>
<tr>
<td>7.9</td>
<td>Diagnostic Output and Statistical Information</td>
<td>7–27</td>
</tr>
<tr>
<td>7.10</td>
<td>Assertions</td>
<td>7–28</td>
</tr>
<tr>
<td>7.10.1</td>
<td>Assertion Mode</td>
<td>7–28</td>
</tr>
<tr>
<td>7.10.2</td>
<td>Defining an Assertion</td>
<td>7–29</td>
</tr>
<tr>
<td>7.10.3</td>
<td>Editing an Assertion</td>
<td>7–31</td>
</tr>
<tr>
<td>7.10.4</td>
<td>Activating and Suspending Assertions</td>
<td>7–31</td>
</tr>
<tr>
<td>7.10.5</td>
<td>Deleting Assertions</td>
<td>7–32</td>
</tr>
<tr>
<td>7.10.6</td>
<td>Using Assertions</td>
<td>7–33</td>
</tr>
<tr>
<td>7.10.7</td>
<td>Gathering Statistics with Assertions</td>
<td>7–35</td>
</tr>
</tbody>
</table>

**DEFINING AND USING MACROS**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1</td>
<td>CrossView Pro Macros</td>
<td>8–3</td>
</tr>
<tr>
<td>8.2</td>
<td>Defining Macros</td>
<td>8–3</td>
</tr>
<tr>
<td>8.2.1</td>
<td>Listing Macros</td>
<td>8–5</td>
</tr>
<tr>
<td>8.2.2</td>
<td>Redefining a Macro</td>
<td>8–5</td>
</tr>
<tr>
<td>8.2.3</td>
<td>Saving Macro Definitions to a File</td>
<td>8–6</td>
</tr>
<tr>
<td>8.2.4</td>
<td>Loading Macro Definitions from a File</td>
<td>8–7</td>
</tr>
<tr>
<td>8.2.5</td>
<td>Deleting Macros</td>
<td>8–8</td>
</tr>
<tr>
<td>8.3</td>
<td>Macro Parameters</td>
<td>8–9</td>
</tr>
<tr>
<td>8.4</td>
<td>Redefining Existing CrossView Pro Commands</td>
<td>8–10</td>
</tr>
</tbody>
</table>
## Table of Contents

### 8.5 Using the Toolbox
- Opening the Toolbox ........................................ 8-11
- Connecting Macros to the Toolbox ............................. 8-11
- Removing a Macro Connection ................................. 8-12

### 9 COMMAND RECORDING & PLAYBACK 9-1

- 9.1 Recording Commands ...................................... 9-3
- 9.1.1 Entering Comments ...................................... 9-4
- 9.1.2 Suspend Recording ....................................... 9-4
- 9.1.3 Resume Recording ........................................ 9-5
- 9.1.4 Check Recording Status ................................. 9-5
- 9.1.5 Close File for Recording ................................. 9-6
- 9.1.6 Command Recording Example ........................... 9-6
- 9.2 Playing Back Command Files ............................... 9-7
- 9.2.1 Setting the Type of Playback ......................... 9-8
- 9.2.2 Calling Other Playback Files ......................... 9-9
- 9.2.3 Quitting Playback Mode ................................. 9-9
- 9.3 Command Line Batch Processing ........................... 9-10
- 9.4 Logging ....................................................... 9-12
- 9.4.1 Setting up Logging ...................................... 9-13
- 9.4.2 Recording Commands and Logging Screen Output .... 9-14
- 9.4.3 Command Window Log File Example ................ 9-14
- 9.4.4 Suspending and Resuming Output Log ............... 9-15
- 9.4.5 Closing the Output Log File ........................... 9-16
- 9.5 Startup Options ............................................ 9-17
- 9.6 CrossView Pro Command History Mechanism ........... 9-18

### 10 I/O SIMULATION 10-1

- 10.1 Introduction ............................................... 10-3
- 10.2 I/O Streams ................................................. 10-3
- 10.2.1 Setting Up File I/O Streams ......................... 10-4
- 10.2.2 Redirecting I/O Streams ............................... 10-6
## SPECIAL FEATURES

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.1</td>
<td>Transparency Mode</td>
<td>11–3</td>
</tr>
<tr>
<td>11.2</td>
<td>RTOS Aware Debugging</td>
<td>11–4</td>
</tr>
<tr>
<td>11.3</td>
<td>Coverage</td>
<td>11–5</td>
</tr>
<tr>
<td>11.4</td>
<td>Profiling</td>
<td>11–7</td>
</tr>
<tr>
<td>11.4.1</td>
<td>Hardware Profiling with a Timer</td>
<td>11–10</td>
</tr>
<tr>
<td>11.4.1.1</td>
<td>Detailed Description</td>
<td>11–11</td>
</tr>
<tr>
<td>11.5</td>
<td>Data Analysis</td>
<td>11–11</td>
</tr>
<tr>
<td>11.5.1</td>
<td>Supplied Data Analysis Window Scripts</td>
<td>11–13</td>
</tr>
<tr>
<td>11.5.2</td>
<td>Syntax of CrossView eXtension Language (CXL)</td>
<td>11–19</td>
</tr>
<tr>
<td>11.6</td>
<td>Background Mode</td>
<td>11–28</td>
</tr>
<tr>
<td>11.6.1</td>
<td>Configuration</td>
<td>11–28</td>
</tr>
<tr>
<td>11.6.2</td>
<td>Manual Refresh</td>
<td>11–29</td>
</tr>
<tr>
<td>11.6.3</td>
<td>Entering Background Mode</td>
<td>11–30</td>
</tr>
<tr>
<td>11.6.4</td>
<td>Leaving Background Mode</td>
<td>11–31</td>
</tr>
<tr>
<td>11.6.5</td>
<td>The Stack in Background Mode</td>
<td>11–32</td>
</tr>
<tr>
<td>11.6.6</td>
<td>Local and Global Variables</td>
<td>11–32</td>
</tr>
<tr>
<td>11.6.7</td>
<td>Refresh Limitation</td>
<td>11–32</td>
</tr>
<tr>
<td>11.6.8</td>
<td>Assertions</td>
<td>11–33</td>
</tr>
</tbody>
</table>

## DEBUGGING NOTES

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.1</td>
<td>Debugging Assembly Language</td>
<td>12–3</td>
</tr>
<tr>
<td>12.2</td>
<td>Debugging Multiple Programs</td>
<td>12–3</td>
</tr>
<tr>
<td>12.3</td>
<td>Debugging with Interrupts Enabled</td>
<td>12–3</td>
</tr>
<tr>
<td>12.3.1</td>
<td>Detailed Description</td>
<td>12–4</td>
</tr>
</tbody>
</table>
## Table of Contents

### COMMAND REFERENCE 13-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.1 Conventions Used in this Chapter</td>
<td>13–3</td>
</tr>
<tr>
<td>13.2 Commands: Summary</td>
<td>13–4</td>
</tr>
<tr>
<td>13.2.1 Viewing Commands</td>
<td>13–4</td>
</tr>
<tr>
<td>13.2.2 Data Monitoring</td>
<td>13–5</td>
</tr>
<tr>
<td>13.2.3 Data Analysis</td>
<td>13–7</td>
</tr>
<tr>
<td>13.2.4 Execution Control Commands</td>
<td>13–8</td>
</tr>
<tr>
<td>13.2.5 Record &amp; Playback</td>
<td>13–11</td>
</tr>
<tr>
<td>13.2.6 Macros</td>
<td>13–12</td>
</tr>
<tr>
<td>13.2.7 Input/Output Simulation</td>
<td>13–12</td>
</tr>
<tr>
<td>13.2.8 File System Simulation</td>
<td>13–13</td>
</tr>
<tr>
<td>13.2.9 Target System Control</td>
<td>13–13</td>
</tr>
<tr>
<td>13.2.10 Save and Restore Target State</td>
<td>13–14</td>
</tr>
<tr>
<td>13.2.11 Help Commands</td>
<td>13–14</td>
</tr>
<tr>
<td>13.2.12 Search Commands</td>
<td>13–15</td>
</tr>
<tr>
<td>13.3 Commands: Detailed Descriptions</td>
<td>13–15</td>
</tr>
</tbody>
</table>

### ERROR MESSAGES 14-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.1 What this Chapter Covers</td>
<td>14–3</td>
</tr>
<tr>
<td>14.2 Error Messages</td>
<td>14–3</td>
</tr>
</tbody>
</table>

### GLOSSARY 15-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.1 What this Chapter Covers</td>
<td>15–3</td>
</tr>
<tr>
<td>15.2 Glossary Terms</td>
<td>15–3</td>
</tr>
</tbody>
</table>

### FLEXIBLE LICENSE MANAGER (FLEXlm) A-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
<td>A–3</td>
</tr>
<tr>
<td>2 License Administration</td>
<td>A–3</td>
</tr>
<tr>
<td>2.1 Overview</td>
<td>A–3</td>
</tr>
<tr>
<td>2.2 Providing For Uninterrupted FLEXlm Operation</td>
<td>A–5</td>
</tr>
<tr>
<td>2.3 Daemon Options File</td>
<td>A–7</td>
</tr>
</tbody>
</table>
## Table of Contents

3 License Administration Tools .................................................. A–8
3.1 lmcksum ................................................................. A–10
3.2 lmdiag (Windows only) .................................................. A–11
3.3 lmdown ............................................................... A–12
3.4 lmgrd ............................................................... A–13
3.5 lmhostid ............................................................. A–15
3.6 lmremove ............................................................. A–16
3.7 lmread ............................................................. A–17
3.8 lmstat ............................................................. A–18
3.9 lmswitchr (Windows only) ........................................... A–20
3.10 lmver .............................................................. A–21
3.11 License Administration Tools for Windows ................... A–22
3.11.1 LMTOOLS for Windows .......................................... A–22
3.11.2 FLEXlm License Manager for Windows .................... A–23
4 The Daemon Log File ...................................................... A–25
4.1 Informational Messages ................................................ A–26
4.2 Configuration Problem Messages ................................. A–29
4.3 Daemon Software Error Messages ................................. A–31
5 FLEXlm License Errors .................................................... A–33
6 Frequently Asked Questions (FAQs) .............................. A–37
6.1 License File Questions ................................................ A–37
6.2 FLEXlm Version ...................................................... A–37
6.3 Windows Questions .................................................. A–38
6.4 TASKING Questions ................................................. A–39
6.5 Using FLEXlm for Floating Licenses ............................. A–41

### INTERPROCESS COMMUNICATION

1 COM Interface ............................................................... B–3
1.1 Introduction .......................................................... B–3
1.2 Using the COM Object Interface ................................. B–3
1.2.1 Run–Time Environment ........................................ B–3
1.2.2 Command Line Options ........................................ B–3
1.2.3 Startup Directory ................................................ B–4
# Table of Contents

1.3 COM Interfaces ............................................. B–5
1.3.1 Activating the COM object ............................ B–5
1.3.2 Methods .................................................... B–6
1.3.3 Implementation Details ................................. B–7
1.4 Events ....................................................... B–8
1.5 COM Examples .............................................. B–12
1.5.1 Python Examples ........................................ B–12
1.5.2 Visual Basic Examples ................................. B–16
1.5.3 WORD Examples ........................................ B–17
1.5.4 Excerpt of the MIDL Definition ....................... B–19
2 DDE Server Interface ...................................... B–20
2.1 Introduction ............................................... B–20
2.2 DDE Items and Topics .................................. B–20
2.3 DDE Events ................................................. B–27
2.3.1 Packet Format ............................................. B–27
2.4 CrossView Pro DDE Specific Options and Commands ........................................ B–28
  2.4.1 Command Line Options ............................... B–28
  2.4.2 Commands ............................................... B–28
2.5 Examples ..................................................... B–29
  2.5.1 Evaluating an Expression ............................. B–29
  2.5.2 Reading Target Memory ............................... B–30
  2.5.3 Writing Into Target Memory ......................... B–31
  2.5.4 Requesting Current File and Line Number .......... B–32
  2.5.5 Using CrossView Pro as Pure Server ............... B–32

## REGISTER MANAGER

1 Introduction .................................................. C–3
2 Invocation .................................................... C–3
3 Syntax of a Register File ................................... C–4
4 Fixed Register Set .......................................... C–5
5 DSP56xxx Family Derivatives .............................. C–7
6 DSP56xxx Register Set ...................................... C–7
## Table of Contents

### SOUND SUPPORT (MS-Windows) D-1

**SIMULATOR**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction</td>
<td>Sim-3</td>
</tr>
<tr>
<td>2. Executable Name</td>
<td>Sim-3</td>
</tr>
<tr>
<td>3. Supported Features</td>
<td>Sim-3</td>
</tr>
<tr>
<td>3.1 Cycle and Instruction Counters</td>
<td>Sim-3</td>
</tr>
<tr>
<td>3.2 Simulation Speed</td>
<td>Sim-4</td>
</tr>
<tr>
<td>3.3 Coverage</td>
<td>Sim-4</td>
</tr>
<tr>
<td>4. Restrictions</td>
<td>Sim-5</td>
</tr>
<tr>
<td>5. Simulator Configuration File</td>
<td>Sim-5</td>
</tr>
</tbody>
</table>

### TARGET BOARDS Emu-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction</td>
<td>Emu-3</td>
</tr>
<tr>
<td>2. Installation</td>
<td>Emu-5</td>
</tr>
<tr>
<td>3. ADS Versions</td>
<td>Emu-5</td>
</tr>
<tr>
<td>4. Motorola DSP Differences</td>
<td>Emu-5</td>
</tr>
<tr>
<td>5. Executable Name</td>
<td>Emu-6</td>
</tr>
<tr>
<td>6. Restrictions</td>
<td>Emu-6</td>
</tr>
<tr>
<td>7. Registers and Reset</td>
<td>Emu-7</td>
</tr>
<tr>
<td>8. Memory Configuration for the DSP563xx/6xx</td>
<td>Emu-8</td>
</tr>
<tr>
<td>9. Communication Setup</td>
<td>Emu-9</td>
</tr>
<tr>
<td>9.1 Creating a Target Configuration File for a JTAG Chain</td>
<td>Emu-11</td>
</tr>
<tr>
<td>10. Hardware Breakpoints</td>
<td>Emu-14</td>
</tr>
</tbody>
</table>
MANUAL PURPOSE AND STRUCTURE

PURPOSE

This manual is aimed at users of the CrossView Pro debugger for the DSP56xxx Family. It assumes that you are familiar with programming the DSP5600x, DSP563xx or DSP566xx.

MANUAL STRUCTURE

Related Publications
Conventions Used In This Manual

CHAPTERS

1. Overview
   Highlights specific CrossView Pro features and capabilities, and shows how to compile code for debugging.

2. Software Installation
   Describes how to install CrossView Pro on your system.

3. Command Language
   Details the syntax of CrossView Pro’s command language.

4. Using CrossView Pro
   Describes the basic methods of invoking, operating, and exiting CrossView Pro.

5. Controlling Program Execution
   Describes the various means of program execution.

6. Accessing Code and Data
   Describes how to view and edit the variables in your source program.

7. Breakpoints and Assertions
   Describes breakpoints and assertions.
8. Defining and Using Macros
   Describes how to simplify a complicated procedure by creating a
   "shorthand" macro which can be used to execute any sequence of
   CrossView Pro or C language commands and expressions.

9. Command Recording & Playback
   Describes the record and playback functions of CrossView Pro.

10. I/O Simulation
    Describes how to simulate your input and output using File System
    Simulation (FSS), File I/O (FIO) or Debug Instrument I/O (DIO).

11. Special Features
    Describes special features of CrossView Pro, such as the Transparency
    Mode, RTOS Aware Debugging, Coverage, Profiling and the
    Background Mode.

12. Debugging Notes
    Contains some notes about debugging in special situations.

13. Command Reference
    An alphabetical list of all CrossView Pro commands. Consult this
    chapter for specifics and the exact syntax of any CrossView Pro
    command.

14. Error Messages
    Contains CrossView Pro error messages and gives advice for correcting
    them.

15. Glossary
    Defines the most common terms used in embedded systems
    debugging.
APPENDICES

A. Flexible License Manager (FLEXlm)
   Contains a description of the Flexible License Manager.

B. Interprocess Communication
   Contains a description of the COM interface and the DDE interface.

C. Register Manager
   Contains a description of the register managers \texttt{rm56} and \texttt{rm563}.

D. Sound Support (MS–Windows)
   Describes how to add sound to CrossView Pro events under MS–Windows.

ADDENDUM

\textit{Execution Environment}

   Contains information specific to your particular type of target system.

INDEX
RELATED PUBLICATIONS

- ANSI X3.159–1989 standard [ANSI]

- DSP56xxx Cross–Assembler, Linker/Locator, Utilities User’s Guide [TASKING, MA039–000–00–00]
- DSP56xxx C Cross–Compiler User’s Guide [TASKING, MA039–002–00–00]

- DSP56000 Digital Signal Processor Family Manual [Motorola, Inc.]

- DSP56300 24–Bit Digital Signal Processor Family Manual [Motorola, Inc.]

- DSP56600 Digital Signal Processor Family Manual [Motorola, Inc.]
- DSP5660x Digital Signal Processor User’s Manual [Motorola, Inc.]

- DSP56652 Baseband Digital Signal Processor User’s Manual [Motorola, Inc.]
- DSP56654 Baseband Digital Signal Processor User’s Manual [Motorola, Inc.]
CONVENTIONS USED IN THIS MANUAL

Notation for syntax

The following notation is used to describe the syntax of command line input:

**bold**  
Type this part of the syntax literally.

*italics*  
Substitute the italic word by an instance. For example:

```
filename
```

means: type the name of a file in place of the word *filename*.

{}  
Encloses a list from which you must choose an item.

[]  
Encloses items that are optional.

|  
Separates items in a list. Read it as OR.

...  
You can repeat the preceding item zero or more times.

For example

```
command [option]... filename
```

This line could be written in plain English as: execute the command *command* with the optional options *option* and with the file *filename*. 
Illustrations

The following illustrations are used in this manual:

- This is a note. It gives you extra information.
- This is a warning. Read the information carefully.
- This illustration indicates actions you can perform with the mouse.
- This illustration indicates keyboard input.
- This illustration can be read as “See also”. It contains a reference to another command, option or section.
1.1 INTRODUCTION

This chapter highlights many of the features and capabilities of CrossView Pro, including an Introduction to Source Level Debugging and the DSP56xxx Family Development Environment.

This chapter also contains the section Getting Started, which shows you how to compile a program to work with the debugger.

1.2 CROSSVIEW PRO’S FEATURES

CrossView Pro is TASKING’s CrossView Pro high-level language debugger. CrossView Pro is a real-time, source-level debugger that lets you debug embedded microprocessor systems at your highest level of productivity. Its powerful capabilities include:

- Multi-Window Graphical User Interface
- C and Assembly level debugging
- C Expression Evaluation including Function Calls
- Breakpoints (both hardware and software)
- Probe Points
- Assertions (software data breakpoints)
- C-trace, Instruction Trace
- I/O Simulation (IOS)
- Data Monitoring
- Single Stepping
- Coverage
- Profiling
- Macros
- Flexible Record & Playback Facilities
- Real-Time Kernel Support
- On-line context sensitive Help
- Documentation
**Multi-Window Interface**

This interface uses your host’s native windowing system, so that you already know how to open, close and resize windows. With windows you can keep track of information concerning registers, the stack, and variables. CrossView Pro automatically updates each window whenever execution stops.

You have great freedom in designing a suitable display. You can hide and resize the various windows if you choose.

**Statement Evaluation**

You can enter C expressions, CrossView Pro commands or any combination of the two for CrossView Pro to evaluate. Expression evaluation is an ideal way to test subroutines by passing them sample values and checking the results.

**Breakpoints**

Breakpoints halt program execution and return control to you. There are several types of breakpoints: code, data, instruction count, cycle count, timer and sequence.

Code breakpoints let you halt the program at critical junctures of program execution and observe values of important variables.

You may place data breakpoints to determine when memory addresses are read from, written to, or both. With data breakpoints, you can easily track the use and misuse of variables.

An instruction count breakpoint halts the program after a specified number of instructions have been executed; a cycle count breakpoint stops the program after a number of CPU cycles; a timer breakpoint stops the program after a number of micro seconds or ticks and sequence breakpoints stop the program when a number of breakpoints are hit in a specified sequence.

Data breakpoints, instruction count breakpoints, cycle count breakpoints and timer breakpoints are not available for all execution environments, please check the Addendum.
**Probe Point Breakpoints**

A breakpoint can be treated as a probe point. When a probe point breakpoint is hit, the associated commands are executed and program execution is continued. Probe points are used with File I/O simulation and sequence breakpoints.

**Assertions**

A powerful assertion mechanism lets you catch hard-to-find-errors. An assertion is a command, or series of commands, executed after every line of source code. You may use assertions to test for all sorts of error conditions throughout the entire length of your program.

**C-Trace**

CrossView Pro has a separate window that displays the most recently executed C statements or machine instructions. This feature uses the execution environment’s trace buffer along with symbolic information generated during compilation. This feature depends on the execution environment.

**I/O Simulation (IOS)**

With I/O simulation you can debug programs before the actual input and output devices are present. CrossView Pro can read input data from the keyboard or a file, or can send output to a window or a file. You can view the data in several formats, including hexadecimal and character. You can have an unlimited number of simulated I/O ports, which can be associated with the screen and displayed in windows.

**Data Monitoring**

You may place variables and expressions in the Data window, where CrossView Pro updates their values when execution stops.

**Single Stepping**

With CrossView Pro, you can single step through your code at source level or at assembly level, into or over procedure calls. Running your program one line at a time lets you check variables and program flow.
Coverage

When a command such as StepInto or Continue executes the application, CrossView Pro traces all memory access, i.e. memory read, memory write and instruction fetch. Through code coverage you can find executed and non-executed areas of the application program. Areas of unexecuted code may exist because of programming errors or because of unnecessary code. It may be that your program input, your test set, is incomplete; It does not cover all paths in the program. Data coverage allows you to verify which memory locations, i.e. which variables, are accessed during program execution. Additionally, you can see stack and heap usage. The availability of this feature depends on the execution environment.

Profiling

Profiling allows you to perform timing analysis on your software. Two forms of profiling are implemented in CrossView Pro.

Function profiling, also called cumulative profiling, gives you timing information about a particular function or set of functions. CrossView Pro shows: the number of times a function is called, the time spent in the function, the percentage of time spent in the function, and the minimum/maximum/average time spent in the function. The timing results include the time spent in functions called by the profiled function.

Code range profiling presents timing information about a consecutive range of program instructions. CrossView Pro displays the time consumed by each line (source or disassembly) in the Source Window. Next to this, the Profile Report dialog shows the time spend in each function. The timing results do not include the time consumed in functions called by the profiled function.

The availability of profiling depends on the execution environment. Function profiling can be supported if the execution environment provides a clock that starts and stops whenever execution starts and stops. Code range profiling heavily relies on special profiling features in the execution environment. Normally code range profiling is only supported by instruction set simulators.
**Macros**

Macros let you store and recall complex commands and expressions with a minimal number of keystrokes. You can store macros in a "toolbox", making it possible to execute complex functions with the touch of a mouse button. You can also place macros in command lists of breakpoints and assertions. You can use flow control statements within macros, and macros can call other macros, allowing you to construct arbitrarily complex sequences. Macros can accept multiple parameters, be saved and loaded from files and can even rename existing CrossView Pro commands.

**Record & Playback**

At any time, you can record the commands you type, and optionally their output, to a file. You can also play back files of commands all at once or in a single-step playback mode. These functions are helpful for setting up standardized debugging tests or to save results for later study or comparison.

**Kernel Support**

CrossView Pro supports RTOS (Real-Time Operating System) aware debugging for various kernels. Since each kernel is different, the RTOS aware features are not implemented in the CrossView Pro executable, but in a library that will be loaded at run–time by CrossView Pro. The amount of windows and dialogs and their contents is kernel dependent.

**On-Line Help**

When you click on a Help button or when you press the F1 function key in an active window, the CrossView Pro help system opens at the appropriate section. From this point, you can also access the rest of the help system.

**Documentation**

CrossView Pro has a comprehensive set of documentation for both new and experienced users. The manual includes an installation guide, description of debugging with CrossView Pro, error messages, and a command reference section. The documentation tries to cover a wide range of expertise, by making few assumptions about the technical experience of the reader.
1.3 SOURCE LEVEL DEBUGGING

CrossView Pro is a source level debugger. Source level means that debugging works on the actual C code or assembly code. CrossView Pro can deal with global and local variables that are both statically and dynamically allocated variables. Therefore, it can deal with compiled addresses of variables that move around the stack. CrossView Pro knows the compiler’s addressing conventions for variables of any type.

The Debugging Environment

All debugging configurations follow a similar pattern. There is a host system where the debugger runs, and a target system (usually an execution environment), where the program being debugged runs. There may also be a probe that can plug into the actual hardware of the embedded system being designed.

CrossView Pro provides a high-level interface between you, the user, working at the host system and a program running at the target system (execution environment). This means that you may issue commands that refer directly to the variables, source files, and line numbers as they appear in the source program. You can do this because CrossView Pro uses symbol information generated during compilation to translate the high-level commands that you type into a series of low level instructions that the target system understands. Using Generic Debug Instrument (GDI) calls towards a shared library for the simulator, or using a connection between the host and target, CrossView Pro finds out information about the state of the target program and then tells the target to perform the requested actions.

A host–target arrangement can perform functions beyond the reach of traditional software–based debuggers. Since the target contains the actual chip, CrossView Pro can observe its operations without interfering. The existence of CrossView Pro and the host is invisible to the target program. This means that the program under debug runs exactly the same as the final program will in a real embedded system (except for real–time situations like timings).
With CrossView Pro, you may also take advantage of any advanced capabilities of your target hardware through *emulator mode* (transparency mode). In transparency mode you can communicate with the target as if the host system were a terminal directly connected to the target. You can enter and leave transparency mode freely without restarting the debugger or the target system. CrossView Pro therefore does not interfere with the normal operation of the target hardware. Thus the debugger is a powerful accessory to the machine-level debugging that you might do with the target system alone. The transparency mode is not available for all execution environments.
1.4 HOW CROSSVIEW PRO WORKS

Although it is not necessary to know how CrossView Pro performs its debugging, you may be curious how CrossView Pro works.

Whenever you enter a debugger command, CrossView Pro obtains information from or controls the execution environment by sending appropriate commands over the host–target link. A typical session may go something like this:

1. Highlight initval and click on the Show Expression button in the Source Window.

   ![Source Window](image)

   **Figure 1–1: Inspect a variable**

2. CrossView Pro converts this action into a command. Depending on preferences you have set, the variable is shown in the Data Window or the Expression Evaluation dialog is shown.

3. CrossView Pro consults the symbol table to deduce the type and address of initval. Suppose initval is a variable of type int which lies at absolute location 100.

4. The debugger forms a command asking the target system to read two bytes starting at address 100 (the size of an int equals 2).

5. CrossView Pro then transmits the command to the target system and receives the response.
6. CrossView Pro interprets the response, and for example determines that `initval` equals 17.

7. CrossView Pro then displays `initval=17` since it knows `initval`'s type.

![CrossView Pro Command Output](image)

*Figure 1–2: CrossView Pro Command Output*

This is a simplified example, many CrossView Pro commands require several complex transactions, but all take place without you being aware of them.
1.5 DSP56XXX FAMILY PROGRAM DEVELOPMENT

The CrossView Pro debugger package is part of a toolchain that provides an environment for modular program development and debugging. The figure below shows the structure of the toolchain. The DSP56xxx/6xxx toolchain contains the following programs (the executables of the DSP5600x toolchain end in ‘56’):

cc563  The control program which activates the C compiler, assembler, linker and/or locator depending on its input files.

cp563  The C++ compiler which translates C++ source into C source suitable for the C compiler. Must be ordered separately.

c563   The C compiler. This is the dedicated DSP56xxx Family C compiler which translates a C source program into a highly optimized assembly source file, using the DSP56xxx Family assembly language specification.

as563  The assembler program which produces a relocatable object file from a given assembly file.

lk563  A linker that links objects and object libraries into one relocatable object file.

lc563  A locator that links one or more linker output files into one absolute load file in the IEEE Std. 695 debugging connection format. This program can also produce files in the Motorola S-record format, Intel Hex format or Motorola CLAS COFF absolute object format.

ar563  A librarian facility, which can be used to create and maintain object libraries.

pr563  A utility to view the contents of a relocatable object file or an absolute file.

mk563  A program builder which uses a set of dependency rules in a ‘makefile’ to build only the parts of an application which are out of date.

xfw56x The CrossView Pro debugger using DSP56xxx family execution environments. The name of the debugger is the same for all members of the DSP56xxx family.
Figure 1–3: DSP563xx development flow

For a full description of all available utility programs see the chapter Utilities in the Cross-Assembler, Linker/Locator, Utilities User’s Guide.
1.6 GETTING STARTED

1.6.1 BEFORE STARTING

Before using CrossView Pro, there are several things that you must do:

- Install the CrossView Pro software. Directions for your particular system are found in the Software Installation chapter.
- Configure your execution environment as described in the Execution Environment addendum.
- Compile the program that you want to debug. A brief description of this process is outlined in the section Building Your Executable later in this chapter.

For the purpose of getting you started quickly, we have supplied you with a demo program that you can debug. The demo program is demo.abs.

1.6.2 SETTING UP THE EXECUTION ENVIRONMENT

The following only applies to ROM monitor and emulator versions of CrossView Pro.

In order for the host and execution environment to communicate, a proper connection must exist between the two machines. Here are some important considerations:

- Use the correct kind of RS-232 cable. Note there are at least two types of cables, null modem and direct. Consult the execution environment’s manual for the correct type.
- Make sure the execution environment is configured to communicate with the host at the baud rate that CrossView Pro expects. Usually, the baud rate is 9600, but this is not always the case.
- Use the correct ports on both the execution environment and host. Many machines have two ports. If you use a different port on the host than the default (COM1 for PC), you will have to use a special startup switch, -D. See the startup options of the Using CrossView Pro chapter.
- See the addendum for details on the connection to the execution environment.
1.6.3 STARTING CROSSVIEW PRO

To invoke CrossView Pro, simply double-click on its icon. CrossView Pro starts up and opens the command window, source window and other windows.

Figure 1–4: Command Window
CrossView Pro can be passed the name of an execution (*.abs) file. This can be done from a command line, but the native windowing system often provides alternatives. Usually this involves dragging the program to be debugged onto the CrossView Pro executable from the Windows Explorer for Windows 95/98/XP/NT/2000, and dropping it there or associating CrossView Pro to be the application to start when double-clicking an .abs icon. CrossView Pro will start and load the symbol information from that file.

1.6.3.1 CROSSVIEW PRO TARGET SETTINGS

You can specify specific CrossView Pro target settings in the Target Settings dialog.

To open the Target Settings dialog:

- From the Target menu, select Settings...

  The Target Settings dialog box appears as shown in figure 1–5.

![Target Settings Dialog](image)

*Figure 1–5: CrossView Pro Target Settings*
You can set the following items in this dialog:

- Select a target configuration. See the text below for more information.
- Select the CPU type.
- Select the execution environment (optional).
- Select a configuration (optional).
- Specify the source directories for CrossView Pro. Click on the Configure... button to change the list of source directories.

**Target Configuration**

The available targets are described by the target configuration files (*.cfg in the etc subdirectory). The target configuration files are text files and can be edited with any text editor.

Empty lines, lines consisting of only white space are allowed. Comment starts at an exclamation-sign (!) and ends at the end of the line. Lines that start with the special notation '!' are script lines that are executed by CrossView Pro.

An information line has the following synopsis:

```
[! comment] field: field-value
```

- **field** one of the keywords described below
- **field-value** the value assigned to the field
- **comment** optional comment

The _fields_ listed in the configuration file are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>The full name of the configuration. This name will be displayed in the Target configuration field of the Target Settings dialog.</td>
</tr>
<tr>
<td>cpu_type</td>
<td>The name of the CPU. You can specify multiple CPU type separated by white space. This also determines the name of the register file regcpu.dat in the etc directory.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>debug_instrument_module</td>
<td>The name of the Debug Instrument (using GDI) used for debugging.</td>
</tr>
<tr>
<td>target_dependent_module</td>
<td>The name of the target specific module needed for your DSP56xxx derivative.</td>
</tr>
<tr>
<td>radm</td>
<td>The name of the Debug Instrument (using KDI) used for RTOS aware debugging.</td>
</tr>
</tbody>
</table>

Notes:
- Fields not required for the target can be omitted.
- CrossView Pro searches for the *.cfg files in the current directory and in the etc directory.

### 1.6.3.2 CONFIGURING CROSSVIEW PRO

You may have to configure CrossView Pro to talk to an emulator or ROM monitor. If you have a simulator version this step is not needed and the associated menu item is grayed out. To configure CrossView Pro:

- From the **Target** menu, select **Communication Setup**...
  The Communication Setup dialog box appears as shown in figure 1–6.

*Figure 1–6: Setting up CrossView Pro Communications*
• Adjust the communication parameters (baud rate and I/O port) to match your hardware configuration.
• Close the dialog box by clicking on the OK button.
• The settings in this dialog (and other dialogs) will be saved on exiting CrossView Pro, when the Save desktop and target settings check box in the Save tab of the Options dialog is set. This dialog always appears on exiting CrossView Pro.

1.6.3.3 LOADING SYMBOLIC DEBUG INFORMATION

You must tell CrossView Pro which program you want to debug. To do this:

• From the File menu, select Load Symbolic Debug Info...
The Load Symbolic Debug Info dialog box appears, as shown in figure 1–7.
• Type in the path and file name of the program that you want to debug, or click on the Browse... button to bring up a file selection dialog box. In our example we are using demo.abs. Note that in most cases you will want to set the code bias field to 0x0000.
• Set the Download image too check box by clicking on it, if you want to download the image of your absolute object file to the target. You can decide to postpone downloading to the target. In that case you can select Download Application... from the File menu any time afterwards.
• Set the Reset target system check box if you want to reset the target system to its initial state. You can decide to postpone resetting the target. In that case you can select Reset Target System from the Run menu afterwards.
• Set the Goto main check box if you want to execute the startup code. This automatically enables the Reset application check box. You can decide to postpone going to the main function. In that case you can execute a high-level single step afterwards.
• When you click on the Communication setup... button (if available), the Communication Setup dialog box appears as shown in figure 1–6. With the Target Settings... button you can open the Target Settings dialog. Please check the information in these dialogs before downloading an application.
• When you click on the **Load** button, the program's symbol file will be loaded into the debugger and, if you have set the **Download image too** check box, the image of your absolute object file will be downloaded.

• Clicking on **Cancel** ignores all actions.

CrossView Pro remembers all previously saved settings. In this case, the Load Symbolic Debug Info dialog already contains the previously saved configuration, so you only have to click the **Load** button to perform your actions.

![Load Symbolic Debug Info](image)

*Figure 1–7: Loading Symbolic Debug Information*

**Compare Application**

You can use the **File | Compare Application...** dialog to check if a file matches the downloaded application. This can be useful when your program has changed some of your code.
1.6.4 EXECUTING AN APPLICATION

To view your source while debugging, the Source Window must be open. To open this window,

- From the View menu, select Source | Source lines

Before starting execution you have to reset the target system to its initial state. The program counter, stack pointer and any other registers must be set to their initial value. The easiest way to do this is:

- Set the Reset target system check box and the Goto main check box in the Load Symbolic Debug Info dialog box. (See the previous section) Goto main automatically enables the Reset application check box.

Depending on your execution environment a target system reset may have undesired side effects. For this reason, the target system reset is executed before the code is downloaded to the target.

If you have not checked these items:

- From the Run menu, select Reset Target System
- From the Run menu, select Reset Application
- Execute a high-level single step (either into or over) using the toolbar in the Source Window (or F11/F10).

The first single step executes the startup code and stops at the first line of code in main(). You should see your program’s source code.

Another way of getting there is:

- Set a breakpoint at the entry of in main() by clicking on a breakpoint toggle at the left side of the text in the Source Window. See figure 1–8.
- Start the application with Run | Reset Application and Run | Run.

To set a breakpoint you can:

- Click on a breakpoint toggle (as shown in figure 1–8) to set or to remove a breakpoint. A green colored toggle shows that no breakpoint is set. A red colored toggle shows that a breakpoint is installed. An orange colored toggle shows that an installed breakpoint is disabled.
Due to compiler optimizations it is possible that a C statement does not translate in any executable code. In this case you cannot set a breakpoint at such a C statement. No breakpoint toggle is shown in this case.

Now it is time to execute your program:

- From the Run menu, select Run

In the Source Window the current execution position (the statement at the address identified by the current value of the program counter) is highlighted in blue. As a result, when execution stops, the line you set a breakpoint on is highlighted. You can now single step through your program using the Step Into and Step Over buttons in the Source Window. Or you may choose to execute the rest of the program (or at least until the next breakpoint) with the Run button.

At any point you can interrupt the emulator and regain control by clicking on the Halt button in either the Source Window or the Command Window.

For more information on executing a program, see the chapter Controlling Program Execution.
1.6.5 DEBUGGING AN APPLICATION

When debugging your application you probably want to see the calling sequence of your program, and inspect the contents of variables and data structures used within your program.

To see the calling sequence of your program the Stack Window must be open. The stack window shows the functions that are currently on the stack. To open the stack window,

- From the View menu, select Stack

To see the value of the local variables of a function,

- From the View menu, select Data | Watch Locals Window

Figure 1-9: Watch variables
To inspect the value of global variables and data structures,

- Double-click on the variable name in the Source Window.

Depending on preferences you have set, the variable is shown in the Data Window as shown in figure 1–9 or the dialog displayed in figure 1–10 is shown.

![Expression Evaluation Window](image)

Figure 1–10: Expression evaluation

Pointers, structures and arrays displayed in the data window have a compact and expanded form. The compact form for a structure is just `<struct>`, while the expanded form shows all the fields. The compact form of a pointer is the value of the pointer, while the expanded form shows the pointed-to object. The compact form is indicated by putting a '+' at the start of the display. (i.e., the object is expandable), while a '-' indicates the expanded form (i.e., the object is contractible). Nesting is supported, so structures within structures can likewise be expanded, ad infinitum.

To expand a pointer, structure or an array:

- Double-click on the '+' in the Data Window
1.6.6 CROSSVIEW PRO OUTPUT

Nearly every CrossView Pro command can be given using the graphical user interface. These commands and the debugger’s response is logged in the Command Output Window which is the upper part of the Command Window. Alternatively, CrossView Pro commands can be entered directly (without using the menu system) in the command edit field of the command window.

To open the Command Window:

- From the View menu, select Command | CrossView

Figure 1-11 shows an example of the Command Window. Commands can be typed into the command edit field (bottom field) or selected from the command history list (middle field) and edited then executed. The top field is referred to as the Command Output Window. Each command, echoed from the command edit field, is displayed with a ‘>’ prefix. CrossView’s response to the command is displayed below the command.

You can choose to clear the command edit field after executing a command. From the File menu, select Options... and select the Desktop tab. Enable the Clear command line after executing command check box. You can use the clear command to clear the Output Window.
1.6.7 EXITING CROSSVIEW PRO

To quit a debugging session:

- From the **File** menu, select **Exit** or close the Command Window.
- In the Options dialog that appears, select in the **Save** tab the options you want to be saved for another debug session.
- Click on the **Exit** button in the Options dialog.

If you selected one or more items in the Options dialog, your settings will be saved in the initialization file `xvw.ini`. This file is located in the startup directory.

**Workspace files**

If you have set the **Save desktop and target settings** check box in the **Save** tab, CrossView Pro will create a workspace file (.cws) for each debugged or loaded application. The settings will be restored in a following debug session. If CrossView Pro cannot find a workspace file for a loaded application it uses the default workspace file `xvw.cws` in the etc directory.

A CrossView Pro workspace file contains:

- Window positions and sizes
- Local toolbars status
- Main toolbar configuration
- Monitored variables in Data windows
- Memory window settings
- Terminal window settings
- Coverage and profiling display settings in the Source window
- Color settings

1.6.8 WHAT YOU MAY HAVE DONE WRONG

Most problems in starting up CrossView Pro for a debugging session stem from improperly setting up the execution environment or from an improper connection between the host computer and the execution environment. Some targets will require you to enter transparency mode to set the execution environment for a debugging session. Check the notes for your particular execution environment.

Here are some other common problems:
• Specifying the wrong device name when invoking the debugger.
• Specifying a baud rate different from the one the execution environment is configured to expect.
• Not supplying power to the execution environment or an attached probe.
• Using the wrong kind of RS-232 cable.
• Plugging the cable into an incorrect port on the execution environment or host. Some target machines and hosts have several ports.
• Installation of a device driver or resident application that uses the same communications port on the host system.
• The port may already be in use by another user on some UNIX hosts, or being allocated by a login process.
• Specifying no or an invalid CPU type with the -C option.
1.6.9 BUILDING YOUR EXECUTABLE

The subdirectory `xvw` in the examples subdirectory contains a demo program for the DSP56xxx toolchain.

In order to debug your programs, you will have to compile, assemble, link and locate them for debugging using the TASKING DSP56xxx Family tools. You can do this with one call to the control program or you can use EDE, the Embedded Development Environment (which uses a project file) or you can call the makefile from the command line. Use `cc56` for the DSP5600x or `cc563` for the DSP563xx/DSP566xx. The example below is given for the DSP563xx.

1.6.9.1 USING EDE

EDE stands for "Embedded Development Environment" and is the Windows oriented Integrated Development Environment you can use with your TASKING toolchain to design your application.

To use EDE on the demo program, located in the subdirectory `xvw` in the examples subdirectory of the DSP56xxx product, follow the steps below.

A detailed description of the process creating the sample program `demo.abs` is described below. This procedure is outlined as a guide for you to build your own executables for debugging.

The dialog boxes shown in this manual serve as an example. They may slightly differ from the ones in your product.

How to Start EDE

You can launch EDE by double-clicking on the EDE shortcut on your desktop.

The EDE screen provides you with a menu bar, a toolbar (command buttons) and one or more windows (for example, for source files), a status bar and numerous dialog boxes.
How to Select a Toolchain

EDE supports all the TASKING toolchains. When you first start EDE, the toolchain of the product you purchased is selected and displayed in the title of the EDE desktop window.

If you have more than one TASKING product installed and you want to change toolchains, do the following:

1. From the Project menu, select Select Toolchain...

   The Select Toolchain dialog appears.
2. Select the toolchain you want. You can do this by clicking on a toolchain in the Toolchains list box and click OK.

If no toolchains are present, use the Browse... or Scan Disk... button to search for a toolchain directory. Use the Browse... button if you know the installation directory of another TASKING product. Use the Scan Disk... button to search for all TASKING products present on a specific drive. Then return to step 2.

**How to Open an Existing Project**

Follow these steps to open an existing project:

1. From the Project menu, select Set Current ->.

2. Select the project file to open. For the demo program select the file demo.pjt, located in the subdirectory xvw in the examples subdirectory of the DSP56xxx product tree. If you have used the defaults, the file demo.pjt is in the directory c:\c563\examples\xvw for the DSP563xx_DSP566xx (use c56 for the DSP5600x).

**How to Load/Open Files**

The next two steps are not needed for the demo program because the files addone.asm and demo.c are already open. To load the file you want to look at:

1. From the Project menu, select Load Files...

_The Choose Project Files to Edit dialog appears._
2. Choose the file(s) you want to open by clicking on it. You can select multiple files by pressing the <Ctrl> or <Shift> key while you click on a file. With the <Ctrl> key you can make single selections and with the <Shift> key you can select everything from the first selected file to the file you click on. Then click OK.

This launches the file(s) so you can edit it (them).

**Check the directory paths**

1. From the **Project** menu, select **Directories**...

The **Directories** dialog appears.
2. Check the directory paths for programs, include files and libraries. You can add your own directories here, separated by semicolons.

3. Click OK.

**How to Select a CPU Type**

The next step is to compile the file(s) together with its dependent files so you can debug the application. But first you need to specify for which CPU type you want to build your application:

1. From the **Project** menu, select **Project Options...**

   *The Project Options dialog box appears.*

2. In the **CPU Selection** page, select the CPU or CPU family for which you want to build your application.

3. Click OK.

**How to Build the Demo Application**

Now you can build your application.

Steps 1 and 2 are optional. Follow these steps if you want to specify additional build options such as to stop the build process on errors and to keep temporary files that are generated during a build.

1. From the **Build** menu, select **Options...**

   *The Build Options dialog appears.*
2. Make your changes and press the **OK** button.

3. From the **Build** menu, select **Scan All Dependencies**.

4. Click on the **Execute 'Make' command** button. The following button is the execute Make button which is located in the toolbar.

   ![Image]

   If there are any unsaved files, EDE will ask you in a separate dialog if you want to save them before starting the build.

**How to View the Results of a Build**

Once the files have been processed you can inspect the generated messages.

You can see which commands (and corresponding output captured) which have been executed by the build process in the **Build** tab:

```
TASKING program builder vx.y rz Build nnn SN 00000000
Compiling “demo.c”
Assembling “demo.src”
Assembling “addone.asm”
Linking to “demo.out”
Creating IEEE-695 absolute file “demo.abs”
```

**How to Start the CrossView Pro Debugger**

Once the files have been compiled, assembled, linked, located and formatted they can be executed by CrossView Pro.

To start CrossView Pro:

1. Click on the **Debug application** button. The following button is the Debug application button which is located in the toolbar.

   ![Image]

   CrossView Pro is launched. CrossView Pro will automatically download the compiled file for debugging.
**How to Start a New Project**

When you first use EDE you need to set up a project space and add a new project:

1. From the **File** menu, select **New Project Space**...

   *The Create a New Project Space dialog appears.*

2. Give your project space a name and then click **OK**.

   *The Project Properties dialog box appears.*

3. Click on the **Add new project to project space** button.

   *The Add New Project to Project Space dialog appears.*

4. Give your project a name and then click **OK**.

   *The Project Properties dialog box then appears for you to identify the files to be added.*

5. Add all the files you want to be part of your project. Then press the **OK** button. To add files, use one of the 3 methods described below.

- If you do not have any source files yet, click on the **Add new file to project** button in the Project Properties dialog. Enter a new filename and click **OK**.

- To add existing files to a project by specifying a file pattern click on the **Scan existing files into project** button in the Project Properties dialog. Select the directory that contains the files you want to add to your project. Enter one or more file patterns separated by semicolons. The button next to the **Pattern** field contains some predefined patterns. Next click **OK**.

- To add existing files to a project by selecting individual files click on the **Add existing files to project** button in the Project Properties dialog. Select the directory that contains the files you want to add to your project. Add the applicable files by double-clicking on them or by selecting them and pressing the **Open** button.
The new project is now open.

6. From the **Project** menu, select **Load Files...** to open the files you want on your EDE desktop.

EDE automatically creates a makefile for the project. EDE updates the makefile every time you modify your project.

### 1.6.9.2 USING THE CONTROL PROGRAM

A detailed description of the process creating the sample program `demo.abs` is described below. This procedure is outlined as a guide for you to build your own executables for debugging.

1. Make the subdirectory `xvw` of the `examples` directory the current working directory.

2. Be sure that the directory of the binaries is present in the PATH environment variable when you work from a command prompt instead of from EDE.

3. Compile, assemble, link and locate the modules using one call to the control program `cc563` (use `cc56` for the DSP5600x):  

   ```
   cc563 -g -M demo.c addone.asm -o demo.abs
   ```

   The `-g` option specifies to generate symbolic debugging information. This option must always be specified when debugging with CrossView Pro.

   The `-M` option specifies to generate map files.

   The `-o` option specifies the name of the output file.

   The command in step 3 generates the object files `demo.obj` and `addone.obj`, the linker map file `demo.lnl`, the locator map file `demo.map` and the absolute output file `demo.abs`. The file `demo.abs` is in the IEEE Std. 695 format, and can directly be used by CrossView Pro. No separate formatter is needed.

   Now you have created all the files necessary for debugging with CrossView Pro using one call to the control program.
If you want to see how the control program calls the compiler, assembler, linker and locator, you can use the \texttt{-v0} option or \texttt{-v} option. The \texttt{-v0} option only displays the invocations without executing them. The \texttt{-v} option also executes them.

\begin{verbatim}
cc563  -g -M demo.c addone.asm -o demo.abs -v0
\end{verbatim}

The control program shows the following command invocations without executing them (UNIX output):

\begin{verbatim}
TASKING DSP563xx/6xx control program   vx.yrz Build nnn
Copyright 1996–year Altium BV          Serial# 00000000
demo.c:
  + c563 -o /tmp/cc19472b.src -g -M24x demo.c
  + as563 -o demo.obj -gs -M24x /tmp/cc19472b.src
addone.asm:
  + as563 -o addone.obj -gs -M24x addone.asm
  + lk563 -o/tmp/cc19472c.out -ddef_targ.dsc -uR_def_targ demo.obj
     addone.obj -lc24 -lfp24 -lrt24
  + lc563 -odemo.abs -ddef_targ.dsc -f1 -M /tmp/cc19472c.out
\end{verbatim}

The \texttt{-lc24}, \texttt{-lfp24} and \texttt{-lrt24} options of the linker specify to link the appropriate C library, run–time library and floating point library.

As you can see, the tools use temporary files for intermediate results. If you want to keep the intermediate files you can use the \texttt{-tmp} option. The following command makes this clear.

\begin{verbatim}
cc563  -g -M demo.c addone.asm -o demo.abs -v0 -tmp
\end{verbatim}

This command produces the following output:

\begin{verbatim}
TASKING DSP563xx/6xx control program   vx.yrz Build nnn
Copyright 1996–year Altium BV          Serial# 00000000
demo.c:
  + c563 -o demo.src -g -M24x demo.c
  + as563 -o demo.obj -gs -M24x demo.src
addone.asm:
  + as563 -o addone.obj -gs -M24x addone.asm
  + lk563 -odemo.out -ddef_targ.dsc -uR_def_targ demo.obj addone.obj
     -lc24 -lfp24 -lrt24
  + lc563 -odemo.abs -ddef_targ.dsc -f1 -M /tmp/cc19472c.out
\end{verbatim}

As you can see, if you use the \texttt{-tmp} option, the assembly source files and linker output file will be created in your current directory also.

Of course, you will get the same result if you invoke the tools separately using the same calling scheme as the control program.
As you can see, the control program automatically calls each tool with the correct options and controls.

1.6.9.3 USING THE MAKEFILE

The subdirectories in the examples directory each contain a makefile which can be processed by mk563 (use mk56 for the DSP5600x). Also each subdirectory contains a readme.txt file with a description of how to build the example.

To build the demo example follow the steps below. This procedure is outlined as a guide for you to build your own executables for debugging.

1. Make the subdirectory xvw of the examples directory the current working directory.

This directory contains a makefile for building the demo example. It uses the default mk563 rules.

2. Be sure that the directory of the binaries is present in the PATH environment variable.

3. Compile, assemble, link and locate the modules using one call to the program builder mk563:

   mk563

This command will build the example using the file makefile.

To see which commands are invoked by mk563 without actually executing them, type:

   mk563 -n

This command produces the following output:

   TASKING DSP563xx/6xx program builder vx.yrz Build nnn
   Copyright 1996-year Altium BV          Serial# 00000000
   cc563 -c -o demo.obj -g -w303 demo.c
   cc563 -c -o addone.obj -g -w303 addone.asm
   cc563 -o demo.abs demo.obj addone.obj -g -w303

   The -M option in the makefile is used to create the linker list file (.1nl) and the locator map file (.map).
To remove all generated files type:

```
mk563 clean
```
SOFTWARE INSTALLATION
2.1 INTRODUCTION

This chapter describes the procedure for the installation of the TASKING CrossView Pro debugger for the DSP56xxx Family on Windows and several UNIX hosts.

2.2 NOTE ABOUT FILENAMES

Members of the CrossView Pro family of debuggers use the following name convention for their executables:

\textbf{x}fw56x \quad \text{(for all DSP56xxx family members)}

2.3 INSTALLATION FOR WINDOWS

1. Start Windows (95/98/NT/2000), if you have not already done so.

2. Insert the CD-ROM into the CD-ROM drive.

\textit{If the TASKING Showroom dialog box appears, proceed with Step 5.}

3. Click the Start button and select Run...

4. In the dialog box type \texttt{d:\setup} (substitute the correct drive letter for your CD-ROM drive) and click on the OK button.

\textit{The TASKING Showroom dialog box appears.}

5. Select a product and click on the Install button.

\begin{quote}
\textbf{The CrossView Pro debugger simulator version is part of the TASKING tools package, so no separate installation is required. If you want to use a hardware execution environment you have to install the package in a preferred order (to prevent uninstall problems): Please install the compiler tools first, then the debugger, and install them in the same directory. This procedure has the advantage that the device drivers for the hardware can be uninstalled successfully; the compiler package can be removed manually.}
\end{quote}
If your target execution environment is the ADS RedCap for the DSP5665x family, and you already have CrossView Pro installed for another ADS execution environment, you must first uninstall CrossView Pro before installing this version. It is also possible to install both device drivers, but then you need two ADS I/O cards in your PC, mapped to different addresses.

6. Follow the instructions that appear on your screen.

You can find your serial number on the Start-up kit envelope delivered, with the product.

7. Make sure that the directory containing the installed executable files is present in the PATH environment variable, when you invoke the tools from a command prompt.

8. License the software product as explained in section 2.7, Licensing TASKING Products.

### 2.3.1 REQUIREMENTS

The hardware/software requirements are:

- 486 PC or higher
- Windows 95/98, NT or 2000
2.4 INSTALLATION FOR UNIX HOSTS

1. Login as a user.

   Be sure you have read, write and execute permissions in the installation directory. Otherwise, login as "root" or use the su command.

   If you are a first time user decide where you want to install the debugger (By default it will be installed in /usr/local).

2. For CD-ROM install: insert the CD-ROM into the CD-ROM drive. Mount the CD-ROM on a directory, for example /cdrom. Be sure to use a ISO 9660 file system with Rock Ridge extensions enabled. See the UNIX manual pages about mount for details.

   Or:

   For tape install: insert the tape into the tape unit and create a directory where the contents of the tape can be copied to. Consider the created directory as a temporary workspace that can be deleted after installation has succeeded. For example:

   ```
   mkdir /tmp/instdir
   ```

3. For CD-ROM install: go to the directory on which the CD-ROM is mounted:

   ```
   cd /cdrom
   ```

   For tape install: copy the contents of the tape to the temporary workspace using the following commands:

   ```
   cd /tmp/instdir
tar xvf /dev/tape
   ```

   where tape is the name of your tape device.

   If you have received a tape with more than one product, use the non-rewinding device for installing the products.

4. Run the installation script:

   ```
   sh install
   ```

   and follow the instructions appearing on your screen.
First a question appears about where to install the software. The default answer is /usr/local. On certain sites you may want to select another location.

On some hosts the installation script asks if you want to install SW00008, the Flexible License Manager (FLEXlm). If you do not already have FLEXlm on your system, you must install it; otherwise the product will not work on those hosts. See section 2.7, Licensing TASKING Products.

If the script detects that the software has been installed before, the following messages appear on the screen:

*** WARNING ***  
SWxxxxxxx xxxx.xxxx already installed.   
Do you want to REINSTALL? [y,n]

Answering n (no) to this question causes installation to abort and the following message being displayed:

=> Installation stopped on user request <=

Answering y (yes) to this question causes installation to continue. And the final message will be:

Installation of SWxxxxxxx xxxx.xxxx completed.

For the DSP5600x the directory c56 will be created. For the DSP563xx/DSP566xx this directory will be c563.

5. For tape install: remove the temporary installation directory with the following commands:

```
cd /tmp
rm -rf instdir
```

6. Make sure that the directory containing the installed executable files is present in the PATH environment variable.

7. If you purchased a protected TASKING product, license the software product as explained in section 2.7, Licensing TASKING Products.

⚠️ X Windows is required to run CrossView Pro.
2.5 CONFIGURING THE X WINDOWS MOTIF ENVIRONMENT

To run the Motif version of CrossView Pro on a Sun, you must define the environment variable \texttt{LD\_LIBRARY\_PATH} to where the library file \texttt{libMrm.a} resides. For example:

\begin{verbatim}
LD_LIBRARY_PATH=/usr/dt/lib
export LD_LIBRARY_PATH
\end{verbatim}

CrossView Pro uses a binary resource file for appearance-related specifications for windows, menus, dialog boxes, and strings to be accessed at run-time. The name of the resource file has the same name as the executable but with .uid extension. Be sure that the .uid file is present in one of the following directories:

1. the current directory
2. the directory specified by the \texttt{UIDPATH} environment variable

The environment variable \texttt{UIDPATH} specifies the path used by Motif to locate the resource (.uid) file. If not set, it is set to a default value. The resource file is installed in the same directory as the associated executable. So, you should set \texttt{UIDPATH} as follows (Bourne shell syntax):

\begin{verbatim}
UIDPATH=path_to_uid/%U
export UIDPATH
\end{verbatim}

Replace \texttt{path_to_uid} by the path to the directory in which the resource file is installed. The \texttt{%U} is required.

For more details refer to \texttt{MrmOpenHierarchy} in the \textit{OSF/Motif Programmer’s Reference} manual.
2.6 USING X RESOURCES

X toolkit resources specify GUI object (widget) attributes. Resources are specified in either the .Xdefaults file or in application class-specific files.

The .Xdefaults file is (typically) loaded into the X server at the start of the session. Any changes take effect only in a new session, or after using xrdb. Alternatively, application class resource files may be used. Application resource files have the same name as the executable CrossView Pro version they refer to (first letter NOT capitalized). Application resource files must be present either in the directory specified by the HOME environment variable, or in the app–defaults directory. The app–defaults directory is typically located under /usr/lib/X11.

X recognizes various environment variables for specifying paths to the application resource files. For more information, consult the chapter on X resources in O'Reilly’s X Toolkit Intrinsics Programming Manual and your system documentation.

The X resource specification allows either global (loosely) bound specifications (*foreground: black) or per-widget instance specifications (*button.foreground: black).

The following list shows the relevant widgets used by the Motif version of CrossView Pro:

Windows:

- TOP–LEVEL – XmMainWindow => XmDrawingArea
- CHILD – XmScrolledWindow => XmDrawingArea

Dialog:

- MODAL – XmBulletinBoard
- MODELESS – XmBulletinBoard

Menu:

- MENUBAR – XmMenuShell
- PULLDOWN – XmCascadeButton
Controls:

- **CHECKBOX** – XmToggleButton
- **RADIODIAGRAM** – XmToggleButton
- **TEXT** – XmLabel
- **EDIT** – XmText
- **LISTBOX** – XmScrolledWindow => XmList
- **SCROLLBAR** – XmScrollBar
- **PUSHBUTTON** – XmPushButton
- **LISTBUTTON** – XmText & XmArrowButton & XmScrolledWindow => XmList
- **LISTEDIT** – XmText & XmArrowButton & XmScrolledWindow => XmList
- **GROUPBOX** – XmFrame => XmLabel
- **ICON** – XmLabel with pixmap
- **FILESELECTION** – XmFileSelectionBox
- **ERRORPOPUP** – XmMessageBox

CrossView Pro repaints its windows in the default color as specified with the Motif widget resource settings. It is possible to overrule this behavior with a resource setting like: "*XmDrawingArea.background: blue".

CrossView Pro uses a non proportional font in all of its windows. The font size is selected using the "Desktop Setup dialog". You can use the "font" resource (*fontList on Motif) to select the font to be displayed in the menubar and dialogs, it won’t affect the font displayed in the CrossView Pro windows.

The CrossView Pro stack and data windows are implemented using a XmScrolledWindow widget on Motif.

The following list show the contents of an example app-defaults file intended for Motif environments. Of course you may adjust the colors and font to your preferences. Sample app-defaults files are delivered with the product in the etc directory (app_def.mwm for Motif).

*fontList: 7x13bold
*foreground: black
*XmMainWindow.background: white
*XmScrolledWindow.background: white
*XmDrawingArea.background: white
*XmBulletinBoard.background: DarkSeaGreen
*XmToggleButton.background: gray
*XmLabel.background: gray
If you encounter any problems due to incorrect resource settings, like invisible text caused by identical text and background color, clear the RESOURCE_MANAGER. Use the following procedure to clear the RESOURCE_MANAGER:

1. Save a copy of the .Xdefaults file located in your home directory.
2. Install an empty .Xdefaults file.
3. Execute `xrdb -all .Xdefaults` to actually clear the RESOURCE_MANAGER property.
4. Restart CrossView Pro and check if windows and dialogs are displayed correctly.
5. Now you add the saved resources (one by one) back into the .Xdefaults file and execute `xrdb` to install them in the server. Restart CrossView Pro and check the influence of the new resource settings. Adapt your saved resources when necessary.
2.7 LICENSING TASKING PRODUCTS

TASKING products are protected with license management software (FLEXlm). To use a TASKING product, you must install the licensing information provided by TASKING for the type of license purchased.

You can run TASKING products with a node-locked license or with a floating license. When you order a TASKING product determine which type of license you need (UNIX products only have a floating license).

**Node-locked license (PC only)**

This license type locks the software to one specific PC so you can use the product on that particular PC only.

**Floating license**

This license type manages the use of TASKING product licenses among users at one site. This license type does not lock the software to one specific PC or workstation but it requires a network. The software can then be used on any computer in the network. The license specifies the number of users who can use the software simultaneously. A system allocating floating licenses is called a license server. A license manager running on the license server keeps track of the number of users.

See Appendix A, Flexible License Manager (FLEXlm), for detailed information on FLEXlm.

2.7.1 OBTAINING LICENSE INFORMATION

Before you can install a software license you must have a "License Information Form" containing the license information for your software product. If you have not received such a form follow the steps below to obtain one. Otherwise, you can install the license.

**Node-locked license (PC only)**

1. If you need a node-locked license, you must determine the hostid of the computer where you will be using the product. See section 2.7.7, How to Determine the Hostid.
2. When you order a TASKING product, provide the hostid to your local TASKING sales representative. The License Information Form which contains your license key information will be sent to you with the software product.

Floating license

1. If you need a floating license, you must determine the hostid and hostname of the computer where you want to use the license manager. Also decide how many users will be using the product. See section 2.7.7, How to Determine the Hostid and section 2.7.8, How to Determine the Hostname.

2. When you order a TASKING product, provide the hostid, hostname and number of users to your local TASKING sales representative. The License Information Form which contains your license key information will be sent to you with the software product.

2.7.2 INSTALLING NODE-LOCKED LICENSES

Keep your "License Information Form" ready. If you do not have such a form read section 2.7.1, Obtaining License Information, before continuing.

Step 1

Install the TASKING software product following the installation procedure described in section 2.3, Installation for Windows.

Step 2

Create a file called "license.dat" in the c:\flexlm directory, using an ASCII editor and insert the license information contained in the "License Information Form" in this file. This file is called the "license file". If the directory c:\flexlm does not exist, create the directory.

If you wish to install the license file in a different directory, see section 2.7.6, Modifying the License File Location.

If you already have a license file, add the license information to the existing license file. If the license file already contains any SERVER lines, you must use another license file. See section 2.7.6, Modifying the License File Location, for additional information.

The software product and license file are now properly installed.
See Appendix A, *Flexible License Manager (FLEXlm)*, for more information on FLEXlm.

### 2.7.3 INSTALLING FLOATING LICENSES

Keep your "License Information Form" ready. If you do not have such a form read section 2.7.1, *Obtaining License Information*, before continuing.

**Step 1**

Install the TASKING software product following the installation procedure described earlier in this chapter on the computer or workstation where you will use the software product.

As a result of this installation two additional files for FLEXlm will be present in the *flexlm* subdirectory of the toolchain:

- **Tasking**: The Tasking daemon (vendor daemon).
- **license.dat**: A template license file.

**Step 2**

If you already have installed FLEXlm v6.1 or higher for Windows or v2.4 or higher for UNIX (for example as part of another product) you can skip this step and continue with step 3. Otherwise, install SW000098, the Flexible License Manager (FLEXlm), on the license server where you want to use the license manager.

The installation of the license manager on Windows also sets up the license daemon to run automatically whenever a license server reboots. On UNIX you have to perform the steps as described in section 2.7.5, *Setting Up the License Daemon to Run Automatically*.

It is not recommended to run a license manager on a Windows 95 or Windows 98 machine. Use Windows NT instead (or UNIX).

**Step 3**

If FLEXlm has already been installed as part of a non-TASKING product you have to make sure that the *bin* directory of the FLEXlm product contains a copy of the **Tasking** daemon (see step 1).
Step 4

Insert the license information contained in the "License Information Form" in the license file, which is being used by the license server. This file is usually called license.dat. The default location of the license file is in directory \c:\flexlm\ for Windows and in /usr/local/flexlm/licenses for UNIX.

If you wish to install the license file in a different directory, see section 2.7.6, Modifying the License File Location.

If the license file does not exist, you have to create it using an ASCII editor. You can use the license file license.dat from the toolchain's flexlm subdirectory as a template.

If you already have a license file, add the license information to the existing license file. If the SERVER lines in the license file are the same as the SERVER lines in the License Information Form, you do not need to add this same information again. If the SERVER lines are not the same, you must use another license file. See section 2.7.6, Modifying the License File Location, for additional information.

Step 5

On each PC or workstation where you will use the TASKING software product the location of the license file must be known. If it differs from the default location (c:\flexlm\license.dat for Windows, /usr/local/flexlm/licenses/license.dat for UNIX), then you must set the environment variable LM_LICENSE_FILE. See section 2.7.6, Modifying the License File Location, for more information.

Step 6

Now all license information is entered, the license manager must be started (see section section 2.7.4). Or, if it is already running you must notify the license manager that the license file has changed by entering the command (located in the flexlm bin directory):

```
lmreread
```

On Windows you can also use the graphical FLEXlm Tools (Imtools): Start Imtools (if you have used the defaults this can be done by selecting Start -> Programs -> TASKING FLEXlm -> FLEXlm Tools), fill in the current license file location if this field is empty, click on the Reread button and then on OK. Another option is to reboot your PC.
The software product and license file are now properly installed.

Where to go from here?

The license manager (daemon) must always be up and running. Read section 2.7.4 on how to start the daemon and read section 2.7.5 for information how to set up the license daemon to run automatically.

If the license manager is running, you can now start using the TASKING product.

See Appendix A, Flexible License Manager (FLEXlm), for detailed information on FLEXlm.

2.7.4 STARTING THE LICENSE DAEMON

The license manager (daemon) must always be up and running. To start the daemon complete the following steps on each license server:

Windows

1. From the Windows Start menu, select Programs -> TASKING FLEXlm -> FLEXlm License Manager.

   The license manager tool appears.

2. In the Control tab, click on the Start button.

3. Close the program by clicking on the OK button.

UNIX

1. Log in as the operating system administrator (usually root).

2. Change to the FLEXlm installation directory (default /usr/local/flexlm):

   cd /usr/local/flexlm

3. For C shell users, start the license daemon by typing the following:

   bin/lmgrd -2 -p -c licenses/license.dat >>& /var/tmp/license.log &
Or, for Bourne shell users, start the license daemon by typing the following:

```
bin/lmgrd -2 -p -c licenses/license.dat >> /var/tmp/license.log 2>&1 &
```

In these two commands, the `-2` and `-p` options restrict the use of the `lmdown` and `lmremove` license administration tools to the license administrator. You omit these options if you want. Refer to the usage of `lmgrd` in Appendix A, *Flexible License Manager (FLEXlm)*, for more information.

### 2.7.5 SETTING UP THE LICENSE DAEMON TO RUN AUTOMATICALLY

To set up the license daemon so that it runs automatically whenever a license server reboots, follow the instructions below that are appropriate for your platform. Steps on each license server:

**Windows**

1. From the Windows Start menu, select Programs -> TASKING FLEXlm -> FLEXlm License Manager.

   The license manager tool appears.

2. In the Setup tab, enable the Start Server at Power-Up check box.

3. Close the program by clicking on the OK button. If a question appears, answer Yes to save your settings.

**UNIX**

In performing any of the procedures below, keep in mind the following:

- Before you edit any system file, make a backup copy.
**SunOS4**

1. Log in as the operating system administrator (usually root).

2. Append the following lines to the file `/etc/rc.local`. Replace `FLEXLMDIR` by the FLEXlm installation directory (default `/usr/local/flexlm`):

```
FLEXLMDIR/bin/lmgrd -2 -p -c FLEXLMDIR/licenses/license.dat >> /var/tmp/license.log 2>&1 &
```

**SunOS5 (Solaris 2)**

1. Log in as the operating system administrator (usually root).

2. In the directory `/etc/init.d` create a file named `rc.lmgrd` with the following contents. Replace `FLEXLMDIR` by the FLEXlm installation directory (default `/usr/local/flexlm`):

```
#!/bin/sh
FLEXLMDIR/bin/lmgrd -2 -p -c FLEXLMDIR/licenses/license.dat >> /var/tmp/license.log 2>&1 &
```

3. Make it executable:

```
chmod u+x rc.lmgrd
```

4. Create an 'S' link in the `/etc/rc3.d` directory to this file and create 'K' links in the other `/etc/rc?.d` directories:

```
ln /etc/init.d/rc.lmgrd /etc/rc3.d/Snumrc.lmgrd
ln /etc/init.d/rc.lmgrd /etc/rc?.d/Knumrc.lmgrd
```

`num` must be an appropriate sequence number. Refer to your operating system documentation for more information.

### 2.7.6 MODIFYING THE LICENSE FILE LOCATION

The default location for the license file on Windows is:

```
c:\flexlm\license.dat
```

On UNIX this is:

```
/usr/local/flexlm/licenses/license.dat
```
If you want to use another name or directory for the license file, each user must define the environment variable `LM_LICENSE_FILE`. Do this in `autoexec.bat` (Windows 95/98), from the Control Panel -> System | Environment (Windows NT) or in a UNIX login script.

If you have more than one product using the FLEXlm license manager you can specify multiple license files to the `LM_LICENSE_FILE` environment variable by separating each pathname (`lfpath`) with a `;` (on UNIX also `:`):

Example Windows:

```
set LM_LICENSE_FILE=c:\flexlm\license.dat;c:\license.txt
```

Example UNIX:

```
setenv LM_LICENSE_FILE
/usr/local/flexlm/licenses/license.dat:/myprod/license.txt
```

If the license file is not available on these hosts, you must set `LM_LICENSE_FILE` to `port@host`; where `host` is the host name of the system which runs the FLEXlm license manager and `port` is the TCP/IP port number on which the license manager listens.

To obtain the port number, look in the license file at `host` for a line starting with `SERVER`. The fourth field on this line specifies the TCP/IP port number on which the license server listens. For example:

```
setenv LM_LICENSE_FILE 7594@elliot
```

See Appendix A, *Flexible License Manager (FLEXlm)*, for detailed information.

### 2.7.7 HOW TO DETERMINE THE HOSTID

The hostid depends on the platform of the machine. Please use one of the methods listed below to determine the hostid.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Tool to retrieve hostid</th>
<th>Example hostid</th>
</tr>
</thead>
<tbody>
<tr>
<td>SunOS/Solaris</td>
<td><code>hostid</code></td>
<td>170a3472</td>
</tr>
<tr>
<td>Windows</td>
<td><code>tkhostid</code> (or use <code>lmhostid</code>)</td>
<td>0800200055327</td>
</tr>
</tbody>
</table>

*Table 2–1: Determine the hostid*
If you do not have the program **tkhostid** you can download it from our Web site at: http://www.tasking.com/support/flexlm/tkhostid.zip. It is also on every product CD that includes FLEXlm.

### 2.7.8 **HOW TO DETERMINE THE HOSTNAME**

To retrieve the hostname of a machine, use one of the following methods.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>SunOS/Solaris</td>
<td>hostname</td>
</tr>
<tr>
<td>Windows 95/98</td>
<td>Go to the Control Panel, open “Network”, click on “Identification”. Look for “Computer name”.</td>
</tr>
<tr>
<td>Windows NT</td>
<td>Go to the Control Panel, open “Network”. In the “Identification” tab look for “Computer Name”.</td>
</tr>
</tbody>
</table>

*Table 2-2: Determine the hostname*
3.1 INTRODUCTION

The syntax and semantics of CrossView Pro’s command language is discussed here. This language is mainly used to enter textual commands in the command edit field of the Command Window. The mouse and menus allow you to access most actions without knowing the command language, although the command language is more powerful. The command language is also used when evaluating expressions and in commands associated with assertions, breakpoints and macros. For information about specific CrossView Pro commands, refer to Chapter 13, Command Reference.

3.2 CROSSVIEW PRO EXPRESSIONS

There are several methods that you can use to input an expression into CrossView Pro:

It is possible to display both monitored and unmonitored expressions in the Data Window. Monitored expressions are updated after every halt in execution. Unmonitored expressions are just one-shot inspections of the expressions value. Refer to section 4.6, CrossView Pro Windows for a detailed description of the Data Window.

To evaluate a simple expression:

Double click on a variable in the Source window. The result of the expression appears in the data window. Alternatively, depending on the preferences you set in the Data Display Setup dialog, the expression appears in the Evaluate Expression dialog. Click the Add Watch or Add Show button to display the result of the expression in the Data Window. Click the Evaluate button to display the result of the expression in the output field of the Evaluate Expression dialog.

To evaluate a complex expression:

From the Data menu, select Evaluate Expression... and type in any C expression in the Evaluate Expression dialog box. Optionally select a display format. Click the Evaluate button.

Type the expression into the command edit field of the Command Window followed by a return or click the Execute button.
Expressions can be any length in most windows and dialog boxes; CrossView Pro provides a horizontal scroll bar if an expression exceeds the visible length of the entry field.

In CrossView Pro, C expressions may consist of a combination of numeric constants, character constants, strings, variables, register names, C operators, function names, function calls, typecasts and some CrossView Pro-specific symbols. Each of these is described in the next sections.

**Evaluation Precision**

CrossView Pro evaluates expressions using the same data types and associated precision as used by the target architecture when evaluating the same expression.

### 3.3 CONSTANTS

Some DSP processors support features to "prevent" against overflow like "limiting". This processor specific behavior is not used by CrossView Pro's expression evaluation.

CrossView Pro, like C, supports integer, floating point and character constants.

In case the C compiler for your target supports non standard C basic types, like for example the fractional type, use a type cast, \(_\text{fract}\)0.123, to enter a constant of the required type.

**Integers**

Integers are numbers without decimal points. For example, CrossView Pro will treat the following as integers:

\[ 5 \quad 9 \quad 23 \]

The following number, however, are not treated as integers:

\[ 5.1 \quad 9.27 \quad 0.23 \]

Negative integers, if they appear as the first item on a line, must have parentheses around the number:

\[ (-5) * 4 \]
This is to prevent confusion with CrossView Pro’s own - (minus sign) command.

In addition, CrossView Pro supports standard C octal, hexadecimal and binary notation. You can specify a hexadecimal constant using a leading 0x or a trailing H (or h). The first character must be a decimal digit, so it may be necessary to prefix a hexadecimal number with the '0' character. The hexadecimal representation for decimal 16 is:

    0x10 or 10H

For the hexadecimal digits a through f you can use either upper or lower case. The following are all correct hexadecimal representations for decimal 43981:

    0xabcd 0xABCD 0abCdH 0AbcDh

You can specify a binary constant using a trailing B or Y (or b or y). The following are all binary representations for decimal 5:

    0101b 101Y 00000101B

You can specify an octal constant using a leading '0'. The octal representation for 8 decimal is:

    010

You can use an L to indicate a long integer constant. For example, CrossView Pro will recognize the following as long integers:

    0L 57L 0xffL

CrossView Pro uses the same ANSI C integral type promotion scheme as the C compiler.

**Floating Point**

A floating point number requires a decimal point and at least one digit before the decimal point. The following are valid examples of floating point numbers:

    12.34  5.6  7.89

In case the C compiler for your target supports non standard C basic types, like for example the fractional type, use a type cast, (float)0.3, to enter a floating point constant of the required type.
Exponential notation, such as $1.234e01$, is not allowed. The following are *not* valid floating point numbers:

\[ .02 \quad 1.234e01 \quad 5 \]

As with integers, bracket a negative number with parentheses:

\[ (-54.321) \]

Expressions combining integers and floating point numbers will evaluate to floating point values:

\[
2.2 \times 2 \\
4.4
\]

**Character**

Character constants are single characters or special constants that follow the C syntax for special characters. Examples of valid character constants include:

\['m' \quad 'x' \quad '\n'\]

Character constants must be a single byte and are delimited by ‘’ (single quotation marks). For instance:

\[
$\text{mychar}='m'$
\]

Remember not to confuse character constants with *strings*. A character constant is a single byte, in this example, the ASCII value of m.

**Strings**

Strings are delimited by “ ” (double quotation marks). In C all strings end with a null (zero) character. Strings are referenced by pointer, not by value. This is standard C practice. In CrossView Pro, you may assign a string literal to a variable which is of type char* (pointer to character):

\[
$\text{ystring} = "name"$
\]
CrossView Pro supports the standard C character constants shown below:

<table>
<thead>
<tr>
<th>Code</th>
<th>ASCII</th>
<th>Hex</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>\b</td>
<td>BS</td>
<td>08</td>
<td>Backspace</td>
</tr>
<tr>
<td>\f</td>
<td>FF</td>
<td>0C</td>
<td>Formfeed</td>
</tr>
<tr>
<td>\n</td>
<td>NL (LF)</td>
<td>0A</td>
<td>Newline</td>
</tr>
<tr>
<td>\r</td>
<td>CR</td>
<td>0D</td>
<td>Carriage return</td>
</tr>
<tr>
<td>\t</td>
<td>HT</td>
<td>09</td>
<td>Horizontal tab</td>
</tr>
<tr>
<td>\</td>
<td>\</td>
<td>5C</td>
<td>Back slash</td>
</tr>
<tr>
<td>?</td>
<td>?</td>
<td>3F</td>
<td>Question mark</td>
</tr>
<tr>
<td>'</td>
<td>'</td>
<td>27</td>
<td>Single quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>&quot;</td>
<td>22</td>
<td>Double quote</td>
</tr>
<tr>
<td>\ooo</td>
<td></td>
<td></td>
<td>3–digit octal number</td>
</tr>
<tr>
<td>\xhhh</td>
<td></td>
<td></td>
<td>hexadecimal number</td>
</tr>
</tbody>
</table>

*Table 3–1: C character codes*

Trigraph sequences are not supported.

### 3.4 VARIABLES

CrossView Pro lets you use variables in the C expressions you type. You may reference two classes of variables: variables defined in the source code and *special variables*.

Variables defined in your source code fall into two categories: *local variables* and *global variables*.

**Storage Classes**

Variables may be of any C storage class. The size of each class is target dependent. Consult your DSP56xxx C Cross- Compiler User’s Guide for specific sizes.

You may cast variables from one class to another:

```
(long) $mychar
```
Local Variables

You define local variables within a function; their values are maintained on the stack or in registers. When the program exits the function, you lose local variable values. This means that you can only reference local variables when their function is active on the stack.

Local variables of type `static` retain values between calls. Therefore, you can reference `static` variables beyond their functions, but only if their function is active on the stack.

CrossView Pro knows whether the compiler has allocated a local variable on the stack or directly in a register and whether the register is currently on the stack. The compiler may move some local variables into registers when optimizing code.

If a part of your source code looks like this:

```c
x = 5;
y = x;
```

and you stopped the program after the assignment to `x`, and set `x` to another value, this may not prevent the second statement from setting `y` to 5 due to "constant folding" optimizations performed by the compiler.

Global Variables

Global variables are defined outside every function and are not local to any function. Global (non-static) variables are accessible at any point during program execution, after the system startup code has been executed.

Global variables can be defined `static` in a module. These variables can only be accessed when a function in this module is active on the stack, or when that file is in the Source Window using the `e` command.
**Specifying Variables in C expressions**

The following table specifies how CrossView Pro treats different variables in C expressions. The left column is the variable’s syntax in the expression, the right column is the CrossView Pro semantics.

<table>
<thead>
<tr>
<th>Variable Syntax</th>
<th>CrossView Pro Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>variable</td>
<td>CrossView Pro performs a scope search starting at the current viewing position and proceeding outwards. The debugger first checks locals, local statics and parameters, followed by statics and globals explicitly declared in the current file. Finally, globals in other files are checked.</td>
</tr>
<tr>
<td>function#variable</td>
<td>CrossView Pro searches for the first instance of function. If found, the debugger uses the frame’s address to perform a scope search for variable. Variables are available only if the specified function is active. That is, the stack frame for that function can be found on the run–time stack.</td>
</tr>
<tr>
<td>number#variable</td>
<td>The frame at stack level number is used by the debugger for the scope search. The current function is always at stack level 0. This format is very useful if you are debugging a recursive function and there are multiple instances of a variable on the stack.</td>
</tr>
<tr>
<td>:variable</td>
<td>CrossView Pro searches for a global variable named either variable or _variable, in that order.</td>
</tr>
<tr>
<td>$variable</td>
<td>CrossView Pro searches the list of special variables for $variable.</td>
</tr>
</tbody>
</table>

*Table 3–2: Variables in C expressions*

**Variables and Scoping Rules**

A variable is in scope at any point in the program if it is visible to the C source code. For instance, if you have a local variable initval declared in main(), and then step (or move the viewing position) into factorial, initval will be out of scope. You can still find the value of initval by typing:

```c
main#initval
```
In this case CrossView Pro will search the stack for the function `main()`, then look outwards from that function for the first occurrence of `initval` in scope and report its value. Note that `main()` must be active, that is, program execution must have passed through `main()` and not yet returned, in order for `initval` to have a value.

You can also use the **Browse...** button in the Expression Evaluation dialog box. This dialog box appears when you click the **New Expression** button in the toolbar or select **Evaluate Expression...** from the **Data** menu.

**Special Variables**

CrossView Pro maintains a set of variables that are separate from those defined in your program being debugged. These special variables reside in memory on the host computer, not on the target system. They contain the values of the target processor's registers, information about the debugger's status, and user-defined values. Special variables are case insensitive. Use the **opt** command to display and set these variables (without using the '$'-sign).

The following is a list of the reserved special variables for CrossView Pro:

<table>
<thead>
<tr>
<th>Reserved Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>$ARG(n)</code></td>
<td>Contains the value of the <code>n</code>th int–sized argument of the current function. Allows access to arguments of variable argument list functions without knowing the name of the argument.</td>
</tr>
<tr>
<td><code>$FILE</code></td>
<td>Contains the name of the file that holds the current viewing position.</td>
</tr>
<tr>
<td><code>$IN(function)</code></td>
<td>Contains the value 1 if the current pc is inside the specified <code>function</code>, otherwise 0.</td>
</tr>
<tr>
<td><code>$LINE</code></td>
<td>Contains the line number of the current viewing position. This variable is often used in assertions to monitor program flow.</td>
</tr>
<tr>
<td><code>$PROCEDURE</code></td>
<td>Contains the name of the procedure at the current viewing position.</td>
</tr>
<tr>
<td><code>$ASMHEX</code></td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the disassembled code as displayed in the assembly window will display hexadecimal opcodes. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>Reserved Variable</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>$AUTOSRC</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the debugger will automatically switch between the source window and the assembly window display depending on the presence of symbolic debug information at the current location. The value &quot;OFF&quot; prevents the automatic window switching. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>$CPU</td>
<td>Contains a string indicating the current CPU type. Default is 5600x for the DSP5600x and 563xx for the DSP563xx/DSP566xx.</td>
</tr>
<tr>
<td>$FP</td>
<td>Contains the value of the frame pointer (system stack).</td>
</tr>
<tr>
<td>$MIXEDASM</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the disassembled code as displayed in the assembly window will be intermixed with the corresponding source lines. The value &quot;OFF&quot; suppresses this intermixing. Default is &quot;ON&quot;.</td>
</tr>
<tr>
<td>$MORE</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the more output pager is enabled. The value &quot;OFF&quot; disables the more output pager. Default is &quot;ON&quot;.</td>
</tr>
<tr>
<td>$PC</td>
<td>Contains the value of the program counter.</td>
</tr>
<tr>
<td>$PIPELINE</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the pipeline should be displayed in the assembly window. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>$register</td>
<td>Contains the value of the specified register.</td>
</tr>
<tr>
<td>$SP</td>
<td>Contains the value of the stack pointer (system stack).</td>
</tr>
<tr>
<td>$SYMBOLS</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot; indicating if local symbols and symbolic addresses (e.g. main:56+0x4) or absolute addresses are present in disassembly. Default is &quot;ON&quot;.</td>
</tr>
<tr>
<td>$SRCLINENRS</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that line numbers should be printed in the source window. The value &quot;OFF&quot; suppresses printing of line numbers. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>$SRCMERGETLIMIT</td>
<td>Contains the value for the source merge limit in the assembly window, the number of source lines to be intermixed in the assembly window. Value 0 indicates that there is no limit. Default is 0.</td>
</tr>
</tbody>
</table>
### Reserved Variables

<table>
<thead>
<tr>
<th>Reserved Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$UFP</td>
<td>User frame pointer (user stack for reentrant functions).</td>
</tr>
<tr>
<td>$USP</td>
<td>User stack pointer (user stack for reentrant functions).</td>
</tr>
</tbody>
</table>

*Table 3–3: Reserved special variables*

#### Registers

You can reference registers and special function registers (SFRs) directly. The format is `$register`. For instance, type:

```plaintext
$r1 = 0x12
$sp
```

Set value of register r1 to 0x12
Inspect value of stack pointer

Of course, altering the contents of registers influences the behavior of your program and may lead to unforeseen results.

For CrossView Pro, a fixed set of registers is always available. Additional SFRs can be added by using the utility `rm563`. See appendix C, *Register Manager*, for more information about `rm563`.

You can configure which (and in which order) registers must appear in the register window in the Register Window Setup dialog (Settings | Register Window Setup...).

In addition to the standard register special variables, CrossView Pro supplies the special variables: $sp (the stack pointer), $pc (the program counter) and $fp (the current frame pointer).

If you use reentrant functions, a user stack is maintained. CrossView Pro allows inspecting the user stack via $usp (user stack pointer) and $ufp (user frame pointer).

The values of Reserved special variables cannot be changed interactively (i.e., on the CrossView Pro command line).
**User-defined Special Variables**

During a debugging session, you may need some new variables for your own debugging purposes, such as counting the number of times you encounter a breakpoint. CrossView Pro allows you to create and use your own special variables for this purpose. CrossView Pro does not allocate space for these variables in target memory; it maintains them on the host computer.

The names of these variables, which must begin with a $ (dollar sign), are defined when they are first used. For instance:

```
$count = 5
```

defines a variable named `$count` of type `int` with a value of 5. Special variables are of the same type as the last expression they were assigned. For example:

```
$name = "john"
```

defines a variable named `$name` of type `char *`. The second statement creates a special symbol `$name` and assigns it the value of 12 of type `int`.

Special variables are just like any other variables, except you cannot meaningfully take the address of them. CrossView Pro allows as a default 26 user-defined special variables. You can change this limit with the `-s` option at startup, or by selecting the **Options...** menu item from the **File** menu and choosing the **Initialization** tab.

![Tip]

See the startup options in Chapter 4, *Using CrossView Pro*. 
3.5 Formatting Expressions

By default, CrossView Pro displays the value of an expression using the appropriate format for the type of expression. CrossView Pro follows several simple rules for displaying variables:

- The defaults are: addresses appear in hexadecimal format, characters as ASCII and integers as decimal.
- There are four possible formats to show one integer value: `decimal`, `hexadecimal`, `octal`, and `ASCII`.
- There are three different formats to display one floating point value: `decimal real`, `hexadecimal` and `fractional`. If the absolute value is either too big or too small (with too many non–significant fractional zeroes), the debugger automatically converts the format to one with fixed decimal point and exponent.
- `ASCII` is the only format to display a string. Note that you can opt for the array format. Unpredictable characters are output as `\xbb`, where `bb` is a hexadecimal value. Control characters are output as `^C`.
- All the values in an array appear in the same format. You are free to select this format from the available options.
- If all the values of a structure appear in the same format. You are free to select this format from the available options.

You can determine in which format a variable is displayed. Once the format has been selected, however, you must enter values or change values in the appropriate format. When editing is finished, the debugger interprets all values in terms of the currently selected formats.

You may, however, tell CrossView Pro to display an expression in a particular format other than the default format. The format code follows the variable, in one of two ways:

The simplest method of specifying display formats is from the Evaluate Expression dialog box. To access this dialog box:

- From the Data menu, select Evaluate Expression...

In the Command Window, you can use several format codes shown in the next table to specify the variable display. The format codes can be entered as:

```
variable/format
```
to display the variable in format \textit{format}, or:

\begin{verbatim}
variable@format
\end{verbatim}

to display the variable's address in format \textit{format}.

The structure of the formatting code is:

\begin{verbatim}
[count] style [size]
\end{verbatim}

\textit{Count} is the number of times to apply the format style \textit{style}. \textit{Size} indicates the number of minimum addressable units (MAUs) to be formatted. Both \textit{count} and \textit{size} must be numbers, although you may use \texttt{c} (char), \texttt{s} (short), \texttt{i} (int), and \texttt{l} (long) as shorthand for \textit{size}. Legal integer format sizes are 1 and 2; legal float format sizes are 4 and 8.

Be sure not to confuse CrossView Pro format codes with C character codes, e.g. \textbackslash a. CrossView Pro uses a forward slash / not a backward slash /.

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Print the specified number of characters of the character array; any positive \textit{size} is OK. Use the expression's value as the address of the first byte.</td>
</tr>
<tr>
<td>c</td>
<td>Print a character; any positive \textit{size} is OK; default \textit{size} is sizeof(char).</td>
</tr>
<tr>
<td>D</td>
<td>Print in decimal; needs NO \textit{size} specifier; \textit{size} is sizeof(long).</td>
</tr>
<tr>
<td>d</td>
<td>Print in decimal; can have a \textit{size} specifier; default \textit{size} is sizeof(expression).</td>
</tr>
<tr>
<td>E</td>
<td>Print in “e” floating point notation; needs NO \textit{size} specifier; default \textit{size} is sizeof(double).</td>
</tr>
<tr>
<td>e</td>
<td>Print in “e” floating point notation; the \textit{size} specifier can be sizeof(float) or sizeof(double); default \textit{size} is sizeof(expression).</td>
</tr>
<tr>
<td>F</td>
<td>Print in “f” floating point notation; needs NO \textit{size} specifier; default \textit{size} is sizeof(double).</td>
</tr>
<tr>
<td>f</td>
<td>Print in “f” floating point notation; the \textit{size} specifier can be sizeof(float) or sizeof(double); default \textit{size} is sizeof(expression).</td>
</tr>
<tr>
<td>G</td>
<td>Print in “g” floating point notation; needs NO \textit{size} specifier; default \textit{size} is sizeof(double).</td>
</tr>
<tr>
<td>Style</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>g</td>
<td>Print in &quot;g&quot; floating point notation; the size specifier can be sizeof(float) or sizeof(double); default size is sizeof(expression).</td>
</tr>
<tr>
<td>I</td>
<td>Print the function, source line, and disassembled instruction at the address.</td>
</tr>
<tr>
<td>i</td>
<td>Print the disassembled instruction at address.</td>
</tr>
<tr>
<td>n</td>
<td>Print in the “natural” format, based on type; use it for printing variables that have the same name as an CrossView Pro command.</td>
</tr>
<tr>
<td>O</td>
<td>Print in octal; needs NO size specifier; size is sizeof(long).</td>
</tr>
<tr>
<td>o</td>
<td>Print in octal; can have a size specifier; default size is sizeof(expression).</td>
</tr>
<tr>
<td>P</td>
<td>Print the name of the function at the address.</td>
</tr>
<tr>
<td>p</td>
<td>Print the names of the file, function, and source line at the address.</td>
</tr>
<tr>
<td>R</td>
<td>Print in long fractional format; needs NO size specifier; size is sizeof(long _fract).</td>
</tr>
<tr>
<td>r</td>
<td>Print in fractional format; the size specifier can be sizeof(_fract) or sizeof(long _fract).</td>
</tr>
<tr>
<td>S</td>
<td>Print the specified number of characters of a packed string. If no size is specified the entire packed string, pointed to by expression, is printed</td>
</tr>
<tr>
<td>s</td>
<td>Print the specified number of characters of the string, using the expression’s value as the address of a pointer to the first byte. Equivalent to *expression/ a. If no size is specified the entire string, pointed to by expression, is printed (till nil–character).</td>
</tr>
<tr>
<td>t</td>
<td>Display the type of the indicated variable or function.</td>
</tr>
<tr>
<td>U</td>
<td>Print in unsigned decimal; needs NO size specifier; size is sizeof(long).</td>
</tr>
<tr>
<td>u</td>
<td>Print in unsigned decimal; can have a size specifier; default size is sizeof(expression).</td>
</tr>
<tr>
<td>X</td>
<td>Print in hexadecimal; needs NO size specifier; size is sizeof(long).</td>
</tr>
<tr>
<td>x</td>
<td>Print in hexadecimal; can have a size specifier; default size is sizeof(expression).</td>
</tr>
</tbody>
</table>

Table 3–4: Format style codes

For example, typing:

```
initval/4xs
```
displays four, hexadecimal two-MAU memory locations starting at the address of initval.

The following piece of C-code can be accessed in CrossView Pro using the string format codes:

```c
char text[] = "Sample\n";
char *ptext = text;

text What is the address of this char array
text = X:$8200

text/a Print it as a string
text = "Sample^J"

ptext What is the contents of this pointer
string = X:$8200

ptext/s Print it as a string
string = "Sample^J"

&ptext Where does ptext itself reside
X:$8210
```

With format codes, you may view the contents of memory addresses on the screen. For instance, to dump the contents of an absolute memory address range, you must think of the address being a pointer. To show (dump) the memory contents you use the C language indirection operator `*`. Example:

```
*0x4000/2x1
P:$4000 = 0x00DB02 0x5A0554
```

This command displays in hexadecimal two MAUs at memory location 0x4000 and beyond. Instead of using the size specifier in the display format, you can force the address to be a pointer to unsigned long by casting the value:

```
*(unsigned long *)_X:0x4000/2x
X:$4000 = 0x00DB020804AC 0x5A055498C233
```

To view the first four elements of the array table from the demo.c program, type:

```
table/4d2
table = 1 1 2 6
```
This command displays in decimal the first four 2-MAU values beginning at the address of the array table.

**Memory Spaces**

Some target processors support more than one memory space. You can place a memory space qualifier in front of the address to identify the requested space.

CrossView Pro recognizes the following memory space keywords, when accessing the different DSP5600x/DSP563xx/DSP566xx family address spaces:

\_P, \_X, \_Y, \_L

If the memory space is omitted, CrossView Pro assumes the memory space \_P (program memory). The memory space keyword must be followed by a colon and the offset of the address. For example (DSP5600x)):

\*(unsigned long *) \_L:0x4000/128x2

dumps 128 MAUs as hexadecimal values, starting from address 0x4000 in memory space \_L.

**Circular Buffers**

Some target processors support circular buffers. A circular buffer is a linear array that can be accessed using modulo address arithmetic, i.e. a pointer that wraps-around automatically. To allow you to use circular buffers in C, the compiler supports the data type \_circ as an extended data type.

Consider the following fragment of C code:

```c
int \_circ Circ_Buf[5];
int \_circ Another_Circ_Buf[16];
int \_circ *Ptr_to_Circ_Buf = Circ_Buf;
```

CrossView Pro supports the following functionality regarding circular buffers.

`Ptr_to_Circ_Buf/t`

 global int \_circ \_X * \_X Ptr_to_Circ_Buf

Shows that `Ptr_to_Circ_Buf` is located in \_X memory and points to a circular buffer located in \_X memory, the circular buffer contains elements of type integer and has global scope.
Increment `Ptr_to_Circ_Buf`. CrossView Pro performs pointer arithmetic in exactly the same way as it is performed on the target.

```
Ptr_to_Circ_Buf = Ptr_to_Circ_Buf++
Ptr_to_Circ_Buf = X:$4
Ptr_to_Circ_Buf = Ptr_to_Circ_Buf++
Ptr_to_Circ_Buf = X:$0
```

Assume `Ptr_to_Circ_Buf=Circ_Buf`. These two CrossView Pro commands are not identical. The first command does not perform modulo addressing, this in opposition to the second command. This behavior is identical to the behavior of the C compiler.

```
Circ_Buf[10]
*(Ptr_to_Circ_Buf + 10)
```

Assign `Ptr_to_Circ_Buf` to `Another_Circ_Buf`. CrossView Pro will update the value of `Ptr_to_Circ_Buf` as well as its modulo modifier. The value of the pointer is in an R-type register, the modulo modifier is in the corresponding M-type register.

```
Ptr_to_Circ_Buf = Another_Circ_Buf
```

CrossView Pro will evaluate this expression using the pointer arithmetic associated with `Another_Circ_Buf`. Notice that `Another_Circ_Buf` must have exactly the same type as `Circ_Buf`, and thus located in the same memory space.

### 3.6 OPERATORS

**Standard C Operators**

CrossView Pro supports the standard C operators in the ANSI defined order of precedence. The order of precedence determines which operators execute first.

The semicolon character (`;`) separates commands on the same line. In this way, you may type multiple commands on a single line. Comments delimited by `/*` and `*/` are allowed; CrossView Pro simply ignores them.
### Order of Precedence

*in descending order*

| ( ) [ ] | -> | . |
| ! ~ ++ -- + * & (type) | sizeof |
| * / / % |
| + - |
| << >> |
| < <= > > = |
| == != |
| & |
| ^ |
| | |
| && |
| || |
| ?: = += -= *= /= %= &= ^= |= <<= >>= |

Table 3–5: Order of precedence of standard C operators

The *, – and + operators appear twice since they exist as both unary and binary operators and unary operators have higher precedence than binary.

Division is represented by // (two slashes) not / (one slash). This is to avoid confusion with CrossView Pro’s format specifier syntax.

**Using Addresses**

To specify an address, you may use the & operator. To determine the address of `initval`, type:

`&initval`

If you try to use the & operator on a local variable in a register, CrossView Pro issues an error message and tells you which register holds the variable.
### 3.7 SPECIAL EXPRESSIONS

**String Commands**

Whenever CrossView Pro encounters an expression consisting solely of a string by itself, it simply echoes the string. For example:

```
"hello, world\n"
hello, world
```

Use this technique to place helpful debugging messages on breakpoints. For example, setting the following breakpoint:

```
60 b {"now in for loop\n"; sum; C }
```

this cause CrossView Pro to echo the message now in for loop, to display the value of sum in the Command Window, and to continue when line 60 is encountered. You can also enter this breakpoint and the associated commands via the Breakpoints dialog box, which you can open by selecting the **Breakpoints...** menu item from the **Breakpoints** menu.

**The Period Operand**

As a shorthand, CrossView Pro supports a special operand, period `.`, that stands for the value of the last expression CrossView Pro calculated. For instance, in the following example, the period in the second command equals the value 11, which is the result of the previous expression:

```
5 + 6
11
4 * .
44
```

The period operand assumes the same size and format implied by the specifier used to view the previous item. Thus if you look at a `long` as a `char`, a subsequent `.` is considered to be one byte. Use this technique to alter specified pieces of a larger data item, such as the second highest byte of a `long`, without altering the rest of the `long`. The period operand may be used in any context valid for other variables.

`.` is the **name** of a location. When you use it, it is dereferenced like any other name. If you want the address of something that is 30 bytes farther on in memory, do not type `.+30` as this takes the contents of dot and adds 30 to it. Type instead `&.+30` which adds 30 to the address of the period operand.
3.8 CONDITIONAL EVALUATION

CrossView Pro supports the if construct. Use this construct in breakpoints and assertions to alter program flow conditionally. For example, if you reset the following breakpoint:

```
60 b {if (sum<=5931){C}{sum}}
```

CrossView Pro compares the value of `sum` with 5931 when the program stops at line 60. If `sum` is less than or equal to 5931, CrossView Pro continues. Otherwise, CrossView Pro displays the value of `sum` with 5931 when the program stops at line 60.

You can also use the `exp1 ? exp2 : exp3` C ternary operator for conditional expressions. For example:

```
$myvar = (5 > 2) ? 1 : -1
```

assigns the value 1 to `myvar`.

3.9 FUNCTIONS

In CrossView Pro expressions, you can include functions defined in the program’s code.

Command line function calls are not supported for the DSP56xxx Family.

You can call functions through the Call a Function dialog box. Note that only the results of the function call are shown. You cannot enter expressions in this field. If you want to use the results of the function call in an expression, then type the expression into the Evaluate Expression dialog box or type in the command into the Command Window (described in the keyboard method below).

- From the Run menu, select Call a Function...
- List all functions by clicking the Browse... button.
- You can place parameters in the Parameters field of the Call a Function dialog box, separated by commas, but without the usual parentheses or select from the drop-down history list.

The Command Window receives the results of the function call.
Type in the expression containing a function call directly into the Command Window.

To execute a function on the target type the function name and the arguments as you would do in your C program. For example,

\[ \text{do\_sub(2, 1)} \quad \text{or:} \quad a = \text{do\_add(3, 4)} \]

### 3.10 CASE SENSITIVITY

The absolute file supplies the case sensitivity information for variable names. It is initially case sensitive for the C language. You may toggle case sensitivity by:

- From the **Edit** menu, select **Search String...** to view the Search String dialog box. This dialog contains the **Case Sensitive** check box.

- Typing the (capital) **Z** command in the Command Window.
CHAPTER 4

USING CROSSVIEW PRO

TASKING
4.1 INTRODUCTION

This chapter and the following 8 chapters give you a comprehensive picture of CrossView Pro's features. In order to address the broadest range of expertise, the contents range from introductory examples to the more technical aspects and techniques of debugging with CrossView Pro. While it is not necessary for you to read the chapters straight through, you may find it especially helpful to do so. All of the examples are from the sample program demo.c which comes with CrossView Pro. For a complete description of the commands presented in this chapter, consult the Command Reference chapter.

Each CrossView Pro command introduced in the text has a matching box summarizing its syntax and semantics. The command description follows these general rules:

- **Items in bold font** are the actual CrossView Pro commands: `save`, `set`.
- **Items in italics** are names for the things you should type: `filename`, `commands`. In addition, the `|` symbol means or. For instance, `screen | filename` means you can use the word "screen" or a filename in the syntax.

4.2 USING THE CROSSVIEW PRO INTERFACE

This manual uses the word “Windows” to generically refer to the host computer system’s windowing system. On IBM–PCs and compatibles, this is equivalent to Microsoft Windows (95/98/, NT or 2000). On UNIX workstations, this refers to the X Window System. Generally, this manual makes no distinctions between the various windowing systems unless needed to clarify the discussion.

This manual assumes you possess a basic familiarity with Windows software. For this reason, discussion focuses on how CrossView Pro works, rather than how to use the Window interface. For more information on your Windows system, consult the Windows documentation provided with your host system.

You can execute most CrossView Pro commands using either mouse or textual commands. Mouse commands are executed by means of buttons and pull–down menus in each of the separate CrossView Pro windows. Text commands are typed at the prompt in the Command Window. In most cases, there is no difference in functionality between mouse and text equivalents.
This manual discusses both methods of performing CrossView Pro functions. For a quick-reference guide to all CrossView Pro commands, refer to the *Command Reference* chapter.

### 4.3 STARTING CROSSVIEW PRO

Once an absolute file has been made it can be executed by CrossView Pro. There are several ways to invoke CrossView Pro.

**From EDE**

To start CrossView Pro from EDE (the Embedded Development Environment), click on the **Debug application** button. The following button is the Debug application button which is located in the toolbar.

![Debug application button]

**From the desktop**

With MS–Windows you can start CrossView Pro through the **Start** menu. Or in the Windows Explorer you can double-click on an absolute file if the `.abs` extension is associated with the CrossView Pro executable.

On the PC, CrossView Pro is a Microsoft Windows application. As such, you must invoke it from the Windows environment.

**From the command line**

To begin the debugging session, type the name of the CrossView Pro debugger and optionally the name of the target program (absolute file).

```
xfw56x [absolute-file] [option]...
```
4.4 STARTUP OPTIONS

CrossView Pro allows you to specify several options when you invoke the program. Type these startup options (or switches as they are sometimes called) after the optional basename of the application. The basename can also contain a path specification. In this case, CrossView Pro sets its current directory to the specified path. A minus sign proceeds each option; the options can appear in any order.

Note that some versions of CrossView Pro have different startup options and procedures than the ones described here. Please consult the Addendum (at the end of this manual), for precise information about starting up CrossView Pro with your target hardware.

From EDE

You can select the execution environment, setup communication parameters, specify record and playback files and set some maximum values via the CrossView Pro entry of the Project | Project Options... dialog.

From CrossView Pro

You can set many of CrossView Pro’s options by using the dialog boxes called by the Target | Settings... and File | Options... menu items. You can save the options in the xvw.ini file and they are automatically used upon startup.

In Windows 95/98/XP, Windows NT 4.0 or Windows 2000 (or higher), add startup options to the program’s property sheet:

- Right-click on the CrossView Pro shortcut icon, shown in your program installation folder.
- Select Properties. The Program Item Properties dialog box appears.
- Enter the startup options after the executable’s name in the Target field of the shortcut.

Use menus to set options. After setting the options in the menus and selecting the appropriate options in the Save Options dialog on exit, CrossView Pro saves the settings in the file xvw.ini for future debug sessions.

To start up CrossView Pro type:

```
xfw56x
```
When your execution environment itself has a human-oriented ASCII interface, you can use transparency mode with the \texttt{-T} option. In transparency mode you can configure the execution environment’s memory. Check the Addendum, the hardware–specific section of this manual. In–circuit emulators generally require you to map the address space, allocating memory ranges to the execution environment and/or the target system. Fortunately, this generally does not mean you need to learn your emulator’s command set, just a rote sequence of startup commands. When your CrossView Pro version does not support transparency mode, you do not need to configure the memory, and the \texttt{-T} option is not needed.

If your target system supports serial communication and if the target system is connected to a port other than the default port (see Chapter 1, \textit{Overview}, to determine the default port for your host), you can use the \texttt{-D} option to specify the port name. The default baud rate is 9600. You may use the \texttt{-D} option to specify the baud rate if the execution environment is not the same as the default. For example:

\texttt{xfw56x -D rs232,com2,19200}

instructs CrossView Pro to use the COM2 port at 19200 baud. See your execution environment in the Addendum of this manual for specific communication information.

When you specify a startup option in CrossView Pro, the option overrules the corresponding value in the current \texttt{xvw.ini} file.

There are many different options you can invoke when starting up CrossView Pro. The listing below gives an overview of all startup options.

There are several startup options having to do with the recording and playing back of CrossView Pro command files. See also Chapter 9, \textit{Command Recording \& Playback}. 
<table>
<thead>
<tr>
<th>Startup Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>–a number</strong></td>
<td>Sets the maximum number of assertions (the default is 100).</td>
</tr>
<tr>
<td><strong>–b number</strong></td>
<td>Sets the maximum number of code breakpoints (the default is 200).</td>
</tr>
<tr>
<td><strong>–c number</strong></td>
<td>Sets the maximum number of instruction trace for the trace buffer (the default is 32).</td>
</tr>
<tr>
<td><strong>–C cpu</strong></td>
<td>Forces CPU type selection. This option also determines which register file (regcpu.dat) will be used. The default is 5600x for the DSP5600x or 563xx for the DSP563xx/DSP566xx.</td>
</tr>
<tr>
<td><strong>–D device_type,opt1,opt2</strong></td>
<td>Selects a device and specifies device specific options, such as communication port and baud rate. The allowed combinations for your execution environment are described in the manual addendum for that specific execution environment. The allowed combinations also depend on the <strong>–E</strong> option, described below. The following combinations are possible:</td>
</tr>
<tr>
<td><strong>–D rs232,port,speed</strong></td>
<td>Select RS–232 communication.</td>
</tr>
<tr>
<td><strong>port</strong></td>
<td>For PC this is COM1, COM2, COM3 or COM4. A colon should not be added. For UNIX this is the full path of the RS–232 device driver (e.g., /dev/tty01). By default CrossView Pro uses the first RS–232 port.</td>
</tr>
<tr>
<td><strong>speed</strong></td>
<td>This is the baud rate used for the specified port. The default is 9600.</td>
</tr>
<tr>
<td><strong>–D parallel,port</strong></td>
<td>Select parallel communication.</td>
</tr>
<tr>
<td><strong>port</strong></td>
<td>For PC this is LPT1 or LPT2. Do not add a colon. For UNIX this is the full path of the parallel device driver. By default CrossView Pro uses the first parallel port.</td>
</tr>
<tr>
<td><strong>–D tcp,host,port</strong></td>
<td>Select TCP/IP communication. On UNIX the standard TCP/IP implementation is used. On MS–Windows the WINSOCK.DLL implementation is used.</td>
</tr>
<tr>
<td><strong>host</strong></td>
<td>The name of the host to be accessed via TCP/IP.</td>
</tr>
<tr>
<td><strong>port</strong></td>
<td>The port number on host to be accessed.</td>
</tr>
<tr>
<td>Startup Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| `-D dev,device-file`   | Use a UNIX device driver as communication channel. For RS–232 devices use the `-D rs232` option, described above.  
  
  `device–file`  
  The full path of the UNIX device file. |
| `-D isa,io–port,address` | Select communication channel to an (E)ISA interface card in the PC.  
  
  `io–port`  
  PC I/O port number or I/O channel used for accessing the (E)ISA card.  
  
  `address`  
  The memory address used to access the (E)ISA card. |
| `-E exec–env`          | Select the execution environment. The possible values for `exec–env` are described in the manual addendum for your execution environment. |
| `-f file`              | Read command line options from `file`.                                      |
| `--fss_root_dir="path"`| Specify root directory for File System Simulation.                         |
| `-G path`              | Specify startup directory for CrossView Pro.                               |
| `-i`                   | Has CrossView Pro download the image of the absolute object file.          |
| `-n address`           | Informs CrossView Pro that the program was loaded into memory at an `address` other than zero. |
| `-p file`              | Starts playing back commands from `file`.                                  |
| `-P file`              | Starts playing back commands from `file` with commands single step.       |
| `-r file`              | Starts recording commands in `file`.                                       |
| `-R file`              | Starts recording screen output in `file`.                                  |
| `-s number`            | Sets the maximum `number` of special variables (variables independent of the program that CrossView Pro provides for your use). The default is 26. |
### Startup Option Description

<table>
<thead>
<tr>
<th>Startup Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-sd directory [:directory]...</code></td>
<td>Specifies the directories CrossView Pro should search for source files. Relative paths are allowed. When the <code>n</code> command is used to load a new symbol file, the current directory is set to the directory containing the symbol file and CrossView Pro now searches for source files relative to this directory. Directories must be separated by semicolons.</td>
</tr>
<tr>
<td><code>-tcfg file</code></td>
<td>Specify a target configuration file. This overrules the filename specified in <code>xvw.ini</code>. See section <code>CrossView Pro Target Settings</code> in the Overview chapter.</td>
</tr>
<tr>
<td><code>--timeout=n_seconds</code></td>
<td>Start CrossView Pro command line batch operation mode and terminate after <code>n_seconds</code>.</td>
</tr>
<tr>
<td><code>-T [file]</code></td>
<td>Starts CrossView in transparency mode if present; if <code>file</code> is given, commands in <code>file</code> are sent to the execution environment.</td>
</tr>
</tbody>
</table>

*Table 4–1: CrossView Pro Startup Options*

### 4.4.1 WHAT YOU MAY HAVE DONE WRONG

Most problems in starting up CrossView Pro for a debugging session stem from improperly setting up the execution environment or from an improper connection between the host computer and the execution environment. Some execution environments require you to enter transparency mode to set the execution environment for a debugging session. Check the notes for your particular execution environment and the Addendum of this manual.

Here are some other common problems:

- Specifying the wrong device name when invoking the debugger.
- Specifying a baud rate different from the one the execution environment is configured to expect.
- Not supplying power to the execution environment or an attached probe.
- Using the wrong kind of communication cable.
- Plugging the cable into an incorrect port. Some target machines have several ports.
• Installation of a device driver or resident applications that use the same communications port on the host system.
• The port is already in use by another user or login process on some UNIX hosts.
• Specifying no or an invalid cpu type with the –C option.
4.5 THE CROSSVIEW PRO DESKTOP

The CrossView Pro desktop is the screen background in which all windows, icons and dialog boxes appear (see figure 4–1). Under some windowing systems, the desktop is itself a window that does not contain all other CrossView Pro windows.

The desktop always has the Command Window opened or iconized.

![CrossView Pro Desktop Diagram]

*Figure 4–1: CrossView Pro Desktop*

At the top of the desktop is the **Menu Bar**, which contains the menus applicable to the currently active window. Below the menu bar is the main **Toolbar**, from which you can execute commands to control program execution as button functions. Except for the Command Window, the desktop can contain other windows as well.

Along the bottom of the desktop there is a **Main Status Bar**. The status bar displays messages such as short “help messages” when you move the cursor over any button in any CrossView Pro window.
Menus

Each CrossView Pro window may have a menu associated with it. Under Microsoft Windows, the active window’s menu is displayed in the menu bar of the desktop.

Depending on your execution environment some menu items are always grayed out. For example, Communication Setup is grayed out if your target is an instruction set simulator.

Windows

The debugger supports two types of windows: primary windows and dialog boxes. Dialog boxes are the windows you access from a primary window. For the remainder of this manual, the term “window” denotes a primary window.

This manual also uses the term pop-up window. A pop-up window is a primary window that contains supplemental information such as on-line help.

CrossView Pro Windows are used to display information and to get user input through either buttons, commands typed in input fields, or menu selections. Windows may be moved around the desktop, sized, or iconized. All windows can be opened from the View menu. The section on CrossView Pro Windows provides more detail about each window.

A window is considered opened even if it is iconized (under Microsoft Windows, this is called minimized). A window is considered closed if it does not exist on the desktop in any form.

Dialog Boxes

Certain menu items or push buttons may call up a dialog box to complete an action, display information, or get additional data. No other actions can be performed until the dialog box is closed.
4.5.1 MENUS

Each window in CrossView Pro uses the menu as shown in figure 4–2. The method of selection of a menu item varies depending on the windowing system being used. See your Windowing System’s manual for details of how to do this.

Each window has a hidden control menu (the icon on the top-left of the window), to manipulate the window. The menu Close command in the control menu closes the current window. Your implementation of the windowing system may have additional features. See your documentation for further details.

Figure 4–2: CrossView Pro Menus
4.5.1.1 LOCAL POPUP MENUS

On MS–Windows environments CrossView Pro supports local popup menus. Local popup menus are invoked by clicking the right mouse button. The menu contents is context sensitive. If the mouse pointer is on top of the global (main) toolbar the Configure Toolbar dialog is shown. If the mouse pointer is located in the MDI window (task window or background) the View Menu is shown which allows you to open new windows.

Within the Source Window four different local popup menus may appear. If the cursor is within the display area of the window the Run Menu is shown. The Run Menu contains commands associated with program execution. If your cursor is at a breakpoint indicator, the Breakpoints dialog is shown. If the cursor is on a code coverage marker then the local popup menu contains commands to move the cursor to the next or previous block of (not)covered statements. If your cursor is in the profile column you can change the format of the timing figures. All other windows have their own local popup menu. The exception to the rule is the command window which does not have a local popup. See figure 4–3 for an example of the local popup menu of the Memory Window.

![Local Popup Menu Example](image)

*Figure 4–3: CrossView Pro Local Popup Menu (Memory Window)*

4.5.2 WINDOW OPERATION

Windows can be opened, made active, and closed.

**Opening Windows**

The **View** menu of the menu bar lists all windows. Selecting a window name from this list causes the window to open up. Selecting a window that is already open brings that window to the front.
**Selecting a Window**

At any one time, a particular window is *active*. Most operations act (by default) on the active window. The active window is distinguished by highlighting the title bar. Only one window may be active at a time. There are several ways to select a window (that is, make a window active).

- Open the window from the **View** menu. If the window is already open it will be brought to the front.
- Click on the window’s border (or on any portion of the window in some windowing systems). It will be brought to the front.
- Select the window name from the **Window** menu. The window will be made active and is brought to the front. (This option is available under Microsoft Windows only).

**Closing a Window**

Windows are closed by selecting **Close** from the **Control** menu, or by clicking a **Close** button, as shown in figure 4–4. Selecting this item from the Command Window will exit CrossView Pro.

![Control Menu and Close Button](image)

*Figure 4–4: Closing a Window*
4.5.3 DIALOG BOXES

The debugger uses dialog boxes to acquire information needed to complete a requested operation. The debugger also uses dialog boxes to display information. If a button or menu item displays an ellipsis (...) after its name, then there is an associated dialog box.

For example, the dialog box shown in figure 4–5 searches for a string. This dialog box uses a list edit field to enter a search string, radio buttons to select the search direction, a check box to specify case sensitivity and push buttons to allow certain functions to be performed.

![Figure 4–5: Dialog Box](image-url)
4.5.4 CUSTOMIZING CROSSVIEW PRO

You can customize CrossView Pro’s visual appearance and operative parameters to best suit your debugging environment.

Changing the Visual Appearance

Windows can be organized by resizing and moving them around the desktop (see your Windowing System’s manual for details on how to do this). All windows under Microsoft Windows have an additional Window menu item. This menu allows the user to arrange all opened windows in a tiled or cascaded format. In the tiled format, selected by Window | Tile, all windows become the same size. All windows are the visible, the same size and do not overlap. In the cascaded format, selected by Window | Cascade, all open windows are changed to the same size and overlapped in a cascade with a constant vertical and horizontal offset. Iconized (minimized) windows can be automatically rearranged by selecting Arrange Icons from the Window menu.

See the section Using X Resources in the chapter Software Installation for details on changing the visual appearance of CrossView Pro under X Windows.

Changing Operative Parameters

You can adjust the operative parameters for CrossView Pro using the various menus in CrossView Pro.

In the Target menu you will find:

- **Settings**: Allows you to specify the execution environment and the CPU type, and the source directories for CrossView Pro. The values are processed at CrossView Pro startup before executing commands entered in the Command Window or before the target is accessed as a result of opening a window. So, first edit this dialog when you start CrossView Pro. If you have not loaded a symbol file yet, you do not have to restart CrossView Pro.
- **Communication Setup**: Allows you to set parameters for communication between CrossView Pro and your target board.
In the **File | Options...** menu you will find:

- **Initialization**: Allows you to specify the maximum number of breakpoints, assertions, special variables, C–trace instructions, command history lines, command output lines, emulator output lines. All values are processed at CrossView Pro startup, except for C–trace. Changing the maximum number of C–trace instructions has an immediate effect on the Trace window.

- **Desktop**: Allows you to specify color settings for the execution position in the Source Window and the colors used in the Memory Window to show how a memory location has been accessed by the application program. You can also specify font sizes to be used in output windows.

- **Toolbar**: Allows you to configure the main toolbar to your personal preferences.

In the **Tools** menu you will find:

- **Record**, **Playback**, and **Log**: Allow you to set command recording and playback options.

- **Toolbox Setup**, and **Macro Definitions**: Allow you to define macros, and assign them to a push button in the Toolbox.

In the **Data** menu you will find:

- **Data Display Setup**: Allows you to specify how CrossView Pro displays data. This dialog also determines if the Expression Evaluation dialog box must be bypassed or not.

In the **Settings** menu you will find:

- **Source Window Setup**: Allows you to specify the step mode, symbolic disassembly, automatically switching between source lines and disassembly source to be displayed in the Source Window and display code coverage information.

- **Register Window Setup**: Allows you to specify the registers that appear in the Register Window. And you can set the display format to hexadecimal or decimal.

- **Memory Window Setup**: Allows you to specify the mode and size of the data and the number of data rows and columns to be shown in the Memory Window. It also allows you to automatically refresh the Memory Window and to display data coverage information.

- **Data Analysis Window Setup**: Allows you to configure the graph display of a Data Analysis Window.
Using CrossView Pro

- **I/O Simulation Setup**: Allows you to specify the I/O streams to be used in the Terminal Windows.

- **Terminal Window Setup**: Allows you to specify the input and output format of a Terminal Window. You can map linefeeds to carriage-return linefeeds, wrap at the end of a line, specify buffered input or specify that the window must be cleared at system reset and program reset. You can also log the input and output data to a file.

- **Background Mode Setup**: Allows you to specify which windows to automatically refresh when running in background mode. This feature is only available if it is supported by your execution environment.

**Saving Changes on Exit**

If you find yourself using a particular configuration, you may want to save your configuration when you exit CrossView Pro:

- From the **File** menu, select **Exit** or close the Command Window.
- In the **Save** tab of the Options dialog that appears, select the options you want to be saved for another debug session.
- Click on the **Exit** button in the Options dialog.

CrossView Pro exits. If you selected one or more items in the **Save** tab of the Options dialog your settings are saved in the initialization file `xvw.ini`. This file is in the startup directory.

### 4.5.5 CROSSVIEW PRO MESSAGES

CrossView Pro communicates with you in a variety of ways. The command window displays the results of commands. Important messages, such as errors, appear in dialog boxes that pop up.
4.6 CROSSVIEW PRO WINDOWS

The two prominent windows used in CrossView Pro are the Command Window and the Source Window. From the Command Window you can type CrossView Pro and emulator commands, and gain access to all other windows. You can accomplish most global operations from either the menu bar or the Command Window. Only from the Command Window can you accomplish Single step playback. When you close the Command Window, you exit CrossView Pro.

The Source Window focuses on the program being debugged. This window controls most of the commonly-used execution operations, such as breakpoints and searching functions.

Available Windows

You can open all CrossView Pro windows (except for the Data Analysis windows) from the View menu by selecting the name of the window. Selecting a window in this case brings the window to front and makes it the active window. Available windows are:

- **Command Window:** Supports two modes: CrossView or Emulator. Displays all CrossView Pro commands and responses or Emulator commands and responses.

- **Source Window:** Controls the execution of the program and displays the source file or disassembly.

- **Register Window:** Displays the current state of the processor's registers.

- **Memory Window:** Displays target memory and allows you to change it.

- **Data Window:** Displays the values of data that are being monitored.

- **Data Analysis Window:** Graphically displays signal data for analysis.

- **Stack Window:** Displays the application's stack trace.

- **Trace Window:** Displays the most recently executed lines.

- **Terminal Windows:** Can be used for I/O simulation of an application.
Improving CrossView Pro Performance

CrossView Pro updates every window that is open (except for the Data Analysis windows), even if it is iconized (minimized). Keeping a window up to date usually involves extra communication with the emulator, slowing CrossView Pro down. For instance, if the Register Window is open, CrossView Pro asks the emulator to dump the contents of all displayed registers after each single step. Thus it is a good idea to keep only those windows open that you need.

4.6.1 COMMAND WINDOW

The Command Window allows you to:

• Enter CrossView Pro and emulator commands from the keyboard.
• View a history of CrossView Pro commands or emulator commands.
• View the result of CrossView Pro commands or emulator commands.
• Execute playback files (in single step mode).

From the View menu you can specify if you want the Command Window to be a CrossView Pro Command Window or an Emulator Command Window. This way you can specify whether CrossView Pro interprets commands or they go directly to the emulator.

Figure 4–6. shows the Command Window. You can type commands into the command edit field (bottom field) or select them from the command history list (middle field), edit and execute them. The command history field displays previously entered commands. You can select and execute one or more commands. The command history list provides you with a clear, comfortable way to re–execute specific commands or sequences of commands by preserving them in a scrollable list.

You can switch between the history list and the command edit field by hitting the <Tab> key. Hitting the <Esc> key (escape) returns you to an empty edit field.

The top field is the Command Output Window or the Emulator Output Window, depending on the type of Command Window you choose. Each command, echoed from the command edit field, appears with a ‘>’ prefix. CrossView Pro displays its response (or the emulator’s response if the window is an Emulator Command Window) to the command immediately following the command. You can use the clear command to clear this window.
The Command Window also has two push buttons that provide rapid access to frequently used actions. The **Execute** button executes the current command (or sequence of commands if more than one command is selected). Note that the `<Enter>` or `<Return>` key is equivalent. Use the **Halt** button to interrupt commands executing in continuous mode, or to stop the emulator.

The Command Window maintains a history of recently executed commands. To re-perform previously executed commands simply double-click on it or select the command(s) from the command history list in the Command Window and press the **Execute** button. By hitting the `<Tab>` key, it is also possible to select one or more entries. Hitting `<Tab>` or `<Esc>` will return you to the command edit field.

The maximum number of lines saved to the CrossView Pro command buffer list is set during debugger startup. The default is 100 lines. To change the default select **Options...** from the **File** menu and select the **Initialization** tab. This number can also be modified via a startup option.
4.6.2 SOURCE WINDOW

The Source Window offers most of the debugging functions you will need on a regular basis. It allows you to:

- View the source file (source lines, disassembly or both).
- Set and clear assertions (not in Toolbar).
- Set and clear breakpoints.
- Monitor and inspect variables.
- Search for strings, functions, lines, addresses.
- Control execution.
- Call functions (not in Toolbar) and evaluate expressions.
- View code coverage information.
- View profiling/timing information.

An example of the source window is shown in figure 4–7.

![Source: demo.c](image)

**Figure 4–7: CrossView Pro Source Window**

You can specify the step mode, symbolic disassembly and source lines / disassembly with the Source Window Setup dialog box (Settings | Source Window Setup...) or with Run | Step Mode. Alternatively, you can use the drop–down menus in the Source Window’s status bar.
The default step modes are:

- **Source lines Window:** Source line step
- **Disassembly Window:** Instruction step
- **Source and Disassembly Window:** mode of previous window! (assumes the step mode of the previous Source Window setting)

The location of the cursor is also the viewing position. The line number and address of the viewing position, appears at the top–left position of the Source Window. This does NOT represent the current execution position ($pc$). The current execution position appears in reverse or blue color. The cursor appears as a dotted line.

On MS–Windows the so-called "quick watch" feature is supported. When you position the mouse cursor over a variable or a function, a bubble help box appears showing the value of the variable or the type information of the function respectively.

A green colored toggle shows that no breakpoint is set. A red colored toggle indicates an installed breakpoint. An orange colored toggle indicates an installed but disabled breakpoint. If code coverage is enabled, coverage markers appear to the right of the breakpoint toggles. If a checkmark appears next to a line, it has been executed. If no checkmark appears next to a line, it has not been executed.

The Source Window provides a local Toolbar containing the following buttons, nearly all of which are shortcuts (using selected text) to operations that you can perform via the menu bar:

- ![Stop](stop.png) Stop program or command
- ![Run](run.png) Run or continue execution (same as F5)
- ![Run](run.png) Run to cursor (same as F7)
- ![Step](step.png) Step (over function calls)
- ![Step](step.png) Step (into function calls)
- ![Restart](restart.png) Restart application
- ![Find](find.png) Find program counter (PC)
Show selected source expression
Watch selected source expression
Find symbol
Search for a text string
Repeat search for text string
Edit current source file
Edit breakpoint at cursor
Display code coverage
Display profiling

You can toggle the appearance of this local toolbar by selecting Local Toolbars | Source from the View menu.

Edit Source

To edit the current source file in the Source Window, select Edit | Edit Source or press the Edit Source button. On MS–Windows the Codewright editor will be called with the filename and line number of the file that is currently in the debugger. On UNIX systems the xxwedit program will be called with the filename and line number of the file that is currently in the debugger.

The xxwedit program is a shell script. You can adapt it to your specific requirements.
4.6.3 REGISTER WINDOW

Figure 4–8 shows the Register Window. This window allows you to view and edit register contents.

![Register Window](image)

*Figure 4–8: CrossView Pro Register Window*

Note that the contents of the Register Window for your particular target may be different from the one show in figure 4–8.

You can specify which register set definition appears in the Register Window with the Register Window Setup dialog box (Settings | Register Window Setup...). In this dialog you can also specify the display format of values in the Register Window: hexadecimal or decimal.

CrossView Pro supports multiple Register Windows. Register Windows either have the title "Register" or "Register – register set name". The "Register" title indicates the default register set.

In–situ editing allows you to change the registers contents directly by clicking on the corresponding cell.
4.6.4 MEMORY WINDOW

The Memory Window is shown in figure 4–9. This window allows you to view and edit the target memory.

Depending on the setting of the Automatically refresh check box in the Memory Window Setup dialog, CrossView Pro updates the displayed values every time the program is stopped or only updates the values by user request. For example, by pressing the Update Memory Window button located on the toolbar.

![Memory Window](image)

*Figure 4–9: CrossView Pro Memory Window*

To edit the target memory, click on a memory cell and type a new value. To display another memory region: click on an address cell and type a new address. CrossView Pro accepts input in symbolic format, so you can enter expressions instead of just values.

CrossView Pro supports multiple instances of the Memory Window. If your target supports multiple memory spaces, the Memory Window supports them all. Refer to the section about memory space keywords to become familiar with the memory space keywords and associated syntax your target system uses.
You can specify the way data appears in the Memory Window by opening the Memory Window Setup dialog. From the Settings menu, select Memory Window Setup... to open this dialog. The memory contents can appear in many formats including ASCII character, hexadecimal, decimal, signed, unsigned, and floating point formats. You can specify the size of the memory window. You specify the number of memory cells that appear within the window. The number of cells is fixed in the sense that if you re-size the window the number of cells does not change.

Besides the current value of memory locations, the Memory Window also displays whether memory locations have been accessed during program execution. This is called 'data coverage'. An application program may read from, write to, or fetch an instruction from a memory location. Of course all combinations may be legal. Although writing data to a memory location from which an instruction has been fetched is suspicious. All types of accesss, read, write, fetch or combinations of these, can be shown using different foreground and background colors. The color combination used to show "rwx" access are specified in the Desktop Setup dialog. Change the background color if instructions are fetched from a memory location, and change the foreground color to show read and write access.

You can display data coverage information in the Memory Window by clicking on the Coverage button in the Memory Window or by setting the Display data/code coverage check box in the Memory Window Setup dialog.

The Memory Window has the ability to highlight memory cells of which the contents have been changed. Click on the Highlight Value Changes button in the Memory Window to see the changed cells. With the Freeze Highlight Reference Values button you can enter a new reference point for highlighting. All the cells that have been changed since that reference point are highlighted.

The Memory Window provides a local Toolbar containing the following buttons:

- Fill memory
- Fill single memory address
- Copy memory
- Find memory
Display data coverage
Highlight changed values
Set highlighted values as reference
Refresh memory window

You can toggle the appearance of this local toolbar by selecting Local Toolbars | Memory from the View menu.

4.6.5 DATA WINDOW

The Data Window is shown in figure 4–10. This window allows you to show the value of monitored expressions and variables.

The Data Window updates the values shown every time the program stops, and after an o command.

It is possible to display both monitored and unmonitored data expressions in the Data Window. CrossView Pro monitors and updates "WATCH" expressions after every halt in execution, and marks them with the text "WATCH" at the start of the display line in the Data Window. "SHOW" expressions, on the other hand, are one–shot inspections of an expression’s value, and CrossView Pro does not update them until you click on the Update Selected Data Item button or Update Old Data Items button. When a "SHOW" expression is no longer actual, it is marked with the word “OLD”.
To set the default display format of the data shown, select the proper format in the Data | Data Display Setup... dialog.

To inspect the value of global variables and data structures, double-click on the variable name in the Source Window. Depending on preferences you set in the Data Display Setup dialog, the variable appears immediately in the Data Window, see figure 4–10, or the Expression Evaluation dialog appears first.

In–situ editing allows you to change the contents of everything in this window by clicking the value you want to change.

If you have set the Display addresses check box in the Data Display Setup dialog box the addresses of the variables are also shown.

Pointers, structures and arrays displayed in the data window have a compact and expanded form. The compact form for a structure is just <struct>, while the expanded form shows all the fields. The compact form of a pointer is the value of the pointer, while the expanded form shows the pointed–to object. Indicate the compact form by putting a ‘+’ at the start of the display. (i.e., the object is expandable), and indicate the expanded form with (i.e., the object is contractible). Nesting is supported, so you can expand structures within structures ad infinitum.
To expand a pointer, structure or an array, double-click on the ’+‘ in the Data Window.

The Data Window provides a local Toolbar containing the following buttons:

- Show or watch a new expression
- Toggle watch attribute of selected item ”on” or ”off”
- Reformat selected item
- Update selected data item
- Delete selected data item
- Update old data items
- Delete old data items

You can toggle the appearance of this local toolbar by selecting **Local Toolbars | Data** from the **View** menu.

The auto-watch locals feature may be activated or deactivated. When active, a selected Data Window becomes the ”auto-watch” window, and all local variables from the current top-of-stack frame appear in that Data Window. The text “LOCAL” appears at the start of the display for variables displayed in this manner. As the execution position changes, the auto-watch window deletes and adds locals as necessary, so that the locals on the current top-of stack frame always appear.

To see the value of the local variables of a function, Select **Data | Watch Locals Window** from the **View** menu.

CrossView Pro supports multiple Data Windows. Data Windows either have the title ”Data Window #n” or ”All Local Variables”. The ”All Local Variables” title indicates the auto-watch window if it exists (as explained above).
4.6.6 STACK WINDOW

The **stack** records the return addresses of all functions the application has called, and CrossView Pro can use this information to reconstruct the path to the current execution position. The Stack Window, shown in figure 4–11, displays the function calls on the stack with the values of the parameters passed to them in an easily accessible and understandable form.

The Stack Window can help you assess program execution and allows you to view parameter values. The stack window allows you to:

- View the stack trace which includes information about function names, parameter values, source line numbers and stack level.
- Easily switch to the call statement of a stack level by clicking on it once.
- Set temporary and permanent breakpoints at any level of the stack, by double-clicking on the desired level.

![Stack Window](image)

*Figure 4–11: CrossView Pro Stack Window with Toolbar*
The Stack Window provides a local Toolbar containing the following buttons:

- Set stack breakpoint after call to function
- Set stack breakpoint at function entry point
- Show local variables in selected stack frame
- Watch local variables in selected stack frame
- Find call site

You can toggle the appearance of this local toolbar by selecting the Local Toolbars | Stack from the View menu.

### 4.6.7 TRACE WINDOW

The Trace Window, shown in figure 4–12, allows you to:

- Display the most recently executed lines of code.

CrossView Pro automatically updates the Trace Window each time you halt execution, as long as the window is open, allowing you to check the progress and flow of your program throughout the debugging session.

The Trace Window is only supported if your execution environment supports the trace facility.

![Trace Source](image)

*Figure 4–12: CrossView Pro Trace Window*
4.6.8 TERMINAL WINDOW

The Terminal Windows, shown in figure 4–13, let you observe and test the input and output of your program.

The CrossView Pro Terminal windows provide an interface to exchange data with the application on the target. This I/O facility can be implemented in various ways. Using standard I/O stream function calls like printf() in your source, you can test I/O to and from the target system or simulator.

The File System Simulation feature redirects I/O to a Terminal Window if the filename FSS_window:window_name is used in the “open” call, window_name is the name of a Terminal Window.

A terminal window can be connected to multiple I/O streams of various types. For example, streams 0, 1 and 2 can be mapped to one terminal window. An I/O stream, however, can be mapped to one terminal window only. Each terminal window must have a unique name.

Figure 4–13: CrossView Pro Terminal Windows
You can specify the characteristics of the Terminal Window by opening the Terminal Window Setup dialog. From the Settings menu, select **Terminal Window Setup...** to open this dialog, or click with the right mouse button in the Terminal Window to bring up a popup menu and select **Setup....** You can specify the input and output format of the terminal window. The input format can be a VT100-like terminal. The output format can be a VT100 terminal, display control codes, decimal, octal or hexadecimal. You can map linefeeds to carriage-return linefeeds, wrap at the end of a line, specify buffered input or specify that the window must be cleared at system reset and program reset. You can also log the input and output data to a file.

The default size of a terminal window is 24 lines of 80 characters. Everything that scrolls outside this window is lost. The visual window size can be smaller (scroll-bars are shown). You can specify another size in the Terminal Window Setup dialog.

Each terminal window has a local popup menu, which you can activate by clicking the right mouse button.

![Figure 4-14: Terminal Window Local Popup Menu](image)

**Reset** clears the contents of the terminal window and it also clears all attributes set with escape sequences. A **Clear** just clears the contents of a terminal window. **Reverse** changes the foreground and background colors and **Local echo** enables echoing back of typed characters in a terminal window. **Setup...** opens the Terminal Window Setup dialog.

You can connect an I/O stream to a terminal window in the **Connections** tab of the Settings | I/O Simulation Setup... dialog box.
4.6.9 DATA ANALYSIS WINDOW

CrossView Pro incorporates an advanced signal analysis interface designed to enable developers to monitor signal data more critically and thoroughly. This feature is useful when developing signal processing software for application areas such as communication, wireless and image processing.

Contrary to the other CrossView Pro windows the Data Analysis window (as shown in figure 4–15) is not opened from the View menu, but is opened as result of processing a data analysis script (or from the Settings menu). Most other CrossView Pro windows are updated whenever the target application stops execution due to, for example, a breakpoint. The Data Analysis window is only updated on user request. This is done because a large set of data is shown in the Data Analysis window and this set of data must be available and complete at the time the window is updated. Therefore, the user normally constructs a complex breakpoint to trigger the update of the Data Analysis window.

![Graph showing data analysis](image)

*Figure 4–15: CrossView Pro Data Analysis Window*

The Data Analysis Window provides a local Toolbar containing the following buttons:

- ![Zoom in horizontally](image)
- ![Zoom out horizontally](image)
Unzoom horizontally to normal (show all collected data)

Zoom in vertically

Zoom out vertically

Unzoom vertically to normal (show all collected data)

Update Data Analysis window

The graph displayed in the Data Analysis window is constructed by processing a CXL script. Refer to the CXL syntax specification in section 11.5.2, Syntax of CrossView eXtension Language (CXL), for details. TASKING provides scripts for standard signal analysis such as FFT. However, the programmer can write CXL scripts and process the data in the format he desires.

See section 11.5, Data Analysis, for more details on data analysis.

### 4.6.10 POP-UP WINDOWS

Finally, two more windows can appear in certain situations:

**Help Window:** Activated with function key F1 or when a Help button is pressed inside a dialog.

**Toolbox:** This window contains user defined buttons.
4.7 CONTROL OPERATIONS FOR CROSSVIEW PRO

All control operations can take place in any CrossView Pro Window. You can select and save startup options. You can record and play back playback files. You can define macros and assign them a button in the toolbox (allowing you to configure up 16 buttons).

4.7.1 ECHOING COMMANDS

The Command Window echoes every command given to CrossView Pro. CrossView Pro translates most button actions and menu selections into the CrossView Pro keyboard command equivalents. The Command Window echoes the equivalent commands just as if you had typed them there.

4.7.2 MOUSE/MENU/COMMAND EQUIVALENTS

Actions in CrossView Pro are performed by using keyboard commands typed into the Command Window, selecting a menu item, by clicking on a push button and sometimes by direct manipulation of objects with the mouse. Many actions can be accomplished several ways. For instance there are three different ways to set a breakpoint. You can:

1. Use the **line b** command in the command entry field.

2. Click on a breakpoint toggle in the Source Window.

3. From the **Breakpoints** menu, select **Breakpoints...** to open up the Breakpoints dialog box.
4.8 USING THE ON-LINE HELP

CrossView Pro has an extensive on–line help system to aid you. Help topics cover all CrossView Pro Windows, commands, and dialog boxes.

4.8.1 ACCESSING ON-LINE HELP

You can access help in several ways:

1. Click the Help button on a dialog box

   Opens the help system with information about how to perform the task or about the meaning of the dialog.

2. Click on the question mark in the upper right corner of a dialog, then click the element in the dialog you want help on.

   A yellow box briefly explains the element you asked help on.

3. Select the Help | Help menu item or press the F1–key.

   Opens the help system with information about the active window.

4. Hover the mouse pointer over a toolbar button.

   A yellow box shows the title of the button. A more complete description is shown in the status bar at the bottom of the screen.

4.8.2 USING MS-WINDOWS HELP

You enter help at a topic that explains the current window or dialog. By clicking on links, you can follow different paths. To return to your starting point click the Back button or open the Options | Display History Window and click on the node that you want to return to.

The Contents tab displays a list of main subjects. The Index tab displays a list of keywords that relate to certain topics. When you click the Find tab, you can search for a string pattern.

To save time, you can iconize the Help Window and maximize it when necessary.
CHAPTER 5

CONTROLLING PROGRAM EXECUTION
5.1 SOURCE POSITIONING

When you have the Source Window open and it displays a source file, there are two points of reference to keep in mind: the execution position and the viewing position.

The **execution position** refers to the line of source at the Program Counter address. This line is always the next statement or instruction to be executed. When you load a file into the Source Window, CrossView Pro automatically displays the portion of the source code that contains the execution position.

The **viewing position** (also called ‘cursor’) is the line currently being examined in the displayed source file. Since many Source Window operations act on this line, you can think of the viewing position as the ‘current line’. For instance, if you set a breakpoint without specifying a line number, CrossView Pro sets the breakpoint at the line marked by the viewing position. Please note that it is the viewing position that appears to the left of the Source Window (NOT the execution position!).

The execution position and the viewing position refer to the same line when a source file is first loaded into the Source Window. You can then change the viewing position, if you wish.

The execution position and the viewing position appear different to distinguish them from the rest of the source code. The execution position line appears in the execution position highlight colors, while the viewing position appears as a broken-line frame, also called the **cursor**. Note that a line containing a breakpoint appears in the breakpoint highlight colors.

A combination of execution position, cursor and breakpoint (all of which are potentially active on the same line) appear accordingly.
5.1.1 Changing the Viewing Position

When a program is active the viewing position is always visible in the Source Window. You can change the viewing position to move throughout the source file. Usually, whenever the execution position changes, the viewing position automatically follows suit. But you may easily change the viewing position without affecting the execution position.

To change the viewing position use any of the following possibilities:

- Use the vertical scroll bar to move a line or a page at a time. The viewpoint stays on the same line until it is no longer visible. It then stays on the first or last line of the display, depending on the direction of scrolling.
- Click on the desired, unmarked source line.
- From the Edit menu, select Find Line... to specify to which particular line you wish to move.

In the upper–left corner of the Source Window, there are two text fields. These fields show the line number of the current viewing position and the address of the first machine instruction for that line. CrossView Pro updates the Line and Address values each time the viewing position changes.

You can change the viewing position to the first executable line of a particular function with the `e` command. For instance:

```
e main
```

will make the first executable line of `main()` the current viewing position and display it in the Source window. You may also use the stack depth as an argument, if you place it before the `e`:

```
1 e
```

This will change the viewing position to stack depth 1, that is, the line that called the current function.

| FUNCTION: | Change the viewing position. |
| COMMAND:  | `stack e` |
|           | `e function` |
To change the viewing position to a specified address, you can use the `ei` command. This command is useful for viewing some code in the assembly window, without changing the program counter, since the execution position is not changed.

**FUNCTION:** Change the viewing position to address.

**COMMAND:** `address ei`

### 5.1.2 Changing the Execution Position

There may be times when you want to start or resume execution at a different line than the one marked by the current execution position.

Exercise caution when changing the execution position. Often each line of C source code compiles into several machine language instructions. Moving the program counter to a new address in the middle of a series of related assembly instructions is sometimes risky. Moreover, even though you change the program counter, registers and variables may not have the expected values if you bypass parts of the code.

In the Source Window you can change the execution position to the viewing position with the menu entry **Run | Jump to Cursor**. This menu entry is disabled in Source file window mode to prevent problems by skidding pieces of C code which are required to be executed. See also the `g` and `gi` commands below.

When the program halts, you can change the execution position with the `g` command in the Command Window. The `g` command moves the execution position, but does not continue the program. To resume execution from your new execution position, use the `C` command.

Although risky, the `g` command does have its uses, especially in conjunction with breakpoints to patch code. Refer to the *Breakpoints and Assertions* chapter for more information.

For example, to change the execution position from the current line, 54, to line 62, enter:

```
g 62
```
When you resume execution in this program, it is from line 62 instead of line 54.

**FUNCTION:** Change the execution position to a specified C source line

**COMMAND:** `g line_number`

You can also change the execution position to a specified address directly, although the same warnings apply. To do so, use the `gi` command. For instance:

```
0x800 gi
```

**FUNCTION:** Change the execution position to address.

**COMMAND:** `address gi`

Of course, moving the program counter (`gi` command) is even more potentially reckless than using the `g` command. Use both with caution especially when debugging a program which has instructions re-ordered due to optimizations.

To determine the address of a line of source, use the `P` command:

```
80 P
80:(P:$53):  sum = sum + 1;
```

The hexadecimal number in parentheses is the instruction address for line 80.

**FUNCTION:** Print a source line and its instruction address.

**COMMAND:** `line_number P`
5.1.3 SYNCHRONIZING THE EXECUTION AND VIEWING POSITIONS

Each time you stop execution, the position of the program counter (PC) is visible in the source window. However, it may disappear from the window when scrolling through the source or when you loaded a new program. To find the program counter again:

Click on the Find PC button in the Source Window or select Find PC from the Edit menu.

From the Command Window, use the L command.

The L Command

The L command is shorthand for 0 e. It synchronizes the viewing and the execution positions, adjusting the viewing position if the two are different. The L command never affects the execution position. The L command is useful if you have changed your viewing position and do not remember where your execution position is.

FUNCTION: Synchronize viewing and execution position.

COMMAND: L
5.2 CONTROLLING PROGRAM EXECUTION

Using the mouse in the Source Window, you can direct the execution of your source programs. Among your options are:

- Starting execution from the first instruction or from the current execution position.
- Manually stopping execution whenever you want.
- Executing the program a single line at a time.
- Executing functions by calling them directly.

5.2.1 STARTING THE PROGRAM

To restart a program from its first instruction:

- Click on the Restart program button in the Source Window.
- or:
  - From the Run menu, select Reset Application
  - From the Run menu, select Run, or click on the Run/Continue button.

Type the R command from the Command Window.

This is NOT a target system reset. Refer to the rst command for information about side effects that may be introduced due to a target system reset.

After restarting a program, you can stop execution only by a breakpoint, an assertion or a halt operation from the user.

---

FUNCTION: Reset program; run program.

COMMAND: R
5.2.2 HALTING AND CONTINUING EXECUTION

To stop or continue execution:

1. Click on the Halt button in the Source Window to stop execution. Click on the Run/Continue button to resume execution.

2. From the Run menu select Halt to stop execution. Select the Run menu item to resume execution.

3. Use the C command or function key F5 to resume execution.

When you halt the program, all the active windows update automatically to reflect the program’s current status. For instance, if you have any expressions monitored in the Data Window, their current value appears.

Note that when you use any of the above methods to stop the program, CrossView Pro halts at the machine instruction that was on when interrupted. While this is a convenient way to stop the program, it is hardly an accurate one — you may stop execution in the middle of a C source statement.

To stop a program at a precise line of C source code, set a breakpoint. For more about breakpoints see the Breakpoints and Assertions chapter.

When continuing, CrossView Pro resumes execution as if the program had never stopped.

FUNCTION: Continue execution from the current execution position.
COMMAND: C

5.2.3 SINGLE-STEP EXECUTION

When the program stops, you can continue execution, or you can step through it one line or instruction at a time. This is called single-step execution.
Single-stepping is a valuable tool for debugging your programs. The effect is to watch your programs run in stop motion. You can observe the values of variables, registers, and the stack at a precise point in a program’s execution. You can catch many potential bugs by watching a program run line by line.

When you single step, CrossView Pro normally executes one line of your source and advances to the next sequential line of the program. If you single step to a line that contains a function call, however, you have two options: step into the function or step over the function call.

**Source Single-Step Into**

There are several methods you can use to single step into:

- Click on the **Step Into** button in the Source Window or select **Step Into** from the **Run** menu.
- Press function key **F8** or type the **s** command in the Command Window. You have the option of setting the number of lines you want to execute. For example, to execute 2 lines of the program, type: `2 s`.

**FUNCTION:** Step through a program one source line at a time.

**COMMAND:** `number s`

**Stepping Into Functions**

Stepping into a function means that CrossView Pro enters the function and executes its prologue machine instructions, halting at the first C statement. When you reach the end of the function, CrossView Pro brings you back to the line after the function call and continues with the flow of the program. The debugger changes the source code file displayed in the Source Window, if necessary.

If you accidentally step into a function that you meant to step over, you can select **Return from Function** from the **Run** menu to escape quickly.

For example, suppose you are at line 59 of a file, which contains a call to the function `factorial()`:

```
main#59:   table[ loopvar ] = factorial(loopvar)
```
By performing one **Step Into** action, you can step into the source code for `factorial()`. Your Execution and viewing position change to:

```
factorial#103: char locvar = 'x';
```

CrossView Pro shows you the current function and line number and the C source code for the current execution position.

### Source Single-Step Over

To step **over** a statement or a function call:

- Click on the **Step Over** button in the Source Window or select the **Step Over** from the **Run** menu.
- Press function key **F10** or enter the **S** command in the Command Window.

You have the option of setting the number of lines you want the debugger to execute. For example, to execute three lines of source, single stepping over functions, enter: **3 S**.

| FUNCTION: | Single step, but treat function calls as single statements. |
| COMMAND:  | `number S` |

### Stepping over Functions

Stepping over a function means that CrossView Pro treats function calls as a single statements and advances to the next line in the source. This is a useful operation if a function has already been debugged or if you do not want to take the time to step through a function line by line.

For example, suppose you reach line 59 in `demo.c`, which calls the function `factorial()`, as in the example above. If you give a **Step Over** command, the execution position moves to line 60 of the source code in the `main()` function immediately, without entering the source code for `factorial()`. CrossView Pro has executed the function call as a single statement.
If you try to step over a function that contains a breakpoint or that calls another function with a breakpoint, CrossView Pro halts at that breakpoint. Once execution stops, the step over command is complete. Therefore, if you resume execution by clicking on the Run button or with the C command, you do not regain control at the entrance to the function with the breakpoint. You can either single step through the rest of the function, or select the Run | Return from Function menu item to return to the line after the point of entry.

### 5.2.4 STEPPING THROUGH AT THE MACHINE LEVEL

While single stepping through code at the source level is informative, you might need a lower level approach. CrossView Pro can step through a program at the assembly language instruction level.

While more time-consuming than a source level step-through, an instruction level step-through allows you to examine how your code has been compiled. As you advance through the assembly instructions, notice how CrossView Pro translates data addresses to variable names, and correlates branch addresses to points in the source code. This makes it much easier to follow the source at the instruction level.

The default step modes are:

**Source lines Window:** Source line step  
**Disassembly Window:** Instruction step  
**Source and Disassembly Window:** mode of previous window!  
(assumes the step mode of the previous Source Window setting)

**Mouse and menu actions:**

- The Step Into and Step Over buttons, and Run | Step Over and Run | Step Into menus can be set to step by instructions by selecting Run | Step Mode | Instruction step from the menu bar.
- To change back to stepping by source lines, select Run | Step Mode | Source line step.
- Another way to set the step mode is to select the Source line step or Instruction step radio button in the Settings | Source Window Setup dialog box.
To control this function from the Command Window, use the \texttt{Si} and \texttt{si} commands. The \texttt{Si} and the \texttt{si} commands are analogous to the \texttt{S} and \texttt{s} commands, \texttt{Si} will treat function calls (more precisely, jump to subroutine instructions) as single statements, while \texttt{si} will enter the function.

\begin{tabular}{ll}
\textbf{FUNCTION:} & Single step at instruction level. Step into functions. \\
\textbf{COMMAND:} & \texttt{number si} \\
\end{tabular}

\begin{tabular}{ll}
\textbf{FUNCTION:} & Single step at instruction level. Step over functions. \\
\textbf{COMMAND:} & \texttt{number Si} \\
\end{tabular}

As an example of stepping through instruction level code, restart the program. Then select \texttt{Run} \begin{itemize}
  \item \texttt{Step Mode} \item \texttt{Instruction step}
\end{itemize} Once it stops at the breakpoint you installed, advance execution one assembly language instruction at a time by using the \texttt{Step Over} and \texttt{Step Into} buttons. Or give the \texttt{Si} or \texttt{si} commands.

CrossView Pro will display disassembly of the next machine instruction that forms part of the C code in the Command Output Window:

\begin{itemize}
  \item \texttt{main#47+0x4: disassembled instruction}
\end{itemize}

Different types of targets, of course, have different assembly code, so debugging at the assembly level is hardware dependent.

Notice that a single C statement is usually compiled into several, sometimes many, machine instructions.

CrossView Pro supports debugging on machine instruction level using the \texttt{Intermixed} or \texttt{Assembly} mode of the Source Window.
5.3 NOTES ABOUT PROGRAM EXECUTION

If you stop the program in a module without debug symbols, then an $S$ or $s$ command attempts to step to a module with symbols. CrossView Pro does this by searching the run–time stack for a return address in a module with symbols, then setting a temporary breakpoint there, and running. This process relies on two assumptions: that the stack layout is uniform, and that each function eventually returns. In the unlikely event that these assumptions are violated, the program may run away when you attempt to single step.

5.4 SEARCHING THROUGH THE SOURCE WINDOW

CrossView Pro can search for addresses and functions in the entire application and for line numbers, and strings in the current source file. A string search starts from the current viewing position and "wraps around" the end (or begin) of the current source file. The string search ends when a matching string is found or when it returns to the starting point.

5.4.1 SEARCHING FOR A FUNCTION

There are several ways to find a function:

Using the mouse:

- From the Edit menu, select Find Symbol... to open the Find Symbol dialog box. Select the function you are looking for.
- Click on the Find Symbol button in the Source Window to open the Find Symbol dialog box.
- Select a function in the Stack Window (double-click) to show the line that called it.

From the Command Window, you can either specify $e$ followed by the function name, or a stack position followed by $e$. For example:

```
e main         Find the function main().
1 e             Find the line that called the current function.
```

CrossView Pro searches through all the relevant source code files to find the one containing the body of the function. The part of the file containing the function appears in the Source Window.
5.4.2 SEARCHING FOR A STRING

CrossView Pro allows you to search for a particular string in the current source file. CrossView Pro searches the Source Window from the current viewing position. If it finds the string, it moves the viewing position to the corresponding line. This does not affect the execution position.

To find a string:

Open the Search String dialog box by clicking on the Find Text String button, or select Search String... from the Edit menu. Click on the Case Sensitive check box to turn case sensitivity on or off.

You can also highlight a text fragment in the source code and click on the Find Next Text String button to find that fragment again.

In the Command Window, use the / or ? commands. The / command searches forwards and the ? command searches backwards. For example, to find the string initval, enter:

```
/initval  Search forward for the string "initval"
```

CrossView Pro's searches "wrap around" beyond the top or bottom of the file if necessary.

---

**FUNCTION:** Search forward for a string.  
**COMMAND:** / string

---

**FUNCTION:** Search backward for a string.  
**COMMAND:** ? string

---

If no string is supplied to the / or ? command, or if you hit carriage return, or press the function key F3 or select the Search Next String from the Edit menu item, CrossView Pro searches again for the last string requested.
5.4.3 JUMPING TO A SOURCE LINE

As mentioned earlier in the *Changing the Viewing Position* section, you can use the scroll bar to scroll through the source code or use the arrow keys or the + and – keys. To find a specific line, you can use one of several methods:

- From the **Edit** menu, select **Find Line...** to open the Find Line dialog box.

  After you enter a line number (or select one from the history list) in this dialog box and click on the **Find** button, CrossView Pro will change the viewing position to the indicated line number. At the first use, the Find Line dialog box contains no line number, but on subsequent invocations it will show the line number you entered before.

- Enter the line number on the command line.
CHAPTER 6

ACCESSING CODE AND DATA
6.1 INTRODUCTION

This chapter discusses topics related to viewing and editing the variables in your source program and execution environment, including accessing variables and registers, viewing and modifying the data space, using monitors, viewing the source file, and disassembling code.

6.2 ACCESSING VARIABLES

This section describes how to view and edit your program variables using the debugger. You can monitor data so that every time you stop the program, CrossView Pro updates the current value.

The Data Window displays the values of variables and expressions. As long as the window is open, CrossView Pro automatically updates the display for each monitored variable and expression each time the program stops.

Uninitialized variables will not have meaningful values when you first start the debugger, since your program’s startup code has not been executed. Also note that global data is initialized at load time. Re-running a program may produce unexpected results. To guarantee that global data is initialized properly, download the program again.

6.2.1 VIEWING VARIABLES, STRUCTURES AND ARRAYS

You may view variable values, and change them, from the Source Window and the Command Window. CrossView Pro returns the variable in the format var_name = value in the Command Window.

It is possible to display both monitored and unmonitored expressions in the Data Window. After every halt in execution, CrossView Pro updates monitored expressions. Unmonitored expressions are just one-shot inspections of the expressions value. Refer to section 4.6, CrossView Pro Windows for a detailed description of the Data Window.

To set the default display format of the data shown, select the proper format in the Data | Data Display Setup... dialog.
To show the contents of a variable or to show the type information of a function:

Position the mouse cursor over a variable or a function in the Source Window. A bubble help box appears showing the value of the variable or the type information of the function, respectively.

To evaluate a simple expression:

Double-click on a variable in the Source window. The result of the expression is shown in the Data Window. Alternatively, depending on the preferences you set in the Data Display Setup dialog, the expression appears in the Evaluate Expression dialog. Click the Add Watch or Add Show button to display the result of the expression in the Data Window. Click the Evaluate button to display the result of the expression in the output field of the Evaluate Expression dialog.

To evaluate a complex expression:

From the Data menu, select Evaluate Expression... and type in any C expression in the Evaluate Expression dialog box. Optionally select a display format. Click the Evaluate button.

Type the expression into the command edit field of the Command Window followed by a return or click the Execute button.

For example, to find the value of initval in demo.c type:

```
initval
```

and CrossView Pro will display:

```
initval = 17
```

FUNCTION: Display the value of a variable.

COMMAND: `variable’s_name`

For variables having the same name as an CrossView Pro command, use /n as format style code.
Any expression that can be typed into the Command Window can also be typed in the **Expression** field of the Expression Evaluation dialog box. Throughout this discussion, expressions can be typed in either location, depending on what is convenient.

**Viewing Structures**

You can also view structures.

By using any of the methods described above, you can print out the entire structure. For example:

```
recordvar
```

and CrossView Pro prints out the structure of `recordvar` and values of `recordvar`'s fields in correct C notation:

```
recordvar = struct rec_s {
    a = -1;
    b = X:$316 "TASKING";
    c = 12345;
    color = blue;
} recordvar
```

**Displaying Individual Fields**

Similarly, you can instruct the debugger to print the value of an individual field.

In the Source Window, highlight `recordvar.color` and click the **Show Expression** button. Or, in the **Expression** edit field of the Expression Evaluation dialog box or in the Command Window, type the structure name followed by a period and the field name. For instance, to see the field `color` for the structure `recordvar`, enter:

```
recordvar.color Command
color = blue Output
```

Note that CrossView Pro returns the value in the form `field_name = value`. CrossView Pro also displays enumerated types correctly.

Variables will not have meaningful values when you first start CrossView Pro, since your program’s startup code has not been executed.
Displaying the Address of an Array

If you enter the name of an array in the Expression Evaluation dialog box or in the Command Window, the debugger returns its address. For instance, to find the address for the array table, select table from the browse list in the dialog box or type the name in the Command Window:

<table>
<thead>
<tr>
<th>Command</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>table = X:$200</td>
</tr>
</tbody>
</table>

Note that CrossView Pro returns the address in the form array_name = address. Also each address contains a memory space qualifier.

The debugger can also display the address and value of an individual element of an array. Enter the name of the array and the number of the element in brackets. For instance, to find the address and value of the third element of array table, enter:

<table>
<thead>
<tr>
<th>Command</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>table[3]</td>
<td>X:$20C = 0</td>
</tr>
</tbody>
</table>

Note that CrossView Pro returns the information in the form address = value. Also each address contains a memory space qualifier.

Displaying Character Pointers and Character Arrays

The following piece of C code can be accessed in CrossView Pro using the string format codes:

```c
char  text[] = "Sample\n";
char  *ptext = text;
```

<table>
<thead>
<tr>
<th>Command</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>text</td>
<td>text = X:$8200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>text/a</td>
<td>Print it as a string</td>
</tr>
<tr>
<td>text</td>
<td>&quot;Sample^J&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>ptext</td>
<td>What is the contents of this pointer</td>
</tr>
<tr>
<td>string</td>
<td>string = X:$8200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>ptext/s</td>
<td>Print it as a string</td>
</tr>
<tr>
<td>string</td>
<td>&quot;Sample^J&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;ptext</td>
<td>Where does ptext itself reside</td>
</tr>
<tr>
<td>X:$8210</td>
<td></td>
</tr>
</tbody>
</table>
```
**Sizing Structures**

With structured variables, it is especially useful to know the size of a variable.

In the Command Window, you can determine the size of a variable with the `sizeof()` function. For instance, to determine the size of the structure `recordvar`, enter:

```plaintext
sizeof(recordvar)
```

20

Note that the size is expressed in MAUs (24-bit for the DSP5600x and DSP563xx, 16-bit for the DSP566xx).

### 6.2.2 CHANGING VARIABLES

With CrossView Pro, you can not only view your variables, but change them. This function allows you to easily test your code by single-stepping through the program and assigning sample values to your variables. For instance, to set the variable `initval` to 100, enter:

```plaintext
initval=100
```

and CrossView Pro confirms `initval`’s new value:

```plaintext
initval = 100
```

Note that CrossView Pro returns the values of variables with the syntax: `var_name=value`, with any right-hand side expression evaluated to a single value.

**Changing variables in the Data Window**

To change a variable in the Data Window, follow these steps:

- In the Data Window, double-click on the variable you wish to edit. In–situ editing will be activated.
- Specify the new value in the edit control and hit the Enter key.

When in–situ editing is active, you can use the Tab key to move the edit field to the next variable value or use the Shift+Tab key combination to move the edit control to the previous variable.
**Assigning Structures**

CrossView Pro also allows you to assign whole structures to one another.

You can use a simple equation to assign the structures. For instance, to assign `statrec` to `recordvar`, enter:

```
statrec = recordvar
```

**Assigning Pointers**

Assigning to and evaluation of pointers requires some extra attention. When request a pointer variable, CrossView Pro takes its memory space attribute (also called pointer qualifier) into account and evaluates the variable accordingly.

A pointer can point to _X, _Y, _L and _P memory space. All pointers are 1-word pointers. (24-bit for the DSP5600x and DSP563xx, 16-bit for the DSP566xx). When you enter an address on the CrossView Pro command line without a memory space qualifier, CrossView Pro converts the address by default to an address in the _P (program) memory space. The following piece of C code illustrates the CrossView Pro pointer support:

```c
_P char ptext[] = "I am in P memory";
_P char *pp = ptext;

_X char xtext[] = "I am in X memory";
_X char *px = xtext;

_Y char ytext[] = "I am in Y memory";
_Y char *py = ytext;

_pp
pp = _P:03
_pp/t
global char _P *pp
_pp/s
pp = "I am in P memory"
sizeof(pp)
1
```

A pointer can point into a circular buffer. If you do not declare the pointer using the keyword _circ, CrossView Pro treats the pointer as a normal pointer, it uses linear addressing, it performs no special form of pointer arithmetic. However if you declare the pointer with the _circ qualifier, the compiler uses modulo pointer arithmetic and so does CrossView Pro when using this pointer in an expression.
Consider the following fragment of C code:

```c
int _circ Circ_Buf[5];
int _circ Another_Circ_Buf[16];
int _circ *Ptr_to_Circ_Buf = Circ_Buf;

Ptr_to_Circ_Buf = Ptr_to_Circ_Buf++   
Ptr_to_Circ_Buf = X:$4   
Ptr_to_Circ_Buf = Ptr_to_Circ_Buf++   
Ptr_to_Circ_Buf = X:$0
```

Increment `Ptr_to_Circ_Buf`. CrossView Pro performs pointer arithmetic in exactly the same way as it is performed on the target.

```
Circ_Buf[10]   
*(Ptr_to_Circ_Buf + 10)
```

Assume `Ptr_to_Circ_Buf=Circ_Buf`. These two CrossView Pro commands are not identical. The first command does not perform modulo addressing, this in opposition to the second command. This behavior is identical to the behavior of the C compiler.

```
Ptr_to_Circ_Buf = Another_Circ_Buf
```

Assign `Ptr_to_Circ_Buf` to `Another_Circ_Buf`. CrossView Pro will update the value of `Ptr_to_Circ_Buf` as well as its modulo modifier. The value of the pointer is in an R-type register, the modulo modifier is in the corresponding M-type register.

```
Ptr_to_Circ_Buf = Ptr_to_Circ_Buf + 321
```

CrossView Pro will evaluate this expression using the pointer arithmetic associated with `Another_Circ_Buf`. Notice that `Another_Circ_Buf` must have exactly the same type as `Circ_Buf`, and thus located in the same memory space.
6.2.3 THE I COMMAND

CrossView Pro's windows contain a great deal of information about the current debugging session. Occasionally, however, you have a few closed windows, or wish the information to appear in the Command window (for instance, when you are recording output). Using the I (list) command, you can find out all sorts of things about the current state of the debugger and have the information appear in the Command window.

<table>
<thead>
<tr>
<th>Arguments of the I Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>a  assertions</td>
</tr>
<tr>
<td>b  breakpoints</td>
</tr>
<tr>
<td>d  directory</td>
</tr>
<tr>
<td>f  files (modules)</td>
</tr>
<tr>
<td>g  globals</td>
</tr>
</tbody>
</table>

For configurations that support real-time kernels the I K command can have additional arguments. See the description of the I command in the Command Reference for details.

You may for example view the contents of the registers:

\[ l \text{ r} \]

Or the list of procedures (that is, functions):

\[ l \text{ p} \]

A complete list of global variables:

\[ l \text{ g} \]

The \[ l \text{ f} \] command (list files) also shows the address where CrossView Pro placed the first procedure in the module. If the module is a data module then the address reflects the first item's placement.

With all of these \[ l \] commands you can specify a string:

\[ l \text{ g record} \]

and CrossView Pro searches the globals for a match with the same initial characters; in this case global variables that begin with record.
6.3 EXPRESSIONS

6.3.1 EVALUATING EXPRESSIONS

CrossView Pro expressions use standard C syntax, semantics, and allow special variables. You can calculate and show the values of expressions in CrossView Pro by using a variety of methods:

It is possible to display both monitored and unmonitored expressions in the Data Window. CrossView Pro updates monitored expressions after every halt in execution. Unmonitored expressions are just one-shot inspections of the expressions value. Refer to section 4.6, CrossView Pro Windows for a detailed description of the Data Window.

To evaluate a simple expression:

Double-click on a variable in the Source window. The result of the expression appears in the data window. Alternatively, depending on the preferences you set in the Data Display Setup dialog, the expression appears in the Evaluate Expression dialog. Click the Add Watch or Add Show button to display the result of the expression in the Data Window. Click the Evaluate button to display the result of the expression in the output field of the Evaluate Expression dialog.

To evaluate a complex expression:

From the Data menu, select Evaluate Expression... and type in any C expression in the Evaluate Expression dialog box. Optionally select a display format. Click the Evaluate button.

CrossView Pro calculates the result and displays the value in the appropriate format. For details about expression formats see the section Formatting Expressions in the chapter CrossView Pro Command Language.

Type the expression in the Command Window.

Expressions can contain variable names as arguments. For instance, if the variable initval has a value of 17 and you enter:

\[ \text{initval} \times 2 \]

CrossView Pro displays:

34
The expression can contain names of variables, constants, function calls with parameters, and so forth; anything that you can write directly at the Command Window, you can use in the Evaluate Expression dialog box. For more information on expressions and the CrossView Pro command language, refer to the section CrossView Pro Expressions in the Command Language chapter.

**The Dot Operand**

Using the dot shorthand "." can save you some typing. The dot stands for the last value CrossView Pro displayed. For instance:

```markdown
initval
initval = 17
```

Now you can use the value 17 in another expression by typing:

```markdown
. * 2
34
```

The value is the result of the new expression.

Naturally, using the dot operand saves you from retyping complex expressions.

### 6.3.2 Monitoring Expressions

CrossView Pro allows you to monitor any variable or expression. Monitoring means that the debugger evaluates a particular expression and displays the result each time the program stops. If you are in window mode, CrossView Pro displays the values of the monitored variables and expressions in the Data window.

**Monitor Set Up**

To set up a monitor you can:

From the **Data** menu, select **Evaluate Expression**... or double-click on a variable in the Source Window, or click on the **Watch Expression** button to view the Expression Evaluation dialog box. From this dialog box, you can enter an expression and monitor (watch) its value in the Data Window. You can skip the Expression Evaluation dialog if you activate the **Bypass Expression Evaluation dialog** check box in the Data Display Setup dialog.
Alternatively, click on the New Expression button in the Data Window.

The Data Window must be open to display the result. Otherwise CrossView Pro does not monitor the expression. Therefore, CrossView Pro opens the Data Window automatically when you choose to show or watch an expression.

Type the \texttt{m expression} command in the Command Window.

To place the variable \texttt{initval} in the Data window type:

\begin{verbatim}
 m initval
\end{verbatim}

\texttt{initval} remains in the Data window. You may run the program, step through it, and the display updates continually. Even if you are not in window mode, CrossView Pro still displays the value of \texttt{initval} after every CrossView command.

\begin{center}
\begin{tabular}{ll}
\textbf{FUNCTION:} & Monitor an expression or variable. \\
\textbf{COMMAND:} & \texttt{m expression} \\
\end{tabular}
\end{center}

Similarly, if you want twice the value of \texttt{initval} you could type:

\begin{verbatim}
 m initval*2
\end{verbatim}

And the expression \texttt{initval*2} is monitored.

Monitored expressions are evaluated exactly as if you had typed them in from the command line; therefore, if you are monitoring a variable, say \texttt{R}, identical to an CrossView Pro command, use the \texttt{/n} format, in this example \texttt{R/n}.

\textit{Monitor Delete}

To remove a monitored expression you can:

Select the item in the Data Window and click on the Delete Selected Data Item button from the Data Window, or select Data \textgreater{} Delete \textgreater{} Item.

To remove all expressions from the Data Window, select Data \textgreater{} Delete \textgreater{} All.

Type the \texttt{number m d} command in the Command Window.
To remove `initval` from your Data Window #1, type the number of the expression (first item of the Data Window has number 0) and `md` (monitor delete):

```
0 md
```

and CrossView Pro removes `initval` (in this case, assuming it is the first variable listed in the window) from the Data Window.

**FUNCTION:** Remove an expression from the Data Window

**COMMAND:** `number md`

Since local variables have no meaning beyond their range, CrossView Pro issues error messages if you try to evaluate local variables beyond their scope. Some variables also become invisible when the program call another function. For instance, if you are in `main()`, monitoring `sum`, and `main()` calls `factorial()`, the unqualified name `sum` is no longer visible inside `factorial()`. You can get around this problem, however, by monitoring `main#sum` instead.

### 6.3.3 Formatting Data

When you display a particular variable, CrossView Pro displays it in the format the symbolic debug information defines for it. You may, however, easily specify another format using dialogues or keyboard commands. See the section *Formatting Expressions* in the chapter *CrossView Pro Command Language*.

**Examples**

To print the value of `initval` in hexadecimal format, enter

```
initval/x
```

Be sure not to confuse CrossView Pro format codes with C character codes. CrossView Pro uses a `/` (forward slash) not a `\` (backward slash).
Don’t worry about trying to memorize the list, you probably won’t have occasion to use all these formats. Notice, however, that the \texttt{/t} format code give information about a particular value. For instance, if you wanted to find out what the type of \texttt{initval} is, type:

\begin{verbatim}
  initval/t
  global long _X initval
\end{verbatim}

You can also take more low-level actions, such as finding out which function contains the hexadecimal address 0x100.

\begin{verbatim}
  0x100/p
  main
\end{verbatim}

CrossView Pro tells you that address 0x100 is in the function \texttt{main()}.  

\section{6.3.4 DISPLAYING MEMORY}

CrossView Pro supports several methods to display memory contents. The Memory Window provides a very user-friendly yet powerful way to display the raw contents of the target memory.

Refer to section 4.6.4 for a description of the Memory Window.

Format codes also give you control over the number and size of multiple pieces of data to display beginning at a particular address. The debugger accepts format codes in the following form:

\begin{verbatim}
[count] style [size]
\end{verbatim}

\textit{Count} is the number of times to apply the format style \textit{style}. \textit{Size} indicates the number of MAUs to be formatted. Both \textit{count} and \textit{size} must be numbers, although you may use \texttt{c} (char), \texttt{s} (short), \texttt{i} (int), and \texttt{l} (long) as shorthand for \textit{size}. Legal integer format sizes are 1 and 2; legal float format sizes are 4 and 8.

For instance:

\begin{verbatim}
  initval/4xs
\end{verbatim}

displays four, hexadecimal two–MAU memory locations starting at the address of \texttt{initval}.  

\begin{verbatim}
  initval/t
  global long _X initval
\end{verbatim}
With format codes, you may view the contents of memory addresses on the screen. For instance, to dump the contents of an absolute memory address range, you must think of the address being a pointer. To show the memory contents you use the C language indirection operator `*`. Example:

```
*0x4000/2x1
P:$4000 = 0x00DB02 0x5A0554
```

This command displays in hexadecimal two MAUs at memory location 0x4000 and beyond. Instead of using the size specifier in the display format, you can force the address to be a pointer to unsigned long by casting the value:

```
*(unsigned long *)_X:0x4000/2x
X:$4000 = 0x00DB020804AC 0x5A055498C233
```

To view the first four elements of the array `table` from the `demo.c` program, type:

```
table/4d2
```

```
table = 1 1 2 6
```

This command displays in decimal the first four 2-MAU values beginning at the address of the array `table`.

By typing the a space followed by a carriage return you can advance and see the succeeding values in the same format:

```
[Enter]
X:$11 = 24 120 720 5040
```

You may recognize that the array `table` contains the factorials for the integers 0 through 7.

Displaying memory in this way is particularly effective when you have two-dimensional arrays. In this case you can display each row by specifying the appropriate count. For instance, if `myarr` is defined as `int myarr[5][8]`:

```
myarr/8d
```

displays the values for the eight elements in the first row of `myarr`. Typing the carriage return repeatedly then display subsequent rows in the same format.
To scroll back in memory, type the ^ (caret) sign:

^  

\[ x:\$$9 = 1 \quad 1 \quad 2 \quad 6 \]

**FUNCTION:** Display value(s) at previous memory location.

**COMMAND:** ^

---

**Bank switching**

CrossView Pro stores the page number of a bank in the most significant bits of an address. On a target that supports 4 pages, this means for example that a 16-bit address is converted to a virtual 18-bit address, where the 2 most significant bits contain the page number. When you access memory in for example range 0x8000–0xffff this is always in page 0, no matter what page is active in the DPCR register. So, when you want to access ranges within page 1 add 0x10000 to the address.

---

**6.3.5 DISPLAYING MEMORY ADDRESSES**

The f command lets you specify in which notation CrossView Pro displays memory addresses. It takes the same arguments as the printf() function in C.

**Memory Space Keywords**

Some target processors support more than one memory space. A memory space qualifier can be placed in front of the address to identify the requested space.

CrossView Pro recognizes the following memory space keywords, when accessing the different DSP5600x, DSP563xx or DSP566xx family address spaces:

\[_P, \_X, \_Y, \_L\]

If the memory space is omitted, CrossView Pro assumes the memory space _P (program memory). You must follow the memory space keyword with a colon and the offset of the address. For example:

\[*_P:0x4000/128\times1\]
dumps 128 MAUs as hexadecimal values, starting from address 0x4000 in (program) memory space _P. Other examples:

\*\_X:0/128x1  
\* (char *) \_X:0x90 = 5

*Shows the first 128 MAUs of the X memory space*

*Assign the byte at address 0x90 in _X with the value 5. Note that address 0x90 refers to a word (3 bytes). Only the least significant byte will be modified by this operation.*

---

**FUNCTION:** Specify memory address notation.

**COMMAND:** \f ["printf-style-format"]

For instance, if you wish to display all memory addresses in octal, type:

\f  "%o"

Now all addresses appear in octal. To return to the default hexadecimal, type:

\f  "%x"

Using the \f command without an argument also returns to hexadecimal address display.
6.4 DISPLAYING DISASSEMBLED INSTRUCTIONS

To show disassembled instructions:

From the **View** menu, select **Source | Disassembly** to open the Disassembly Source Window.

Use the `/i` format switch to display disassembled code in the Command Window.

By using an address and the `/i` format it is possible to display disassembled code at any point. Suppose you wish to see how the `factorial()` function has been compiled. One method would be to examine the instructions displayed as you single step through a program at the assembly language level. There is however a quicker method that does not require you to execute the instructions. Type:

```
factorial/10i
```

This command displays the first ten assembly language instructions of `factorial()`. Remember that in C a function's name is also its address. Thus `factorial` is the address of the function `factorial()`.

Note that CrossView Pro keeps track of variable and function names for you in the disassembled code. You can also disassemble from the current execution position by using the program counter:

```
$pc/5i
```

This command disassembles five assembly language instructions from the current execution line.

You can display disassembled code for any function:

```
main#56/7i
```

disassembles seven instructions from line 56.

See also the `ei` command for displaying disassembly in a window.

**Labels in Disassembly**

To show labels in disassembly:

From the **Settings** menu, select the **Source Window Setup...** to open the Source Window Setup dialog box and enable the **Symbolic disassembly** check box.
Turn the $symbols special variable "ON" by typing the following command in the Command Window:

```
opt symbols=on
```

### 6.4.1 INTERMIXED SOURCE AND DISASSEMBLY

To show intermixed source and disassembly:

1. From the **View** menu, select **Source | Source and Disassembly** to open the Source and Disassembly Window.
2. Use the `/I` format switch to display intermixed C and disassembled code in the Command Window.

   The `/I` format works exactly as the `/i` format, except CrossView Pro intermixes the pseudo-assembly listing with the original C source. This feature is often helpful in displaying long portions of code.

**Auto Switch between Source and Disassembly**

To automatically switch between source and disassembly window depending on the presence of symbols:

1. From the **Settings** menu, select the **Source Window Setup...** to open the Source Window Setup dialog box.
   Enable the **Show assembly when SDI is missing** check box.
2. Turn the $autosrc special variable "ON" by typing the following command in the Command Window:

   ```
opt autosrc=on
```
6.5 THE STACK

During debugging, you frequently find yourself lost or unable to pinpoint your location through a series of function calls. The stack helps you with the problem by recording the return addresses of all functions you have passed through. CrossView Pro can use this information to reconstruct the path to your current location.

The following diagrams show the structure of the stack. The first diagram reflects the system stack. The second diagram shows the user stack when using reentrant functions.

![System Stack Diagram]

*Figure 6–1: Stack frame layout*
6.5.1 HOW THE STACK IS ORGANIZED

The DSP563xx/DSP566xx processors have a system stack with 16 locations, 15 for the DSP5600x, divided in a system stack high word (SSH) and system stack low word (SSL). This system stack is used by the DSP for function calls, long interrupts and program looping (DO and REP loops). For a C program the system stack size is not sufficient. A deeply nested C program that also uses DO and REP loops and where long interrupts may occur, would soon generate a system stack overflow, because the system stack is also used by the DSP for return addresses of function calls. Therefore, all memory models except the static model (c56 only) support a user stack to store C variables, common subexpressions, temporary results, and to pass parameters when all registers are occupied. The mixed model for functions that are not explicitly declared _reentrant, and the static model use overlayable sections for these purposes.

The compiler pops the return address from the system stack and pushes it on the user stack (reentrant function) or saves it in a static area on function entry (static function). A leaf function does not move the return address from the system stack.
The user stack is defined in the locator description file (.dsc in directory etc) with the keyword stack, which results in a section called stack. The description file tells lc563 where to allocate the user stack.

The user stack size can be controlled with the keyword length=size in the description file. If you do not specify the stack size, the locator will allocate the rest of the available RAM for the stack, as done in the startup code. You can use the locator defined labels F_lc_bs and F_lc_es in your application to retrieve the begin and end address of the stack. Please note that the locator will only allocate a stack section if the application refers to one of the locator defined symbols F_lc_bs or F_lc_es. Remember that there must be enough space allocated for the stack, which grows upwards.

For non-reentrant functions, (non-register) automatics and (non-register) parameters are allocated in a static area and therefore do not use any stack space.

For reentrant functions, a user stack is used in memory. Automatics and parameters are all accessed using a user stack pointer register, allocated as a 16-bit pointer (USP). The stack pointer USP points to the last occupied location on the stack. If the compatibility option –Cs is used, the stack pointer USP points to the first free location on the stack. The stack frame also contains a so-called user frame pointer (UFP). The saved registers are also accessed using a user stack pointer. The user stack pointer (USP) is maintained in R7 or R6 if the compatibility option is used. The stack must be placed in default memory, or at least contain default memory, so L memory can be used for it when default memory is X or Y.

The UFP is always relative to the USP. To save registers the UFP is not maintained in a register, but is calculated from the USP with an offset.

### 6.5.2 THE STACK WINDOW

The Stack Window shows the current contents of the stack after the program has been stopped. This window helps you assess program execution and allows you to view program values. You can also set breakpoints for different stack levels from this window, as described in the chapter Breakpoints and Assertions.

The Stack Window displays the following information for each stack level:

- The name of the function that was called
• All parameters specified to the function
• The line number in the source code from which the function was called

Each stack level shown in the Stack Window is displayed with its level number first. The levels are numbered sequentially from zero. That is, the lowest/last pushed level in the function call graph is always assigned zero.

When you first see stack information, the lowest level appears against a darker background than the other lines in the window. The marked line in the Stack Window is the selected stack level, meaning that this line is selected for window operations. You can change the selected stack level by clicking on a different line.

**Checking the Stack from the Command Window**

The stack information is also accessible from the Command Window with the t and T commands. The t command reconstructs the program’s calling path. For instance, if you stepped into the function factorial() and issue a t (trace) command:

```
t
```

CrossView Pro displays:

```
0 factorial(num=0)   [demo.c:105]
1 main() [demo.c:59]
```

The numbers to the left indicate the depth of each function on the stack. The function at the zero stack level is your current function. CrossView Pro tells you the line number where the function was called ([demo.c:line_nr]) and the value of the argument passed (num=value). With this information it is fairly easy to reconstruct your calling path, and see what parameter values your functions have received.

---

**FUNCTION:** Trace stack to reconstruct program's calling path.

**COMMAND:** t
There is a slight variation on the \texttt{t} command called the \texttt{T} command. The two are identical, except that the \texttt{T} command also displays the local variables for each function. For instance:

\begin{verbatim}
T
0 factorial(num=0) [demo.c:105]
   locvar = 'x'
1 main() [demo.c:59]
   loopvar = 0
   sum = 0
   cvar = '\xff'
\end{verbatim}

FUNCTION: Trace stack and display local variables.
COMMAND: \texttt{T}

6.5.3 LISTING LOCALLS AND PARAMETERS OF A FUNCTION

As mentioned in the previous section, CrossView Pro displays all parameters of a function. You can view the local variables and parameters of any single function active on the stack. To do this:

Follow these steps:

- Open up the Expression Evaluation dialog box by clicking on the \textit{New Expression} button from the toolbar or selecting \textit{Evaluate Expression...} from the \textbf{Data} menu.
- Click on the \textit{Browse...} button.

In the Command Window, use the \texttt{l} (lowercase L) command.

For example, assuming you are still in \texttt{factorial()}, issue an \texttt{l} command:

\begin{verbatim}
l factorial
   num = 0
   locvar = 'x'
\end{verbatim}
You can accomplish the same task by specifying the stack depth instead of a function name:

```
1 0
```

### 6.5.4 LOW-LEVEL VIEWING THE STACK

You can directly view the contents of the user stack. Although CrossView Pro provides several high level methods of tracing functions on the user stack, you can view its contents directly with the frame pointer special variable, $ufp. For instance, the command:

```
* $ufp/4x1
```

displays the four one-MAU values in hexadecimal to which the frame pointer points. Notice that the stack frame is not really an array, but by pretending it is, you can display the memory much as you did with the table array. Refer to the *Accessing Variables* section in this chapter for more information.
6.6 TRACE WINDOW

C level trace is not available for all execution environments. Please check the Addendum for details.

The Trace Window displays the most recently executed lines of code each time program execution stops. CrossView Pro automatically updates the Trace Window each time execution halts, as long as the window is open.

For each executed line of code, the Trace Window displays:

- The name of the source file
- The name of the function
- The line number and corresponding source code
- The window shows all the code executed since the the last time the program halted.

6.6.1 TRACE WINDOW SETUP

The Trace Window’s only function is to display the contents of the emulator's/ simulator's trace buffer. The only operation you can perform in this window that directly affects the contents is to set the maximum number of instructions in the display.

To set the displaying limit, select the Initialization tab in the File | Options... dialog. You can change the maximum number of C–Trace machine instructions to fetch from the execution environment’s trace buffer and the maximum number of trace output lines in the Trace Window.

To view the most recently executed source statements from the Command Window, use the ct command preceded by the number of machine instructions you want to list. For example, to view the last source lines corresponding to the last ten machine instructions, enter:

10 ct

FUNCTION: Display in the Command window the most recently executed C statements.

COMMAND: number ct
To activate the source level trace window:

From the View menu, select Trace | Source Level to view the Trace Source Window.

You can view the last machine instructions executed with the ct i command. For example:

```
15 ct i
```

displays the last 15 machine instructions in disassembled form in the Command Window.

**FUNCTION:** Display the most recently executed machine instructions.

**COMMAND:** number ct i

To activate the instruction level trace window:

From the View menu, select Trace | Instruction Level to view the Trace Instructions Window.

You can view a raw trace with the ct r command. For example:

```
20 ct r
```

displays the last 20 trace frames in the Command Window.

**FUNCTION:** Display a raw trace.

**COMMAND:** number ct r

To activate the raw trace window:

From the View menu, select Trace | Raw to view the Trace Raw Window.
6.7 REGISTER WINDOW

The Registers Window shows you the values of internal registers on your target processor.

You can create multiple Register Windows and each Registers Window contains the names and contents of all currently selected registers in the selected register set definition. Values are displayed in hexadecimal format. As long as the window is open, the debugger automatically updates the values when the program stops.

To show the list of current registers and their contents in the Command Window, enter the list registers command (l r).

CrossView Pro also supplies the following special variables:

- $sp stack pointer
- $pc program counter
- $fp current frame pointer

for all targets. For more information, refer to the Command Language chapter.

6.7.1 REGISTER WINDOW SETUP

You can configure which register set definition with which (and in which order) registers must be displayed in the Register Window; using the Settings | Register Window Setup... dialog. Since you can have more than one Register Window, the last active Register Window will be configured when you select this menu item.

To configure a Register Window follow these steps:

- Select a Register Window.
- From the Settings menu, select Register Window Setup... to view the Register Window Setup dialog box.

The dialog will show the active register set definition and the list of available and selected registers for this particular register set definition.
• You can create a new register set definition by entering an unique register set definition name in the Name edit field and using the Add button.

• You can delete a register set definition by selecting an item from the defined register set definition list and using the Delete button. Note that when you delete a register set definition, any Register Window displaying a deleted register set will be closed.

• You can select a register set definition by selecting an item from the defined register set definition list. The list of available and selected registers will be updated according to the configuration of the selected register set definition.

Once you have selected a register set definition, follow these steps to configure this register set definition:

• You can add registers to the list of selected registers by selecting registers from the list of available registers by highlighting those registers in the left list box and using the Add- or Add All button or by double-clicking on the register you want to add.

• You can remove registers from the list of selected registers by highlighting those registers in the right list box and using the Remove <- or Remove All button, or by double-clicking on the register you want to remove.

• By using the Move Up and Move Down buttons you can change the display order of the selected registers in the Register Window.

CrossView Pro automatically updates all Register Windows and places the registers in each Register Window starting at the top-left position on one line, wrapping to the next line if the next register does not fit.

6.7.2 EDITING REGISTERS

CrossView Pro lets you change the contents of registers in a simple and direct manner.

Follow these steps:

• In the Register Window, click on the register value you wish to edit. In-situ editing will be activated.

• Specify the new value in the edit control and hit the Enter key.

If the edited value is not acceptable, the debugger will emit an error message and reset the old value.
When in-situ editing is active, you can use the Tab key to move the edit field to the next register value or use the Shift+Tab key combination to move the edit control to the previous register. Use the Esc key to cancel in-situ editing. When a register is not in view the contents of the Register Window will be updated automatically.

You can enter any expression in the Registers Window.

Registers which can be edited symbolically have a special marker just before the register name. You can click on this marker to activate the Assign Register Symbolically dialog.

To access registers from the Command Window, use the $ designation and the register name in the format:

\[ \$register = value \]
You can use breakpoints to stop program execution at specified locations and return control to the user. An assertion is a number of statements executed by the debugger each time the target executes a program line. Use assertions to track down bugs, the cause of which is very hard to find.

**7.1 INTRODUCTION TO BREAKPOINTS**

Breakpoints halt program execution and return control to you. There are several types of breakpoints: code, data, instruction count, cycle count, timer and sequence. A code breakpoint halts the program on a particular statement or instruction; a data breakpoint stops the program when a particular memory address (or range of addresses) is accessed; an instruction count breakpoint halts the program after a specified number of instructions have been executed; a cycle count breakpoint stops the program after a number of CPU cycles; a timer breakpoint stops the program after a number of micro seconds or ticks and sequence breakpoints stop the program when a number of breakpoints are hit in a specified sequence.

Data breakpoints, instruction count breakpoints, cycle count breakpoints and timer breakpoints are not available for all execution environments, please check the Addendum.

**7.1.1 CODE BREAKPOINTS**

A **code breakpoint** is set on a line in the code and makes the program halt exactly before that line executes. When you define a code breakpoint, you can include four elements:

- A *count*, which is the number of times the breakpoint must be encountered before it stops the program (default is 1).
- A *reset count*, which is the value assigned to the *count* after the program has stopped on a breakpoint (default is 1).
- A *name*, which is the symbolic name you can associate with a breakpoint.
- A list of commands, which will be executed when the program hits the breakpoint.
In the Source Window, a green colored toggle shows that no breakpoint is set. A red colored toggle shows that a breakpoint is installed. An orange colored toggle indicates an installed but disabled breakpoint. If coverage is enabled, coverage markers are present to the right of the breakpoint toggles. An executed line is marked and not executed lines are not marked.

**Figure 7–1: Code Breakpoint**

**Permanent/Temporary Code Breakpoints**

Code breakpoints can be: *permanent* or *temporary*. A permanent breakpoint exists until explicitly deleted. A temporary breakpoint only exists until it stops the program once.

**Probe Point Code Breakpoints**

A breakpoint can be treated as a probe point. When a probe point breakpoint is hit, the associated commands are executed and program execution is continued. Probe points are used with File I/O simulation and sequence breakpoints.
How CrossView Pro Sets Code Breakpoints

CrossView Pro depends on the symbol table for information about how machine instructions map to lines of source. In general, the C compiler issues line symbols at the start of each statement or line, whichever comes first. This can lead to some surprising results. If you look carefully, you can tell on which line CrossView Pro set the breakpoint, since CrossView Pro tells you on which line the program stopped, a line that may be different from the one you expected. To find out what happens if you install a code breakpoint, use single stepping and watch the order in which the source lines print out.

Multiple Statements on a Single Source Line

If you frequently include multiple statements on a single line in your source code, you may have difficulties setting code breakpoints at certain locations. For instance, suppose you have a source line containing:

```c
a = 0; b = 1
```

Suppose you want to halt execution after the assignment to `a` and before the one to `b`. A normal code breakpoint does not work here, because execution stops at the first instruction of the source line. CrossView Pro provides you with the capability of disassembling the code and inserting breakpoints at the machine level. You can use the Assembly Source Window or the Intermixed Source Window to spot the right location.

For more information on machine level breakpoints, see below.

Setting Breakpoints for Multi–line Statements

Code breakpoints have a special behavior for multiple–line statements, such as a multiple–line `if`. In an `if` clause, a line symbol is generated at the beginning of the list of conditions, and the other lines of the conditions are generally associated with the first line of the clause. In an `if–then–else` construct, the `}` character before the `else` is associated with the branch–around to the end of the statement.

Consider the following example:

```c
22: if ((a == b) &&
23:     (c == d)) {
24:     x = 2;
25: } else {
26:     y = 3;
27: }
```
If you try to set a code breakpoint at line 23, CrossView Pro sets the breakpoint on the preceding statement. If you try to set a breakpoint on line 22, CrossView Pro highlights line 23. If you set a breakpoint on line 25, it hits after the assignment to x, but before the jump to line 27. Notice that it is not hit unless the if clause is true. In other words, a breakpoint on line 25 is really a break on the }, not on the else {}. The same behavior applies when the else {} statement is on the next source line.

**Breakpoints and For Loops and While Loops**

The code generated for a C 'for' statement has three parts: the initialization; the body of the loop; and the increment, test, and branch. The initialization part and the increment, test, and branch are different parts of code, but are both associated with the 'for' statement itself. For example consider:

```
99: for (i = 0; i < 9; i++) {
100:   myfunction(i);
101: }
```

A breakpoint placed on line 99 will only be hit once, because it is hit at the initialization code. The code for the increment, test, and branch is associated with line 101, not 99, as you might expect.

The same applies to 'while' loops.

**Breakpoints and Emulator Mode**

Upon entering emulator mode, the debugger removes any breakpoints it established in the target code. Removing breakpoints ensures that you can access unmodified target code. When emulator mode ends, CrossView Pro reestablishes breakpoints as necessary.

As long as you avoid the debugger’s own breakpoint trap, you may establish arbitrary breakpoint conditions while in emulator mode. These will not be removed by CrossView Pro and thus remain active, however, after you exit emulator mode. If one of these breakpoints is hit during normal debugging, CrossView Pro will issue a message such as:

`Stopped on breakpoint not set by debugger.`
System Startup Code

It is possible (for example, by using the `si` command) to debug system level startup code that initializes the target environment. You should not use any global variables in CrossView Pro expressions until the data area has been initialized. CrossView Pro assertions and other CrossView Pro commands that examine C variables may deliver erroneous information or cause memory access errors if used before the C environment is established.

7.1.2 DATA BREAKPOINTS

A data breakpoint instructs the execution environment to watch a particular data address or address range and halt execution if the program reads from or writes to that address. Data breakpoints are a powerful feature for tracking the use, and possible misuse, of pointers, global variables and memory mapped I/O ports.

Data breakpoints are not available for all execution environments, please check the Addendum.

When setting a data breakpoint, you can specify whether the breakpoint stops the program when data is read from, written to, or both.

Data breakpoints are implemented in hardware. As a consequence, the number of allowable data breakpoints is limited by your execution environment. A simulator does not have these restrictions. Refer to the environment-specific Addendum for more information.

You may set a data breakpoint on a local variable, but only if the local variable is active. CrossView Pro notifies you when program execution passes beyond a local variable's scope, and a breakpoint set on such a variable is deleted automatically. Data breakpoints for static variables do not have this restriction.

Note that any local variables placed in registers cannot be tracked with data breakpoints. In this case, you must use an assertion. Refer to the Assertions section later in this chapter for more information.
7.1.3 LISTING BREAKPOINTS

To see a listing of all of the currently defined breakpoints:

From the Breakpoints menu, select Breakpoints... to view the Breakpoints dialog box.

In the Command Window, enter the \l or \B commands. The list appears in the Command Window.

For example entering the \B command can result in:

\B
0 ena CODE main (CODE:0x78) 2/2

The breakpoint's number (used when deleting breakpoints) is listed first, then if it is enabled or disabled, then its type: such as CODE for code breakpoints and DATA for data breakpoints. Next, CrossView Pro lists the function and/or address, its count and reset count, and finally any attached commands enclosed by { and }.

---

FUNCTION: View all breakpoints in the Command window.

COMMAND: \B

CrossView Pro decrements the count each time the breakpoint is hit. When the breakpoint's count reaches 0, CrossView Pro halts the program.

7.2 SETTING BREAKPOINTS

You may set a code or data breakpoint by:

- Using the mouse to open the Breakpoints dialog box.
- Using the mouse in the Source Window.
- Using the Stack Window.
- Using the command line in the Command Window.

When you set a new breakpoint using the mouse, without using the Breakpoint dialog box, the type is always permanent, the count 1 and the location corresponds to the current viewing position, if the Source Window is open. These variables are described in more detail below.
Setting Breakpoints from the Menu

To set a breakpoint from the menu, select Breakpoints... from the Breakpoints menu to view the Breakpoints dialog box. From this dialog box, you can define several types of breakpoints.

To set a code break point at line number # of the C source, click the Add > button and select Code Breakpoint.... Click the Break At... button, choose a C module (for example demo.c) and click the OK button. Now you can enter a line number to set the breakpoint at.

![Breakpoints dialog box]

The last entry of the list is always empty. Select it to start defining a new breakpoint.

Setting Breakpoints from the Source Window

You can set or remove a code breakpoint directly from the Source Window by clicking on:

- The breakpoint toggle next to the source lines in the Source Window.

To set data breakpoints use the menu as described above.
Setting Breakpoints from the Stack Window

See the section *Up–level Breakpoints* later in this chapter.

Setting Breakpoints from the Command Window

You can set a code breakpoint from the Command Window using the `break code` command or the `b` command, and set a data breakpoint using the `break data` command. Several options are available after these commands.

See the `break` command in the *Command Reference* for detailed information.

For example, the following command sets a code breakpoint at the address specified by function `main`:

```
break code main
```

To set a code breakpoint at a specific source line, you can enter a breakpoint address in the form: `filename#line` after the `break` command, or you can specify a line number, followed by the `b` command and any commands you want to attach to the breakpoint. For example, to set a code breakpoint at line 51 in your source, enter:

```
b break demo.c#51
```

or

```
51 b
```

If you do not specify a line number, a breakpoint will be set at the current viewing position.

---

**FUNCTION:** Set a code breakpoint.

**COMMAND:** `break [code] address [option]...`

---

**FUNCTION:** Set a code breakpoint.

**COMMAND:** `[line_number] b [commands]`
To set a data breakpoint, you must specify the `break data` command, followed by an address, followed by any commands you want to attach to the breakpoint. There are three types of data breakpoints:

- A data read breakpoint to see if a variable is read from (`break data address, access_type=r` command)
- A data write breakpoint to watch if a variable is written to (`break data address, access_type=w` command)
- A data read or write breakpoint to check if a variable is either read from or written to (`break data address, access_type=rw` command)

For example, to set a data breakpoint to watch the global variable `initval`, enter:

```
break data &initval, access_type=w
```

This command instructs CrossView Pro to set a data breakpoint that will halt execution if the program writes to the variable `initval`. Note that you have to specify the variable’s address.

---

**FUNCTION:** Set a data breakpoint.

**COMMAND:** `break data address [option]...`

---

### 7.2.1 DATA BREAKPOINTS OVER A RANGE OF ADDRESSES

You can also use data breakpoints to watch a contiguous range of memory. As with standard data breakpoints, data breakpoints over a range of addresses can be set to watch for reading, writing or both. To set a data breakpoint of this type:

Using mouse and menu:

- From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box.
- Select the data breakpoint you want to edit and click the **Edit...** button, or click the **Add >** button and select **Data Breakpoint**...
- Specify a start address and click on the **Advanced** button.
- Select one of the **Type** options: break on read, write, read or write.
• Specify an end address. The end address is part of the range.

From the Command Window:

• Type `break data address, end_addr=end_address, access_type=r` to set a data read breakpoint over a range.
• Type `break data address, end_addr=end_address, access_type=w` to set a data write breakpoint over a range.
• Type `break data address, end_addr=end_address, access_type=rw` to set a data breakpoint for both reading and writing over a range.

For example, to ensure that the program stops if any of `recordvar`'s fields are either written to or read from:

```c
break data &recordvar, end_addr=(int) &recordvar+sizeof(recordvar)-1, access_type=rw
```

**FUNCTION:** Set a data breakpoint over a range of addresses.
**COMMAND:** `break data address, end_addr=end_address [option]...`

### 7.2.2 TEMPORARY BREAKPOINTS

Breakpoints can be: *permanent* or *temporary*. A breakpoint exists until it is manually deleted. A temporary breakpoint is automatically removed by CrossView Pro after it halts the program once.

To set a temporary breakpoint:

Follow these steps:

• Open the Source Window by selecting `Source | Source lines` from the `View` menu.
• Open the Breakpoints dialog by selecting `Breakpoints...` from the `Breakpoints` menu.
• Click on the `Add >` button and select `Code Breakpoint...`
• Enter an address in the `Break At` field and click on the `Advanced` button.
• Enable the `Remove when hit` check box in the `Behavior` field.
Breakpoints and Assertions

7–13

- Click on the **Continue** button in the Source Window when the program halts. This removes the temporary breakpoint at the viewing position and the program continues.

- Alternatively, scroll to the line that you want to stop at and click once (to establish a viewing position). From the **Run** menu, select **Run to Cursor** to continue execution until you reach this temporary breakpoint.

From the Command Window:

- Type `break code address, temporary=true` to set a temporary code breakpoint.

- Type the **C** command followed by a line number, to set a temporary breakpoint at a line number.

For example,

```
C 51
```

sets a temporary breakpoint at line 51 and resumes execution at the current execution position.

**FUNCTION:** Set a temporary code breakpoint.

**COMMAND:** `break code address, temporary=true [option]`...

### 7.2.3 BREAKPOINT NAMES

You can associate a symbolic name with a breakpoint. You can then use this name with the following commands: **break set** and **break delete**. Breakpoint names must be unique and cannot be a number or the word "all". Allowed characters are a-Z, A-Z, 0–9 and "."

To assign a name to a breakpoint:

Follow these steps:

- From the **Breakpoints** menu, select **Breakpoints**... to open the Breakpoints dialog box.

- Select a breakpoint to edit and click on the **Edit...** button.

- Alternatively, click on the **Add >** button and select a breakpoint type to create.
• Enter the breakpoint information in the first field, for example an address.
• Enter a symbolic name in the Name field.

Use the name=name option of the break command in the Command Window.

For example,

    break code 0x1234, name=brk_1

sets a code breakpoint at address 0x1234 with the name brk_1.

7.2.4 SETTING THE COUNT

CrossView Pro allows you to set a breakpoint’s count. The count defines how many times you encounter the breakpoint before it halts the program. For example, a breakpoint with a count of 3 means the program stops on the third hit. Each time the breakpoint is hit, CrossView Pro decrements the count. When the count reaches 0, CrossView Pro halts the program, and resets the count to the value of the reset count. The default reset count is 1.

To set a breakpoint’s count,

Follow these steps:

• From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box.
• When you add or edit a breakpoint, click on the Advanced button.
• Enter a breakpoint’s count in the Breakpoint count field.
• Enter a reset count in the Reset count field.

From the Command Window,

• Use the count= argument with the break command to set both the current count and the reset count.
• Use the curr_count= and/or reset_count= arguments with the break command to set the current count and the reset count separately.
For example, suppose you have a breakpoint set at address 0x59 of your source code. The first time the program halts at address 0x59, enter:

\[ \text{break code 0x59, curr\_count=3, reset\_count=4} \]

This command sets the breakpoint’s count to 3 and the reset count to 4. You can observe a breakpoint’s current count and reset count when you list the breakpoints in the Command Window with the `lb` command.

**FUNCTION:** Set the count and reset count for a breakpoint.

**COMMAND:**

\[ \text{break type address, count=count} \]

**FUNCTION:** Set the count and reset count for a breakpoint separately.

**COMMAND:**

\[ \text{break type address, count=count, reset\_count=reset\_count} \]

### 7.2.5 SEQUENCE BREAKPOINTS

A sequence breakpoint is a special kind of breakpoint. Only if other breakpoints are hit in a specified order, the sequence breakpoint itself will hit.

To hit a breakpoint without halting the program, the breakpoint in the sequence must be specified as a *Probe point*. When a probe point is hit, the associated commands are executed and program execution is continued.

When all specified probe points are passed in the logical sequence you specified, the program stops at the last breakpoint in the sequence.

To set a sequence breakpoint:

Follow these steps:

- From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box.
- Click on the **Add >** button and select **Sequence Breakpoint...**
• Click the **Sequence**... button to open the Edit Sequence Breakpoint dialog box.

• Select a breakpoint from the **Available Breakpoints** list box and add it to the sequence with the buttons **ADD**, **AND** or **OR**. Use the **NOT** button for a breakpoint that should *not* be passed. All breakpoints you add to the list must be enabled, otherwise the sequence breakpoint itself will not hit.

From the Command Window:

• Use the **sequence** argument of the **break** command with a list of breakpoints to specify the sequence.

For example,

```
break sequence (0) (1 and 3) (2)
```

In this example, the sequence breakpoint hits when probe point 0 is hit first, then 1 and 3 are hit in any order, and finally probe point 2 is hit.

---

**FUNCTION:** Set a sequence breakpoint.

**COMMAND:** `break sequence sequence [, option]...`

### 7.3 DELETING BREAKPOINTS

You can delete a breakpoint directly from the source code, using the menu items, or through the Command Window. To see a list of active breakpoints, select **Breakpoints**... from the **Breakpoints** menu or use the **lh** command in the Command Window.

To delete a code breakpoint:

- Click on the corresponding red breakpoint toggle next to the source line in the Source Window. This deletes the code breakpoint and the breakpoint toggle turns green.

- You can also follow these steps:
  
  • From the **Breakpoints** menu, select **Breakpoints**... to open the Breakpoints dialog box. This box contains a remove function.
  
  • Select the Breakpoint from the list.
• Click the **Remove** button.

Use the **break delete** `breakpoint_number | name` command in the Command Window. You need to know the breakpoint’s number or name for this command.

For example, to delete the breakpoint numbered 1, enter:

```
break delete 1
```

**FUNCTION:** Delete a breakpoint.

**COMMAND:**

```
break delete breakpoint_number
break delete breakpoint_name
```

To clear all the breakpoints in the program, type:

```
break delete all
```

Do you want to delete all breakpoints? **y**

**FUNCTION:** Delete all breakpoints.

**COMMAND:**

```
break delete all
```

### 7.4 Enabling/Disabling Breakpoints

You can enable or disable a breakpoint directly from the source code, using the menu items, or through the Command Window. To see a list of active breakpoints, select **Breakpoints...** from the **Breakpoints** menu or use the `lb` command in the Command Window.

To enable or disable a code breakpoint:

Follow these steps:

- From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. This box contains an edit function.

On Windows:

- In the list of breakpoints toggle the check box in front of the breakpoint to enable or disable the breakpoint.
On UNIX:

- Select the breakpoint form the list.
- Click the **Enable** or **Disable** button to enable or disable a breakpoint.

Use the **break enable** or **break disable** command in the Command Window to enable or disable a breakpoint. You need to know the breakpoint’s number or name for these commands.

For example, to disable the breakpoint numbered 1, enter:

```
break disable 1
```

**FUNCTION:** Disable a breakpoint.

**COMMAND:**

```
break disable breakpoint_number
break disable breakpoint_name
```

To enable the breakpoint numbered 1, enter:

```
break enable 1
```

**FUNCTION:** Enable a breakpoint.

**COMMAND:**

```
break enable breakpoint_number
break enable breakpoint_name
```

### 7.5 BREAKPOINT COMMANDS

CrossView Pro allows you to attach commands to code and data breakpoints. When execution halts at a breakpoint, CrossView Pro executes the commands. Valid commands are almost any C statements and CrossView Pro commands, giving you a very powerful tool for manipulating a debugging session. To do this:

Follow these steps:

- From the **Breakpoints** menu, select **Breakpoints**... to open the Breakpoints dialog box.
• Select an existing breakpoint from the list and click on the **Edit...** button or click on the **Add >** button and select a type of breakpoint you want to add.

• Enter the breakpoint information in the first field, for example an address.

• Click on the **Advanced** button. Note that the button is only visible when there is more information available on the breakpoint.

• Click in the **Commands edit** area.

• Type in the commands to be executed when the breakpoint is reached.

You do not need to enclose a group of commands in brackets. However, each individual command must be delimited by a semicolon.

---

**Figure 7–3: Breakpoint Commands**

Type the commands, enclosed in brackets and delimited by semicolons, after **commands** argument of the **break** command in the Command Window.
For instance, suppose you want a program to stop at a breakpoint, display a variable’s value, and resume execution all in one stroke. To perform this function, you need to attach the appropriate commands to a breakpoint. Enter:

```
break code main, commands={initval; C}
```

This places a breakpoint at address main. When execution stops at the breakpoint, CrossView Pro displays the value of initval and immediately resumes execution.

If you enable the **Probe point** check box, you can omit the **C** command. This is done automatically.

You can attach almost any valid CrossView Pro commands or C statement to breakpoints. This latitude allows you to use breakpoints in powerful ways. Later on you find out how breakpoints can create patches in your program.

CrossView Pro does not check the syntax of attached commands until the breakpoint is hit.

Data breakpoints accept command lists the same way as code breakpoints. For instance, to set a data breakpoint that monitors the value of initval, enter:

```
break data &initval, access_type=w, commands={initval; C}
```

Every time the program writes to the variable initval, this breakpoint halts the program, prints the value of initval and continues execution.

For more information on the use of attached commands, see the *Patches* and *Diagnostic Output and Statistical Information* sections later in this chapter.
7.5.1 ATTACHING CONDITIONALS TO A BREAKPOINT

You can pass standard C conditionals to a breakpoint.

For example:

```
break code demo.c#63, commands= {if (initval==17) {C}
{initval/n}}
```

stops the program at line 63, checks to make sure the variable `initval` is 17, and resumes execution if it is. If `initval`'s value does not equal 17, CrossView Pro prints the value, and the program remains halted.

7.5.2 ATTACHING MACROS TO A BREAKPOINT

You can attach any currently defined macro to a breakpoint in a command list. For example, suppose you define a macro named `rg` that checks the value of the variable `initval`. The command to define this macro is:

```
set rg "if (initval != 17) {initval/n} {C}"
```

If the value does not equal 17, the macro prints the value and halts the program. Otherwise, execution continues.

You can include this macro at any point by attaching it to a breakpoint. Entering:

```
break code demo.c#51, commands={rg}
break code demo.c#63, commands={rg}
```

this is a very efficient way to insert the macro with breakpoints at lines 51 and 63.

For more information on macros, refer to *Defining and Using Macros* chapter.
7.5.3 ATTACHING STRINGS TO A BREAKPOINT

You can attach strings to a breakpoint’s command list. This feature is useful for placing comments and reminders within your breakpoints. Attaching a string to a breakpoint also eliminates the need for diagnostic printf() statements in your compiled code.

For example, you could place a breakpoint on line 49 such as:

```
49 b {"Passed line 47\n";C}
```

Whenever the breakpoint on line 49 is hit, CrossView Pro prints the string and continues execution.

7.6 SUPPRESSING BREAKPOINT MESSAGES

Whenever a breakpoint is hit, CrossView Pro displays in the Command Window, the name of the function, line number and file in which the breakpoint appears. You can suppress this information by setting breakpoint “silent” mode. In the silent mode, the current location is not printed out.

To set silent mode you can use the Q (for quiet) command as part of the command attached to a breakpoint definition.

Pass the Q command to a breakpoint first. For example:

```
51 b {Q; initval = 5}
```

stops the program on line 51, but does not print a message stating where the break occurred.

7.7 UP-LEVEL BREAKPOINTS

Up-level breakpoints are breakpoints set at the entrance and/or exit of functions. Basically, up-level breakpoints are code breakpoints that are directly connected to the current HLL stack handling.

To see the current HLL stack, open the Stack Window or enter the t command in the Command Window.
You can set up-level breakpoints via the Stack Window or in the Command Window. You cannot set up-level breakpoints in the Source Window:

Double-click on the function in the Stack Window to install a stack breakpoint after the function call.

You can also follow these steps:

- Click on the function in the Stack Window.
- From the Breakpoints menu, select either Stack Breakpoint | After Call to Function or Stack Breakpoint | At Function Entry

You have the option of setting the breakpoint before (function entry) or after (up-level) a selected function.

All breakpoints set through the Stack Window are temporary by default. To make a breakpoint permanent, select Breakpoints... from the Breakpoints menu to open the Breakpoints dialog. Select the breakpoint you want to edit and click on the Edit... button. Click on the Advanced>> button and disable the Remove when hit check box.

In the Command Window, use the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>bU</td>
<td>Sets breakpoint after call to function</td>
<td>temporary</td>
</tr>
<tr>
<td>bu</td>
<td>Sets breakpoint after call to function</td>
<td>permanent</td>
</tr>
<tr>
<td>bB</td>
<td>Sets breakpoint at beginning of function</td>
<td>temporary</td>
</tr>
<tr>
<td>bb</td>
<td>Sets breakpoint at beginning of function</td>
<td>permanent</td>
</tr>
</tbody>
</table>

For example, suppose you have accidentally single-stepped into a function called factorial(). If you do not want to single step through the function, an up-level breakpoint can help you. Enter:

bU
The `bu` command sets a temporary breakpoint after return of the function. Now, instead of having to single step all the way through the function, you can start continuous execution, which stops when it hits the new breakpoint at the function's return. Note that it makes no difference whether the function has several possible points of return; the up-level breakpoint works at all points of return. Note that when the function that contains the breakpoint is called from one of the functions that are located below it on the stack, the execution may be stopped before returning at the desired stack level, for example with recursive functions.

When setting up-level breakpoints from the Command Window, you can specify how deep in the stack the function's address is located. For example, if you are two functions down from the `main()` program, enter:

```
2 bu
```

This command breaks when you return to the top level of the call graph.

---

**FUNCTION:** Set a temporary breakpoint after call to function.

**COMMAND:** `[stack] bu [commands]`

---

**FUNCTION:** Set a permanent breakpoint after call to function.

**COMMAND:** `[stack] bu [commands]`

---

**FUNCTION:** Set a temporary breakpoint at function entry.

**COMMAND:** `[stack] bb [commands]`

---

**FUNCTION:** Set a permanent breakpoint at function entry.

**COMMAND:** `[stack] bb [commands]`
7.8 PATCHES

A patch is a means of using CrossView Pro to change the execution of your program without recompiling. Patches involve manipulating breakpoints to skip code, include code, or replace existing code with new code.

Basically, a patch is a breakpoint with certain associated commands that enable you to alter program execution. This capability is a useful debugging tool.

You can associate the commands used to patch code with a breakpoint through either the Command Window or through the Commands edit box in the Breakpoint dialog box. The examples below set breakpoints using CrossView Pro commands typed in the Command Window. You can also set breakpoints in the Breakpoints | Breakpoints... dialog. In this case the commands between the brackets are entered into the Command edit area.

7.8.1 PATCHING CODE OUT OF A PROGRAM

To patch code out of a program, you can set a breakpoint that changes the execution position. For instance, suppose you want to patch an infinite loop out of your source.

```plaintext
78:  while (loopvar)  
79:   {  
80:     sum = sum + 1;  
81:   }  
82:  
83:  sum = sum + 5;  
```

On line 78, place a breakpoint that jumps to line 83, effectively bypassing the loop. In the Command Window, enter:

```plaintext
78 b {g 83; C}  
```

This creates a breakpoint on line 78 that does nothing more than move the execution position beyond the loop and issue a C command. Remember that the breakpoint on line 78 is hit before the C statement on that line executes.
7.8.2 PATCHING CODE INTO A PROGRAM

You can also patch code into a program by just including the code in the breakpoint command. For example, suppose you want to add an equation with the variable loopvar.

```c
78: while (loopvar)
79: {
80:     sum = sum + 1;
81: }
82:
83: sum = sum + 5;
```

In the Command Window, enter:

```c
78 b {loopvar = 0; C}
```

This command halts execution at line 78, adds the statement `loopvar=0` to the program, and continues execution.

7.8.3 REPLACING CODE IN A PROGRAM

Finally, you can combine the two techniques described above to replace code in a program. For instance, suppose you want to replace an infinite loop with new code.

```c
78: while (loopvar)
79: {
80:     sum = sum + 1;
81: }
82:
83: sum = sum + 5;
```

In the Command Window, enter:

```c
78 b {Q; if (sum<100) {sum++; g 78; C} {g 83; C}}
```

This command sets a breakpoint that halts execution (quietly) at line 78 and inserts an `if` statement into the program. If `sum` is less than 100, `sum` increments and line 78 executes again. If `sum` equals 100, CrossView Pro moves the execution position to line 83 (beyond the infinite loop) and resumes execution.
7.9 DIAGNOSTIC OUTPUT AND STATISTICAL INFORMATION

Breakpoints with attached commands allow you to report on various variables while the program executes. In the past, one inefficient method of tracking variables was to litter code with `printf()` statements. Using breakpoints makes that process unnecessary.

For instance, suppose you want to keep track of the variable `loopvar` at line 59 of a program. Install a breakpoint with the following command:

```
59 b {Q; loopvar; C}
```

The breakpoint halts the program, prints the value of `loopvar`, and resumes execution. The `Q` command suppresses the listing of where the break occurred. This breakpoint does not affect the source code and no recompilation is necessary.

Using special variables, you can also keep statistics about your program, such as how many times a line of code executes or how many times a variable is accessed.

For example, suppose you want to know how many times line 60 executes. You must define a special variable to keep track of your statistical data, and set a breakpoint to accumulate the data for you.

First, define the special variable. In the Command Window, enter:

```
$test = 0
```

This command defines the special variable `$test` and sets it to zero. For convenience, you can also set a breakpoint at the beginning of the program that initializes `$test`.

Secondly, set a breakpoint at line 60 that increments `$test` and continues execution every time the program hits line 60:

```
60 b {$test++; C}
```
Chapter 7

7.10 ASSERTIONS

An assertion is a collection of debugger commands executed by the debugger after each program line. When you execute a program using assertions, the debugger is in assertion mode. Running the debugger in assertion mode is a way of executing continuous control of certain data.

Using assertions, you can have continuous control of certain data and stop program execution if any of the set conditions are fulfilled. In this respect, assertions are similar to data breakpoints. Assertions, however, are more versatile than data breakpoints. For instance, a data breakpoint can only detect when a variable is accessed. An assertion, on the other hand, can check that the variable’s value falls within a certain range. Also, an assertion can monitor variables whose values are kept in registers.

The default limit for the number of assertions you can define is 16. It is possible to increase the number of assertions by selecting the Initialization tab in the File | Options... dialog box. Each individual assertion can be activated or deactivated. In addition, you can also choose to suppress all assertions by turning off the global assertion mode.

Opening the Assertions Dialog Box

From the Breakpoints menu, select Assertions...

The Assertions dialog box contains scrollable lists of all defined assertions, and provides functions for defining, activating, suspending, editing and deleting assertions.

7.10.1 ASSERTION MODE

The debugger is running in assertion mode when there is at least one active assertion. A program executing in assertion mode is actually being single-stepped very quickly, to ignore breakpoints. Because the program is single-stepping, however, it runs significantly slower than at normal speed.

An Assertion Mode Active checkbox is available that activates all marked (*) assertions. Clear this option if you want to suspend all assertions temporarily. To activate marked assertions:

Open the Assertions dialog box and activate all marked assertions by enabling the Assertion Mode Active check box.
In the Command Window, enter the A command:

- **A a** — activates assertion mode
- **A s** — suspends assertion mode
- **A** — (by itself) toggles the assertion mechanism

The Global Active state activates all assertions. Globally activating the assertion mode, however, does not change how each assertion is marked.

---

**FUNCTION:** Activate assertion mechanism.

**COMMAND:** `A a`

---

**FUNCTION:** Suspend assertion mechanism.

**COMMAND:** `A s`

---

**FUNCTION:** Toggle assertion mechanism.

**COMMAND:** `A`

---

### 7.10.2 DEFINING AN ASSERTION

To define or edit an assertion:

Follow these steps:

- From the **Breakpoints** menu, select **Assertions...** to open the Assertions dialog box.
- Click on the **New...** button to open a text edit dialog box as shown in figure 7–4 to type in commands.
Figure 7–4: Defining Assertions

Use the \texttt{a} command followed by a list of commands.

\begin{itemize}
\item **FUNCTION:** Create an assertion.
\item **COMMAND:** \texttt{a commands}
\end{itemize}

Assertions accept standard C statements and certain CrossView Pro commands as arguments.

An assertion usually contains a conditional. For example, suppose you want to create an assertion that watches the value of the global variable \texttt{initval} to see that it’s value does not exceed a certain limit. In this case, you enter in the Assertion dialog box (or into the Command Window after the \texttt{a} command):

\begin{verbatim}
if (initval > 17) \{x\}
\end{verbatim}

This command creates an assertion with the condition that if \texttt{initval} exceeds 17, CrossView Pro halts the program. The \{x\} is a special assertion command that tells CrossView Pro to halt the program and return control to you.
7.10.3 EDITING AN ASSERTION

To edit the contents of an assertion:

Follow these steps:

• From the Breakpoints menu, select Assertions... to open the Assertions dialog box.
• Click on the assertion to edit.
• Click on the Edit... button. A text edit dialog box opens allowing you to edit the assertion. Click on OK or Cancel when finished.

You must delete the specific assertion (section 7.10.5) and define a new assertion (previous section) with the desired command.

7.10.4 ACTIVATING AND SUSPENDING ASSERTIONS

A particular assertion is either active or suspended. A suspended assertion does not execute before every line, but it retains its definition.

You may find it helpful to use activate and suspend assertion commands in conjunction with code breakpoints, since assertions tend to slow the target program. By attaching commands to a breakpoint to activate and suspend assertions, you can turn assertions on only for certain sections of code where a particular value needs checking. This method can dramatically speed up the program.

From the Breakpoints menu, select Assertions... and double-click on the assertion’s number.

To activate or suspend an assertion from the Command Window, you must know the assertion’s number. To see a list of assertions and their assigned numbers:

• Enter l a, the list assertions command, in the Command Window.

To activate an assertion:

• Enter assertion_number a a command. For example:

  2 a a  activates assertion 2
To suspend an assertion:

- Enter the `assertion_number a s` command. For example:

  ```
  2 a s suspends assertion 2
  ```

**FUNCTION:** Activate an assertion.
**COMMAND:** `assertion_number a a`

---

**FUNCTION:** Suspend an assertion.
**COMMAND:** `assertion_number a s`

---

### 7.10.5 DELETING ASSERTIONS

Deleting an assertion removes its definition. It is important to note the difference between suspending an assertion and deleting an assertion: deleting an assertion removes its definition for good, while suspending it retains the definition but prevents its execution.

**Follow these steps:**

- From the **Breakpoints** menu, select **Assertions...** to open the Assertions dialog box.
- Click on the assertion to delete.
- Click the **Delete** button. Click on **OK** or **Cancel** when finished.

**Follow these steps:**

- List the assertion numbers with **l a** command in the Command Window.
- In the Command Window, enter the assertion number followed by the **a d** command. For example:

  ```
  2 a d Deletes assertion 2.
  ```

**FUNCTION:** Delete an assertion.
**COMMAND:** `assertion_number a d`
7.10.6 USING ASSERTIONS

You can use assertions for almost any type of debugging task. For example, if you want to check the value of a global variable, `global_val`, during the execution of a certain function, `f()`. A data breakpoint or a straightforward CrossView Pro assertion does not suffice for this task since there is no way to make either method limited to that function's code range. The solution lies in creating an assertion that is active only over a specific range of lines. In this case, you could solve your problem with the following steps:

```c
110: void f(void)
111: {
112:     if ( global_flag )
113:         ++global_val;
114:     }
115: else
116:     global_val = g();
117: }
```

Using the mouse and menu:

1. From the **Breakpoints** menu, select **Assertions...** to open the Assertions dialog box.

2. Click on the **New** button.

3. Set up the assertion to check the value of `global_val`. Enter:

   ```c
eq (global_val == 17) {
   ```

   This assertion halts program execution if the value of `global_val` equals 17.

4. From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add** button and select **Code Breakpoint**...

5. We want to establish a breakpoint at line 112, the first line of the function `f()` and attach commands to the breakpoint to activate assertion mode and continue execution. Change the **Line** number to 112. Click in the **Command** edit area and enter:
A a; C  

 Activate the assertion and continue.

6. Create an assertion whose only function is to check that the current line number is still valid for assertion mode. To do this, use the reserved special variable $LINE, which contains the line number of the current execution position. In the Assertions dialog box, click on New... and enter:

   if ($LINE >= 120) {A s; 1 x; C}

If the line number exceeds 120, the program is about to leave the function f( ) and CrossView Pro deactivates assertion mode. Normally, the x command would make the program stop, but the non-zero value tells CrossView Pro to execute the rest of the commands in the list, in this case, C for continue.

You must enter all commands in the Command Window.

1. First set up the assertion you want:

   a if (global_val == 17) {x}

2. Now set a breakpoint on the first line of the function factorial() that will activate assertion mode, and continue execution:

   110 b {A a; C}

3. Now create an assertion that does nothing but make sure that the current line number is still valid for assertion mode. If the line number exceeds 120, you know you have left the function f( ) and assertion mode should be suspended.

   a if ($LINE >= 120) {A s; 1 x; C}

$LINE is a reserved special variable that CrossView Pro maintains containing the number of the line currently executing. If it becomes equal to 120, assertion mode is turned off. Normally, the x would make the program stop, but the non-zero value 1 tells CrossView Pro to execute the rest of the commands in the list, in this case, C for continue.

In this manner you have created an assertion that is only active over a limited range of source lines.
7.10.7 GATHERING STATISTICS WITH ASSERTIONS

You can also use assertions to gather statistics about your code. For instance, you can find out how many lines of C code execute in a particular session:

```c
a { $numlines++ }
```

$numlines is a user-defined special variable that increments on each line of C code. When the program stops, type:

```
$numlines
```

and CrossView Pro gives the result. To start again, you may want to re-initialize $numlines to zero:

```
$numlines = 0
```

Or just set a breakpoint on the first line of code to do the same.
Chapter 8

Defining and Using Macros
8.1 CROSSVIEW PRO MACROS

A macro is a user-created shorthand for any sequence of CrossView Pro or C commands and expressions. Macros allow you to debug more efficient when using CrossView Pro by substituting a short string for a longer combination of words and evaluators.

You can use a macro anywhere an CrossView Pro or C expression is valid: in a breakpoint’s command list, with assertions, from the keyboard, among other places. CrossView Pro also allows you to save macro definitions, so they are always available. By passing parameters to a macro, you can create powerful and flexible macros to debug your code more efficiently.

You can use macros in the Command Window, or connect them to the graphic interface in a feature called the toolbox. You can have this toolbox visible as a CrossView Pro window and use it to execute a macro by clicking a button. You control which macros have corresponding buttons, making the toolbox easy to adapt to different situations.

8.2 DEFINING MACROS

You can create as many macros as you want:

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box and click on the New... button.

![Figure 8–1: Macro Definitions](image)
In the Command Window, use the `set` command followed by the macro’s invocation name and the list of commands. Note that the list of commands must be in (double) quotation marks. For example, the command:

```
set st "e main; R"
```

creates a macro call `st` that tells CrossView Pro to change the viewing position to be the first executable line in the function `main()` and restart the program from the beginning. Each time you enter `st` in the Command Window, CrossView Pro substitutes the lengthier list of commands in the definition.

**FUNCTION:** Create a macro.  
**COMMAND:** `set name "commands"`

Note that there is no rule that the macro definition must be shorter than the commands it represents. For instance, you could substitute `break` for the `b` command, to make CrossView Pro’s command language more expressive:

```
set break "b"
```

Now instead of typing `74 b` to set a breakpoint, you can also type:

```
74 break
```

Macros defined using either the command line or the graphic interface are accessible both from the Command Window and the Toolbox.

Macros may call other macros, so it is possible to use simple macros as building blocks for more complex functionality. No macro, however, can call itself, or another macro that refers to the calling macro, since this type of action results in infinite recursion.

Because of the order in which CrossView Pro parses statements, you may not use the CrossView Pro commands `#` or `%` in a macro.
8.2.1 LISTING MACROS

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box. This dialog box contains a scrollable list of the macros.

To see the current definition of a macro:

Follow these steps:

- From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box.
- Click on the macro that you want to see.
- The Commands box shows (a part of) the macro. If you need to see more, click on the Edit... button.

Type the echo name command in the Command Window. For instance, to see the definition for the st macro:

```
  echo st Command.
e main; C 56  Output.
```

FUNCTION: Display macro expansion.

COMMAND: echo name

8.2.2 REDEFINING A MACRO

If you want to change the definition of a macro:

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box. Click on the name of the macro you want to change and click on the Edit... button.

In the Command Window, use the set command again, but enter an exclamation point after the macro name. For instance, to redefine the macro st, which was defined in the example above, use the command:

```
  set st! "e main; C 56"
```
Now, the st macro changes the viewing position and restarts program execution, placing a temporary breakpoint at line 56. Be sure you do not include a space before the exclamation point. Otherwise, CrossView Pro may interpret the ! as the C “not” operator.

### 8.2.3 SAVING MACRO DEFINITIONS TO A FILE

You can save all the macros you define in a debugging session in an external file. This way, you do not lose the definitions when the program ends.

To save macros to an external file:

Follow these steps:

- From the **Tools** menu, select **Macro Definitions...** to open the Macro Definitions dialog box.
- Click on the **Save as...** button. A Save Macro File dialog box opens.
- If you want to save a file previously opened, click on the **Save** button. This saves the file without opening the Save Macro File dialog box.
- Alternatively, you can use the **Autosave** check box. When **Autosave** is checked, all macros are saved in the 'current file' when you leave CrossView Pro.

Type the **save file** command in the Command Window. This command saves your macros to the file of your choice. For instance:

```plaintext
save macro.mac  writes all your macros to macro.mac
```

**FUNCTION:** Save macros to a file.

**COMMAND:** `save filename`
8.2.4 LOADING MACRO DEFINITIONS FROM A FILE

You can load saved macros anytime you want to re-use a definition. There is no limit to the number of times you can load macros.

To load a macro file:

Follow these steps:

• From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box.
• Click on the Load... button and select the macro file you want to load.
• Alternatively, you can use the Autoload check box. When Autoload is checked, the macros saved in the 'current file' are loaded at startup.

To reinstate your macro definitions from the Command Window, use:

< filename.mac

You must load a program before you can read a macro definition file. Autoload will be ignored when the Execute these settings at CrossView startup check box in the Load Symbolic Debug Info dialog box is not checked.

For more information on record and playback functions, see the next chapter, Command Recording & Playback.
8.2.5 DELETING MACROS

To delete a specific macro:

Follow these steps:

- From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box.
- Highlight the name of the macro.
- Click on the Delete button. To delete all the macro definitions at the same time, click on the Delete All button. CrossView Pro prompts you for confirmation.

Type the unset command in the Command Window. For example, to remove the st macro, enter:

```
unset st!
```

When you are removing a macro definition in this manner, you must place an exclamation point after the macro name to prevent CrossView Pro from expanding the name to its full macro definition. To update your macro definition files, issue a save command after using unset.

You can remove all existing macro definitions by entering the unset command by itself. CrossView Pro prompts you for confirmation before deleting the macros:

```
unset
Do you want to delete all macros? y
```

| FUNCTION:   | Delete a macro.               |
| COMMAND:    | unset name!                   |
8.3 MACRO PARAMETERS

Macros can accept arguments. Parameters are labelled sequentially in a macro definition: \$1, \$2, \$3, etc. Note that \$0 has no meaning. When you invoke a macro with parameters, enclose the parameters with parentheses and separate them with commas.

CrossView Pro macros can accept any number of parameters, so it is possible to create very complex command shortcuts. You may use any type of parameter when defining a macro, including integers, strings, or addresses. Note, however, that you must pass the macro the correct type at invocation.

For instance, suppose you want to set a detailed breakpoint on any number of lines and a parameter is to specify each line number on which to install a breakpoint. Defining a macro named \texttt{brk}, type in the Macro Definitions dialog box:

\begin{verbatim}
  \$1 b {Q; initval; recordvar.a; if (initval > 1) {C}}
\end{verbatim}

or type in the Command Window:

\begin{verbatim}
  set brk "$1 b {Q; initval; recordvar.a; if (initval > 1) {C}}"
\end{verbatim}

In this case, the argument \$1 represents the intended line number. To use the \texttt{brk} macro, type:

\begin{verbatim}
  brk(72) From the Command Window
\end{verbatim}

CrossView Pro replaces every instance of \$1 with the value 72. For this example, that means a breakpoint is set at line 72.
8.4 REDEFINING EXISTING CROSSVIEW PRO COMMANDS

Using macros, you can even redefine an existing CrossView Pro command.

For instance, you could redefine the breakpoint command b to always place a breakpoint at line 72 of your source code. To do this, enter the command:

```
set b "72 b!"
```

CrossView Pro now interprets the b command as 72 b.

The exclamation point in the definition is necessary to prevent infinite recursion. It tells CrossView Pro to take the command literally and to not expand it into a macro definition. For example:

```
66 b!
```

CrossView Pro interprets this command as the standard breakpoint command and places a breakpoint at line 66, despite the macro definition for b.

Be sure not to have any space between the command and the exclamation point. Otherwise CrossView Pro may interpret the ! as the C `not` operator.
8.5 USING THE TOOLBOX

The CrossView Pro toolbox, shown in figure 8–2, is controlled from the View menu. Using the Tools menu, you can configure the toolbox and define the macros for it. You can resize the toolbox to the size you want.

![CrossView Pro Toolbox](image)

*Figure 8–2: CrossView Pro Toolbox*

8.5.1 OPENING THE TOOLBOX

To open the toolbox:

- From the View menu, select Toolbox.

The Toolbox is a pop-up window that remains on top of the CrossView Pro Desktop while you work in other windows.

8.5.2 CONNECTING MACROS TO THE TOOLBOX

To configure the toolbox, select Toolbox Setup... from the Tools menu to view the Toolbox Setup dialog box, shown in figure 8–3. This dialog box displays the toolbox buttons and an alphabetized list of the current macro definitions.

To connect a macro to a toolbox button:

- Follow these steps:
  - Click on the button you wish to change
  - Scroll through the macro list to highlight the desired function
• Click on the **Assign** button or press the **Enter** key

Note that double clicking on the macro name in the alphabetized list performs the third step automatically. The name of the new function appears on the selected button and the connection is performed.

![Toolbox Setup Dialog Box](image)

*Figure 8–3: Setting Up the Toolbox*

Do not assign parameterized macros to the toolbox since there is no way to pass in parameter values.

### 8.5.3 **Removing a Macro Connection**

To delete a macro definition from the toolbox:

Follow these steps:

- From the **Tools** menu, select **Toolbox Setup...** to open the Toolbox Setup dialog box.
- Select the desired button.
- Click **Clear**.

This deletes the macro definition from the toolbox.
CHAPTER 9

COMMAND RECORDING & PLAYBACK

TASKING
9.1 RECORDING COMMANDS

CrossView Pro lets you save a series of CrossView Pro commands to the file of your choice. This is **record mode**. You can re-load a saved file to repeat parts of debugging tasks or replay a debugging session (up to the point where you left the last time).

Record mode means that all CrossView Pro commands from the keyboard, mouse or menu are recorded to a disk file. The debugger can read this file and execute the commands as if they were entered into the Command Window. This is called **playback mode**, see more about playback mode later in this chapter.

Record and playback modes can never be active at the same time.

You can only record CrossView Pro commands. When recording on CrossView Pro command level, all commands that you type in the Command Window, as well as the CrossView Pro command language equivalents of dialog actions and menu selections are saved in a file. When you want to record commands entered in the Emulator Command Window, you have to turn on CrossView–Emulator I/O logging (see the section **Logging** in this chapter).

From the Command Window you control record mode using either the mouse or keyboard commands. To start or setup recording:

From the menu system:

- From the **Tools** menu, select **Record...**
  
  The Record dialog box contains an **Automatically at CrossView startup** check box. If you select this check box the debugger enters record mode at every startup.

- Enter the name of the file in the **Command file**: edit field, or click on the **Browse...** button to select an existing file. The default filename extension is .cmd.

- Click on the **OK** button to save the current settings into the initialization file xvw.ini for following debugging sessions.

- Click on the **Start** button to start recording.

Enter the > command with the name of the file to start recording. For example, enter:

```plaintext
>session.cmd
```
After you invoke this command, CrossView Pro saves every executed command, whether using the mouse or manually typed into the Command Window, to the file session.cmd.

**FUNCTION:** Save CrossView Pro commands to a file.

**COMMAND:** `>filename`

---

**FUNCTION:** Save CrossView Pro commands to a file and force flushing.

**COMMAND:** `>filename`

---

### 9.1.1 ENTERING COMMENTS

Every command, whether typed into the Command Window or the result of a mouse or menu action goes into the recording file. To add comments to a file recording CrossView Pro commands, enclose text typed in the Command Window with C comments delimiters, `//` and `//`. When logging emulator commands, refer to your emulator documentation for the appropriate comment characters.

### 9.1.2 SUSPEND RECORDING

This function acts like the pause button on a tape recorder: the recording mechanism stays in place, but suspends temporarily. CrossView Pro does not save to file any commands you enter while you suspend recording, but the file remains open and ready to accept input. To suspend recording:

- From the **Tools** menu, select **Record...** to open the Record dialog box. Click on the **Suspend** button.

- In the Command Window, use the `>f` command (for “false”).
FUNCTION: Suspend recording.
COMMAND: >f

9.1.3 RESUME RECORDING

This function is the counterpart of the suspend recording function. CrossView Pro resumes adding commands to the current record file. Any new command you enter appears in the file; they do not affect the commands already saved.

From the Tools menu, select Record... to open the Record dialog box. Click on the Resume button to resume recording.

In the Command Window, use the >t command (for “true”).

FUNCTION: Resume command recording.
COMMAND: >t

9.1.4 CHECK RECORDING STATUS

If at any point you do not remember whether recording is on or off, check by:

From the Tools menu, select Record... If record mode is active, the Stop button is enabled. If the Start and OK buttons are enabled, record mode is off.

Enter the > command in the Command Window.

This command shows the status of the recording and logging mechanism. For example, if you enter > you might see:

> Output logging is OFF
Command recording is ON
Target communication logging is OFF
The > command gives you the status for the different recording mechanisms. Output logging and target communication logging are described below.

### 9.1.5 CLOSE FILE FOR RECORDING

Closing a file for recording differs from suspending recording in that when you close a file, you may not add any more commands to it. If you were to start recording again using the same filename, the old commands in the file would be deleted. (Note that this does not exclude editing the file manually by some other means, since the file is saved as ASCII text.)

From the Tools menu, select Record... to open the Record dialog box. Click on the Stop button to stop recording.

Insert the >c command to close the file:

```
> c
```

**FUNCTION:** Close command recording file.

**COMMAND:** > c

### 9.1.6 COMMAND RECORDING EXAMPLE

For example, consider the following command sequence (from the Command Window):

```
> session.cmd
  initval
  p 12

> f
  l b
  sum

> t

/* This is a comment! */
> c
```

----- Start Recording to File

----- Carriage Return

----- Suspend Recording

----- Resume Recording
This series starts with a command to record to a file named `session.cmd`. The blank line above represents a carriage return. After the last command, `c`, if you were to view this file, it contains:

```
initval
p 12
/* This is a comment! */
```

The saved command file contains simply the commands, without any output. Note that commands entered while recording was suspended (`l` and `sum`) do not appear in the file. Carriage returns are not recognized as commands.

### 9.2 Playing back command files

Once you have recorded a set of CrossView Pro commands, you can play them back to recreate a debugging session or repeat often-used sequences. Running the debugger while reading commands from a file is **playback mode**.

Remember that for a file to be played back, it can only contain CrossView Pro or emulator commands. For this reason, screen output files cannot be used in playback mode. Refer to the *Recording Commands* section earlier in this chapter for more information.

As with recording, the Command Window controls playback mode. To playback a command file:

Follow these steps:

1. From the **Tools** menu, select **Playback | CrossView...** to open the CrossView Playback dialog box, or select **Playback | Emulator...** to open the Emulator Playback dialog box.

You can choose to playback either CrossView Pro commands or Emulator commands. Open the Emulator Command Window if the playback file contains commands sent directly to your emulator.

2. Type the playback filename or use the **Browse...** button to select the file. The default filename extension is `.cmd`. 
In the Playback dialog box, you have two additional options: **Playback at XVW startup** and **Continuous playback**. CrossView Pro enters playback mode automatically when you start the debugger if you click on the **Playback at XVW startup** check box in the Playback dialog box. The entire playback file executes if you enable the **Continuous playback** check box.

3. Click on the **Execute** button to start the playback.

   In the Command Window, use the `<` or `<< filename` command to playback CrossView Pro commands.

   On the command line of CrossView Pro give the option `-T filename` to start CrossView Pro in transparency mode and playback emulator commands. Not available for all execution environments.

### 9.2.1 Setting the Type of Playback

Enable the **Continuous playback** check box in the CrossView Playback dialog box to turn on continuous play back of commands.

In the Command Window, there are two commands for the type of playback. The `< filename` command starts playback. Commands are read from a file and executed without any stop. For example:

```
<session.cmd  load and execute all the commands
```

The `<<` command causes CrossView Pro to playback commands one at a time, similar to single-stepping through code. For example:

```
<<session.cmd  read a command from the file.
```

Clicking the **Execute** button or pressing the **Enter** key executes the next command.

---

**FUNCTION:** Play back a file of CrossView Pro commands.

**COMMAND:** `<filename`
FUNCTION:  Play back a file of CrossView Pro commands, one command at a time.

COMMAND:  <<filename

9.2.2 CALLING OTHER PLAYBACK FILES

A playback file can call another playback file in the course of its execution.

When CrossView Pro creates a command file, it saves all commands in their textual form, whether entered by the mouse or as text. You must edit this file to use the < and << commands.

When the debugger reaches a < or << command in a playback file, playback execution switches to the new file, but does not return to the original file. In other words, you chain playback files but not nest them.

9.2.3 QUITTING PLAYBACK MODE

Playback mode stops automatically when CrossView Pro reaches the end of the command file. If you want to end playback mode before this point, click the Halt button.
9.3 Command Line Batch Processing

CrossView Pro supports command line batch file processing, but CrossView Pro will halt if a modal dialog is encountered or if the target program contains an endless loop. The command line option --timeout=n_seconds switches CrossView Pro to a different mode of operation, without the two drawbacks mentioned above.

In order to process files in batch mode you have to do the following:

1. Create a temporary directory.
2. Start CrossView Pro from this temporary directory. For Windows 95/98/XP/NT/2000 you can create a separate icon or shortcut to start CrossView Pro, which has the working directory (Start in:) set to the temporary directory.
3. Close all CrossView Pro windows except the Command Window.
4. Exit CrossView Pro (with Save desktop and target settings enabled).
   You now have generated an xvw.ini file with minimal GUI overhead.
5. Save the xvw.ini file and remove the temporary directory.

For each batch run of CrossView Pro you have to do the following:

1. Create a temporary directory.
2. Copy the saved xvw.ini file to the temporary directory.
3. Create a command file in the temporary directory.

The following command file session.cmd loads the .abs file, downloads the code, runs the code and exits.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N hello.abs</td>
<td>load the symbols</td>
</tr>
<tr>
<td>dn</td>
<td>download the program</td>
</tr>
<tr>
<td>F_exit bi</td>
<td>set a breakpoint at the exit point</td>
</tr>
<tr>
<td>R</td>
<td>run the program</td>
</tr>
<tr>
<td>$pc</td>
<td>optional: show the program counter</td>
</tr>
<tr>
<td>q y</td>
<td>exit CrossView Pro</td>
</tr>
</tbody>
</table>
where hello.c contains

```c
#include <stdio.h>

void main()
{
    printf("Hello World!\n");
}
```

4. Copy the .abs file to the temporary directory. This is needed because CrossView Pro changes its working directory when the N command is used.

5. The following line executes CrossView Pro in batch mode and waits for it to finish:

Windows 95/98/XP/NT/2000:

```bash
start /wait c:\c563\bin\xfw56x --timeout=120 -tcfg evm563.cfg -p session.cmd -R session.log
```

UNIX:

```bash
xfw56x --timeout=120 -tcfg evm563.cfg -p session.cmd -R session.log
```

This command must be issued in the temporary directory! After the execution has ended, the file session.log contains a transcript of the commands.

6. Save the output files and clean up (or remove) the temporary directory. This must be done because the xvw.ini file has been modified now. If CrossView Pro would be started again in the temporary directory, the file session.cmd would be executed again.

The `--timeout=n_seconds` command activates the batch operation mode of CrossView Pro. It causes CrossView Pro to terminate when the specified amount of time has elapsed, which is crucial in batch processing; if a program does not terminate, the timeout will terminate CrossView Pro, so that the next program in the batch can be executed. CrossView Pro will also terminate in the batch mode if a modal dialog pops up, since this requires user interaction to continue. Before CrossView Pro exits, the text in the dialog will be written to the log file. A special case of this dialog is the 'End of program reached' dialog. For this reason, the line F_exit bi has to be added to the .cmd file, so it is possible to do some things (for example, read registers modified by a machine code program) after
the program is finished. If the breakpoint at `F_exit` is absent, CrossView Pro immediately exits after having executed the `R` command, so any consecutive commands will be ignored.

### 9.4 LOGGING

Logging means that all output text to a particular window is saved in a file for later use. Two windows allow logging:

- Command Output Window
  (upper part of the CrossView Command Window)
- Emulator Output Window
  (upper part of the Emulator Command Window)

"GDI Accesses" can also be logged. This is the information transferred between CrossView Pro and the Debug Instrument (DI).

You can control logging from the **Tools** menu or from the Command Window.

You can also determine the status of each logging function:

- From **Tools** menu, select **Log | Command Input/Output...** Log | CrossView-Emulator I/O... or Log | CrossView-GDI Accesses...

  If a logging function is active, the **Stop** button is enabled. If the **Start** and **OK** buttons are enabled, logging is off.

- Enter the `>>` or `>>&` command in the Command Window.

  Each type of logging is described in the following section.

The Emulator Output Window is primarily a diagnostic tool. It should be used wisely, since it generates substantial amounts of output, the format of which is emulator dependent. For emulators that have an ASCII interface, the actual command/response dialogue will be displayed. For emulators with a binary interface, CrossView Pro will generate a record of function calls with their associated input and output parameters. This also applies to the GDI Accesses output logging.
9.4.1 SETTING UP LOGGING

To setup logging:

From the menu system:

- From Tools menu, select Log | Command Input/ Output..., Log | CrossView–Emulator I/O... or Log | CrossView–GDI Accesses... to open the appropriate dialog box.
- Type in the name of the log file or use the Browse... button to select a filename. The default filename extension is .log.

Each Log dialog box has an Automatically at CrossView startup check box. This check box instructs CrossView Pro to start recording the output of a particular window or information stream upon starting up of CrossView Pro.

- Click on the OK button to save the current settings into the initialization file xvw.ini for following debugging sessions.
- Click on the Start button to start logging.

You can open up a log file for CrossView Command Output by using the >>filename command as in:

>>screen.log

You can force flushing by using the >>!filename command as in:

>>!screen.log

You can open up a log file for Emulator Output by using the >&filename command as in:

>&target.log

You can force flushing by using the >&!filename command as in:

>&!target.log

**FUNCTION:** Save CrossView Pro commands and command window output to a file.

**COMMAND:** >>filename
FUNCTION: Force flushing of CrossView Pro commands and command window output to a file.
COMMAND: \texttt{>>!filename}

FUNCTION: Log target communications.
COMMAND: \texttt{>&filename}

FUNCTION: Force flushing of target communication logging.
COMMAND: \texttt{>&filename}

### 9.4.2 RECORDING COMMANDS AND LOGGING SCREEN OUTPUT

It is possible to have command recording, command output logging and target communication logging on at the same time. That is, you can have one file recording just the CrossView Pro commands, and another file concurrently recording both the commands and the computer responses. Refer to the previous section for information on command record files.

Since the Command Window log file contains both your commands and the computer responses, you cannot use it in playback mode.

### 9.4.3 COMMAND WINDOW LOG FILE EXAMPLE

For example, if you entered the following commands:

```
>>screen.log
initval
1 a
```
The output file, `screen.log`, contains:

```
> initval
initval = 0
> 1 a
no assertions
```

### 9.4.4 SUSPENDING AND RESUMING OUTPUT LOG

You can resume and suspend the Logging process from the menu or from the Command Window:

From **Tools** menu, select **Log | Command Input/Output...**, **Log | CrossView-Emulator I/O...** or **Log | CrossView-GDI Accesses...** to select the appropriate dialog box.

To suspend logging:

Click on the **Suspend** button.

In the Command Window, use the `>>f` command for suspending the logging of the Command Output Window. Type `>>&f` to suspend the Emulator Output Window. After you issue this command, CrossView Pro does not save all subsequent commands and their computer responses.

To resume logging:

Click on the **Resume** button.

In the Command Window, use the `>>t` command to resume logging the Command Output Window. Type `>>&t` to resume the Emulator Output Window. After you issue this command, CrossView Pro saves all subsequent commands and their computer responses.

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Suspend output logging  (logging is false).</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><code>&gt;&gt;f</code></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Resume output logging  (logging is true).</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><code>&gt;&gt;t</code></td>
</tr>
</tbody>
</table>
FUNCTION: Suspend target logging  (logging is false).
COMMAND:  >&f

FUNCTION: Resume target logging  (logging is true).
COMMAND:  >&t

9.4.5  CLOSING THE OUTPUT LOG FILE

To close the output file:

From **Tools** menu, select **Log | Command Input/Output...**, **Log | CrossView–Emulator I/O...** or **Log | CrossView–GDI Accesses...** to select the appropriate dialog box. Click on the **Stop** button to stop logging.

Enter the `>>c` or `>&c` command in the Command Window to close the Command Output and Emulator Output log files. These commands end the recording for the currently specified output log file.

FUNCTION:  Close output log file.
COMMAND:  `>>c`

FUNCTION:  Close target log file.
COMMAND:  `>&c`
9.5 STARTUP OPTIONS

When starting up CrossView Pro you may immediately start recording or playing back files. For instance,

```
xfw56x fact -p session
```

plays back the commands in the file `session`. A `-P` switch single-steps through each command, prompting you for a return after each. You can also start recording:

```
xfw56x fact -r session
```

This command records all your commands (just like the `>` command) to the file `session`, while:

```
xfw56x fact -R session
```

logs your commands and screen output to the file `session` (just like the `>>` command).

You can also use the Automatically at CrossView startup option in the Record, Playback, and Log dialogs to immediately start recording, playback or logging at CrossView Pro startup.

You can also enter record and playback files via EDE. From the Project menu, select Project Options... Expand the CrossView Pro entry and select Logging. Enter your record and playback filenames.
9.6 CROSSVIEW PRO COMMAND HISTORY MECHANISM

CrossView Pro stores the command history in the list box of the Command Window.

You can select a command from the history list by clicking on it or jumping with the **<Tab>** key to the history listing and using the arrow keys. The command appears in the edit field of the Command Window. You may edit the command if you want.

To execute the command, click on the **Execute** button.

If you do not want to edit the command, double-click on the selected command in the list box to execute the command, or hit the **<Return>** key.
10.1 INTRODUCTION

The CrossView Pro Terminal windows provide an interface to exchange data with the application on the target. You can use the following I/O simulation types for this purpose.

File System Simulation (FSS)

With FSS you can use standard stream I/O function calls like printf() in your source, to test I/O to and from the target system or simulator.

File I/O (FIO)

With File I/O you can connect actions to a probe point. Probe points are breakpoints that do no update the graphical user interface (GUI) and when they are hit, connected actions are performed and execution continues. The actions are in this case I/O actions to a file and/or a terminal window.

Debug Instrument I/O (DIO)

If you have a debug instrument that supports it, the debug instrument can perform input and output using GDI callback functions.

10.2 I/O STREAMS

You can setup I/O streams with the I/O Simulation Setup dialog. There is virtually no limit on the number of streams that can be opened or created. Each type of I/O stream (FSS, DIO, FIO) has its own numbering:

- FSS 0,1,2,...,k
- DIO 0,1,2,...,m
- FIO 0,1,2,...,n

You can map multiple streams to one terminal window.

For File I/O you can use the ios_ commands to open or close a FIO stream on the command line. Streams can be opened manually or are opened at the first call or operation that accesses a specified I/O stream (for Debug Instrument I/O handling). For FSS the target application can open or close streams with fopen(), open(), fclose() or close() calls.
Streams can be mapped to a terminal window and/or a file that is NOT the terminal log file. If a stream is mapped to a terminal window and a file the output will go to the terminal window and also to the file. In case of input the input will be read from the file. The read input will be echoed on the connected terminal window.

I/O streams opened by FSS are closed when end of program is reached or if a program reset occurs. I/O streams opened by CrossView Pro will be rewound. The windows to which the streams are mapped remain open.

In the I/O Simulation Setup dialog you can connect an I/O stream to a terminal window before the stream is opened by specifying the stream type, filename and terminal window name.

### 10.2.1 SETTING UP FILE I/O STREAMS

You can set up an input or output stream. For input you may specify either a file or the keyboard, for output either a file or the screen. Each stream has its own identifying number.

You can also specify the format of the stream’s values. The default is character, but you may want to use hexadecimal or octal values when directing data to or from a file.

To setup a File I/O stream:

1. From the menu system:
   - From the **Settings** menu, select **I/O Simulation Setup...** to open the I/O Simulation Setup dialog box.
   - Open the **File I/O** tab to setup a File I/O stream.
   - Select the **Configure...** button. This opens the File I/O Configuration dialog.
   - In the **Probe point** list box, select an existing probe point or press the **New...** button to set a new probe point. The Breakpoints dialog appears.
   - In the **Stream** list box, select a stream or press the **New...** button to create a new stream. Select a new stream and click **OK**.
   - Enter the **Address** and **Length** (in minimum addressable units, MAU) of the memory location you want to read from or write to.
   - Optionally, enable the **Use hexadecimal format** check box when you want the data to be interpreted as a hexadecimal value.
• Choose the Direction: **Input** if the stream must provide input to the application, or **Output** if the stream must be an output stream.

• Click on the **Apply** button to accept the contents and enter another configuration or click on the **OK** button to close this dialog box.

Enter the **ios_open** or **ios_wopen** command in the Command Window to open a File I/O stream.

**FUNCTION:** Open a File I/O stream

**COMMAND:**

```bash
ios_open ["file", [mode], [r], [$xvw_variable]]
```

**FUNCTION:** Open a File I/O stream and map the stream to a terminal window

**COMMAND:**

```bash
ios_wopen ["terminal_window", [$xvw_variable]]
```

Enter the **ios_read** or **ios_write** command in the Command Window to read from or write to a File I/O stream.

**FUNCTION:** Read from a File I/O stream

**COMMAND:**

```bash
ios_read {stream | "file"}, address, number_of_maus[,x]
```

**FUNCTION:** Write to a File I/O stream

**COMMAND:**

```bash
ios_write {stream | "file"}, address, number_of_maus[,x]
```

To read 1 MAU hexadecimal value from file `mydata.dat` and store it at address 0x100, type:

```bash
ios_read "mydata.dat", 0x100, 1, x
```
10.2.2 REDIRECTING I/O STREAMS

In the I/O Simulation Setup dialog you can connect an I/O stream to a terminal window before the stream is opened or you can redirect an existing stream to a file and/or terminal window.

To redirect an I/O stream to a file and/or terminal window:

From the menu system:

- From the Settings menu, select I/O Simulation Setup... to open the I/O Simulation Setup dialog box.
- In the Connection tab select the I/O stream you want to change and select the Redirect... button.
- In the Connection Configuration dialog enter a filename and/or a terminal window name.
- Click OK to accept the changes and close the dialog.

Enter the **ios_open** or **ios_wopen** command in the Command Window to open a File I/O stream.

To disconnect an I/O stream from a file and/or terminal window:

From the menu system:

- From the Settings menu, select I/O Simulation Setup... to open the I/O Simulation Setup dialog box.
- In the Connection tab select the I/O stream you want to change and select the Redirect... button.
- In the Connection Configuration dialog erase the filename and/or terminal window name.
- Click OK to accept the changes and close the dialog.

Enter the **ios_close** command in the Command Window to close a File I/O stream.

---

**FUNCTION:** Close a File I/O stream  
**COMMAND:** **ios_close** {**stream** | ”**file””}
To disable/enable an I/O stream:

From the menu system:

- From the **Settings** menu, select **I/O Simulation Setup...** to open the I/O Simulation Setup dialog box.
- In the **Connection** tab clear the check box in front of the I/O stream you want to disable. Set the check box to enable the stream.

Disabling a File I/O stream means that I/O actions will not be honored. Writing is not passed to the output file, and reading does not result in new data being placed in the target buffer.

### 10.3 FILE SYSTEM SIMULATION

File system simulation enables the application on the target board to use system calls (such as open, read, write) that are handled by the host system file I/O services. These files can be read directly from the host system, and output can be written to a file on the host system or in a CrossView Pro window. File system simulation is available for all execution environments.

The File System Simulation feature redirects I/O to a Terminal Window if the filename `FSS_window:window_name` is used in the "open" call, `window_name` is the name of a Terminal Window.

You can specify a root directory for FSS. CrossView Pro will search for the file from the root directory downwards. You can do this in the I/O Simulation Setup dialog, by entering a directory name in the **FSS root directory** field of the **Options** tab. This setting is saved in the `xvw.ini` file. Another possibility is to set a temporary resource by specifying the command line option `--fss_root_dir="path"` on CrossView Pro startup.

The libraries have been optimized to only attach the file I/O routines if the application actually uses file I/O. This includes the `exit()` routine, that must close all opened streams before returning to the debugger. The default I/O streams `stdin`, `stdout` and `stderr` are opened on the fly whenever file I/O is used; this behavior is transparent to the user. It is no longer necessary to inform CrossView Pro about the use of any streams.
The Motorola DSP56xxx has a MAU (minimal addressable unit) size of 24 (or 16) bits, but the size of a char has been set to 8 bit. This conflicts with the definition of some of the standard C library routines, that expect pointers to be able to address memory one character at a time. Therefore, there are some special restrictions, that have been made as small as possible. Streams are opened in text mode by default. Text mode streams have only 8–bit significant content, although 16 or 24 bits are written. This makes (f)printf() and (f)puts() work as expected, both to CrossView Pro windows and to files on the host system. Binary opened files will be read or written with the full MAU size of 16 or 24 bits. Using fread() and fwrite(), binary data can be transferred with ease, and at a much higher speed than using text mode.

You can redirect File System Simulation streams to a file or another stream. Redirection to a file can be needed when a stream is only mapped to a window and you want it to be mapped to a file also.

Redirection can be used for scripting purposes, using the FSS command.

\[
\text{FSS } \{< | > \}\&\text{stream | } "\text{file}" \\
\]

For example,

\[
\text{FSS } 2>\&1 \\
\text{FSS } 1<\&4 \\
\text{FSS } 4<"\text{data.txt}" \\
\text{FSS } 3>"\text{data.txt}" \\
\]

The first example will redirect output of stream 2 to stream 1. The second example will retrieve input for stream 1 from stream 4. The third example will retrieve input for stream 4 from file "data.txt". The fourth example will redirect output of stream 3 to file "data.txt".

Disabling an FSS stream means in effect connecting the stream to /dev/null or NUL, causing writes to go into oblivion, and reads to return EOF.

### 10.3.1 FILE SYSTEM SIMULATION LIBRARIES

The functions _read() and _write() of the C library are modified to use File System Simulation. This redirects all high–level I/O calls such as printf() and scanf() type functions through CrossView Pro’s FSS feature, allowing you to perform stdin, stdout and stderr I/O by just using these standard C library functions.
For more information see the section *C Library Interface Description* in the C Cross-Compiler User’s Guide.

### 10.4 DEBUG INSTRUMENT I/O

If you have a debug instrument that supports it, the debug instrument can perform input and output using GDI callback functions. The Debug Instrument I/O (DIO) stream number is passed as parameter to these callbacks. The output can be redirected to DDE (Windows only). The first access to a DIO stream will create a new terminal window and the title of the window will be "DIO x", where x is is the number of the used stream. No new window will be created if the used stream is already mapped to a terminal window. You can use the I/O Streams Terminal Map dialog to map one or more streams to one window.
10.5 THE TERMINAL WINDOW

If you direct I/O simulation to the screen, CrossView Pro displays the output in the terminal window. Similarly, if you direct input from the keyboard; whatever you input appears in the appropriate terminal window. See section 4.6.8, *Terminal Window* for more information.

10.5.1 TERMINAL WINDOW KEYBOARD MAPPINGS

The following keyboard mappings, being both control codes and escape sequences, are supported by the VT100-like terminal mode of the terminal windows:

<table>
<thead>
<tr>
<th>Key</th>
<th>Character Sequence and/or Decimal Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backspace</td>
<td>8d</td>
</tr>
<tr>
<td>TAB</td>
<td>9d</td>
</tr>
<tr>
<td>DEL</td>
<td>127d</td>
</tr>
<tr>
<td>ESC</td>
<td>27d</td>
</tr>
<tr>
<td>Insert</td>
<td><em>ESC</em>[ 2 ~</td>
</tr>
<tr>
<td>Prev/Page Up</td>
<td><em>ESC</em>[ 5 ~</td>
</tr>
<tr>
<td>Next/Page Down</td>
<td><em>ESC</em>[ 6 ~</td>
</tr>
<tr>
<td>Arrow Up</td>
<td><em>ESC</em>[ A</td>
</tr>
<tr>
<td>Arrow Right</td>
<td><em>ESC</em>[ B</td>
</tr>
<tr>
<td>Arrow Left</td>
<td><em>ESC</em>[ C</td>
</tr>
<tr>
<td>Arrow Down</td>
<td><em>ESC</em>[ D</td>
</tr>
</tbody>
</table>

*Table 10–1: General Keyboard Mappings*
Display Control

The VT100–like terminal mode of the terminal windows comprises the following control codes and escape sequences for displaying:

<table>
<thead>
<tr>
<th>ASCII Code</th>
<th>Decimal Value</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BELL</td>
<td>7</td>
<td>Ring the bell</td>
</tr>
<tr>
<td>BS</td>
<td>8</td>
<td>Move cursor one position back</td>
</tr>
<tr>
<td>TAB</td>
<td>9</td>
<td>Move cursor to next tab stop</td>
</tr>
<tr>
<td>LF</td>
<td>10</td>
<td>Move cursor one line down</td>
</tr>
<tr>
<td>CR</td>
<td>13</td>
<td>Move cursor to start of line</td>
</tr>
<tr>
<td>ESC</td>
<td>27</td>
<td>Start escape sequence (see below)</td>
</tr>
</tbody>
</table>

Table 10–2: Control Codes

Escape Sequences

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC D</td>
<td>Cursor one line down (scrolls if already at last line)</td>
</tr>
<tr>
<td>ESC E</td>
<td>Cursor one line down and to left margin (scrolls)</td>
</tr>
<tr>
<td>ESC M</td>
<td>Cursor one line up (scrolls if already at top line)</td>
</tr>
<tr>
<td>ESC [ n1 A</td>
<td>Cursor n1 lines up</td>
</tr>
<tr>
<td>ESC [ n1 B</td>
<td>Cursor n1 characters right</td>
</tr>
<tr>
<td>ESC [ n1 C</td>
<td>Cursor n1 characters left</td>
</tr>
<tr>
<td>ESC [ n1 D</td>
<td>Cursor n1 lines down</td>
</tr>
<tr>
<td>ESC [ H</td>
<td>Cursor home</td>
</tr>
<tr>
<td>ESC [ n1 ; n2 H</td>
<td>Move cursor to (n1,n2) with n1=row, n2=col</td>
</tr>
</tbody>
</table>

Table 10–3: Cursor Motion

Parameters n1 and/or n2 may be left out, in which case a value of 1 is assumed.
Table 10–4: Erasing

For example, to clear the entire screen in the C programming language, you can enter:

```c
printf("\033[H\033[2J");
fflush(stdout);
```

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC [ J</td>
<td>Clear screen from cursor till bottom–right</td>
</tr>
<tr>
<td>ESC [ p1 J</td>
<td>0: Clear screen from cursor till bottom–right</td>
</tr>
<tr>
<td></td>
<td>1: Clear screen from top–left till cursor</td>
</tr>
<tr>
<td></td>
<td>2: Clear entire screen</td>
</tr>
<tr>
<td>ESC [ K</td>
<td>Clear line from cursor till end</td>
</tr>
<tr>
<td>ESC [ p1 K</td>
<td>0: Clear line from cursor till end</td>
</tr>
<tr>
<td></td>
<td>1: Clear line from begin to cursor</td>
</tr>
<tr>
<td></td>
<td>2: Clear entire line</td>
</tr>
</tbody>
</table>

Table 10–5: Inserting and Deleting

Parameter \( n1 \) may be left out, in which case a value of 1 is assumed.
### Escape Sequence

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>( ESC \ [ \ m )</td>
<td>Turn off all attributes</td>
</tr>
</tbody>
</table>
| \( ESC \ [ \ n1 \ m \) | 0: turn off all attributes  
1: bold  
4: underline  
5: blinking  
7: reverse  
8: invisible  
22: turn off bold  
24: turn off underline  
25: turn off blinking  
27: turn off reverse  
28: turn off invisible |

*Table 10–6: Character Attributes*

Multiple parameters may be specified simultaneously:

\[ ESC \ [ \ n1 \ ; \ldots ; \ nN \ m \]

Some attributes or combinations of attributes are mapped to a regular standout mode.

Parameters may be left out, in which case a value of 0 is assumed.

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>( ESC \ [ \ 12 \ l )</td>
<td>Local echo on</td>
</tr>
<tr>
<td>( ESC \ [ \ 12 \ h )</td>
<td>Local echo off</td>
</tr>
<tr>
<td>( ESC \ [ \ 7 \ h )</td>
<td>Wrap around on</td>
</tr>
<tr>
<td>( ESC \ [ \ 7 \ l )</td>
<td>Wrap around off</td>
</tr>
<tr>
<td>( ESC \ [ \ ? \ 25 \ h )</td>
<td>Cursor on</td>
</tr>
<tr>
<td>( ESC \ [ \ ? \ 25 \ l )</td>
<td>Cursor off</td>
</tr>
</tbody>
</table>
| \( ESC \ [ \ ? \ 92 \ l \) | Enquire after the window’s size  
Response: \[ ESC \ [ \ ? \ rows, columns \ c \]

*Table 10–7: Miscellaneous*
11.1 TRANSPARENCY MODE

Transparency mode allows you to communicate directly with the execution environment. Most of the time CrossView Pro will handle all the low level communications, freeing you to concentrate on the high level C code. Depending on the type of execution environment, however, you may have to enter transparency mode to set up the execution environment when the machine is first turned on.

To enter transparency mode:

From the View menu, select **Command | Emulator**.

All commands entered in the Emulator Command Window are passed directly to the execution environment.

To exit transparency mode:

From the View menu, select **Command | CrossView**.

In CrossView Pro, you can pass a string directly to the execution environment without leaving CrossView Pro with the o command:

```
  o map
```

This passes the command map directly to the execution environment, while you remain in CrossView Pro. Naturally you will have to learn your execution environment’s command set to make use of the o command.

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Pass a command to the execution environment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td>o string</td>
</tr>
</tbody>
</table>

Do not issue one–shot transparency commands that result in large output (or otherwise require intervention other than a carriage return to terminate output). Instead, enter transparency mode first, then issue the command.

You may also enter transparency mode upon startup with the -T option. See the section on startup options.
11.2 RTOS AWARE DEBUGGING

CrossView Pro supports RTOS (Real-Time Operating System) aware debugging for various kernels. Since each kernel is different, the RTOS aware features are not implemented in the CrossView Pro executable, but in a library that will be loaded at run-time by CrossView Pro. The amount of windows and dialogs and their contents is kernel dependent.

Within the CrossView Target Settings dialog (Target | Settings...), select the CrossView Pro configuration you will use by selecting a "Target configuration". These target configuration files are normal ASCII text files. The name of the shared library that contains the kernel aware code can be specified in the target configuration. The "radm" configuration item specifies the name of the shared library that contains the kernel aware code.

The syntax of a target configuration file is:

```
[! comment] field : field-value
```

- `field` one of the defined keywords
- `field-value` the value assigned to the field
- `comment` optional comment

Empty lines, lines consisting of only white space are allowed. Comments start at an exclamation-sign ('!') and end at the end of the line.

The line for the shared library that supports RTOS aware code could be:

```
radm: yourrtos.dll
```
11.3 COVERAGE

You can only use this feature if it is supported by the execution environment (see the addendum).

When the application program is executed as a result of a command such as StepInto or Continue, CrossView Pro traces all memory access, i.e. memory read, memory write and instruction fetch. Through code coverage, executed and not execute areas of the application program can be found. Areas of unexecuted code may exist in case of programming errors or simply dead code which could be eliminated. Alternatively, your program input, your test set, is incomplete. It does not cover all paths in the program. Data coverage allows you to verify which memory locations, i.e. which variables, are accessed during program execution. Additionally, stack and heap usage can be shown.

To enable/disable coverage:

From the Tools menu, select the Coverage checked menu item.

When the menu item is checked, coverage is enabled. Select the menu item again to disable coverage.

Type the ce or cd command on the command line:

```
ce
```

FUNCTION: Enable coverage.
COMMAND: ce

```

FUNCTION: Disable coverage.
COMMAND: cd
```
Two dialogs are present to give you coverage information. The code coverage dialog shows the percentage of executed code within application, module and function scope. Code coverage information can also be displayed in the Source Window. The data coverage dialog shows the data access of HLL variables in the executed program. Data coverage can also be displayed in the Memory Window. The coverage dialogs can be opened via the Tools menu.

**FUNCTION:** List coverage information to output window or file.

**COMMAND:** `covinfo [all | module_or_function_name][,filename]`

You can display code coverage information in the Source Window by clicking on the **Coverage** button in the Source Window. In this case an extra column appears to the right of the breakpoint toggles (to the left of the source line). For each source code line that is executed (*covered*), the source line is marked. The not executed lines are not marked. CrossView Pro has special commands to move the cursor to the next or previous covered or uncovered line:

**FUNCTION:** Move cursor to next covered line.

**COMMAND:** `nC`

**FUNCTION:** Move cursor to next uncovered line.

**COMMAND:** `nU`

**FUNCTION:** Move cursor to previous covered line.

**COMMAND:** `pC`

**FUNCTION:** Move cursor to previous uncovered line.

**COMMAND:** `pU`
You can display data coverage information in the Memory Window by clicking on the Code Coverage button in the Memory Window. Besides the current value of memory locations, the memory window also displays whether memory locations have been accessed during program execution. An application program may read from, write to, or fetch an instruction from a memory location. Of course all combinations may be legal. Although writing data to a memory location from which an instruction has been fetched is suspicious. All types of accesss, read, write, fetch or combinations of these, can be shown using different foreground and background colors. The color combination used to show "rwx" access are specified in the Desktop tab of the File | Options... menu item. It is advised to change the background color if instructions are fetched from a memory location, and to change the foreground color to show read and write access.

11.4 PROFILING

You can only use this feature if it is supported by the execution environment (see the addendum).

Profiling allows you to perform timing analysis on your software. Two forms of profiling are implemented in CrossView Pro. Both forms of profiling are fully implemented in the CrossView Pro debugger. You do not have to recompile your source code to enable the profiling features.

Function profiling, also called cumulative profiling, gives timing information about a particular function or set of functions. The time spent in functions called by the function being profiled is included in the timing results. Within the Cumulative Profiling Setup dialog you select one or more functions to be profiled. The gathered profile is shown in the Cumulative Profiling Report dialog. For each function the number of calls, the minimum/maximum/average and total time spent in the function are shown. Also, the relative amount of time consumed by a function in respect to the time consumed by the application is shown.
Function profile data is gathered whenever the program is executed using the Continue command (not single stepped). Function profiling can be supported if the execution environment provides a clock that starts and stops whenever execution starts and stops. Basically function profiling is implemented by using a special type of breakpoint. Breakpoints are inserted at the function entry address and all it's return addressed. Whenever execution stops due to a profile-breakpoint hit, CrossView Pro will read the clock, update the internal profile tables, and restart execution.

To specify the functions to be profiled:

From the **Tools** menu, select **Cumulative Profiling Setup...**

Type the **cproinfo** command on the command line:

```
cproinfo add main
```

To view the profiling results:

From the **Tools** menu, select **Cumulative Profiling Report...**

Type the **cproinfo** command on the command line:

```
cproinfo
```

---

**FUNCTION:** List cumulative profining results to output window or file, or add or remove functions from the list of profiled functions.

**COMMAND:** `cproinfo [all|filename] | {add | remove } | function`

---

*Code range profiling* presents timing information about a consecutive range of program instructions. CrossView Pro displays the time consumed by each statement, C or assembly, in the source window. The timing data can be displayed in three different formats: absolute, relative to program, and relative to function. To change the display format: position the cursor on the profile column and click the right mouse button. Select the appropriate format from the popup menu.
Next to the source window, the profile report dialog (Tools | Profiling Report...) shows the time spent in each function. The time consumed by functions called from the function being profiled is not included in the displayed time.

**FUNCTION:** List profile information to output window or file.

**COMMAND:** `proinfo [all | module_or_function_name][filename]`

Code range profiling data is gathered whenever the program is executed. It does not matter if the program executes due to a continue, step-over or step-into command. Code range profiling heavily relies on special profiling features in the execution environment. Normally code range profiling is only supported by instruction set simulators.

To enable/disable profiling:

- From the **Tools** menu, select the **Profiling** checked menu item.
  
  When the menu item is checked, code range profiling is enabled. Enabled means that the execution environment starts gathering profiling data. Select the menu item again to disable profiling.

- Type the **pe** or **pd** command on the command line:
  
  **pe**

  **FUNCTION:** Enable profiling.
  
  **COMMAND:** `pe`

  **FUNCTION:** Disable profiling.
  
  **COMMAND:** `pd`

Select the **Profiling** button in the Source Window to display profile data in the Source Window. If profiling is not enabled, this button also starts gathering of profiling data.
Normally both function and code range profiling will slow down the execution speed of the application being debugged. Therefore, switch off profiling whenever the timing information is not required.

**11.4.1 HARDWARE PROFILING WITH A TIMER**

The Motorola DSP56xxx does not provide a cycle counter that is available to the debugger, and therefore profiling an application on the hardware is not directly possible (the simulator does not have this problem). To overcome this limitation a hardware timer on the chip can be used to emulate the cycle counter. At maximum timer frequency the achieved resolution is two clock cycles.

To be able to profile your application you can link some small routines with your application that set up the timer and instruct CrossView Pro to derive the cycle count from the timer.

In EDE, from the **Project** menu select **Project Options...** Expand the **Linker/Locator** entry and select **Linker Miscellaneous**. Enable the **Use hardware timer for cycle counting** check box.

In a makefile or on the command line you can supply the option `-uxvw_profiling_start` to the linker to extract the module from the library.

You have to force a rebuild of your application, as the make utility does not detect changes in options.

In CrossView Pro, the register CCNT can be added to the register window, and will then be 'alive'. CrossView Pro uses this register to fill in the reports of profiled functions. You can use the register content directly, or use the regular profiling report settings to profile functions.

Every profiled function gets invisible breakpoints on entry and on all exit points, so profiling may become very slow (but accurate) when many functions are profiled. In fact, using the simulator may be preferable in cases where many breakpoints are required. This also explains why profiling information for individual instructions is not available with hardware profiling.

The hardware profiling option interferes with ‘debugging with interrupts enabled’, as they both require the use of the software interrupt. You can use only one of them at a time.
11.4.1.1 DETAILED DESCRIPTION

If CrossView Pro detects the label "xvw_profiling_start" in the application, this routine is executed after every program reset. Also, CrossView Pro inserts a "trap" instruction instead of a "debug" instruction at each breakpoint position. So, when the breakpoint position is hit, the DSP starts executing the trap handler routine "trap_handler". The trap handler stops the timer and marks the current timer value. It then replaces the originating "trap" instruction by a "debug" instruction, sets the return address one position back and returns to the newly inserted "debug" instruction. So, finally the situation is the same as without the additional routine, but the timer has been read in a very accurate way (the debugger would be too slow to do this by itself, a large and inaccurate number of cycles would pass before it could read the timer). On every single step or program continuation, the timer is enabled again by the debugger. The timer overflow is handled in an interrupt routine to extend the range of the cycle counter to 48 bits.

By default, timer 1 is used for hardware profiling. If you wish to use a different timer for this purpose, you can add the lib/src/profile.asm file to your project and add the define TIMER=timernumber.

11.5 DATA ANALYSIS

CrossView Pro incorporates an advanced signal analysis interface designed to enable developers to monitor signal data more critically and thoroughly. This feature is useful when developing signal processing software for application areas such as communication, wireless and image processing.

The Data Analysis window (as shown in figure 4–15) is used for this purpose. This window is opened as result of processing a data analysis script (CXL script) and is only updated on user request. TASKING provides scripts for standard signal analysis such as x–t plotting, x–y plotting, FFT power spectrum, FFT waterfall, combined FFT power spectrum and phase, and eye diagram. However, the programmer can write CXL scripts and process the data in the format he desires.

Refer to the CXL syntax specification in section 11.5.2, Syntax of CrossView eXtension Language (CXL), for details.

Four processes are associated with the graph window:

1. Get raw data
2. Transform data

3. Generate representation

4. Draw

The *get raw data* process retrieves data from the target and stores the data at the host system in one or more CrossView Pro internal acquisition data buffers. Since these buffers reside on the host system it is possible to maintain a history of data.

The *transform data* process takes the raw data as input, processes it, and the result of the transformation, a set of (x, y) pairs, is saved in the processed data buffer associated with a window. Since the transformations are described in CXL (CrossView eXtension Language) the user can program the data transformation that is of most interest for him. For example, an FFT power spectrum would produce *(frequency, power)* pairs.

The *generate representation* process takes data from the processed data buffer, (x, y) pairs, as input and generates a display list. This process scales the data according to the given display window size. This process is coded in CXL. So, in addition to the scripts provided by TASKING, the user can write his own representation processes. For example, an FFT power spectrum is usually represented by a bar graph.

The *drawing engine* process takes the display list as input and produces the graph that is displayed in the Data Analysis window. The drawing engine is part of the CrossView Pro executable and cannot be configured by the user.

A clear separation between data transformation (the transform data process) and data presentation (generate representation process) has been made to increase the reusability of complex data presentation scripts.

Once the scripts are written (a number of frequently used operations are supplied), the following three steps must be made in order to display data:

1. Set the display mode for the desired window using the `graphm` command. For example,

   ```
   graphm "demo","show_x_t.cxl"
   ```

   "demo" will be shown in the title bar of the window. It is also the name used to refer to the window.
2. Retrieve data from the target into a buffer using the **memget** command. For example,

```
memget ((int []) _P:0x0)[i],128,$buffer
```

$i$ is the "iterator" to walk 128 times through the expression (Note: the retrieved elements are assumed to be equidistantly placed in memory) and store the results in $buffer$.

Optionally the buffer contents can be appended to another buffer using the **bufa** command, in order to maintain a (limited) history. For example,

```
bufa $all_data,$buffer,1024
```

3. Transform the buffer contents to displayable data using the **graph** command. For example,

```
graph "demo","x_t.cxl",$buffer,0,1
```

For details of the arguments provided to $x_t.cxl$, see below. Now a used buffer can be freed using the **bufd** command (if the target data is not to be used anymore).

Steps 1. and 2. can be repeated as many times as desired. The display mode can be changed at any time by issuing a **graphm** command for the window to be changed. Using the **graphp** command, a window can be positioned anywhere on the screen.

### 11.5.1 SUPPLIED DATA ANALYSIS WINDOW SCRIPTS

The following scripts and commands are described for completeness. Normally, you will not use the commands directly, because they are automatically invoked when you click **OK** in the Data Analysis Window Setup dialog.

For some **graphm** scripts both x– and y-axis can be user specified. If the limits are not specified or low $\geq$ high, then autoscaling is used.

**X-T plotting**

An x–t plot is the most straightforward way of displaying data. Data is taken from one buffer, each value is taken as the x value and the t value is increasing linearly. It is displayed as a graph the way it is found in the buffer (memory). The layout of the scales and the form of the graph (line, bar, dot) can be selected as shown below.
1. Generating window data pairs:

   \texttt{graph "win\_title", "x\_t.cxl", \$buffer, t\_offset, t\_increment}

   generates (t, x) pairs: \((t\_offset + i \times t\_increment, \$buffer[i])\). The generated data is attached to the specified window.

2. Setting the display mode:

   \texttt{graphm "win\_title", "show\_x\_t.cxl" [\(low\_x, high\_x, low\_y, high\_y\)]}

   displays lines drawn between successive coordinates specified by the window data pairs.

   \texttt{graphm "win\_title", "show\_cross.cxl" [\(low\_x, high\_x, low\_y, high\_y\)]}

   displays ‘x’s at the coordinates specified by the window data pairs.

   \texttt{graphm "win\_title", "show\_plus.cxl" [\(low\_x, high\_x, low\_y, high\_y\)]}

   displays ‘+’s at the coordinates specified by the window data pairs.

   \texttt{graphm "win\_title", "show\_bars.cxl" [\(low\_x, high\_x, low\_y, high\_y\)]}

   displays bars at the coordinates specified by the window data pairs. The x–coordinates are expected to be equidistant.

\textit{X-Y plotting}

An x–y plot takes values from two buffers, one from each at a time. The first is interpreted as the x–value, the second as the y–value of a point to display. No further processing is done on these values. The most common display mode is ‘x’s or ‘+’s (\texttt{show\_cross.cxl}, \texttt{show\_plus.cxl}, see previous description) to give a scattergram. The values can also be interconnected in order (\texttt{show\_x\_y.cxl}) to create Lissajous–like displays.

1. Generating window data pairs:

   \texttt{graph "win\_title", "x\_y.cxl", \$x\_buffer, \$y\_buffer}

2. Setting the display mode:

   \texttt{graphm "win\_title", "show\_x\_y.cxl" [\(low\_x, high\_x, low\_y, high\_y\)]}

   draws lines from all \((x[i], y[i])\) to \((x[i+1], y[i+1])\). When autoscaling is active, some space is reserved on both x– and y–axis.
The FFT power spectrum plot takes a buffer of arbitrary size to compute the power of all frequencies present in the signal (in decibels). If the buffer size is not a power of two, it will expand its input set to the next higher power and augment it with zeroes. To handle non–recurrent data correctly, several window functions can be applied in the process. If no reference level is given the maximum level is calculated and set to be 0 dB. The usual display mode is bars, although all x–t display methods can be used. The horizontal axis is in frequency steps, the vertical axis in decibels.

1. Generating window data pairs:

   \[\text{graph } "\text{win\_title}, "\text{fft\_cxl"}, $\text{buffer, filter\_index, frequency\_step, ref\_level} \]

   generates pairs (i * frequency_step, log_power[j]). The filter_index specifies one of the following FFT windowing functions:
   
   0  rectangular
   1  triangular
   2  Hanning
   3  Blackman–Harris

   ref_level is the 0 dB reference level.

2. For displaying the generated pairs, any of the x–t plotting display scripts can be used. "show_bars.cxl" is recommended.

The multi FFT power spectrum displays a chronilogical series of FFT power spectra. This diagram is also known as FFT waterfall. The FFT power spectrum plot takes a buffer of arbitrary size and splits it up in a number of frames of size \(2^{two\_exp}\). You can specify the overlap between successive frames. The overlap can be negative indicating gaps between successive frames. For each frame, the power (in decibels) of all frequencies present in the signal is computed.

1. Generating window data pairs:

   \[\text{graph } "\text{win\_title}, "\text{multi\_fft\_cxl"}, $\text{buffer, filter\_index, frequency\_step, two\_exp, overlap, ref\_level} \]

   generates pairs (i * frequency_step, log_power[j]). The filter_index specifies one of the following FFT windowing functions:
rectangular
1 triangular
2 Hanning
3 Blackman–Harris

$2^{two\_exp}$ is the width of one single frame in number of input samples. $two\_exp$ must be a value between 2 and 14 (inclusive). If the input buffer does not contain enough samples to fill the last frame, the frame is completed with zeros.

overlap is the number points shared by successive frames. When negative, a 'gap' will occur between processed points. The first sample taken from the input buffer of frame $N$ is equal to the first sample of frame $N + 2^{two\_exp} - overlap$. overlap must be smaller than $2^{two\_exp}$.

ref\_level is the 0 dB reference level.

2. For displaying the generated pairs, the display script "show_multi_bars.cxl" is required.

**Multi FFT power spectrum in lines**
Displays the same multi FFT power spectrum, but now in lines instead of bars. Here a 3D graph is shown. The script name is show_multi_lines.cxl.

**Multi FFT power spectrum in lines and grid**
Displays the same multi FFT power spectrum as the multi lines spectrum. Now each point on a curve is interconnected with a point with the same x-coordinate of the previous graph. What you see here is a 'grid' with the values. The script name is show_multi_grid.cxl.
Use of colors in Multi FFT power spectrum

For all three graphm scripts show_multi_bars.cxl, show_multi_lines.cxl and show_multi_grid.cxl an optional third parameter can be added to set the color offset value. This allows you to create a dynamic display in which the color of each curve remains the same. The color offset can range from 0 to the maximum number of colors, and the maximum number of colors is the number of curves to be plotted. When the color offset exceeds the number of colors, the modulo will be taken; if it is negative it will be set to zero. The colors selected for the curves are spread evenly over the color spectrum. The number of colors can also be set as an (optional) fourth parameter of the script.

An example of a command file for a running script can be:

```plaintext
/* INITIALIZE */
rst           /* Rerun the program when the script is executed */
$fast_mode=2   /* If on the simulator, go to fast mode */
s            /* Step to the main() routine to allow access */
/* to the output[] array. */
memget output[$i],256,$t /* It’s clear now. */
bufa $f,$t,4096 /* Construct an empty time domain history */
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
$color=0      /* Initialize the $color variable to track the graphs */

/* DEFINE THE TIME DOMAIN WINDOW */
graphp "Output time domain",50,25,716,295 /* set window position */
graphm "Output time domain","show_x_t.cxl" /* set draw method */
graph "Output time domain","x_t.cxl",$t,0,1 /* use the ‘t’ buffer */

graph_clear_updates "Output time domain"
/* Set ‘Output time domain’ window update actions: */
graph_add_update "Output time domain",memget output[$i],256,$t /* Get new time domain data from output[] into $t buffer */
graph_add_update "Output time domain",graph "Output time domain","x_t.cxl",$t,0,1 /* This command recalculates and redraws the window */

/* DEFINE THE FREQUENCY DOMAIN WINDOW */
graphp "Output freq domain",50,350,716,295 /* set window position */
graphm "Output freq domain","show_multi_grid.cxl",-120,5,($color) /* set draw method */
graph "Output freq domain","multi_fft.cxl",$f,0,1,256 /* use the ‘f’ buffer */
```
graph_clear_updates "Output freq domain"
    /* Set 'Output freq domain' window update actions:          */
graph_add_update "Output freq domain", bufa $f,$t,4096
    /* Add new data to buffer, max size 4096 (purging oldest)    */
graph_add_update "Output freq domain", $color = ($color+1) % 16
    /* 4096/256 = 16 graphs, increment color offset to follow    */
graph_add_update "Output freq domain", graphmn "Output freq
domain",”show_multi_grid.cxl”,–120,5,($color)
    /* Use the graphmn command to avoid double redraws          */
    /* Place $color in braces to avoid confusion with buffers   */
graph_add_update "Output freq domain”,graph “Output freq
domain”,”multi_fft.cxl”,$f,0,1,256
    /* This command recalculates and redraws the window         */

    /* PLACE COMPLEX BREAKPOINT, HAVE IT UPDATE THE GRAPHICAL DATA WINDOWS */
main#141 bi { update! "Output time domain"; update! "Output freq
domain"; C }
    /* CONTINUE RUNNING THE PROGRAM */
C

For passing the parameter $color, the command interpreter requires
parentheses around it, otherwise it is interpreted as a buffer.

**Combined FFT power spectrum and phase**

The combined FFT power spectrum and phase plot adds a display of the
phase of each component to the FFT power spectrum. The phase is
normalized between −180 degrees and +180 degrees. To display both
features of the input data a special display script must be used
(show_fft_pairs.cxl).

1. Generating window data pairs:

   **graph** "win_title”, "fft_pairs.cxl”, $buffer, filter_index, freq_step[ref_level]

   The filter_index specifies one of the following FFT windowing
   functions:
   0  rectangular
   1  triangular
   2  Hanning
   3  Blackman–Harris

   **ref_level** is the 0 dB reference level.

2. Setting the display mode:

   For displaying the generated display list, the display script
   "show_fft_pairs.cxl” is required.
Eye diagram

The eye diagram is a recurrent x-t plot. The input data is not processed, but the time parameter is reset when the signal crosses the trigger level, and also after a specified interval (wrap_limit). After crossing trigger_level, retriggering is suppressed during the trigger_hold_off next data values. The eye diagram uses the X-t plot method and exploits the feature of suppressing the fly-back of the displayed line.

1. Generating window data pairs:

   graph "win_title", "show_fft_pairs.cxl" [min_power, max_power]

2. Setting the display mode:

   graph "win_title", "show_x_t.cxl" [low_x, high_x [low_y, high_y]]

   displays lines drawn between successive coordinates specified by the window data. If \( x[i+1] < x[i] \) (going back in time), no line is drawn from \( (x[i], y[i]) \) to \( (x[i+1], y[i+1]) \), which can be regarded as the fly-back suppression in an oscilloscope.

11.5.2 SYNTAX OF CROSSVIEW EXTENSION LANGUAGE (CXL)

CXL has a C-like syntax, the basic differences from C are:

- No preprocessor, so no defines.
- Only "//" comments.
- No structs or unions, so the operators "." and "->" are not supported.
- No type definition
- No enums
- No switch statement.
- Blocks must not be empty ("1;" is the minimal expression).
- No 'main', all the script code is to be enclosed within a '{' and '}' pair.
• Function prototypes and function definitions can be nested, but must be preceded by the keyword "sub". They can be used anywhere in the source. Following the scope rules, a function declaration hides a previous definition when it is defined.

• No casts allowed. Casts are (like in C) performed automatically. When explicit rounding/casts are needed, you can use the floor() function. E.g. by floor(x) (chopping) or floor(x+0.5) (rounding off to nearest integer).

• No ?: operator allowed.

• Single statements after a flow control statement (if, else, for, while) should always be between braces. For example, the usual C expression

\[
\text{if } (x < 0 ) \\
\quad x = 0;
\]

should be written as

\[
\text{if } (x < 0 ) \\
\quad \{ \\
\quad \quad x = 0; \\
\quad \}
\]

• Initializers in declarations are not allowed. For example,

\[
\text{int } i = 1;
\]

should be written as

\[
\text{int } i; \\
\quad \ldots \text{ possible other variable declarations } \ldots \\
\quad i = 1;
\]

• Modifiers such as signed, unsigned, register and static are not supported.

• Floating point numbers below 1 should always be preceded by a zero. For example, the number .15 is treated as invalid, this should be 0.15.
Furthermore, the syntax is like the C syntax.

Example:

```c
{  
    sub void p(function f)  
    {  
        outd(f());  
        outc(’\n’);  
    }  
    
    sub int h() { return 1; }  
    {      //This is the “main” entry point  
        p(h);  
        sub int h() { return 2; }  
        p(h);  
    }  
}
```

This example would print the following output in the command window:

1
2

**Base Types**

CXL supports the following base types:

- char
- int
- long
- float
- double
- string  (only allowed for parameters)
- function  (only allowed for parameters)

Internally, char, int and long are treated the same, as are float and double. Since they are the same, types belonging to one group can be interchanged freely.

Pointer to base type is only supported for parameters not for other variables. Pointers to variables are the result of the ”address–of” operator and are treated as arrays of the mentioned base type with upper-bound 1.
A return value can be of any base type. Data type void is also a valid return type.

**Compound Types**

CXL supports the following compound types:

- array of char
- array of int
- array of long
- array of float
- array of double

Structures, unions and type definitions are not part of the CXL syntax.

**Predefined Functions**

1. Mathematical functions:

   ```c
   double sin(double x);
   double cos(double x);
   double tan(double x);
   double acos(double x);
   double asin(double x);
   double atan(double x);
   double sinh(double x);
   double cosh(double x);
   double tanh(double x);
   double log(double x);
   double log10(double x);
   double exp(double x);
   double sqrt(double x);
   double ceil(double x);
   double floor(double x);
   double fabs(double x);
   double pow(double x, double y);
   ```

2. Functions to send output to the command window:

   ```c
   double outc(double x);  -> { printf("\%c", (int) x); return x; }  
   double outd(double x);  -> { printf("\%ld", (long) x); return x; } 
   double outf(double x);  -> { printf("\%f", x); return x; }  
   ```

3. Upperbound of an array:

   ```c
   long upperbound(array a);
   ```
4. GUI interaction functions available when a script is passed to the `graph` command:

```c
void add_point(double x, double y);
```
This function adds graph points to the acquisition buffer.

```c
void printf(string format, ...);
```
The output of `printf` is written to the command window.

5. GUI interaction functions available when a script is passed to the `graphm` command:

```c
void printf(string format, ...);
```
The output of `printf` is sent to the "window contents script".

This at first sight strange function name of `printf` is chosen to facilitate development and debugging `graphm` scripts using a host system C development environment. The C code can be very easily ported to CXL afterwards. The output is in fact a command of the drawing engine and is therefore not the same as a usual `printf` and no the same as `printf` in the `graph` command. Logging to the command window from a `graphm` script is not possible via `printf`.

The following drawing commands are supported:

**clear**

Clear drawing area. This is usually the first command issued in a drawing sequence.

**graph_area**  
`x-offset, y-offset, x-size, y-size`

```c
printf("graph_area \%d,\%d,\%d,\%d/n", xo, yo, xs, ys)
```
Set graph area size. The offset determines the lower left corner of the graph area. Size is the exact number of pixels.

**axis**  
`xlow, ylow, xhigh, yhigh`

Define the axes ranges, for determining the cross-hair cursor coordinates (to be displayed in the cursor field and to be passed to the representation generator). The axes range up-to the top-right coordinate, which is excluded (reduces axis drawing maths, but mind axis lengths of 0). The axes are linear.
**pen_color** *color*

Set pen color. Black is the default color. The *color* can be specified by name or by RGB number in the form *red*,*green*,*blue* as decimal number for each base color for 0 to 255. E.g. 255,128,0 is orange. Valid names are:

black, red, yellow, green, blue, cyan, magenta, dkgray, gray, ltgray, white

**brush_color** *color*

Color used for filling areas. Black is the default color. See **pen_color** for possible colors. The value *background* sets the brush to the current background color which is WINDOW_BACKGROUND under Windows.

**filled_rectangle** *x1, y1, x2, y2*

Puts a rectangle, filled with the latest set brush_color, bounded by (x1, y1) and (x2, y2) (both points inclusive). Coordinates are expressed in pixels. The origin is the lower left corner.

**dot** *x1, y1*

Draw pixel. Coordinates are expressed in pixels. The origin is the lower left corner.

**line** *x1, y1, x2, y2*

Draw line from (x1, y1) up-to and including (x2, y2). Coordinates are expressed in pixels. The origin is the lower left corner.

**polygon** *x1, y1, x2, y2, ... xn, yn*

**polyline** *x1, y1, x2, y2, ... xn, yn*

Puts a polyline, using the latest set pen_color, from line sections from the points (x1, y1) to (xn, yn), where n >= 3 (which means at least 2 lines). Coordinates are in pixels.
filled_polygon \( x_1, y_1, x_2, y_2, \ldots, x_n, y_n \)

Puts a polygon, filled with the latest set brush_color, bounded by a polygon formed by the line sections between the points \((x_1, y_1)\) to \((x_n, y_n)\) and back to \((x_1, y_1)\), where \(n \geq 3\). Coordinates are in pixels. As with filled_rectangle, the pen is only temporarily set to the same color as the current brush and restored when the call is finished.

filled_polygon_brush \( x_1, y_1, x_2, y_2, \ldots, x_n, y_n \)

As with filled_polygon, but using a separate brush and pen, that is, using the latest brush and pen color also when they are different.

text \( x, y, \text{anchor, "text"} \)

Draw text with its anchor at location \((x, y)\). The anchor is the point in the text string, which will get placed at the specified location. For example, anchor 7 specifies that the text must be placed such that the bottom–left side of the text is at the specified position. Coordinates are expressed in pixels. The origin is the lower left corner.

Anchors:

\[
\begin{array}{|c|c|c|}
\hline
1 & 2 & 3 \\
\hline
4 & 5 & 6 \\
\hline
7 & 8 & 9 \\
\hline
\end{array}
\]

Text may include any characters, except a nil character. Double quote and backslash characters must be escaped by a backslash character. Text will be formatted using the current font settings. See below for the font info exchange between the window and the representation generator.
long get_attr(string attribute);

Supported attributes are:

- "draw-area-x-size"
- "draw-area-y-size"
- "x-scrollbar-present"
- "x-scrollbar-size"
- "x-scrollbar-low"
- "x-scrollbar-high"
- "y-scrollbar-present"
- "y-scrollbar-size"
- "y-scrollbar-low"
- "y-scrollbar-high"
- "selection-available"
- "selection-start"
- "selection-end"

long get_text_attr(string attribute, string text_format, ...);

Supported attributes are:

- "leading"
- "ascent"
- "descent"
- "width"

6. Argument passing.

The graph and graphm commands can be given a number of arguments. These arguments are accessible as follows.

long n_args;

The number of arguments.

arg1..argN

with N = n_args are added to the global scope and have type double * for buffers, type string for strings and type double for evaluated expressions.

Parsing the script will fail if a certain argument has not been provided. Evaluation of the script will fail if the type of the argument does not match its use.
For argument testing and argument retrieval the following functions are provided:

```c
long is_string_arg(long n);
long is_double_arg(long n);
long is_buffer_arg(long n);
double get_double_arg(long n);
string get_string_arg(long n);
double *get_buffer_arg(long n);
```

Numerical arguments can be retrieved by using `get_double_arg()`. In the `graphm` command, the `(x, y)` pairs produced by a sequence of calls to `add_printf()` in the `graph` script are accessible via global variables `x` and `y` of data type `array of double`. 
11.6 BACKGROUND MODE

Background mode is a feature for running the application under debug and CrossView Pro at the same time. This allows you to monitor the target application using CrossView Pro, while the application is running. Depending on the target hardware and/or debug instrument connected to CrossView, target execution can even be real-time.

Since CrossView's monitoring of the target hardware must be non-intrusive, not all functions of the debugger are enabled while running in background mode.

You can only use this feature if it is supported by the execution environment (see the addendum).

11.6.1 CONFIGURATION

CrossView can be instructed to automatically refresh one or more windows of the debugger periodically while running in background mode. You can use the Background Mode Setup dialog for specifying the desired set of windows to be refreshed.

From the Settings menu, select Background Mode Setup... to open the Background Mode Setup dialog.

A distinction has been made between updating the Source lines window and updating the Disassembly window. Updating the Disassembly window may be too time-consuming, so you may want to disable its updating in Background mode, while still keeping the Source lines window up-to-date when that is displayed on screen.

Use the u command to toggle the updating of windows in background mode.

| FUNCTION: | Toggle update of window in background mode. |
| COMMAND:  | \[interval\] u | d | k | r | cd | ck | cr | s | a | mem | t |
The following windows can be updated in background mode:

- **d** (Data), **k** (Stack), **r** (Register),
- **s** (Source), **a** (Assembly), **mem** (Memory), **t** (Trace)

Initially only the data window will be updated. CrossView Pro repeatedly looks at the execution environment to react on changes. It pseudo–simultaneously looks for user commands from the keyboard (or from the playback file), and periodically it updates the windows.

If all windows would be updated the update frequency would drop. That is why you can toggle a switch for each window. To toggle the updating of the register window, you can type:

```
xvw% u r
```

If the switch for a window is 'on', it will be updated, otherwise it will be skipped.

You can also specify a new update interval.

Without arguments, CrossView Pro displays all windows updated periodically plus the update interval.

Notice that simulated I/O is done through 'invisible' breakpoints, and these must be handled inside the loop. Hence, if updating the windows takes a lot of time (many monitor commands), it will also slow down simulated I/O.

### 11.6.2 MANUAL REFRESH

If you have windows which you do not want to refresh periodically, you can disable them in the Background Mode Setup dialog’s refresh list, and refresh these windows manually.

From the **View** menu, select **Background Mode** and select one of the refresh options.

Use the **ubgw** command.
FUNCTION: Update the appropriate window when the target runs in the background.

COMMAND: \texttt{ubgw [ s | a | k | r | d | mem | t | all ]}

Section \textit{Refresh Limitation} in this chapter.

\section*{11.6.3 ENTERING BACKGROUND MODE}

To run a program in background mode:

\begin{itemize}
  \item From the \texttt{Run} menu, select \texttt{Background Mode | Run in Background}
  \item Type the \texttt{CB} command on the command line.
\end{itemize}

FUNCTION: Run a program in background mode.

COMMAND: \texttt{[count] CB [linenumber]}

This will start the application under debug to run continuously (as with the \texttt{C} command), and switch CrossView Pro from Halted to Background Mode. \textit{count} is assigned to the breakpoint at the current execution position as the number of times to hit this breakpoint before execution to stop. \textit{linenumber} specifies the source line to place a temporary breakpoint.

The mouse pointer changes to an arrow with a small watch face underneath. This indicates that CrossView Pro is now in background mode. Some commands are treated a little different in this mode, because they can otherwise influence the running program badly. Commands that need information from the stack (like \texttt{bu, bu, bb} or \texttt{bB}) are not allowed because that information is not reliable. Other commands require great care, for example the \texttt{o} command.

For example if you type the \texttt{g} while in background mode you will see:

\begin{verbatim}
xvw% g 56
Command “g” is not allowed while the emulator is running in background.
\end{verbatim}
11.6.4 LEAVING BACKGROUND MODE

You can leave Background Mode in three ways:

1. Stop the target immediately:

   From the Run menu, select Background Mode | Halt Target

   Enter the \texttt{st} command:

   \texttt{xvw\% st}

2. Let CrossView wait for the target to stop:

   From the Run menu, select Background Mode | Wait for Target to Stop

   To wait for a breakpoint, you can use the \texttt{wt} command:

   \texttt{xvw\% wt}

3. A program running in background mode also stops when it encounters a breakpoint.

   \begin{center}
   \textbf{FUNCTION:} Stop a program in background mode. \\
   \textbf{COMMAND:} \texttt{st}
   \end{center}

   The \texttt{wt} command behaves just as if you have typed the \texttt{C} command. CrossView Pro returns with a prompt, after the program hits a breakpoint. However, there is an interesting difference with the \texttt{C} command. If you push the Halt button, it returns with the background prompt. The program that runs in the execution environment continues without interruption.

   \begin{center}
   \textbf{FUNCTION:} Wait for the running process to stop \\
   \textbf{COMMAND:} \texttt{wt}
   \end{center}
11.6.5 THE STACK IN BACKGROUND MODE

While the execution environment runs in background, CrossView Pro does not allow the use of information that comes from the stack. The reason is that the running program must be stopped in order to get consistent information from the stack. Stopping (and afterwards continuing) the program conflicts with the “real-time” nature of the background mode.

If there is a need for it, you can make a macro that performs the desired operations.

11.6.6 LOCAL AND GLOBAL VARIABLES

In background mode you can continuously monitor variables. However, realize that local variables (in CrossView Pro variables are called ‘local’ if they reside on the stack) cannot be monitored. Instead you will see "unknown name". Global variables have a fixed address, so CrossView Pro knows where to get their contents from.

If you are very anxious to see local variables you can first get an address and then use that address to monitor the contents. For example:

\[
\begin{align*}
\textit{adr}_\textit{sum} &= \&\textit{sum} \\
\textit{m} \times (\textit{adr}_\textit{sum})/2
\end{align*}
\]

In this example \textit{sum} is a long (2 MAUs). You must be sure that \textit{sum} remains at that address while the program is running.

The values you get this way are only valid under specific conditions. Local variables from the function \textit{main} normally meet these conditions.

11.6.7 REFRESH LIMITATION

While running the application in the background mode, the automatic refresh functionality may not be able to keep up with all the debugging information produced by the running target. Typically, the collected information will be correctly displayed and automatically updated in the current open views and no information will be lost. You might lose the debugging information when scrolling these views during the background mode. The reason is that either CrossView Pro does not run fast enough or the communication with the target hardware is not handled fast enough by the operating system.
The information that cannot be processed by CrossView Pro within the specified update interval, is displayed as either '<unknown>' or dashes. The way the lost information is displayed depends on the internal communication level within CrossView Pro where the information is lost. Information lost during communication with the target hardware is displayed as '<unknown>'. Information lost by CrossView Pro while processing and interpreting this information, is displayed as dashes.

On the next automatic or manual update, all debugging information in the currently open views is automatically updated. All visible '<unknown>' values and dashes are replaced with their actual values as produced by the running target.

11.6.8 ASSERTIONS

CrossView Pro automatically suspends assertions with the CB command.
Here are a few notes about debugging in special situations:

### 12.1 DEBUGGING ASSEMBLY LANGUAGE

You may debug assembly language programs or modules much as you do C source. The `s`, `S` and `si` commands single step through the assembly source. You may place code breakpoints on assembly language instructions with the `bi` command.

For additional information on debugging assembly code, see `$autosrc`, `$mixedasm` and `$symbols` in the *Reserved Special Variables* table in section 3.4.

There is a restriction on debugging assembly language code:

- Assembly language subroutines cannot be called from the command line.

### 12.2 DEBUGGING MULTIPLE PROGRAMS

You probably have only one linked and located absolute object file that describes the whole system load. However, for various reasons, you may want to build your system load by linking and locating into several files. The debugger can handle the symbols from only one load module in one absolute object file at a time. Consequently, if there are several absolute files or several load modules within one absolute file, you will have to change the context from one to another explicitly. Use the `N` command or the Load Symbolic Debug Info dialog to load the appropriate symbols. This does not disturb the state of the target system.

You can also download the image part of another absolute object file (using the `dn` command), without leaving the debugger.

### 12.3 DEBUGGING WITH INTERRUPTS ENABLED

When debugging an application where interrupts occur frequently, single-stepping is very difficult because the debugger steps into the interrupt routine rather than following the current execution path. The reason is that during the idle time between single steps an interrupt becomes pending.
To be able to single-step your application you can link some small routines with your application that will help CrossView Pro to avoid this situation.

In EDE, from the **Project** menu select **Project Options...** Expand the **Linker/Locator** entry and select **Linker Miscellaneous**. Enable the **Debug with interrupts** check box.

In a makefile or on the command line you can supply the option `-uxvw_iss_start` to the linker to extract the module from the library.

You have to force a rebuild of your application, as the make utility does not detect changes in options. This module disables the interrupts when the program is stopped, and does not enable them during single-stepping. When the program execution is continued, the interrupt enable flags are restored to their previous state. As single-stepping is not a real-time process anyway, this gives the least interference with your application.

Debugging with interrupts enabled interferes with the "hardware profiling’ option, as they both require the use of the software interrupt. You can use only one of them at a time.

### 12.3.1 Detailed Description

If CrossView Pro detects the label "xvw_iss_start" in the application it inserts a "trap" instruction instead of a "debug" instruction at each breakpoint position. So, when the breakpoint position is hit, the DSP starts executing the trap handler routine "trap_handler". The trap handler marks the current interrupt flags and disables the interrupts by manipulating the hardware stack contents. It then replaces the originating "trap" instruction by a "debug" instruction, sets the return address one position back and returns to the newly inserted "debug" instruction. So, finally the situation is the same as without the additional routine, but interrupts are switched off in a very fast way (the debugger would be too slow to do this by itself, there would be interrupts pending already).

During single-stepping, the interrupts remain switched off. This means that no interrupts are accepted during single-stepping. When a **go** command is issued, the saved interrupt state is restored in the processor before starting to execute code by the `xvw_iss_start` routine (the interrupt mask and start address are placed in `xvw_iss_buffer`).
An important issue is that code that manipulates the interrupt bits in the status register during single-stepping is not recognized. This may lead to two situations:

1. Interrupts are enabled, and the single-step fix will fail (interrupts are stepped into again). On the next go this will be fixed again, but an incorrect mask may have been restored (the one that was saved on the previous breakpoint).

2. Interrupts are disabled. On the next go an incorrect mask will be restored (the one that was saved on the previous breakpoint). Interrupts are now enabled when they should not have been.

All in all it is best to put a breakpoint after code that manipulates the interrupt mask bits and issue a go.
This chapter contains a summary of all CrossView Pro commands, followed by a complete description of each command.

### 13.1 CONVENTIONS USED IN THIS CHAPTER

Each CrossView Pro command has a particular syntax, that is, the form it must take for CrossView Pro to recognize it. To help you learn the syntax of each command, this chapter uses a special notation to describe the syntax of each command. Consider the following example:

```plaintext
ios_read [stream | "file"],address,number_of_maus,x
```

Command items in **bold** font are the actual command keywords typed from the keyboard. In the example above, `ios_read` is in bold font since you must type it exactly as shown.

Items in *italics* are names of the command part. Here `stream` is in italics, since you must substitute the appropriate value for `stream`. The Description section for each command describes what kinds of values should be substituted for italicized terms.

Expressions in [brackets] are optional items you may include in a particular command. In this example, `x` is not necessary for the `ios_read` command to work. Usually if you omit an optional expression, CrossView Pro uses a default value.

The `|` symbol means or. For instance, `{stream | "file"}` means a stream number or a filename between double-quotes (but not both) can be used in the command.
13.2 COMMANDS: SUMMARY

13.2.1 VIEWING COMMANDS

- `^[format]`  Display contents of preceding memory location.
- `exp`  Print value of expression using /n format.
- `exp @ format`  Print address of expression `exp` in format `format`.
- `exp/format`  Print value of expression `exp` in format `format`.
- `line`  Move viewing position to line `line`.
- `clear`  Clear the Command Output Window.
- `number ct`  Display a source-level trace corresponding to the last number of machine instructions executed. This command is not available for all execution environments.
- `number ct i`  Display a disassembled assembly-level trace corresponding to the last number of machine instructions executed. This command is not available for all execution environments.
- `number ct r`  Display a raw trace corresponding to the last number of trace frames. This command is not available for all execution environments.
- `e [func | file]`  Enter function `func` or file `file` or view current viewing position.
- `stack e`  Enter function using stack address.
- `[addr] ei`  View current viewing position or view instruction at address `addr`.
- `f ["printf-style-format"]`  Change default address display format.
- `gus {on | off}`  Suppress or reactivate CrossView Pro window updating.
- `L`  Synchronize the viewing position with the execution position. Print current file, function and line number.
\texttt{l \{a|b|d|f|g|k|l|m|p|r|s|S\} \{string\}}

List assertions, breakpoints, directories, files, globals, kernel state data, labels (on module scope), all Labels, memory map (of application code sections), procedures, registers, special variables, Symbol tables. If given, only those starting with \textit{string}.

\texttt{l \{func\}}

List all parameters and locals of function \textit{func}. Without a function, this command lists all parameters and locals of the current function in view.

\texttt{l stack}

List all parameters and locals of function at depth \textit{stack}.

\texttt{nc}

Move viewing position to next covered line.

\texttt{nu}

Move viewing position to next uncovered line.

\texttt{opt \{option \[= value\]\}}

List or set option value. Without an argument, list all option values.

\texttt{[line] P [exp]} Print \textit{exp} lines of source starting at line \textit{line}, include machine addresses.

\texttt{[line] p [exp]} Print \textit{exp} lines of source starting at line \textit{line}.

\texttt{pc}

Move viewing position to previous covered line.

\texttt{pu}

Move viewing position to previous uncovered line.

\texttt{[exp] T}

Trace the stack for \textit{exp} number of levels, list local variables.

\texttt{[exp] t}

Trace the stack for \textit{exp} number of levels, printing active functions and parameters passed.

\texttt{td}

Disable tracing.

\texttt{te}

Enable tracing.

\subsection{13.2.2 DATA MONITORING}

\texttt{cd}

Disable, turn off, gathering of coverage data.

\texttt{ce}

Enable, turn on, gathering of coverage data.
covinfo  [[all | module_or_function_name][,filename]]
  List coverage info.

cproinfo  [all[,filename] | {add | remove} function]
  List cumulative profiling info or add or remove functions from the list of profiled functions.

dis  address [, {address | #count} [,i]]
  Disassemble a range of memory.

dump  address [, {address | #count} [, {style | width} [, filename [,a]]]]
  Dump a memory range.

M
  Display list of monitored expressions in the Command window.

m exp
  Monitor the expression exp.

num m d
  Remove monitored expression labeled num.

addr_start  mcp addr_end, addr_dest
  Memory copy.

addr  mF exp[exp]...
  Single fill memory address addr with expressions.

addr_start  mf addr_end, exp[exp]...
  Fill memory address range with expressions and repeat the pattern until the end address of the memory region is reached.

addr_start  ms addr_end, exp[exp]...
  Search memory address range for a given pattern.

pd
  Disable, turn off, profiling.

pe
  Enable, turn on, profiling.

proinfo  [[all | module_or_function_name][,filename]]
  List profiling info.
13.2.3 DATA ANALYSIS

bufa target_buffer_name,added_buffer_name[size_limit]
   Add the contents of buffer added_buffer_name to buffer
target_buffer_name.

bufd buffer_name
   Discard the specified buffer.

graph "window","script"[,arg]...
   Create Data Analysis window and execute CXL script.

graphm "window","script"[,arg]...
   Set the representation script for the window specified.

graphmn "window","script"[,arg]...
   Similar to the graphm command, but without an update of
   the graph window.

graphp "window",left_top_x,left_top_y,width,height
   Position the named window at the specified screen
   coordinates.

graph_add_update "window",command
   Add command to the sequence of update commands for the
   specified window.

graph_clear_updates "window"
   Clear the update commands associated with the specified
   window.

graph_close "window"
   Close the specified window.

graph_debug expression
   Enable the "graphical data window debugging mode",
   showing all communication between the scripts and the
   windows in the command window.

memget expr,count,buffername
   Retrieve symbolically specified data from the target system
   and store the data in the acquisition buffer.

rawmemget address,type,count,buffername [,interleave]
   Retrieve data from the target system and store the data in the
   acquisition buffer.
**update** "window"

Update the window specified.

### 13.2.4 EXECUTION CONTROL COMMANDS

**A [a | s]**
Toggle state of assertion mechanism.

**a cmds**
Create a new assertion with the command list *cmds*.

**exp a {a | d | s}**
Activate, delete, suspend assertion *exp*.

**B**
List all breakpoints.

**[line] b [cmds]**
Set breakpoint at source line *line*, and associate command list *cmds* with breakpoint.

**[stack] bb [cmds]**
Set temporary breakpoint at beginning of function at stack level *stack* and associate command list *cmds*.

**[stack] bB [cmds]**
Set breakpoint at beginning of function at stack level *stack* and associate command list *cmds*.

**[number] bc [count] [reset_count]**
Set breakpoint *count* and *reset_count* for breakpoint with number *number*.

**count bCYC [cmds]**
Set temporary breakpoint after the specified cycle *count* and associate command list *cmds*.

**count bcyc [cmds]**
Set breakpoint after the specified cycle *count* and associate command list *cmds*.

**exp bD {r | w | b} exp2 [cmds]**
Set a data range breakpoint (between addresses *exp* and *exp2*) read (*r*), write (*w*) or both read and write (*b*), and associate command list *cmds*. This command is not available for all execution environments.
`exp bd {r | w | b} [cmds]`
Set a data breakpoint, read (r), write (w) or both read and write (b) at address `exp`, and associate command list `cmds`. This command is not available for all execution environments.

`num bdis` Disable code breakpoint.

`num bena` Enable code breakpoint.

`[addr] bi [cmds]`
Set temporary breakpoint at machine instruction and associate command list `cmds`.

`[addr] bi [cmds]`
Set breakpoint at machine instruction and associate command list `cmds`.

`count bINST [cmds]`
Set temporary breakpoint after `count` machine instructions and associate command list `cmds`.

`count binst [cmds]`
Set breakpoint after `count` machine instructions and associate command list `cmds`.

`break [type] where [, option]...`
Universal breakpoint command. Several `types` of breakpoints are available. The meaning of `where` depends on the selected `type`. Breakpoint `options` must be separated by commas.

`time bTIM [cmds]`
Set temporary breakpoint after `time` number of seconds and associate command list `cmds`.

`time btim [cmds]`
Set breakpoint after `time` number of seconds and associate command list `cmds`.

`[stack] bU [cmds]`
Set a temporary up–level breakpoint at stack level `stack` and associate command list `cmds`.

`[stack] bu [cmds]`
Set up–level breakpoint at stack level `stack` and associate command list `cmds`.
[exp] C [line]  Continue execution from current value of program counter. If line is specified, execution continues up to that line. Breakpoint’s count is set to exp.

[exp] CB [line]  Continue execution in background from current value of program counter. If line is specified, execution continues up to that line. Breakpoint’s count is set to exp. This command is not available for all execution environments.

D  Delete all breakpoints.

Dy  Delete all breakpoints without prompt for confirmation.

[number] d  Delete breakpoint number.

cpu eC  Start execution on the current CPU and switch to cpu.

[cpu] ec  Select CPU or show current CPU number.

g line  Go to the specified line in the current procedure.

address gi  Go to the specified address.

if (exp) {cmds} {{cmds}}  Conditionally execute commands.

prst  Reset program counter.

Q  Report breakpoint quietly.

q [y]  Quit debugger (do not save desktop settings).

q s  Save current desktop settings and quit debugger.

R  Reset program counter and start execution.

rst  Reset target system to initial conditions.

[exp] S  Single step for exp lines, step over function calls.

[exp] s  Single step for exp lines, step into function calls.

[exp] Si  Single machine step for exp machine instructions, step over subroutine calls.

st Stop the execution of the target immediately.
This command is not available for all execution environments.

[interval] u [d|k|r|s|a|mem|t]
Toggle updating of the appropriate window when the target runs in the background. You can specify the update interval, in seconds. If interval is zero, never update automatically.
This command is not available for all execution environments.

ubgw [s|a|k|r|d|mem|t|all]
Refresh the appropriate window, or all open windows, when the target runs in the background. This command is not available for all execution environments.

use [path]...
Clear source directory search path or use the specified path to search for source files.

wt Wait for the completion of the target.
This command is not available for all execution environments.

[exp] x Force an exit from assertion mode. If exp is non-zero, finish executing command list of the current assertion.

13.2.5 RECORD & PLAYBACK

<file> Play back commands from file.

<<file> Play back commands with single step from file.

>file Record commands in file.

>{t|f|c} Set recording file status, true (t), false (f) or closed (c).

> Report status of command recording mechanism.

>>file Log commands and screen output in file.

>>>{t|f|c} Set logging file status, true (t), false (f) or closed (c)
Report status of command and screen output logging mechanism.

Log host-to-target communication in file. Not available for all execution environments.

Turn target communication logging on (t), off (f) or close (c) log file. Not available for all execution environments.

Report status of target communication logging mechanism. Not available for all execution environments.

13.2.6 MACROS

echo string  Display macro expansion of string.

save file  Save current macros to file.

set Display all macros.

set macro ”cmds”  Define macro macro as command list cmds.

unset Delete all macros.

unset macro!  Delete definition of macro macro.

macro! Prevent expansion of macro.

13.2.7 INPUT/OUTPUT SIMULATION

ios_open ["file",[mode],[r],[$xvw_variable]]  Open a CrossView Pro File I/O stream.

ios_wopen ["terminal_window",[$xvw_variable]]  Open a CrossView Pro File I/O stream an map the stream to a terminal window.

ios_close {stream  |  ”file”}  Close a CrossView Pro File I/O stream.
ios_read {stream | "file"},address,number_of_maush,x
Read binary data from a File I/O stream. Optionally, interpret the read data as hexadecimal values.

ios_readf {stream | "file"},"format",expression
Formatted read from a File I/O stream (scanf).

ios_write {stream | "file"},address,number_of_maush,x
Write binary data to a File I/O stream. Optionally, interpret the data as hexadecimal values.

ios_writef {stream | "file"},"format",expression
Formatted write to a File I/O stream (printf).

ios_rewind {stream | "file"}
Move File I/O file pointer to the beginning of the file.

13.2.8 FILE SYSTEM SIMULATION

FSS  { < | > }&stream | "file"}
Redirect to or from a stream or file.

FSS_stdio_open  filename,rwdirection,streamnumber
Redirect the output of a stream to a file.

FSS_stdio_close  streamnumber
Close the specified stream.

13.2.9 TARGET SYSTEM CONTROL

dcmp [file][number_of_bits][d]
Compare an application file with the memory contents and display differences.

dn
Download the image part of the current absolute file, specified when CrossView Pro was invoked or loaded with the N command.

dn file
Download the image part of the absolute file file.

dnm mem
Download the image part of the current hexadecimal file, specified when CrossView Pro was invoked or loaded with the N command, into memory space mem.
**dnm mem file**  
Download the image part of the hexadecimal file *file*, into memory space *mem*.

**load [file]**  
Load symbol table of *file* in CrossView Pro and download the image part to the target. This is a combination of N and dnm.

**N [file]**  
Load symbol table of *file* in CrossView Pro.

**n [addr]**  
Set code address bias (for overlays) to *addr*. If no address is given, then display the current bias.

**o [cmd]**  
Enter transparency mode (exit with *ctrl*–D). If *cmd* is present, pass *cmd* to the execution environment. Not available for all execution environments.

**! [command–line]**  
Execute shell command *command–line* or invoke new shell.

### 13.2.10 SAVE AND RESTORE TARGET STATE

This feature is only available when it is supported by the debug instrument.

**di_state open state name**  
Open the state with the specified *state_name*.

**di_state save state name, number**  
Save the state of the debug instrument with the specified *state_name* and *number*.

**di_state restore state name, number**  
Restore the state of the debug instrument with the specified *state_name* and *number*.

**di_state close state_name, delete**  
Close the state with the specified *state_name*. *delete* can be 1 to delete the state or use 0 to keep the state.

### 13.2.11 HELP COMMANDS

**I**  
Print information about debugger state.
13.2.12 SEARCH COMMANDS

Z  Toggle case sensitivity in searches.

/string/  Search forwards in source file for string. If string is not present, perform previous search again.

?/string/  Search backwards in source file for string. If string is not present, perform previous search again.

"string"  Print string.

13.3 COMMANDS: DETAILED DESCRIPTIONS

The rest of this chapter provides the detailed descriptions of the CrossView Pro commands.
expression

Function

Print the value or address of an expression.

From the Data menu, select Evaluate Expression... Enter an expression and optionally select a display format. You may set up a monitor, which instructs the debugger to evaluate a particular expression each time the program stops, from the Source Window by selecting text there and by clicking on the Watch Expression button.

Enter the expression in the Command Window. You may specify in which format you want CrossView Pro to display the answer.

Description

In the Command Window, the syntax for this command is:

```
exp /[ format |@ format]
```

Print the value or address of exp with format format. A / (slash) is used to print the value of exp and a @ (commercial at) is used to print the address of exp. If format is not supplied, the natural (/n) format of the expression is used.

Formats have the syntax:

```
[count] style [size]
```

count is the number of times to apply the format style and defaults to 1. style may be one of:

```
acDUXdouxEFGefgiINPPrrSst
```

See Chapter 6, Accessing Code and Data, and section 3.5 Formatting Expressions in Chapter 3, Command Language, for details on each of the format styles.

size indicates the number of MAUs (Minimum Addressable Units) to be formatted. Rather than a number for the integer type styles, size may also be: c for char, s for short, i for int, and l for long.

The default action, if no modifier is specified, is to print the value of exp using the /n (normal) format.
Be careful with one letter variable names, as they may be taken as an CrossView Pro command rather than as a variable. If an expression begins with a variable that might be mistaken for a command, then eliminate any white space between the variable and the first operator. For example: use h=9 instead of h = 9.

To display the value of a variable that has the same name as an CrossView Pro command you must use the natural format modifier. For example: to print the value of the variable c, use c/n.

Variables may be altered as a side effect of evaluation of exp. See the example below.

Example

To set variable aux to t times 8, type:

```c
aux = t+++8
```

As a side effect the variable t is post-incremented. If you type:

```c
$s_aux = func(t,s)
```

CrossView Pro will set special variable $s_aux to the result of the function call to func with the variables t and s passed as parameters. If you type:

```c
$s_aux/x2
```

Print the value of the special variable $s_aux as two hex MAUs; you could also use: $s_aux/xs.
Function
Display the C source line numbered \textit{line} in the current source file.

From the \textbf{Edit} menu, select \textbf{Find Line...} Enter the line number and click on the \textbf{Find} button. Alternately, you may click on the desired source line in the Source Window.

Enter the line number in the Command Window. The syntax is:

\textit{line}

Description
The current viewing position becomes \textit{line}.

Example
To display the twelfth line in the current source file, type:

12

e, p, P
string

Function
Echo a string to the terminal.

Enter the string to the Command Window.

Description
A string may contain standard C escapes, such as \n for a newline. The syntax for a string in the Command Window is:

"string"

Example
This function can be useful for labelling breakpoints. For example, to insert a breakpoint at line 12 and have a message printed when that line is reached, enter:

12 b {"At the twelfth line\n"; C}

When CrossView Pro reached line 12, the message “At the twelfth line” will be printed and the program will continue. If you only type:

"Debug"

CrossView Pro will simply echo the word “Debug.”
Function

Instruct CrossView Pro to interpret a command literally, ignoring any macro definitions of the same name. Also, enter a shell command.

The syntax for this command is:

```
[ string ] !
```

or:

```
! [ string ]
```

Description

This command is useful whenever `string` should be treated literally and not as a potential macro invocation. It can be used, for example, in executing an CrossView Pro command whose name has been defined as a macro.

Example

To enter the host environment under a new shell, type:

```
!
```

To execute the host `date` command, type:

```
!date
```

To execute the CrossView Pro command `b` instead of the macro named `b`, type:

```
b!
```

`set, unset, echo, save`
Function

Search down (forward) for a string.

To search for a string in the Source Window, select `Search String...` from the Edit menu and select the up radio button. To repeat your search click on the Find Next Text String button.

The command line syntax is:

```
/ [ string ]
```

Description

The search begins with the line after the current line. If the `string` is found the viewing position is changed to the line containing the string. The execution position is not affected. If you do not specify a string to search for, CrossView Pro will look for the most recent specified string.

Searches wrap around to the beginning of the file. Regular expressions are not recognized.

Example

To look for the next occurrence of `Random` in the current file, beginning with the line after the current line, type:

```
/Random
```
Function

Search up (backward) for a string.

To search for a string in the Source Window, select select **Search String...** from the **Edit** menu and select the **down** radio button. To repeat your search click on the **Find Next Text String** button.

The command line syntax is:

```
? [ string ]
```

Description

The search begins with the line before the current line. If **string** is found, the current line is changed to point to the line containing the string. The execution position is not affected. If you do not specify **string**, CrossView Pro searches for the previously-specified string again.

Searches wrap around to the end of the file. Regular expressions are not recognized.

Example

To look for the previous occurrence of **Random** in the current file, beginning with the line above the current line, type:

```
?Random
```

```
/ , Z
```
Function

Continuous command playback. Read commands continuously from a file.

To setup command playback, select **Playback | CrossView...** from the **Tools** menu. Enable the **Continuous playback** check box and click on the **Execute** button.

The command line syntax is:

```
<file
```

Description

All the commands in *file* will be read and executed. If a playback file contains either a `<` or `<<` command, playback switches to the newly specified file and does not return to the original file.

Record and playback options can also be specified via command line parameters.

If the execution of commands from the playback file is interrupted with the **Halt** button, CrossView Pro will begin reading the remainder of commands in file using single step playback (see the `<<` command.)

Example

To read and execute the commands found in the file *command.cmd*, type:

```
<command.cmd
```

```
<<, >, I
```
Function

Single-step command playback.

To setup command playback, select **Playback | CrossView...** from the **Tools** menu. Disable the **Continuous playback** check box and click on the **Execute** button.

The command line syntax is:

```
<<file
```

Description

Commands will be played back one at a time. Each command will be loaded sequentially into the entry field of the Command Window. The command can then be edited and executed.

The carriage return will execute the current command and stop at the next one.

If a playback file contains either a `<` or `<<` command, playback switches to the newly specified file and does not return to the original file. Record and playback options can also be specified via command line parameters.

Example

To read and execute the commands found in the file `command.cmd`, type:

```
<< command.cmd
```

`<, >, I`
Function

Record CrossView Pro commands to a file.

To start recording or toggle the state of the command recording mechanism, select **Record...** from the **Tools** menu. Type or select a file to record commands in and click on the **Start** button to start recording. To suspend recording click on the **Suspend** button. To resume recording click on the **Resume** button. To stop recording click on the **Stop** button.

The command line syntax is (note that the greater than sign must be typed as shown):

```
> [ ! ] [ file ] t f c
```

Description

CrossView Pro will start recording commands in a file if *file* is specified, otherwise, turn recording on (t), off (f), or close (c) the recording file. Specifying a different file while recording is on will cause the old output file to be closed and all successive commands will be sent to the new file. If no arguments are given, the state of the recording mechanism will be displayed.

The optional '!' forces flushing of the output after every write.

The commands recorded can be played back by using the < or < command. It is possible to have a command recording file and a screen output recording file to be open concurrently. The file is also closed as a side effect of the **q** command.

Commands issued to the emulator under transparency mode are not recorded.

Files may not be named: t, f or c.

Example

To set (or change) the command recording file to *command.cmd* and turn command recording on, type:

```
>command.cmd
```
To suspend recording commands, type:

>`f`

To resume recording the commands to the recording file, type:

>`t`

To stop recording commands and close the file, type:

>`c`

To display the state of the recording mechanism, type:

>`

`>>, >&, <, <<, I, q`
Function

Log Command Window screen output. All Command Window input and output will be saved to a file.

To create a log of Command Window screen output, select Log | Command Input/Output... from the Tools menu. Type or select a file to log to and click on the Start button to start logging. To suspend logging click on the Suspend button. To resume logging click on the Resume button. To turn off logging click on the Stop button.

The command line syntax is:

```
>> [!] [file | t | f | c]
```

Description

Start logging the commands typed and their output in a file if file is specified, otherwise, turn logging on (t), off (f), or close (c) the log file. Specifying a different file while logging is on will cause the old output file to be closed and all successive Command window output will be sent to the new file. If no arguments are given, the state of the recording and logging mechanism is displayed.

The optional '!' forces flushing of the output after every write.

Because output is logged as well as commands, files logged using >> cannot be played back like those recorded with the > command.

It is possible to have both a command recording file and a screen output logging file open concurrently. The log file is also closed as a side effect of the q command. Log files may not be named: t, f or c.

Example

To set (or change) screen output recording file to the file screen.log and turn screen output recording on, type:

```
>>screen.log
```

To suspend recording the screen output, type:

```
>>f
```
To resume recording the screen output in the recording file, type:

    >>t

To stop recording the screen output and close the file, type:

    >>c

To display the state of the recording mechanism, type:

    >>

    >, >& I, q
> &

**Function**

Log communications between debugger and emulator.

To save debugger/emulator communications, select Log | CrossView–Emulator I/O... from the Tools menu. Type or select a file to log to and click on the Start button to start logging. To suspend logging click on the Suspend button. To resume logging click on the Resume button. To turn off logging click on the Stop button.

The command line syntax is:

```
>& [ ! ] [ file | t | f | c ]
```

**Description**

Start host-to-execution environment communication logging in a file if file is specified; otherwise, turn logging on (t), off (f), or close (c) the log file. This feature is most often used to diagnose problems with CrossView Pro itself.

The optional ‘!’ forces flushing of the output after every write.

The commands captured cannot be played back the way commands recorded by the > command can. The log file is also closed as a side effect of the q command.

Not available for all execution environments.

**Example**

To open the file out.log and put the following host-to-emulator communications in this file, type:

```
>&out.log
```

To suspend logging communications in the log file, type:

```
>&f
```

To resume logging communications in the log file, type:

```
>&t
```
To stop logging communications and close the file, type:

```
>&c
>
, >>, q
```
Function

Display contents of preceding memory location based on the size of the last data item displayed.

The command line syntax is:

```
^ [format ]
```

Description

Use previous format or `format`, if supplied. Formats have the syntax:

```
[count] style [size]
```

`count` is the number of times to apply the format `style` and defaults to 1. `style` may be one of:

```
 a c D O U X d o u x E F G e f g i I n P p R r S s t
```

See Chapter 6, *Accessing Code and Data*, and section 3.5 *Formatting Expressions* in Chapter 3, *Command Language*, for details on each of the format styles.

`size` indicates the number of MAUs (Minimum Addressable Units) to be formatted. Rather than a number for the integer type styles, `size` may also be: `c` for char, `s` for short, `i` for int, and `l` for long.

This command is most often used in combination with `exp/format` to look at the value of some variable or memory location.

Example

To display the variable `aux` as two octal values of length two, type:

```
^ aux/2o2
```

To show the four MAUs before `aux` in hexadecimal format, next type:

```
^2x2
```

`expression`
Function

Toggle the state of the assertion mode.

To activate or suspend assertion mode, select **Assertions...** from the Breakpoints menu, and enable or disable the **Assertion Mode Active** check box.

The command line syntax is:

```
A [ a | s ]
```

Description

Activate (A a) or suspend (A s) overall state of the assertion mechanism. If no operand is given, toggle the state.

Example

To activate the assertion mechanism, type:

```
A a
```

To suspend the assertion mechanism, type:

```
A s
```

To toggle the state of the assertion mechanism, simply type:

```
A
```
Function
Define or modify an assertion.

From the Breakpoints menu, select Assertions... to open the Assertions dialog box. Click the New... button to define an assertion. Select an assertion and click the Edit... button to modify an assertion.

The command line syntax is:

```
exp  a { a | d | s }
```

Description
The `a` command is used to invoke two different commands. The syntax for each command is distinct. The first version allows modification of the state of the assertion specified by the expression `exp`. (The assertion can be activated (`a a`), deleted (`a d`) or suspended (`a s`).) The second version creates a new assertion with the given command list `cmds`. Using the mouse, you can create a new assertion or toggle the state of an existing one from the Assertions dialogue box.

Suspended assertions continue to exist, but are not active. Deleted assertions must be explicitly redefined in order to be made active again.

The commands for every active assertion are executed after every source statement is executed. The `x` command in an assertion command list forces an exit from assertion mode.

This command is not allowed when the target runs in the background.

Example
To suspend assertion 3, type:

```
3 a s
```

To delete assertion 1, type:

```
1 a d
```
To set an assertion to stop the program when global variable `myvar` exceeds 3, type:

```c
if (myvar > 3) {x}
```

A, I, x
B

Function
List all of the currently defined breakpoints.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box.

The command line syntax is:

B

Description
Breakpoints are listed with numbers associated with them. These numbers can be used to delete individual breakpoints.

break, b, bb, bB, bi, bi, bu, bU, R, C, D, l
b

Function
Set a code breakpoint.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint... to open the Add Code Breakpoint dialog. Enter the name of the source module or click the Break At... button to select a source module and enter a line number.

Alternatively, you can set a code breakpoint directly in the source by clicking on a green breakpoint toggle next to the source line.

The command line syntax is:

[line] b [commands]

Description
You can attach a list of CrossView Pro commands with the breakpoint. If no line is given, set the breakpoint at the current viewing position.

When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the b command.

Example
To set a breakpoint at the current line, type:

    b

To set a breakpoint at line 10 that will list all global variables and halt execution, type:

    10 b {l g}

break, bd, bD, bdis, bena, bb, bB, bi, bI, bt, bti, bti, bu, bU, Q
Function

Set a temporary breakpoint at the beginning of a function.

In the Stack Window, click on the desired function and select **Stack Breakpoint | At Function Entry** from the **Breakpoints** menu.

The command line syntax is:

```
[ stack ] bB [ cmds ]
```

Description

The function is designated by the stack level `stack`. If no function is specified, CrossView Pro uses the current function (stack level 0), and associates the list of CrossView Pro commands `cmds` with the breakpoint.

Breakpoints set in the Stack Window are always temporary, meaning they will be deleted after the first time you reach them. A breakpoint set in this manner will not be visible in the Source Window.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The `Q` command can be used to suppress the output from the `bB` command.

This command is not allowed when the target runs in the background.

Example

To set a temporary breakpoint at the beginning of the current function which prints a stack trace, type:

```
bB {T}
```

To set a temporary breakpoint at the beginning of the function whose stack number is 2, type:

```
2 bB
```

**break, b, bb, bd, bD, bi, bi, bt, bti, bti, bu, bU, Q**
**bb**

**Function**
Set a permanent breakpoint at the beginning of a function.

In the Stack Window, click on the desired function and select **Stack Breakpoint | At Function Entry** from the Breakpoints menu. To make the stack breakpoint permanent, select **Breakpoints...** from the Breakpoints menu, select the desired breakpoint and click on the **Edit...** button. The Edit Code Breakpoint dialog appears. Click on the Advanced>> button and disable the **Remove when hit** check box.

The command line syntax is:

```
[ stack ] bb [ cmds ]
```

**Description**
Set a breakpoint at the beginning of the function designated by the stack level `stack`. Otherwise, use the current function (stack level 0), and associate the list of CrossView Pro commands `cmds` with the breakpoint.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bb** command.

This command is not allowed when the target runs in the background.

**Example**
To set a breakpoint at the beginning of the current function, which prints a stack trace, type:

```
bb {T}
```

To set a breakpoint at the beginning of a function whose stack number is 2, type:

```
2 bb
```

**break, b, BB, bd, bD, bi, bi, bt, bti, bti, bu, bu, Q**
bc

Function
Set a breakpoint’s count and reset count.

From the Breakpoints menu, select Breakpoints…, select the breakpoint for which you want to set the count and reset count and click on the Edit… button. The Edit Code Breakpoint dialog appears. Click on the Advanced button and enter a breakpoint count.

The command line syntax is:

```
[ number ] bc [ count ] [ reset_count ]
```

Description
Set the count and reset_count for the breakpoint with breakpoint number number. When no arguments are given, the breakpoint at the current viewing position is set to a count of 1 and a reset count of 1. If no breakpoint is present at the current viewing position, the message "No such breakpoint" appears.

Each time a breakpoint is hit, CrossView Pro decrements the count. When the count reaches 0, execution is halted and the count is reset to the reset_count.

This command is not allowed when the target runs in the background.

Example
To set a breakpoint’s count and reset count to 1 for the breakpoint at the current viewing position, type:

```
bc
```

To set the count to 3 and the reset count to 4 for the breakpoint whose breakpoint number is 2, type:

```
2 bc 3 4
```

break, C
Function

Set a temporary cycle count breakpoint.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Cycle Breakpoint... to open the Add Cycle Breakpoint dialog. Click the Advanced button and enable the Remove when hit check box.

The command line syntax is:

```
  count bCYC [cmds]
```

Description

Set a temporary breakpoint after the specified cycle count. count can be any expression evaluating to a number. The list of CrossView Pro commands cmds are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the bCYC command.

Example

To set a temporary breakpoint after 4 clock cycles and list all global variables, type:

```
  4 bCYC {l g}
```

break, b, bcyc, bINST, binst, bTIM, btim, D
**bcyc**

**Function**
Set a permanent cycle count breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Cycle Breakpoint...** to open the Add Cycle Breakpoint dialog. Enter a cycle count and click the **OK** button.

The command line syntax is:

```
count bcyc [cmds]
```

**Description**
Set a permanent breakpoint after the specified cycle *count*. *count* can be any expression evaluating to a number. The list of CrossView Pro commands *cmds* are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bcyc** command.

**Example**
To set a cycle count breakpoint after 4 clock cycles and list all global variables, type:

```
4 bcyc {l g}
```

`break, b, bCYC, bINST, binst, bTIM, btim, D`
bD

Function
Set a read and/or write data breakpoint over a range of addresses.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Data Breakpoint... to open the Add Data Breakpoint dialog. Enter an address or click the Address... button to select a symbol to use as the address. Click the Advanced button. Enter an address in the End address field or click the Browse... button to select a symbol to use as the end address. Click the OK button to add the data breakpoint.

The command line syntax is:

```
exp1 bD { r | w | b } exp2 [cmds]
```

Description
Set a read, write, or both (read and write) data breakpoint in the address range exp1 to exp2 and associate the list of CrossView Pro commands cmds with the breakpoint.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the bD command.

If exp1 is the address of a local (stack) variable, the function in which it was declared must be currently active on the stack. If the local variable corresponding to a data breakpoint goes out of scope due to a return from the function in which it is currently active, the data breakpoint will be removed and a message will be printed telling the user that the variable is no longer active.

Not available for all execution environments.

Example
To set a data breakpoint that includes the entire structure rec1, type:

```
&rec1 bD r (int)&rec1+sizeof(rec1)-1
```
This breakpoint will be hit only if any address in the range of addresses is read from.

To set a data breakpoint for the address range 10 to 10f hex (256 bytes) that will list all global variables, type:

```
0x10 bD b 0x10f {l g;}
```

This breakpoint will be hit if any memory locations within the range 10–10f hex are either read from or written to.

```
break, b, bb, bB, bd, bi, bI, bt, bti, btI, bu, bU, Q
```
bd

Function

Set a read and/or write data breakpoint at an address.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Data Breakpoint... to open the Add Data Breakpoint dialog. Enter an address or click the Address... button to select a symbol to use as the address. Click the OK button to add the data breakpoint.

The command line syntax is:

```
exp bd { r | w | b } [cmds ]
```

Description

Set a read, write or both (read and write) data breakpoint at the address specified by exp and associate the list of CrossView Pro commands cmds with the breakpoint.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the bd command.

If exp corresponds to a local (stack) variable, the function in which it was declared must be currently active on the stack. If the local variable corresponding to a data breakpoint goes out of scope due to a return from the function in which it is currently active, the data breakpoint will be removed and a message will be printed telling you that the variable is no longer active.

Not available for all execution environments.

Example

To set a breakpoint at the variable count which will all be hit only if the variable is read from memory, type:

```
&count bd r
```
To set a breakpoint at address 10 hex that will list all global variables, type:

```
0x10 bd b {l g}
```

This breakpoint will be hit if address 10 hex is either read from or written to.

```
break, b, bb, bB, bD, bi, bi, bt, bti, bti, bu, bu, bU, Q
```
bdis

Function

Disable code breakpoint.

From the Breakpoints menu, select Breakpoints... On Windows toggle the check box in front of the breakpoint to enable or disable the breakpoint. On UNIX select the breakpoint and click the Enable or Disable button.

The command line syntax is:

\[ \text{number \ bdis} \]

Description

Disable the code breakpoint associated with the given number.

This does not delete the code breakpoint. It disables the code breakpoint until you enable it again with the bena command.

This command does not work on data breakpoints, only on code breakpoints.

Example

To disable code breakpoint number 3, type:

\[ 3 \ bdis \]

break, b, bena, D
bena

Function

Enable code breakpoint.

From the Breakpoints menu, select Breakpoints... On Windows toggle the check box in front of the breakpoint to enable or disable the breakpoint. On UNIX select the breakpoint and click the Enable or Disable button.

The command line syntax is:

    number  bena

Description

Enable the code breakpoint associated with the given number, which was previously disabled by the bdis command.

This command does not work on data breakpoints, only on code breakpoints.

Example

To enable code breakpoint number 3, type:

    3  bena

break, b, bdis, D
**bl**

**Function**

Set a temporary low-level breakpoint at a machine instruction.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Code Breakpoint...** to open the Add Code Breakpoint dialog. Edit the **Break At...** field. In the Advanced dialog enable the **Remove when hit** check box.

The command line syntax is:

```
[addr]  bl  [cmds]
```

**Description**

Set a temporary breakpoint at the machine instruction at address `addr`, or the current viewing position’s address if `addr` is not specified; the list of CrossView Pro commands `cmds` are executed when the breakpoint is hit.

Make sure that `addr` is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the `bl` command.

**Example**

To set a temporary breakpoint at the current viewing position’s address, type:

```
bI
```

To set a temporary breakpoint at address 100 that will print the addresses of the next five source statements, type:

```
100  bI  {P 5}
```

**break, b, bb, bB, bd, bD, bi, bt, bti, btI, bu, bU, Q**
bi

Function

Set a permanent low-level breakpoint at a machine instruction.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add button and select Code Breakpoint... to open the Add Code Breakpoint dialog. Edit the Break At... field. In the Advanced dialog disable the Remove when hit check box.

Alternatively, you can place a breakpoint in the intermixed window or assembly window by double clicking on the desired instruction.

The command line syntax is:

\[ [addr] \ bi \ [cmds] \]

Description

Set a permanent breakpoint at the machine instruction at address addr, or the current viewing position’s address if addr is not specified; the list of CrossView Pro commands cmds are executed when the breakpoint is hit.

Make sure that addr is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the bi command.

Example

To set a breakpoint at the current viewing position’s address, type:

bi

To set a breakpoint at address 100 that will print the addresses of the next five source statements, type:

100 bi {P 5}

break, b, bb, bB, bd, bD, bi, bt, bti, btI, bu, bU, Q
**bINST**

**Function**
Set a temporary instruction count breakpoint.

- From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Instruction Breakpoint...** to open the Add Instruction Breakpoint dialog. Type a value in the **Instruction count** field and enable the **Remove when hit** check box in the Advanced dialog.

- The command line syntax is:

  \[ \text{count bINST [cmds]} \]

**Description**
Set a temporary breakpoint after the specified \( \text{count} \) number of machine instructions have been executed. \( \text{count} \) can be any expression evaluating to a number. The list of CrossView Pro commands \( \text{cmds} \) are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The \texttt{Q} command can be used to suppress the output from the \texttt{bINST} command.

**Example**
To set a temporary breakpoint after execution of 5 instructions and list all global variables, type:

\[ \text{5 bINST \{l g\}} \]

\texttt{break, b, bCYC, bcyC, binst, bTIM, btim, D}
binst

Function
Set a permanent instruction count breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Instruction Breakpoint...** to open the Add Instruction Breakpoint dialog. Type a value in the **Instruction count** field and disable the **Remove when hit** check box in the Advanced dialog.

The command line syntax is:

```
count binst [cmds]
```

Description
Set a permanent breakpoint after the specified `count` number of machine instructions have been executed. `count` can be any expression evaluating to a number. The list of CrossView Pro commands `cmds` are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The `Q` command can be used to suppress the output from the `binst` command.

Example
To set a permanent breakpoint after execution of 5 instructions and list all global variables, type:

```
5 binst {l g}
```

**break, b, bCYC, beyc, bINST, bTIM, btim, D**
break

Function

Universal breakpoint command.

From the Breakpoints menu, select Breakpoints... to add/remove/enable/disable breakpoints.

The general command line syntax is:

\[ \text{break [type] where [, option]} \ldots \]

Description

This is a universal breakpoint command.

type can be one of: code | data | instructions | cycles | time | sequence | set | delete | enable | disable. The type can be abbreviated. So, t | ti | tim | time are the same. When the type field is not specified the type defaults to code.

Depending on the type field the where field will evaluate to an address, count, name, breakpoint number or a sequence.

The available options are listed below.

Code breakpoints

Syntax:

\[ \text{break code address [, option]} \ldots \]

address can be any expression evaluating to an address.

Data breakpoints

Syntax:

\[ \text{break data address [, option]} \ldots \]

address can be any expression evaluating to an address.
Instruction count breakpoints

Syntax:

```
break instructions count [, option]...
```

count can be any expression evaluating to the number of instructions.

Cycle count breakpoints

Syntax:

```
break cycles count [, option]...
```

count can be any expression evaluating to the number of cycles.

Timer breakpoints

Syntax:

```
break timer time [, option]...
```

time can be any expression evaluating to a time value. Depending on the setting of the timer_unit option this value is in seconds or timer ticks (default is in seconds).

Sequence breakpoints

Syntax:

```
break sequence sequence [, option]...
```

sequence is a combination of breakpoints.

Set/change breakpoint attributes

Syntax:

```
break set bp_number | bp_name [, option]...
```

bp_number is the breakpoint number. If the breakpoint has a name (bp_name) you can use this name instead of a number.
Delete breakpoint attributes

Syntax:

```
break delete bp_number | bp_name | all [, option]...
```

*bp_number* is the breakpoint number. If the breakpoint has a name (*bp_name*) you can use this name instead of a number.

Enable/disable breakpoints

Syntax:

```
break enable bp_number | bp_name
break disable bp_number | bp_name
```

*bp_number* is the breakpoint number. If the breakpoint has a name (*bp_name*) you can use this name instead of a number.

Options

**name=str**

Change/set the name of a breakpoint. Note that when a name of a breakpoint which name is used in a sequence is changed the name in the sequence is not automatically changed.

**temporary[=bool]**

Single shot breakpoint, temporary breakpoints are deleted after they are hit.

**enabled[=bool]**

Enable or disable a breakpoint.

**curr_count=expr**

Set current count.

**reset_count=expr**

Set reset count.

**count=expr**

Set current and reset count of a breakpoint.
access_type=r | w | rw

Set the access type of a data breakpoint: read (r), write (w) or read/write (rw).

addr=expr

Set the (start)address for a code or data breakpoint.

value=expr

set the value for a data breakpoint.

method=hardware | software | none

Set the breakpoint method.

probe_point[=bool]

Treat the breakpoint as a probe point. When a probe point breakpoint is hit the associated commands are executed and program execution is continued. Probe points do not update CrossView Pro windows.

size=expr

Length of a data or code breakpoint (end_addr = begin_addr+size–1).

end_addr=expr

The end address of a range is inclusive.

end_value=expr

The end value is inclusive.

value_is_absolute[=bool]

For instructions and cycles breakpoints only, the specified value is an absolute count, breakpoint will hit when count has value, otherwise repeat every number of instructions.

commands={ commands }

Set breakpoint commands.

timer_unit=seconds | ticks

The specified timer value is in seconds or ticks.
bool

1 | 0 | true | false

True/false, case insensitive.

expr

Appropriate CrossView expression.

Example

To set a code breakpoint at an address range, type:

```
break code code:0x10, end_addr=code:0x1f
```

To set a code breakpoint at an address range by specifying a size, type:

```
break code:0x10, size=0x10
```

To set a code breakpoint with a name, type:

```
break code:0x10, name=brk_1
```

To disable the breakpoint with name brk_1, type:

```
bbreak dis brk_1
```

To set a cycle count breakpoint and treat the value as an absolute count, type:

```
bbreak cycles 1000, value_is_absolute
```

Chapter 7, Breakpoints.
**bt**

**Function**

Set a task aware code breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Code Breakpoint...** to open the Code Breakpoint dialog. Fill in the **Task ID** field.

The command line syntax is:

```
[line] bt "TaskId" [cmds]
```

**Description**

Set a task aware code breakpoint at the specified source **line** and associate the list of CrossView Pro commands **cmds** with the breakpoint. If no line is given, set the breakpoint at the current viewing position. The **TaskId** is the identification of the task as displayed in the Tasks Window or specified by the **lk** command.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bt** command.

**Example**

To set a breakpoint for task 4 at the current viewing position, type:

```
bt "4"
```

To set a breakpoint for task 4 at line 10, which lists all global variables, type:

```
10 bt "4" {l g}
```

**break, b, bb, bB, bd, bD, bi, bI, bti, btl, bu, bU, l, Q**
Function

Set a temporary low-level task aware breakpoint at a machine instruction.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint... to open the Code Breakpoint dialog. Edit the Break At... field and fill in the Task ID field. In the Advanced dialog enable the Remove when hit check box.

The command line syntax is:

```
[addr] btl "TaskId" [cmds]
```

Description

Set a temporary task aware breakpoint at the machine instruction at address addr, or the current viewing position’s address if addr is not specified; the list of CrossView Pro commands cmds are executed when the breakpoint is hit. The TaskId is the identification of the task as displayed in the Tasks Window or specified by the I k command.

Make sure that addr is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the btl command.

Example

To set a temporary breakpoint for task 4 at the current viewing position’s address, type:

```
btl "4"
```

To set a temporary breakpoint for task 4 at address 0xF00 and print the message, type:

```
0xF00 btl "4" {"breakpoint triggered:
    address 0xF00, task 4"}
```

break, b, bb, bB, bd, bD, bi, bI, bt, bti, bu, bU, l, Q
Function

Set a permanent low-level task aware breakpoint at a machine instruction.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint... to open the Code Breakpoint dialog. Edit the Break At... field and fill in the Task ID field. In the Advanced dialog disable the Remove when hit check box.

The command line syntax is:

```
[addr] bti "TaskId" [cmds]
```

Description

Set a permanent task aware breakpoint at the machine instruction at address \( addr \), or the current viewing position’s address if \( addr \) is not specified; the list of CrossView Pro commands \( cmds \) are executed when the breakpoint is hit. The \( TaskId \) is the identification of the task as displayed in the Tasks Window or specified by the \( l k \) command.

Make sure that \( addr \) is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The \( Q \) command can be used to suppress the output from the \( bti \) command.

Example

To set a breakpoint for task 4 at the current viewing position’s address, type:

```
bti "4"
```

To set a breakpoint for task 4 at address \( 0xF00 \) and print the message, type:

```
0xF00 bti "4" {"breakpoint triggered:
address 0xF00, task 4"}
```

\( break, b, bb, bB, bd, bD, bi, bi, bt, btI, bu, bU, l, Q \)
**bTIM**

**Function**
Set a temporary time breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Timer Breakpoint...** to open the Add Timer Breakpoint dialog. Enter a value in the **Time** field and enable the **Remove when hit** check box in the Advanced dialog.

The command line syntax is:

```
time bTIM [cmds]
```

**Description**
Set a temporary breakpoint after the specified **time** (in seconds). **time** can be any expression evaluating to a number. The list of CrossView Pro commands **cmds** are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bTIM** command.

**Example**
To set a temporary breakpoint after 0.5 seconds and list all global variables, type:

```
0.5 bTIM {l g}
```

`break, b, bCYC, bcyc, bINST, binst, btim, D`
**btim**

**Function**

Set a permanent time breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add** button and select **Timer Breakpoint...** to open the Add Timer Breakpoint dialog. Enter a value in the **Time** field and disable the **Remove when hit** check box in the Advanced dialog.

The command line syntax is:

```
> time btim [cmds]
```

**Description**

Set a permanent breakpoint after the specified time (in seconds). time can be any expression evaluating to a number. The list of CrossView Pro commands cmds are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the btim command.

**Example**

To set a permanent breakpoint after 0.5 seconds and list all global variables, type:

```
> 0.5 btim {l g}
```

break, b, bCYC, bcyc, bINST, binst, btIM, D
Function

Set a temporary up-level breakpoint (to finish the function at a specific stack level).

In the Stack Window, double-click on the desired function. Alternately, you can click on the desired function in the Stack Window and select Stack Breakpoint | After Call to Function from the Breakpoints menu.

The command line syntax is:

```
[bU] [stack] [bU] [commands]
```

Description

This command sets a temporary up-level breakpoint immediately after the call to the function designated by the stack number `stack`, otherwise the currently viewed function is used. Associate the list of CrossView Pro commands `commands` with the breakpoint.

When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The `Q` command can be used to suppress the output from the `bU` command.

Breakpoints set in the Stack Window are always temporary, meaning they will be deleted after the first time you reach them. A breakpoint set in this manner will not be visible in the Source Window.

This command is not allowed when the target runs in the background.

Example

To set a temporary up-level breakpoint immediately after the call to the currently viewed function, type:

```
bU
```

To set a temporary up-level breakpoint immediately after the call to the function at stack level 2, type:

```
2 bU {1}
```
After stopping, this command will cause CrossView Pro to print out the function's local variables and arguments.

break, b, bb, bB, bd, bD, bi, bt, bti, btl, bu, Q


**bu**

**Function**

Set a permanent up-level breakpoint (to finish the function at a specific stack level).

Click on the desired function in the Stack Window and select **Stack Breakpoint | After Call to Function** from the **Breakpoints** menu. To make the stack breakpoint permanent, select **Breakpoints...** from the **Breakpoints** menu, select the desired stack breakpoint and click on the **Edit...** button. The Edit Code Breakpoint dialog appears. Click on the **Advanced>>** button and disable the **Remove when hit** check box.

The command line syntax is:

```
[ stack ] bu [ commands ]
```

**Description**

Set a permanent up-level breakpoint immediately after the call to the function designated by the stack number `stack`, otherwise the currently viewed function is used. Associate the list of CrossView Pro commands `commands` with the breakpoint.

When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bu** command.

This command is not allowed when the target runs in the background.

**Example**

To set a temporary up-level breakpoint immediately after the call to the currently viewed function, type:

```
bu
```

To set an up-level breakpoint immediately after the call to the function at stack level 2 and, after stopping, print out the local variables and arguments of that function, type:

```
2 bu {l}
```
break, b, bb, bB, bd, bD, bi, bt, bti, btI, bU, Q
**bufa**

**Function**
Append the contents of one buffer to another buffer.

The command line syntax is:

```
bufa target_buffer_name,added_buffer_name[size_limit]
```

**Description**
Add the contents of buffer *added_buffer_name* to buffer *target_buffer_name*. If *size_limit* is specified, buffer *target_buffer_name* will be trimmed down to the specified size (keeping *size_limit* elements of the tail of the buffer).

**Example**
To append the contents of $buffer$ to buffer $all_data$, and keep the last 1024 elements, type:

```
bufa $all_data,$buffer,1024
```

**bufd, graph, memget.**
Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
bufd

Function
Free a used buffer.

The command line syntax is:

```
bufd buffer_name
```

Description
Discard the specified buffer (if the target data is not to be used anymore).

Example
To discard buffer $buffer, type:

```
bufd $buffer
```

bufa, graph, memget.
Section 11.5, Data Analysis, in Chapter Special Features.
**Function**

Continue using the current value of the program counter.

In the Source Window, click on the Run/Continue button. You can also select Run from the Run menu.

The command line syntax is:

```
[ exp ]  C  [ line ]
```

**Description**

If `exp` is specified and you are stopped at a breakpoint, then the breakpoint count is set to this value. If `line` is specified, a temporary breakpoint is set at that line number. Note that this temporary breakpoint will overwrite any existing breakpoint at that line.

The **C** command can be used in the command lists of breakpoints to resume execution automatically.

This command is not allowed when the target runs in the background.

**Example**

To continue execution from the current target program counter, type:

```
C
```

To set the breakpoint’s count to 4 and continue, type:

```
4  C
```

To set a temporary breakpoint at line 52 and continue, type:

```
C  52
```

- **break**, **bc**, **g**, **R**, **CB**
CB

Function

Continue execution in background using the current value of the target program counter.

The command line syntax is:

\[ \text{exp} \mid \text{CB} \mid \text{line} \]

Description

If exp is specified and you are stopped at a breakpoint, then the breakpoint count is set to this value. If line is specified, a temporary breakpoint is set at that line number. Note that this temporary breakpoint will overwrite any existing breakpoint at that line.

The CB command can be used in the command lists of breakpoints to resume execution automatically.

This command is not allowed when the target runs in the background.

Not available for all execution environments.

Example

To continue execution from the current target program counter, type:

\[ \text{CB} \]

To set the breakpoint’s count to 4 and continue, type:

\[ \text{4 CB} \]

To set a temporary breakpoint at line 52 and continue, type:

\[ \text{CB 52} \]

\[ \text{g, R, C, st, wt} \]
**cd**

**Function**

Disable, turn off, gathering of coverage data.

From the **Tools** menu, select **Coverage** if this item was set.

The command line syntax is:

```
  cd
```

**Description**

If coverage is supported by your version of CrossView Pro, this command disables the coverage system. Normally, you should disable coverage if you are not interested in the coverage results, as this will often improve the performance of the execution environment.

**Example**

To disable coverage, type:

```
  cd
```

```
  ce, nc, nU, pC, pU
```
ce

Function

Enable, turn on, gathering of coverage data.

From the **Tools** menu, select **Coverage** if this item was not set.

The command line syntax is:

```
cc
```

Description

If coverage is supported by your version of CrossView Pro, this command enables the coverage system. Normally, you should disable coverage if you are not interested in the coverage results, as this will often improve the performance of the execution environment.

Example

To enable coverage, type:

```
cc
```

```
cd, nC, nU, pC, pU
```
clear

Function
Clear the Command Output Window.

The command line syntax is:

```
clear
```

Description
Use this command if you want to clear the output window part of the Command Window.

Example
To clear the Command Output Window, type:

```
clear
```
covinfo

Function
List coverage information.

From the Tools menu, select Code Coverage..., make your changes and select the Update button.

The command line syntax is:

```
covinfo [all | module_or_function_name][filename]
```

Description
If coverage is supported by your version of CrossView Pro and coverage is enabled, this command lists the coverage information. Without arguments (same as all) this command lists the coverage information of all modules and functions.

Instead of listing the results you can also save the results in a file with extension .cov.

Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example
To list the coverage information of all modules and functions to the output window, type:

```
ce
covinfo
```

To list coverage information of function main to the output window, type:

```
covinfo main
```

To list coverage information of all modules and functions in file hello.cov, type:

```
covinfo all,hello.cov
```

.cd, ce, proinfo
cproinfo

Function

List cumulative profiling results or add or remove functions from the list of profiled functions.

From the Tools menu, select Cumulative Profiling Setup..., make your changes and click the OK button. Select Cumulative Profiling Report... to see the cumulative profiling report.

The command line syntax is:

```
cproinfo [all|filename] | {add | remove } function
```

Description

If profiling is supported by your version of CrossView Pro and profiling is enabled, this command lists the cumulative profiling results. Without arguments (same as all) this command lists the cumulative profiling information of all functions.

Instead of listing the results you can also save the results in a file with extension .cpr.

Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example

To list the cumulative profiling results of all functions to the output window, type:

```
pe

cproinfo
```

To dump cumulative profile information of all functions in file hello.cpr, type:

```
cproinfo all,hello.cpr
```

To add function main to the list of profiled functions, type:

```
cproinfo add main
```
To remove function `main` from the list of profiled functions, type:

```
cproinfo remove main
```

`proinfo`, `pd`, `pe`
Function

Display a C-execution trace.

From the View menu, select Trace | Source Level. The Trace Window displays the most recently executed lines of code every time program execution is stopped. CrossView Pro automatically updates the Trace Window each time execution is halted, as long as the window is open.

The command line syntax is:

```
number ct
```

Description

Display a C-execution trace in the Command window, corresponding to the last number of machine instructions executed. Since the ct command relies on the emulator’s trace buffer, the ct command will not be implemented on some emulators.

For each executed line of code, the Trace Window displays:

- The name of the source file
- The name of the function
- The line number and corresponding source code

The window shows all the code executed since the the last time the program halted.

This command is not allowed when the target runs in the background.

Not available for all execution environments.

Example

To display, in the Command window, the last C statements (corresponding to the last ten machine instructions) executed, type:

```
10 ct
```

ct i, ct r
**ct i**

**Function**

Display a disassembled trace.

From the **View** menu, select **Trace | Instruction Level**. The Trace Window displays the most recently executed lines of code every time program execution is stopped. CrossView Pro automatically updates the Trace Window each time execution is halted, as long as the window is open.

The command line syntax is:

```
number ct i
```

**Description**

Display a disassembled trace in the Command window, corresponding to the last `number` of machine instructions executed.

On execution environments other than the simulator, this command shows the last `number` of ‘change-of-flow’ instructions. See chapter 10.9 Trace Buffer, of the DSP56300 Family Manual for more information on the trace buffer of the DSP563xx.

Since the `ct i` command relies on the emulator’s trace buffer, the `ct i` command will not be implemented on some emulators (or implemented differently).

This command is not allowed when the target runs in the background.

Not available for all execution environments.

**Example**

To display in the Command window the last 20 disassembled instructions executed, type:

```
20 ct i
```

`ct, ct r`
### ct r

**Function**
Display a raw trace.

From the View menu, select **Trace | Raw**. The Trace Window displays the most recently executed lines of code every time program execution is stopped. CrossView Pro automatically updates the Trace Window each time execution is halted, as long as the window is open.

The command line syntax is:

```
number ct r
```

**Description**
Display a raw trace in the Command window, corresponding to the last `number` of trace frames. This command merely shows the contents of the emulator's trace buffer.

Since the `ct r` command relies on the emulator's trace buffer, the `ct r` command will not be implemented on some emulators.

This command is not allowed when the target runs in the background.

Not available for all execution environments.

**Example**
To display in the Command window the last 20 trace frames, type:

```
20 ct r
```

`ct, ct i`
D

Function
Delete all currently defined breakpoints.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click on the Remove All button.

The command line syntax is:

D[y]

Description
D deletes all currently defined breakpoints. Dy does not ask for confirmation.

break, B, d
**d**

**Function**

Delete a specific breakpoint.

To delete a code breakpoint directly from the C source, click on the red breakpoint toggle next to the corresponding, source line in the Source Window.

Otherwise, select **Breakpoints...** from the **Breakpoints** menu to open the Breakpoints dialog box. Select the breakpoint you want to remove and click on the **Remove** button.

The command line syntax is:

```
[ number ] d
```

**Description**

Delete the breakpoint associated with the given `number`. If no number is given, delete the breakpoint at the current line. If there is no breakpoint at the current line, a **B** command will be executed to display all breakpoints.

Whenever a breakpoint is deleted the remaining breakpoints are renumbered starting at 0.

**Example**

To delete a breakpoint at the current line, type:

```
d
```

To delete breakpoint number 3, type:

```
3 d
```

**break, b, bb, bB, bd, bD, bi, bi, bt, bti, btl, bu, bU, B, D**
Command Reference

dcmp

Function
Compare a file with the downloaded application.

From the File menu, select Compare Application... Specify an application file and click on the Compare button.

The command line syntax is:

dcmp [file] [number_of_hits] [d]

Description
Compare an application file with the memory contents and display differing memory addresses or addresses and values. If you have already loaded an application you can invoke this command without specifying a file name. You can limit the number of differences by specifying a number_of_hits. The value 0 means there is no limit on the number of differences.

This command is not allowed when the target runs in the background.

Example
To compare the currently loaded application, there is no limit on the number of differences and the contents of differing memory addresses are not displayed, type:

dcmp

To compare the currently loaded application and stop when the number of differences equals 10, type:

dcmp ,10

To compare the currently loaded application there is no limit on the number of differences and display the contents of differing memory addresses, type:

dcmp ,,d
To compare file test.abs, stop if the number of differences equals 5 and display the contents of differing memory addresses, type:

```
dcmp "test.abs",5,d
```

```
dn
```
di_state

Function
Open, save/restore, close a debug instrument state.

From the Target menu, select Save/Restore Target State...

The command line syntax is:

- `di_state open state_name`
- `di_state save state_name, number`
- `di_state restore state_name, number`
- `di_state close state_name, delete`

Description
Before a state can be saved, restored or closed it must be opened first. To open a state use the `di_state open state_name` command. When opened successfully the name is added to the available state names list.

With the `di_state save` command you can now save the state of the debug instrument with the specified `state_name` and `number`. With `di_state restore` you can restore a previously saved state of the debug instrument with the specified `state_name` and `number`.

Use `di_state close` to close a state. The `delete` flag can be 1 to delete the state or use 0 to keep the state.

This feature is only available when it is supported by the debug instrument.

Example
To open and save a state, type:

```
    di_state open S1
    di_state save S1, 0
```

To restore a state, type:

```
    di_state restore S1, 0
```
dis

Function
Disassemble a range of memory.

From the View menu, select Source | Disassembly or Source | Source and Disassembly window respectively.

The command line syntax is:

```
dis address [, {address | #count} [,i]]
```

Description
Disassemble a range of memory. The output is interleaved with source lines when i is specified. You can enter valid expressions as well for address and count.

Example
To disassemble 4 instructions starting at 3 bytes behind the start address of the function main., type:

```
dis main+3,#4
```

To disassemble memory for (initval+1) instructions, starting at the address of the function main., type:

```
dis main+3,#initval+1
```

To disassemble from 0x2000 up to and including the instruction at 0x2100 and also interleave C source lines of any function resident in that memory range, type:

```
dis 0x2000,0x2100,i
```

dump, expression
**dn**

**Function**

Download a file.

From the **File** menu, select **Download Application...** to download the image part of the file to the execution environment.

The command line syntax is:

```
  dn  [file ]
```

**Description**

Download the image part of the specified `file` to the execution environment. If no `file` is specified, use the file specified when CrossView Pro was invoked, and from which the symbolic information was read during startup, or the file specified in either the **N** command or the Load Symbolic Debug Info dialog.

Downloading a file only copies an image part into target memory. It will not cause CrossView Pro to re-read symbolic information.

This command is not allowed when the target runs in the background.

**Example**

To download the current file, type:

```
  dn
```

To download the IEEE file `demo.abs`, type:

```
  dn demo.abs
```

To download the hex file `test.hex`, type:

```
  dn test.hex
```

I, N
**dnm**

**Function**

Download a file into a specific memory space

From the **File** menu, select **Download Application...** to download the image part of the file to the execution environment. Select a memory space in the **Start address** list selection box.

The command line syntax is:

```
 dnm  mem_space  [file]
```

**Description**

Download the image part of the specified file to the execution environment into the specified memory space `mem_space`. The file must contain data in hexadecimal format, that is, Intel Hex, Motorola S-records, Tektronix Hex and Extended Tektronix Hex formats are supported. If no file is specified, use the file specified when CrossView Pro was invoked, or the file specified in either the **N** command or the **Load Symbolic Debug Info** dialog.

`mem_space` can be one of `_P`, `_X` or `_Y`.

This command is not allowed when the target runs in the background.

**Example**

To download the current file into memory space `_P`, type

```
 dnm  _P
```

To download the IEEE file `demo.abs` into memory space `_P`, type:

```
 dnm  _P demo.abs
```
**dump**

**Function**
Dump a range of memory.

From the **View** menu, select **Memory** | **New** to open a Memory Window.

The command line syntax is:

```
dump address [, address | #count] [, style [width ]] [, filename [, a]]
```

**Description**

The **dump** command can dump memory as hexadecimal data or as C variables. You can enter valid C expressions as well for **address** and **count**. You can also dump Motorola S records or Intel hex records. Also, you can specify a **filename** in which the dump is to be written or appended.

**style** can be one of:

```
a c D O U X d o u x E F G e f g n P p R r s t I M
```

Style **I** dumps Intel hex and style **M** specifies Motorola S records output. See Chapter 6, *Accessing Code and Data*, and section 3.5, *Formatting Expressions*, in Chapter 3, *Command Language*, for details on each of the other format styles. The **R** and **r** style are only available for targets that support the fractional type.

Mind the following:

- the commas are required
- the addresses can also be C expressions
- default width is MAU (usually byte) sized words
- additional style **M**: Motorola S records
- additional style **I**: Intel hex
- a semicolon is a command terminator
- the **dump** is end address INclusive

**Example**

To dump the first byte of the function **main**, type:

```
dump main
```
To dump the first 10 bytes of the function `main` as Motorola S records in the file `main.sre`, type:

```
dump main,main+10,M,main.sre
```

To dump the first 5 bytes of the function `main` as 1 string, type:

```
dump main,main+10,M,main.sre,a
```

To append the first 5 bytes of the function `main` as 1 string, type:

```
dump main,,c5
```

To dump the resulting value bytes of `the address of main binary anded with 3`, type:

```
dump main+1,#main&3
```

To dump the first 16 MAUs of address `_P:0xFF0000` in the file `bootrom.dmp`, type:

```
dump _P:0xFF0000,#16,bootrom.dmp
```

```
dis, expression
```
e

Function

Establish viewing position

From the **File** menu, select **Open Source...** to view a file. In the Source Window, click on the **Find Symbol** button to find a function, or select **Find Symbol...** from the **Edit** menu.

In the Stack Window click once on the function to be examined.

The command line syntax is:

```
e  [file | function ]
stack  e
```

Description

The *e* option invokes two distinct commands. The first version establishes the viewing position to be the first line of *file*, the first executable line of the function *function* or the current viewing position if no argument is given.

The second version establishes the viewing position to be the line at stack level *stack* in the stack trace. (See the *t* command.)

The *stack e* command is not allowed when the target runs in the background.

The *L* command is equivalent to *0 e*.

Example

To view the function main, type:

```
e main
```

To view the test file *test.c*, type:

```
e test.c
```

To view the call site of the current function, type:

```
0 e
```
To view the line at stack level 3, type:

3 e

?, /, ei, L, p, P, t
Function
Start execution on current CPU and switch to another CPU.

The command line syntax is:

```
cpu_number eC
```

Description
Start execution on the current CPU and switch to CPU `cpu_number`.

This command can only be issued when the currently selected CPU is in debug mode.

Example
To start execution on the current CPU and select the CPU indicated by number 1, type:

```
1 eC
```

```
eC
```
**ec**

**Function**

Select a CPU or show current CPU number.

From the **Target** menu, select **Select Target CPU...**
(Also allowed while the currently selected CPU is running.)

The command line syntax is:

```
[cpu_number] ec
```

**Description**

The **ec** command allows you to select a CPU in your current Execution Environment if your target has multi-CPU support.

This command can only be issued when the currently selected CPU is in debug mode.

**Example**

To view the current CPU selection, type:

```
ec
```

To select the CPU indicated by number 1, type:

```
1 ec
```

eC
**echo**

**Function**
Display the definition of a macro name without executing the macro.

From the **Tools** menu, select **Macro Definitions...** to view the definition of a macro.

The command line syntax is:

```
  echo  text
```

**Description**
Perform macro expansion on *text* without executing. This allows you to see how a macro is expanded. It is particularly informative when macros call other macros.

**Example**
If you type:

```
  echo macro(3)
```

CrossView Pro will display the expansion of `macro(3)`.

```
set, unset, save, !
```


**Function**

Establish viewing position at a specified address.

From the **Edit** menu, select **Find Address...**

The command line syntax is:

```
[addr] ei
```

**Description**

The **ei** command establishes the viewing position to be at the instruction specified.

This command is useful for viewing some code in the assembly window, without changing the program counter, since the execution position is not changed.

**Example**

To view the current viewing position, type:

```
ei
```

To view the instruction at address 0x100, type:

```
0x100 ei
```

? / e L p P t
et

Function
Select the specified task’s context.

In the Tasks Window click once on the task to be examined.

The command line syntax is:

et "TaskId"

Description
Select the specified task’s context. The TaskId is the identification of the task as displayed in the Tasks Window or specified by the lik command.

The current execution position, function, line number, and source statement are displayed. All other windows, except for the Kernel Windows, are updated accordingly.

Subsequent CrossView Pro commands use the context of the selected task. For example, the t command shows a stack trace of the selected task.

Example
To select task 4, type:

    et "4"

    l
Function

Set default address printing format

The command line syntax is:

\[ f \ [ \ "printf\text{-style\text{-format}} \ ] \]

Description

Set the default address printing format, using a printf format specification.

If there is no argument, the format defaults to %x, which prints an address in hexadecimal.

This command is intended to allow users to see memory addresses in decimal, octal or a format of their choosing.

Example

To display addresses in octal, type:

\[ f \ "%o" \]

To display addresses in hex, type:

\[ f \]

expression
**FSS**

**Function**
File System Simulation redirection.

The command line syntax is:

```
FSS { < | > } { &stream | "file" }
```

**Description**
Redirect a File System Simulation stream to a file or another stream.
Redirection to a file can be needed when a stream is only mapped to a
window and you want it to be mapped to a file also.

**Example**
To redirect the output of stream 2 to stream 1, type:

```
FSS 2>&1
```

To retrieve input for stream 1 from stream 4, type:

```
FSS 1<&4
```

To retrieve input for stream 4 from file "data.txt", type:

```
FSS 4<"data.txt"
```

To redirect the output of stream 3 to file "data.txt", type:

```
FSS 3>"data.txt"
```

Section 10.3, *File System Simulation* in Chapter I/O Simulation.
FSS_stdio_close

Function
Close a stream previously opened by FSS_stdio_open.

The command line syntax is:

FSS_stdio_close  streamnumber

Description
Close the stream indicated by streamnumber.

Example
To close stream 1, type:

FSS_stdio_close 1

FSS_stdio_open.
Section 10.3, File System Simulation in Chapter I/O Simulation.
FSS_stdio_open

Function
Redirect the output of a stream to a file.

The command line syntax is:

FSS_stdio_open  filename,rwdirection,streamnumber

Description
Redirect the stream indicated by streamnumber to the file filename. rwdirection can be an r for read-only, w for writable, or rw for read/write.

Example
To redirect stream 1 (output, so w for writable) to the file myfile.out, type:

FSS_stdio_open  myfile.out,w,1

The following command is used to close the stream.

FSS_stdio_close  1

FSS_stdio_close.
Section 10.3, File System Simulation in Chapter I/O Simulation.
g

Function
Change the program counter to a new execution position.

Click on a source line and select **Jump to Cursor** from the **Run** menu.

The command line syntax is:

```
g line
```

Description
This command changes the program counter so that *line* becomes the current execution position. *Line* must be a line in the current function.

This command changes only the program counter. It does not cause the target to begin execution.

Exercise caution when changing the execution position. Oftentimes, each line of C source code is compiled into several machine language instructions. Moving the program counter to a new address in the middle of a series of related assembly instructions is sometimes risky. Moreover, even though you change the program counter, registers and variables may not have the expected values if parts of the code are bypassed.

This command is not allowed when the target runs in the background.

Example
To change the program counter so that the next instruction to be executed corresponds to line 127, type:

```
g 127
```

C, gi, R
gi

Function

Change the program counter to a new execution position.

Click on a source line and select Jump to Cursor from the Run menu.

The command line syntax is:

address gi

Description

This command changes the program counter so that address becomes the current execution position.

This command changes only the program counter. It does not cause the target to begin execution.

Exercise caution when changing the execution position. The Jump to Cursor menu item is not available in the source lines window mode to prevent problems by skipping pieces of C code which are required to be executed. Moving the program counter to a new address in the middle of a series of related assembly instructions is sometimes risky. Moreover, even though you change the program counter, registers and variables may not have the expected values if parts of the code are bypassed.

This command is not allowed when the target runs in the background.

Example

To change the program counter so that the next instruction to be executed corresponds to address 0x0800, type:

0x0800 gi

C, g, R
**graph**

**Function**

Create Data Analysis window and execute CXL script.

The command line syntax is:

```
graph "window","script"[arg]...
```

**Description**

Create Data Analysis window *window* and execute CXL script *script*. The display list produced by the script is shown in the specified window. Arguments *arg* are passed as global variables to the script. Each argument is treated as an expression. Arguments starting with a "$" refer to an acquisition buffer. In all other cases *arg* is evaluated as an expression and will be casted to type double.

If for example register $R1 should be passed as argument to the script you must write "0+$R1" to avoid that $R1 is recognized as an acquisition buffer.

**Example**

To transform the contents of buffer $buffer to displayable data in window demo using CXL script x_t.cxl, type:

```
graph "demo","x_t.cxl",$buffer,0,1
```

**bufa, graphm, graphp, memget.**

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 

graph_add_update

Function
Add a command to the sequence of update commands.

For the supplied scripts only. From the Settings menu, select Data Analysis Window Setup... Enter a new window name and click New. Click Configure... to open the Data Analysis Window Setup dialog.

The command line syntax is:

```
graph_add_update "window",command
```

Description
Set the sequence of update commands for Data Analysis window window manually. These update commands are executed when the Update button on the Data Analysis window is pressed or when the update command is issued.

Prior to adding update commands, you have to remove all update commands with the graph_clear_updates command.

Example
To retrieve data and show it in window demo, type:

```
graph_clear_updates "demo"
graph_add_update "demo",memget data[$i],100,$buffer
graph_add_update "demo",graphm "demo","show_x_t.cxl"
graph_add_update "demo",graph "demo","x_t.cxl",$buffer,0,1
update "demo"
```

graph_clear_updates, update.
Section 11.5, Data Analysis, in Chapter Special Features.
graph_clear_updates

Function
Clear the sequence of update commands.

The command line syntax is:

    graph_clear_updates "window"

Description
Clear the sequence of update commands for Data Analysis window 
window. This is needed prior to adding new update commands with the 
graph_add_update command.

Example
To retrieve data and show it in window demo, type:

    graph_clear_updates "demo"
    graph_add_update "demo",memget data[$i],100,$buffer
    graph_add_update "demo",graphm "demo","show_x_t.cxl"
    graph_add_update "demo",graph "demo","x_t.cxl",$buffer,0,1
    update "demo"

graph_add_update, update.
Section 11.5, Data Analysis, in Chapter Special Features.
graph_close

Function

Close a Data Analysis window.

The command line syntax is:

```
graph_close "window"
```

Description

With the `graph_close` command you can close the named `window`.

Example

To close window `demo`, type:

```
graph_close "demo"
```

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
Function

Debug Data Analysis graph window.

The command line syntax is:

```
graph_debug expression
```

Description

If `expression` evaluates to a non-zero value, this value is an ORed value of two flags:

- 1 (bit 0) the "graphical data window debugging mode" will be enabled, showing all communication between the scripts and the windows in the command window. This can be useful when developing scripts.

- 2 (bit 1) When errors occur during script processing, these errors are logged to the command window. The total error count (per script) is now shown in a popup window rather than logged in the command window. The errors themselves remain logged in the command window.

Other bits (when `value` & 3 equals zero, for example 4) are ignored and treated like zero. No parameters result in value 1. A value of zero turns off all debugging.

`graph`, `graphm`, `graphmn`.

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
graphm

Function
Set Data Analysis window display mode.

The command line syntax is:

```
graphm "window","script"[arg]...
```

Description
The `graphm` command sets the representation `script` for the specified `window`. Depending on the script, the arguments may vary.

Several scripts are supplied with the product that you can use with the `graphm` command. See section `Supplied Data Analysis Window Scripts` in Chapter `Special Features` for more information.

Example
To set the display mode for window `demo` using CXL script `show_x_t.cxl` and show "demo" in the title bar of the window, type:

```
graphm "demo","show_x_t.cxl"
```

`bufa, graph, graphp, memget.
Section 11.5, `Data Analysis`, in Chapter `Special Features`.```
**graphmn**

**Function**
Set Data Analysis window display mode.

The command line syntax is:

```
graphmn "window","script"[,arg]...
```

**Description**
The `graphmn` command works similar to the `graphm` command, but it does not update the graph window. This can be useful where a `graph` and a `graphm` command are followed by each other, preventing the redrawing of the same graphics twice.

**Example**
To set the display mode for window `demo` using CXL script `show_x_t.cxl` and show "demo" in the title bar of the window, type:

```
graphmn "demo","show_x_t.cxl"
```

`bufa, graph, graphp, memget`.
Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
**graphp**

**Function**

Position Data Analysis window on the screen.

The command line syntax is:

```
graphp "window",left_top_x,left_top_y,width,height
```

**Description**

With the **graphp** command you can position the named *window* at the specified screen coordinates.

**Example**

To put window *demo* at position (0,0) on the screen with a size of 100x100, type:

```
graphp "demo",0,0,100,100
```

**graph, graphm.**

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
**gus**

**Function**

Suppress or reactivate window updating.

The command line syntax is:

```
gus {on | off}
```

**Description**

With **gus on** the GUI updating suppress feature is enabled. This means that the graphical windows are no longer updated. To reactivate the window updating use the **gus off** command.

**Example**

To suppress the updating of CrossView windows, type:

```
gus on
```
Function
Print out information about the state of CrossView Pro.

The command line syntax is:

```
I
```

Description
Print out information about the state of CrossView Pro, including: the CrossView Pro version number, the execution environment version information, the name of the program being debugged (and the number of its files and functions), the state of the assertion mechanism, the state of output recording, the state of command recording, the state of target communication recording and the state of search case sensitivity.

The state of the assertion mechanism tells how many assertions have been defined and whether the overall assertion mechanism is active or suspended; it does not tell whether any individual assertions are active or suspended.

```
I, a, A, >, >>, >& Z
```
### if

**Function**
Conditional command execution.

The command line syntax is:

```
if ( expression ) { cmds } [ { cmds } ]
```

**Description**
If `expression` evaluates to a non-zero value, execute the first group of commands. Otherwise, the second group of commands, if present, will be executed. This command is nestable.

Leave a space between `if` and `exp`. `if (a==b)` parses as a function call. The `if` statement is used primarily within breakpoint command lists.

**Example**
If you type:

```
if (a=b) {5t} {C}
```

CrossView Pro will trace back five levels on the stack if `a` is equal to `b`. Otherwise, CrossView Pro will continue.

The command line:

```
if (wait>1000) {wait;1 r}
```

will print the value of `wait` and list all registers if the value of `wait` exceeds 1000.
**ios_close**

**Function**

Close a File I/O stream.

From the **Settings** menu, select **I/O Simulation Setup**... Select a stream in the **Connections** tab and click on the **Delete** button.

The command line syntax is:

```
ios_close {stream | "file"}
```

**Description**

You can specify either a filename or a stream number.

**Example**

To close stream number 1, type:

```
ios_close 1
```

To close file `data.txt` and close 1 stream that is mapped to this file, type:

```
ios_close "data.txt"
```

Only 1 stream is closed, even if multiple streams are attached to this file. The command displays which stream number has been closed.

**ios_open, ios_wopen**
**ios_open**

**Function**

Open a File I/O stream.

From the **Settings** menu, select **I/O Simulation Setup...** Open the **File I/O** tab and click on the **Configure...** button. Attach a stream (with a file) to a probe point.

The command line syntax is:

```
ios_open ["file",[mode],[r],[xvw_variable]]
```

**Description**

This command is useful to connect a file to a stream at the command line of CrossView. CrossView returns a stream number which is opened with this command in the `$xvw_variable` and displays it too.

The filename is optional. When the filename is omitted and such a newly opened stream receives data and is not shown in any opened terminal window a new window will be opened that interacts with this stream.

Furthermore the **mode** can be specified when a I/O stream is opened: read, write or append:

- **r** Open file for reading. The file pointer is positioned at the beginning of the file.
- **r+** Open file for reading and writing. The file pointer is positioned at the beginning of the file.
- **w** Truncate file to zero length or create file for writing. The file pointer is positioned at the beginning of the file.
- **w+** Open file for reading and writing. The file is created if it does not exist, otherwise it is truncated. The file pointer is positioned at the beginning of the file.
- **a** Open file for writing. The file is created if it does not exist. The file pointer is positioned at the end of the file.
- **a+** Open file for reading and writing. The file is created if it does not exist. The file pointer is positioned at the end of the file.
All modes can have a `b` appended, indicating binary access. The `b` can be positioned before or after the `+`. This mode affects the `ios_read` and `ios_write` commands. The `ios_read` command writes host data to target memory. In binary mode MAUs (minimum addressable units) are filled with a number of bytes that fits in 1 MAU. For example, a MAU with a size of 24 bits will be filled with $24/8=3$ bytes. Otherwise the least significant 8 bits of a MAU will be filled with 1 byte and the highest 16 bits will be filled with zeros. The `ios_write` command writes target memory to the host. In binary mode for each MAU the number of bytes to be written equals the number of bytes that fits in 1 MAU. For a MAU size of 24 bits CrossView Pro will write 3 bytes to the host. If the mode is not binary CrossView Pro will write the least significant 8 bits (1 byte) of each MAU to the host.

CrossView Pro opens all files by default in `w+` mode, overwriting the opened file if it already exists.

The optional `r` specifies to rewind to the beginning of the file when the end of file is reached.

$xvw_variable$ is a user special variable in CrossView Pro which holds the value of the newly opened stream number. This variable can also be used in the read and write commands to read from or write to the file.

**Example**

To open a new File I/O stream, type:

```
ios_open
```

To open file `data.txt` and assign the new stream number to `$ios_nr`, type:

```
ios_open "data.txt",,,$ios_nr
```

To open file `data.txt` in read-only mode and wrap around when end of file is reached, type:

```
ios_open "data.txt",r,r,$ios_nr
```

$ios_wopen, $ios_close, $ios_read, $ios_write$
**ios_read**

**Function**

Read binary data from an I/O stream.

The command line syntax is:

```
ios_read {stream | "file"},address,number_of_maus[,x]
```

**Description**

You can specify a File I/O stream number or a filename. `address` is the memory location where the read data will be stored. `number_of_maus` is the length of the data to be read in MAUs (minimum addressable units).

The optional `',x'` specifies that the read data should be interpreted as hexadecimal values. The hexadecimal format is a whitespace separated (no TAB) hexadecimal string without the `0x` prefix.

If the stream was opened in binary mode (see `ios_open`), MAUs are filled with a number of bytes that fits in 1 MAU. For example, a MAU with a size of 24 bits will be filled with 24/8=3 bytes. Otherwise the least significant 8 bits of a MAU will be filled with 1 byte and the highest 16 bits will be filled with zeros.

**Example**

To read 16 minimum addressable units from stream 4, type:

```
ios_read 4,_X:0x100,16
```

To read from stream `$istrm` 1 MAU hex value, type:

```
ios_read $istrm,_X:0x100,1,x
```

`ios_readf, ios_write, ios_open`
**ios_readf**

**Function**

Formatted read from an I/O stream (scanf). Store the data at the location defined by the expression.

The command line syntax is:

```
iios_readf {stream | "file"},"format",expression
```

**Description**

You can specify a File I/O stream number or a filename. *format* is a format specifier as used in the scanf C library function. *expression* can be any CrossView Pro expression.

Valid format specifiers are:

- `%d` Decimal.
- `%x` Hexadecimal (without `0x` prefix).
- `%c` Char.
- `%s` String.
- `%f` Float.

**Example**

To read a hex value from stream 4 and store it the value of program variable ch1, type:

```
iios_readf 4,"%x",&ch1
```

To read a hex value from stream 4 and store it in register R2, type:

```
iios_readf 4,"%x",$R2
```

To read two hex values from stream `$istrm` and assign them to program variable ch1 and target register R2, type:

```
iios_readf $istrm,"%x %x",&ch1,$R2
```

**Related**

`ios_read`, `ios_write`, `ios_open`
ios_rewind

Function

Move File I/O file pointer to the beginning of the file.

From the Settings menu, select I/O Simulation Setup... Open the File I/O tab and click on the Configure... button. Attach a stream to a probe point. In the New Stream dialog enable the Wrap around check box.

The command line syntax is:

```
ios_rewind {stream | "file"}
```

Description

With ios_rewind the file pointer is moved to the beginning of the file.

Example

To move the file pointer of the file connected to stream 4 to the beginning of the file, type:

```
ios_rewind 4
```

To move the file pointer of the file connected to stream $istrm to the beginning of the file, type:

```
ios_rewind $istrm
```

To move the file pointer to the beginning of file my.txt, which is connected to a stream, type:

```
ios_rewind "my.txt"
```

ios_read, ios_write, ios_open
**ios_wopen**

**Function**
Open a File I/O stream and map the stream to a terminal window.

From the **Settings** menu, select **I/O Simulation Setup**... Open the **File I/O** tab and click on the **Configure**... button. Attach a stream (which is only connected to a terminal window) to a probe point.

The command line syntax is:

```
ios_wopen [["terminal_window"],[$xvw_variable]]
```

**Description**
When the name matches the name of an existing terminal window the newly opened stream is mapped to this terminal window.

$\text{xvw\_variable}$ is a user special variable in CrossView Pro which holds the value of the newly opened stream number. This variable can also be used in the read and write commands to read from or write to the terminal_window.

You can close the opened stream with **ios_close**.

**Example**
To create a new terminal window and map the newly created stream to it. The name of the new terminal window will be like $\#x\_.$, type:

```
ios_wopen $\#\text{ios\_nr}
```

To open a new stream and if there is a terminal window with the name "My terminal" map stream to it, otherwise create a new terminal and name it "My terminal"., type:

```
ios_wopen "My terminal",$\text{ios\_nr}
```

**ios_open, ios_close**
**ios_write**

**Function**

Write binary data to an I/O stream.

The command line syntax is:

```
ios_write {stream | "file"},address,number_of_maus[,x]
```

**Description**

You can specify a File I/O stream number or a filename. `address` is the memory location where the data will be read from. `number_of_maus` is the length of the data to be written in MAUs (minimum addressable units).

The optional `,x` specifies that the data should be interpreted as hexadecimal values. The hexadecimal format is a whitespace separated (no TAB) hexadecimal string without the `0x` prefix.

If the stream was opened in binary mode (see `ios_open`), for each MAU the number of bytes to be written equals the number of bytes that fits in 1 MAU. For a MAU size of 24 bits CrossView Pro will write 3 bytes to the host. If the mode is not binary CrossView Pro will write the least significant 8 bits (1 byte) of each MAU to the host.

**Example**

To write 16 minimum addressable units to stream 4, type:

```
ios_write 4,_X:0x100,16
```

To write 1 MAU hex value to stream $ostrm, type:

```
ios_write $ostrm,_X:0x100,1,x
```

`ios_read`, `ios_writef`, `ios_open`
ios_writef

Function

Formatted write to an I/O stream (printf). The data is obtained from the C expression, for example a variable.

The command line syntax is:

`ios_writef {stream | "file"},"format",expression`

Description

You can specify a File I/O stream number or a filename. `format` is a format specifier as used in the printf C library function. `expression` can be any CrossView Pro expression.

Valid format specifiers are:

- `%d` Decimal.
- `%x` Hexadecimal (without `0x` prefix).
- `%c` Char.
- `%s` String.
- `%f` Float.

Example

To write the hex value of program variable `ch1` to stream 4, type:

`ios_writef 4,"%x",ch1`

To write the hex value of register `R2` to stream `$ostrm`, type:

`ios_writef $ostrm,"%x",$R2`

To write the hex values of program variable `ch1` and target register `R2` to stream 4, type:

`ios_writef 4,"%x %x",&ch1,$R2`

`ios_read`, `ios_write`, `ios_open`
L

Function

Synchronize the viewing and execution positions.

To synchronize the positions manually, click on the Find PC button in the Source Window or select Find PC from the Edit menu.

The command line syntax is:

```
L
```

Description

This command synchronizes the viewing and execution positions. It also lists the current file, function and line number of the current program counter. The viewing position is always moved to match the execution position.

The L command is synonymous with a 0 e command and does not affect the execution position.

Example

To synchronize the viewing and execution positions, then list current file, function, and line number, type:

```
L
```

```
e, l
```
Function

List.

In general, the dialog box in which you define a feature also contains a list.

The command line syntax is:

```
list \{ a | b | d | f | g | k | l | L | m | p | r | s | S \} \{string\}
list [func]
list stack
```

Description

In the first case above, list one of the following: assertions, breakpoints, directories, files, globals, kernel state data, labels (on module scope), all labels, memory map (of application code sections), procedures, registers, special variables, symbol tables. If \textit{string} is present, then list only those items that start with \textit{string}.

In the second case, list the values of all parameters and locals of the function \textit{func}. Without a function, this command lists all parameters and locals of the current function in view.

In the third case, list all parameters and locals of the function at depth \textit{stack}.

The \texttt{lf} and \texttt{lm} commands also show the address of the modules' first procedure. The \texttt{lm} command is identical to \texttt{lf}, list files, but the list of files is sorted on ascending segment addresses. \textit{func} must be a function on the stack or the current function.
For configurations that support real-time kernels, the \texttt{l k} command can have one of the following arguments (\texttt{l k} is the same as specifying \texttt{l k t}):

\begin{verbatim}
  t  - Display tasks.
  m  - Display mailboxes.
  q  - Display queues.
  p  - Display pipes.
  s  - Display semaphores.
  e  - Display events.
  h  - Display HISRs (High-level Interrupt Service Routines)
  si - Display signals.
  ti - Display timers.
  pm - Display partition memory.
  dm - Display dynamic memory.
  r  - Display resources.
  misc - Display miscellaneous information.
\end{verbatim}

\textbf{Example}

To list defined assertions and the state of the assertion mechanism, type:

\texttt{l a}

To list all locals and parameters of the current function, type:

\texttt{l p}

Data is displayed using the normal (\texttt{n}) format. To list all the parameters and locals of the function \texttt{fcn}, type:

\texttt{l fcn}

To list queue information for the current tasks (only if your configuration supports it), type:

\texttt{l k q}
load

Function
Load a program's symbol file and download the image part.

From the File menu, select Load Symbolic Debug Info... This dialog allows you to specify the file.

The command syntax is:

```
load [filename]
```

Description
This command performs the N and dn commands successively.

Downloading a file only copies the image part into target memory (dn). It will not cause CrossView Pro to re-read symbolic information (N). The load command does both.

This command is not allowed when the target runs in the background.

Example
To load the symbol table of file demo.abs in CrossView Pro and download the image part, type:

```
load demo.abs
dn, N
```
Function

List the data currently being monitored.

Refer to the Data Window. Each time the program stops, the debugger evaluates all monitored expressions and displays the results in the Data Window.

The command line syntax is:

\textbf{M}

Description

List all C expressions being monitored by CrossView Pro. The listing associates a unique number with each expression. This number is used to specify the deletion of monitored data.

\textbf{m}
Function

Monitor (watch) an expression. (Also delete a monitor.)

From the Source Window, double-click on an expression. A new monitor is created in the Data Window or the Expression Evaluation dialog is opened if the Bypass Expression Evaluation Dialog check box in the Data Display Setup dialog is not set. If the latter is the case, click on the Add Watch button to create a new monitor in the Data Window. To remove an existing monitor, select the monitor in the Data Window and click on the Delete Selected Data Item button.

The command syntax is:

\[ \text{m exp number m d} \]

Description

The \text{m} command has two distinct functions. The first monitors the given expression. The second deletes the monitoring of the expression specified by \text{number}.

Data monitoring takes place whenever the program stops execution, that is, for a breakpoint, assertion, single step, or user interrupt (\text{ctrl-C}). In window mode, the values of all currently monitored data are displayed in the Data window. Each piece of monitored data has a unique identifying number that is used when deleting it.

Example

To monitor the value of the variable \text{myvar}, type:

\[ \text{m myvar} \]

To monitor the address of variable \text{myvar}, type:

\[ \text{m &myvar} \]

To monitor the element \text{alpha+1} of \text{array}, type:

\[ \text{m array[alpha+1]} \]
To delete expression number 2 of the monitored data, type:

```
2 m d
```

M, b, a, s, R, C
mcp

Function
Memory copy.

From the Memory Window, click on the Copy Memory button to open the Copy Memory dialog. Enter the start address and the end address (inclusive) of the memory region you want to copy. Enter the destination address and click on the OK button.

The command syntax is:

```
addr_start mcp addr_end, addr_dest
```

Description
The mcp command copies a block of target memory starting at address `addr_start` to destination address `addr_dest`. The size of the memory block is defined as: `addr_end - addr_start + 1`. The data item located at address `addr_end` is included in the copy.

If your target supports multiple memory spaces then it is legal to copy data between different memory spaces. Of course `addr_start` and `addr_end` must be located in the same memory space. This command does not have any effect on code breakpoints.

Example
To copy the contents of variable `buf` to address 0x200, type:

```
&buf mcp &buf+sizeof(buf), 0x200
```

mF, mf
memget

Function
Retrieve data from the target into a buffer.

The command line syntax is:

    memget expr,count,buffer_name

Description
The memget command is used to retrieve data from the target system and to
store the data in the acquisition buffer buffer_name. Data in the
acquisition buffer is of type double. CrossView Pro will automatically
handle data conversion based upon the type of expression expr.

Expression expr contains the iterator "$i" which initially starts at 0 and
increments to count-1.

Notation convention:
"expr<$i{n}>" means "expr in which all instances of "$i" are substituted
by "n".

To correctly retrieve the data from the target CrossView Pro needs to know
the start address, the size of the data elements, and the number of items to
fetch. The number of items to fetch from the target is specified by count.
The following algorithm is used to fill the acquisition buffer:

addr0 = (char *) &expr<$i{0}>
addr1 = (char *) &expr<$i{1}>
delta = addr1 - addr0
elem_size = sizeof(expr<$i{0}>)
type = C-type(expr<$i{0}>)
for (i = 0; i < count; i++)
{
    value = read elem_size MAUs from address addr0 + (i * delta)
    buffer[i] = convert_to_double(type, value);
}
Example

1. C structure access.

   ```
   struct {
       double re,
         im;
       int f;
   } data[100];
   ```

   To store the `data[x].re` values into acquisition buffer $a$:

   ```
   memget data[$i].re,100,$a
   ```

   To store the `data[x].im` values into acquisition buffer $b$:

   ```
   memget data[$i].im,100,$b
   ```

2. Memory access.

   To retrieve 18 integer values from memory starting at address 0x100 and store these in acquisition buffer $buffer$:

   ```
   memget ((int[]) 0x100][$i],3*6,$buffer
   ```

   buf báo, buf López, graph, rawmemget.

   Section 11.5, Data Analysis, in chapter Special Features.
mF

Function

Memory single fill.

From the Memory Window, click on the Fill Single Memory Address button to open the Single Fill Memory dialog. Enter the start address the memory region you want to fill. Enter one or more expressions separated by commas and click on the OK button.

The command syntax is:

addr mF expr [,expr]...

Description

The mF command fills target memory with data. The value defined by exp is written to address addr in target memory. Multiple exprs separated by commas may be entered. Each exp is written to a subsequent MAU.

If your target supports multiple memory spaces then addr may refer to any memory space.

If the size of a given exp occupies more than one MAU, only the least significant MAU will be written to memory. This command does not have any effect on code breakpoints.

Example

To store value 0x12 at memory location 0x400 and value 0xAB at location 0x401, type:

0x400 mF 0x12, 0xAB

mcp, mf
mf

Function
Memory fill, repeating the specified pattern until the specified region is filled.

From the Memory Window, click on the Fill Memory button to open the Memory Fill dialog. Enter the start address and end address (inclusive) of the memory region you want to fill. Enter one or more expressions separated by commas and click on the OK button.

The command syntax is:

\[ addr\_start \, mf \, addr\_end, \, expr \, [expr]... \]

Description
The mf command fills a block of target memory with a pattern. The memory region starting at address \( addr\_start \) and ending at address \( addr\_end \) is filled with the pattern defined by \( expr \, [expr] \). Multiple \( exps \) separated by commas may be entered. Each \( exp \) is written to a subsequent MAU.

The specified pattern is repeated until the end address of memory region is reached.

If your target supports multiple memory spaces then \( addr \) may refer to any memory space.

If the size of a given \( exp \) occupies more than one MAU, only the least significant MAU will be written to memory. This command does not have any effect on code breakpoints.

Example
To store values 0x01 and 0x02 at succeeding memory locations in the range 0x400 to 0x404, type:

\[ 0x400 \, mf \, 0x404, \, 0x01, \, 0x02 \]
The result of this command is:

address: 0x400 0x401 0x402 0x403 0x404

value: 1 2 1 2 1

\texttt{mcp, mf}
ms

Function

Memory search.

From the Memory Window, click on the **Find Memory** button to open the Search Memory dialog. Enter the start address and end address (inclusive) of the memory region you want to search. Enter one or more search patterns separated by commas and click on the **OK** button.

The command syntax is:

```
addr_start ms addr_end, expr [,expr]...
```

Description

The **ms** command searches for a pattern within a block of target memory. The memory region starting at address `addr_start` and ending at address `addr_end` (inclusive) is searched for the pattern defined by `expr [,expr]`. Multiple `expr`s separated by commas may be entered. Each `expr` corresponds to a subsequent MAU.

If your target supports multiple memory spaces then `addr` may refer to any memory space.

This command does not have any effect on code breakpoints.

Example

Suppose the memory range 0x400 to 0x4ff was filled using the following commands:

```
0x400 mf 0x4ff, 0
0x400 mf 0x404, 1, 2
```

To search for the values 0x01 and 0x02 at memory locations in the range 0x400 to 0x4ff, type:

```
0x400 ms 0x4ff, 0x01, 0x02
```

The result of this command is:

```
FOUND pattern at 0x400
FOUND pattern at 0x402
```
mcp, mF, mf
**N**

**Function**

Load a program’s symbol file.

From the **File** menu, select **Load Symbolic Debug Info...** This menu item allows you to specify the file.

The command syntax is:

```
N [path]filename[.abs]
```

**Description**

Load the symbol table of the specified file in CrossView Pro. If no filename is given, the file being debugged is reloaded. In this case only the breakpoints set by the user are removed. Monitors, I/O simulation streams, assertions and CrossView Pro local variables remain active.

If a new file (different filename) is loaded, all breakpoints, monitors, I/O simulation streams, assertions and CrossView Pro local variables are removed.

If a path is supplied, CrossView Pro changes its current directory according to the specified path. In case a relative search path to source files was provided at startup time, CrossView Pro will search relative to the new working directory.

This command is automatically executed during CrossView Pro startup when a filename was given on the command line. Use the **dn** command to send the associated executable code to the target.

**Example**

To load the symbol table of file demo.abs in CrossView Pro, type:

```
N demo.abs
```

dn
Function

Set address bias

From the **File** menu, select **Load Symbolic Debug Info**. In the Load Symbolic Debug Info dialog you can edit the **Code address bias** field.

The command syntax is:

\[ n \ [ \text{addr} ] \]

Description

Set address bias of overlay files to `addr`. If no address is given, then display current bias.

If a program is to be loaded at a different address than that indicated in the linked and located (absolute object) file, then the address information in the debugger's symbol file will be incomplete, since it does not know where the program is actually going to be loaded. This command will normalize the addresses by adding the bias to every address.

Example

To add a bias of 1000 to every address in the code, type:

\[ n \ 1000 \]

To display the current bias, type:

\[ n \]
nC

**Function**

Set the viewing position to the next covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

```
  nC
```

**Description**

If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the next block of statements that have been executed while the program was running on the target.

**Example**

To move the cursor to the next executed block, type:

```
  nC
```

```
  nU, pC, pU
```
**nU**

**Function**
Set the viewing position to the next not covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

```
  nU
```

**Description**
If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the next block of statements that have not been executed while the program was running on the target.

**Example**
To move the cursor to the next not executed block, type:

```
  nU
```

```
  nC, pC, pU
```
**Function**

Enter emulator mode.

From the View menu, select **Command | Emulator**. If you know the emulator-level command language, you can communicate directly with the emulator from this window.

The command line syntax is:

`o string`

**Description**

Pass `string` to emulator and show the emulator response.

The `o` command lets you communicate with the emulator directly via emulator commands.

Do not issue one-shot transparency emulator commands that result in large output (or otherwise require intervention other than a carriage return to terminate output). Instead, enter transparency mode first, then issue the command.

**Example**

To send the string `map` to the emulator, type:

`o map`
opt

Function
Set or display specific options.

Option values can be changed in various dialogs and menus.

The command line syntax is:

```
opt [option_name [= option_value]]
```

Description
If no arguments are passed, all options with their current value are listed. By specifying an option’s name, the current value of that option is displayed. By specifying an option name followed by a valid value, the option is set to that new value.

The options are a sub-set of CrossView’s so-called “special variables”. See Chapter 3, Command Language, for a list of all special variables.

Example
To display all options, type:

```
opt
```

To disable mixing of disassembly code and source lines in the assembly window, type:

```
opt mixedasm=off
```
P

Function

Print source lines, including machine addresses.

In the Source Window, the machine address of the line at the current viewing position is displayed in the address field in the upper left corner.

The command line syntax is:

\[
\text{line} \quad \text{P} \quad \text{exp}
\]

Description

Print \( \text{exp} \) lines of source starting at line \( \text{line} \), including machine addresses. If \( \text{exp} \) is omitted, print one line. If \( \text{line} \) is omitted, start from the current viewing position.

Example

To print source lines 4, 5, 6, 7 and 8 (displaying machine addresses) of the current source file, type:

\[4 \quad \text{P} \quad 5\]
Function

Print source lines.

C source is displayed in the Source Window.

The command line syntax is:

\[ line \ p \ exp \]

Description

Print exp lines of source starting at line line. If exp is omitted, print one line. If line is omitted, start from the current viewing position.

Example

To print source lines 4, 5, 6, 7 and 8 of the current source file, type:

4 p 5
pC

Function
Set the viewing position to the previous covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

pC

Description
If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the previous block of statements that have been executed while the program was running on the target.

Example
To move the cursor to the previous executed block, type:

pC

nC, nU, pU
**pd**

**Function**
Disable, turn off, profiling.

From the **Tools** menu, select **Profiling** if this item was set.

The command line syntax is:

```
pd
```

**Description**
If profiling is supported by your version of CrossView Pro, this command disables the profiling system. Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

**Example**
To disable profiling, type:

```
pd
```

```
pe
```
pe

Function
Enable, turn on, profiling.

From the Tools menu, select Profiling if this item was not set.

The command line syntax is:

    pe

Description
If profiling is supported by your version of CrossView Pro, this command enables the profiling system. Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example
To enable profiling, type:

    pe

    pd
proinfo

Function

List profiling results.

From the Tools menu, select Profiling Report...
Make your changes and select the Update button.

The command line syntax is:

\[ \text{proinfo } ([\text{all} \mid \text{module_or_function_name}][,\text{filename}]) \]

Description

If profiling is supported by your version of CrossView Pro and profiling is enabled, this command lists the profiling results. Without arguments (same as all) this command lists the profiling information of all modules and function.

Instead of listing the results you can also save the results in a file with extension .pro.

Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example

To list the profiling results of all modules and functions to the output window, type:

\[ \text{pe} \]
\[ \text{proinfo} \]

To list profile information of function main to the output window, type:

\[ \text{proinfo main} \]

To list profile information of all modules and functions in file hello.pro, type:

\[ \text{proinfo all,hello.pro} \]

\[ \text{cproinfo, pd, pe} \]
**Function**

Reset the application being debugged to initial conditions. That is, set the program counter to the start address of the application.

From the Run menu, select **Reset Application**.

The command line syntax is:

```
prst
```

**Description**

The program counter is set to the start address of the application being debugged. This command does NOT perform a hardware reset of the target system. That is, no registers are modified except for the program counter.

This command is not allowed when the target runs in the background.

```
R, rst
```
pU

Function
Set the viewing position to the previous not covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

pU

Description
If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the previous block of statements that have not been executed while the program was running on the target.

Example
To move the cursor to the previous not executed block, type:

pU

nC, nU, pC
Function

Quiet breakpoint reporting.

The command line syntax is:

```
Q
```

Description

If this appears as the first command in a breakpoint’s command list, the debugger does not make the usual announcement of:

```
function: line number: source file
```

when the breakpoint is hit.

The purpose of this command is to allow quiet breakpoint reporting. For example, to check the value of a variable without cluttering the screen with text.

Example

If you type the following:

```
21 b {Q; var1}
```

CrossView Pro will set a breakpoint at line 21. When that breakpoint is hit, CrossView Pro will print the value of var1, but will not print the current function, line number, and source file.
q

Function
Quit a debugging session.

From the File menu, select Exit.

The command line syntax is:

q [ s | y ]

Description
CrossView Pro will prompt you if you really want to quit if you do not specify anything. Note that the current desktop settings are NOT saved then!

Typing q s saves the current desktop settings and quits the debugger without confirmation.

Typing q y does not save the current desktop settings and quits the debugger without confirmation.

Inside a command line procedure call it will just quit from this.

When the target runs in the background CrossView Pro will first stop the target.
Function
Reset program and begin execution from initial conditions.

From the Run menu, select Reset Application and then Run.

The command line syntax is:

R

Description
Reset the application being debugged and begin execution from initial conditions. The program counter is set to the start address of the application being debugged. This command does NOT perform a hardware reset of the target system. That is, no registers are modified except for the program counter.

This command is not allowed when the target runs in the background.

C, g, prst
**rawmemget**

**Function**

Retrieve data from the target into a buffer.

The command line syntax is:

```
rawmemget address,type,count,buffernname [,interleave]
```

**Description**

The `rawmemget` command is used to retrieve data from the target system and to store the data in the acquisition buffer `buffername`. Data in the acquisition buffer is of type `double`. CrossView Pro will automatically handle data conversion based upon the `type` of the data. It reads `count` elements of type `type` from the target starting at address `address` into the buffer.

`interleave` indicates the distance between successive elements. The default value is `sizeof(type)`.

**Example**

To retrieve 18 integer values from memory starting at address 0x100 and store these in acquisition buffer `$buffer`:

```
rawmemget 0x100,int,3*6,$buffer
```

`bufa, bufd, graph, memget`.

Section 11.5, *Data Analysis*, in chapter *Special Features*. 
rst

Function
Reset target system to initial conditions.

From the Run menu, select Reset Target System.

The command line syntax is:

rst

Description
The target is initialized according to the power-up sequence for the processor. Almost all registers, including the system stack pointer and program counter are initialized.

A target system reset may have undesired side effects. To be sure that the application code is correct, a download must be performed after a target system reset.

This command is not allowed when the target runs in the background.

R, prst
**S**

**Function**

Single step C statements, stepping over function calls.

To step over a function, click on the **Step Over** button in the Source Window. You can also select **Step Over** from the **Run** menu. Check the **Step Mode** menu item in the **Run** menu: **Source line step** must be selected.

The command line syntax is:

```
[ exp ] S
```

**Description**

If you try to step over a call to a function which contains a breakpoint (or which calls another function with a breakpoint) then the breakpoint will be hit.

Stepping over a function means that CrossView Pro treats function calls as a single statement and advances to the next line in the source. This is a useful operation if a function has already been debugged or if you do not want to take the time to step through a function line by line.

When multiple statements are present on one line, they are all executed by this single step.

This command is not allowed when the target runs in the background.

**Example**

To step one C statement, type:

```
S
```

To step five C statements, type:

```
5 S
```

C, s, si, Si
**S**

**Function**

Single step C statements, stepping into function calls

To step *into* a function (single step), click on the **Step Into** button in the Source Window. You can also select **Step Into** from the **Run** menu. Check the **Step Mode** menu item in the **Run** menu: **Source line step** must be selected.

The command line syntax is:

```
[ exp ] s
```

**Description**

Single step *exp* (default is 1), C statements, stepping into function calls.

Stepping into a function means that CrossView Pro enters the function and executes its prologue machine instructions halting at the first C statement. When the end of the function is reached, CrossView Pro brings you back to the line after the function call. The debugger changes the source code file displayed in the Source Window, if necessary.

This command is not allowed when the target runs in the background.

**Example**

To step one source instruction, type:

```
s
```

To step five source instructions, type:

```
5 s
```

C, S, si, Si
**save**

**Function**

Save macros.

From the **Tools** menu, select **Macro Definitions...** to open the Macro Definitions dialog box. From this dialog box, you can save macros with the **Save** button. To save macro definitions in a file other than the current one, click on the **Save as...** button.

The command line syntax is:

```
save file
```

**Description**

Save all currently defined macros in the specified file. This file is in the format of a sequence of **set** commands, and thus can be loaded by reading it as a playback file. See the `<` and `<<` commands.

An existing save file with the same name will be overwritten.

**Example**

To save the definitions of the currently defined macros in the file `mac.sav`, type:

```
save mac.sav
```

```
set, unset, echo, !, <, <<
```
set

**Function**

Definition and display of macros.

To create a macro, select **Macro Definitions...** from the **Tools** menu. Click on the **New...** button and add a new macro.

The command line syntax is:

```
set [ name [ "cmds" ] ]
```

**Description**

The set command allows for definition and display of macros. If `name` and `cmds` are supplied, a macro entry is made associating the `name` with the commands. If only `name` is supplied, the body of the specified macro is displayed.

If no arguments are supplied the names of all currently defined macros are displayed. Macro definitions must contain the body of the macro in double quotation marks.

Macros may take arguments. In the body of a macro formal arguments are referred to as `$n`, where $n$ is the argument number starting from 1.

It is important to understand that macro expansion takes place for all names. Therefore, if you wish to pass the name of an existing macro to a command, such as `set`, you must escape it with `''`, to keep CrossView Pro from expanding the name.

**Example**

To display the names of all currently defined macros, type:

```
set
```

To display the body of the macro named `macro`, type:

```
set macro!
```

To define `macro` to be a macro which lists the registers then enters the function given by its first argument, type:

```
set macro "l r; e $1"
```
To invoke this macro, you might type, for example:

```macro(main)
unset, echo, save, !```
Si

Function

Single step machine instructions, stepping over subroutine calls

From the Run menu, select Step Mode | Instruction step. Then click on the Step Over button in the Source Window, or select Step Over from the Run menu.

The command line syntax is:

\[
[ \text{exp} ] \text{ Si}
\]

Description

Single step \text{exp} (default is 1) machine instructions, stepping over subroutine calls.

If you try to step over a call to a subroutine which contains a breakpoint (or which calls another subroutine with a breakpoint) then the breakpoint will be hit.

The next instruction to be executed is shown as a disassembled instruction, not as a C statement.

This command is not allowed when the target runs in the background.

Example

To step one machine instruction, type:

\[
\text{Si}
\]

To step five machine instructions, type:

\[
5 \text{ Si}
\]

\[
\text{C, s, S, si, R}
\]
**si**

**Function**

Single step machine instructions, stepping into subroutine calls

From the Run menu, select Step Mode | Instruction step. Then click on the Step Into button in the Source Window, or select Step Into from the Run menu.

The command line syntax is:

\[ \text{[ } \text{exp} \text{ ] } \text{si} \]

**Description**

Single step \( \text{exp} \) (default is 1), machine instructions, stepping into subroutine calls.

The next instruction is shown as a disassembled instruction, not as a C statement.

This command is not allowed when the target runs in the background.

**Example**

To step one machine instruction, type:

\[ \text{si} \]

To step five machine instructions, type:

\[ 5 \text{ si} \]

C, s, S, Si, R
**st**

**Function**
Stop the execution of the target immediately.

The command line syntax is:

```
st
```

**Description**
This command stops the running process immediately.

Not available for all execution environments.
Function
Stack trace with local variables

The command line syntax is:

\[ \text{exp} \ T \]

Description
Produce a trace of functions on the stack and show local variables. Only the first \( \text{exp} \) levels of the stack trace will be displayed. If \( \text{exp} \) is omitted, all of the levels of the stack trace (up to 20) will be printed.

This command works independently of the Stack Window.

This command is not allowed when the target runs in the background.

Example
To print out a stack trace of 20 levels with corresponding local variables, type:

\[ T \]

To print out the top five levels of the stack trace with corresponding local variables, type:

\[ 5 \ T \]

\[ e, l, t \]
\(t\)

**Function**

Stack trace.

From the **View** menu, select **Stack**. The Stack Window shows the current situation in the stack after the program has been stopped. It displays the following information for each stack frame:

- The name of the function that was called
- The value of all input parameters to the function
- The line number in the source code from which the function was called

The command line syntax is:

\[
[\ exp\ ]\ t
\]

**Description**

Produce a trace of functions on the stack.

\(exp\) specifies the number of levels of the stack trace to be displayed. If omitted, up to 20 levels of the stack trace will be printed.

Each stack level shown in the Stack Window is displayed with its level number first. The levels are numbered sequentially from zero. That is, the lowest/last level in the function call chain is always assigned zero.

This command is not allowed when the target runs in the background.

**Example**

To print out a stack trace of 20 levels, type:

\[t\]

To print out the top five levels of the stack trace, type:

\[5\ t\]

\[e, l, T\]
**td**

**Function**
Disable, turn off, trace.

From the **Tools** menu, select **Trace** if this item was set.

The command line syntax is:

```
  td
```

**Description**
If trace is supported by your version of CrossView Pro, this command disables tracing (both instruction level, high level and raw). Trace is automatically disabled when you close the Trace Window.

**Example**
To disable tracing, type:

```
  td
```

```
te
```
te

Function
Enable, turn on, trace.

From the Tools menu, select Trace if this item was not set.

The command line syntax is:

```
tel
```

Description
If trace is supported by your version of CrossView Pro, this command enables tracing (both instruction level, high level and raw). Trace is automatically enabled when you open a Trace Window.

Example
To enable tracing, type:

```
te
```

```
td
```
Function
Toggle the updating of the appropriate window when the target runs in the background.

The command line syntax is:

```
[interval] u [d|k|r|s|a|mem|t]
```

Description
The following windows can be updated:

- **d** (Data), **k** (Stack), **r** (Register),
- **s** (Source), **a** (Assembly), **mem** (Memory), **t** (Trace)

With `interval` you can specify the update interval (in seconds). If `interval` is zero, no window is automatically updated.

The updating of the Data Window is ON at startup, the others are OFF.

If all windows are being updated and/or many monitor commands are active it will increase the load on the communication between CrossView Pro and the target.

This command is not available if the background mode is not supported (check the addendum).

Example
To toggle the updating of the Register Window, type:

```
u r
```

To toggle the updating of the Source Window, type:

```
u s
```

To disable period updating, type:

```
0 u
```

CB, ubgw
**ubgw**

**Function**
Update the appropriate window when the target runs in the background.

From the View menu, select **Background Mode** and select one of the refresh options.

The command line syntax is:

```
ubgw [ s | a | k | r | d | mem | t | all ]
```

**Description**

The following windows can be updated:

- s (Source), a (Assembly), k (Stack), r (Register), d (Data), mem (Memory), t (Trace), all (all open windows)

Without an argument, the **ubgw** command refreshes all windows selected by the background mode (**u** command).

The **ubgw all** command refreshes all open windows.

This command is not available if the background mode is not supported (check the addendum).

**Example**

To update the Source Window, type:

```
ubgw s
```

To update the Memory Window, type:

```
ubgw mem
```

**u**
unset

Function
Delete a macro definition.

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box. Highlight the name of the macro and click on the Delete button.

The command line syntax is:

```
unset [ name !]
```

Description
The unset command deletes a macro. If name is supplied, the specified macro is deleted. If no arguments are supplied, all currently defined macros are deleted after CrossView Pro confirms your intent.

It is important to understand that macro expansion takes place for all names. Therefore if you wish to pass the name of a macro to a command, for example unset, you must escape it with ‘!’, to keep from expanding the name.

Example
To delete all macros, type:

```
unset
```

CrossView Pro will first ask for confirmation. To delete all the macro definitions at the same time, click on the Delete all button in the Macro Definitions dialog box.

To delete the macro named macro, type:

```
unset macro!
```

set, echo, save, !
update

Function
Update a Data Analysis window.

Click on the Update Data Analysis Window button in a Data Analysis window.

The command line syntax is:

$update \"window\$"

Description
Update Data Analysis window \textit{window} by issuing a sequence of update commands. These update commands were added with the \texttt{graph\_add\_update} command.

When you use the update command in a complex breakpoint, you should append a \texttt{!} character to prevent early macro expansion.

Example
To retrieve data and show it in window \texttt{demo}, type:

\begin{verbatim}
graph_clear_updates "demo"
graph_add_update "demo",memget data[$i],100,$buffer
graph_add_update "demo",graphm "demo","show_x_t.cxl"
graph_add_update "demo",graph "demo","x_t.cxl",$buffer,0,1
update "demo"
\end{verbatim}

To update window \texttt{demo} as part of a complex breakpoint, type:

\begin{verbatim}
0x100 bi {update! "demo"}
\end{verbatim}

\texttt{graph\_add\_update, graph\_clear\_updates}.
Section 11.5, \textit{Data Analysis}, in chapter \textit{Special Features}. 
use

Function

Change source directories run-time.

From the Target menu, select Settings... to open the Target Settings dialog box. Click on the Configure... button and specify the names of the directories containing your source files. Relative paths are allowed.

The command line syntax is:

```
use [path]...
```

Description

The use command changes the source directories. Without a path this command empties the search path, except for the path . (current directory). If one or more paths are supplied, this command adds the, semicolon separated, paths to the list of searched directories. Relative paths are allowed.

Example

To clear the source directory path, type:

```
use
```

To search for source files in the directory /project/src and in the src directory relative to your current directory, type:

```
use /project/src;../src
```
**wt**

**Function**

Wait for the completion of the target.

The command line syntax is:

```
wt
```

**Description**

This command can only be used if the target runs in the background mode.

This command waits for the running process to stop.

Waiting can be interrupted by typing `ctrl-C`. The target continues to run without interruption. It could be that some informational messages from the target are displayed in the command window. They can be ignored.

Not available for all execution environments.

**CB, st**
Function

Force an exit from assertion mode.

The command line syntax is:

\[ \texttt{[exp]} \texttt{x} \]

Description

Normally this command stops execution immediately, but if \texttt{exp} is present and its value is non-zero, then CrossView Pro finishes executing the entire command list of the current assertion.

Example

To define an assertion to stop the program when the value of global variable \texttt{myvar} exceeds 10, type:

\[ \texttt{a if (myvar > 10) \{x\}} \]

To define an assertion to suspend the assertion mechanism and continue program execution when global variable \texttt{myvar} exceeds 10, type:

\[ \texttt{a if (myvar > 10) \{ A s; 1 x; C\}} \]
Z

Function

Toggle case sensitivity in searches

From the Edit menu, select Search String... to open the Search String dialog box. This dialog contains the Case Sensitive check box.

The command line syntax is:

Z

Description

Toggle case sensitivity in searches. The initial state of this toggle depends on information in the currently loaded absolute file. Use the I command to find out the state of the case sensitivity.

This command affects everything: file names, function names, variables and string searches.
14.1 WHAT THIS CHAPTER COVERS

The following is a list of common user error messages, and some suggested ways to solve the problem.

CrossView Pro is a complex program running on several hosts. From time to time, slight differences between the documentation and the program's operations do occur. The list of errors presented below and the suggested remedies may not be, therefore, entirely comprehensive.

If you get a message that begins with "XVW Error" or "XVW Fatal Error" please contact TASKING technical support for help.

14.2 ERROR MESSAGES

(in alphabetical order):

"member-name" is not defined for "enum enum"

You cannot assign or compare an enum type with a name that is not in the enumeration's members. Try casting the enum to a different type.

'save' must have a filename; type 'help save' for more information

The save command requires a file to be supplied. Note: if the supplied file name already exists, it will be overwritten.

*** Fatal XVW error

CrossView Pro has detected a error which it can not handle. If information is displayed, you may be able to detect the source of the error and correct it. Otherwise, if the message persists, please contact TASKING Technical Support.

0x value is an invalid value. The register register is unchanged.

The value supplied is incorrect for the specified register. Verify that both the value and the register are correct and retry.

Adding 2 pointers not allowed

You cannot add two pointers together in an expression. If you intended to add to a pointer, make sure that the argument is a value, not another pointer.
Address not allowed for '!' or ~ or % operator'

The "Not", "One's complement", and "Modulus" operators cannot be used with an address. If you intended to perform the operation on the contents of the address, please be sure to dereference the pointer.

Addresses not allowed in ' * or / operator'

The multiply and divide operators cannot be used with address data. If you intended to perform the operation on the contents of the address, please be sure to dereference the pointer.

Addresses not allowed in ' bitwise logical or logical or shift operators'

Bitwise logical (&, ^, or |), logical (&& or ||), and shift (<< >>) operators only work on data, not addresses. If you intended to perform the operation on the contents of the address, please be sure to dereference the pointer.

Attempt to set breakpoint at invalid address

The memory location is not available. If the memory location is not out of the target chip’s range, you may need to map the target system’s memory to allow access to this location.

Bad argument to the command command

The argument you have given to the sio or f command is not allowed. Refer to the Command Reference chapter, for allowable arguments and their meanings.

Bad assertion number: number

The number number is not a valid assertion number. List assertions with the l a (list assertions) command to determine which assertion numbers are valid.

both expressions must be addresses for 'relational operator'

If one of the expressions is an address type, both expressions for relational operators (<, <=, >, >=, ==, and !=) must be address types. Retry with both expressions as either addresses or arithmetic types.

Breakpoint is (or at the address of) an CrossView internal breakpoint. It can not be deleted.

You may not install a breakpoint over an CrossView Pro internal breakpoint. See Breakpoints and Assertions chapter for more information.
Error Messages

com return code=code

The MS–DOS version of CrossView Pro received a status condition from the monitor communication channel which it can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

command takes no arguments.

The command command needs no arguments. Refer to the Command Reference chapter, for the command syntax.

Can not open file (file)

CrossView Pro could not open the file file. Check the spelling of file and check that the file is in the correct directory. You should also check the permission of file. With MS–DOS, check the CONFIG.SYS file for the maximum number of open files allowed. Increase the number and reboot if necessary.

Can not output to input stream

An attempt was made to output to an input stream. The most common case is incorrectly setting up your simulated i/o streams. Correct and retry.

Can not scroll that window

The window you have tried to scroll is not scrollable. Examine your choice of window and/or your choice of windowing commands.

Can’t define macro: out of space

There is not enough host memory to add your macro. Eliminate one or more unused macros before adding a new one.

Can’t expand macro: out of space

There is not enough host memory to expand your macro. Eliminate one or more unused macros before adding a new one.

Can’t monitor data: out of space

CrossView Pro cannot add any more variables or expressions to monitor. You must delete one or more variables or expressions before adding any more.
Can’t open **logfile–name** as log file

CrossView Pro could not open the specified host-to-target system communications logfile. Check the spelling of **logfile–name** and that **logfile–name** is in the correct directory. Check permissions of **logfile–name**. With MS-DOS, check the CONFIG.SYS file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host Operating System.

Can’t open **output–file–name** as output file

CrossView Pro could not open the specified output file. Check the spelling of **output–file–name** and that **output–file–name** is in the correct directory. Check permissions of **output–file–name**. With MS-DOS, check the CONFIG.SYS file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.

Can’t open **playback–file–name** as playback file

CrossView Pro could not open the specified playback file. Check the spelling of **playback–file–name** and that **playback–file–name** is in the correct directory. Check permissions of **playback–file–name**. With MS-DOS, check the CONFIG.SYS file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.

Can’t open **record–file–name** as record file

CrossView Pro could not open the specified recording file. Check the spelling of **record–file–name** and that **record–file–name** is in the correct directory. Check permissions of **record–file–name**. With MS-DOS, check the CONFIG.SYS file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.

Can’t open file ‘**file**’

CrossView Pro could not open the specified file. Check the spelling of **file** and that **file** is in the correct directory. Check permissions of **file**. With MS-DOS, check the CONFIG.SYS file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.
Can’t perform trace, out of memory

There is not enough host memory to support tracing. Reduce memory demands and retry again. If the problem persists, please contact the TASKING Technical Support staff for assistance.

Can’t set breakpoint; either the current file has no symbols, or line line# is not inside any procedure in the current file.

CrossView Pro was unable to set the breakpoint that you specified. First check the location of line line# and verify that it is in the current procedure being debugged. If it is within the current procedure, then you may need to compile/assemble/link/locate for debugging. Refer to chapter Overview for details.

Can’t start a new process. Feature not implemented.

Your host system does not support shell commands. Any attempt to issue shell commands will cause this message to be displayed.

Can’t write to a read–only SFR.

The SFR register is a read–only register. It can not be set or altered.

Cannot allocate memory for symbol table

Allocating memory for storing the symbol table failed. Remove some tasks from memory or add more memory to your computer system.

Cannot allocate symbol table memory buffers

The symbol table is too large for CrossView Pro. You may need to selectively compile with the –g switch only those files and procedures that most interest you.

Cannot allow that combination of operand(s) and operator

The operand(s) is/are incompatible for this type of operation. For example, you may not add two structures. Please verify the operation and data types you are using.

Character constant is missing ending ’

Character constants must be delimited with single quotes. Example: ’a’.
**Command 'command' not allowed while emulator running in background**

The target is running, this command is not allowed unless the target is stopped. See the `st` command.

**couldn’t error–message**

VMS is reporting a condition that CrossView Pro can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

**Data already being monitored "task-id":‘symbol’**

The variable or expression `symbol` is already being monitored by CrossView Pro. You do not need to enter it again.

**Display format required**

The display command expected an output format option that was not supplied. See chapter *Command Language* for valid format options and their meanings.

**Double not allow in ’% or ~ operator’**

You may not use the one’s complement or modulus operators on double floating point types.

**Double not allow in ’bitwise operator’**

You may not use bitwise operators (&, ^ and |) on double floating point types.

**ERROR: you must enter ?,i,r,d**

CrossView Pro’s line editor only supports the following commands: `?`–help, `i`–insert, `r`–replace, `d`–delete, and `<cr>` to execute command.

**Establish a file context first.**

The command executed requires an active file. Verify the file you specified to CrossView Pro on start up.

**Establish a procedure context first**

The command executed requires an active procedure. Either execute the command from within a procedure, or give a procedure name as an argument to the command.
Exiting procedure call state
An unknown system signal caused the end of a command line function call.

Expecting stream number
The following forms of the `sio` command expect a stream number:

- `stream sio {i | o} {file | screen}
- `stream sio d
- `stream sio p prompt`

Expression garbled
The symbol table contains a type that is unknown to CrossView Pro. Please verify that you are using the compiler and utilities supplied to you. If the condition persists, please contact the TASKING Technical Support staff for assistance.

File has already been edited, going to NEW file
The command executed requires that the file be edited only once. A new file has been created.

Failed to allocate the SIO tables
Entries for recording simulated input/output information could not be allocated due to lack of host memory. Please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Float not allowed in `% or ~ operator`
You may not use the modulus or one’s complement operators on floating point types. Change the data type to an appropriate type, for example, integer.

Float not allowed in `bitwise or shift operator`
You may not use the `bitwise` (&, ^, or |) or `shift` (>>, or <<) operators on floating point types. Change the data type to an appropriate type, for example, integer.

Framing Error on COM port number
The host computer detected a data frame communication error on COM port `number`. Check the host and target communication set up as well as line connections. If the problem persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.
I can’t put something that big in the child process

The size of the expression exceeds the buffer size needed to spawn a child process. Be sure you have linked end.c in your application. This module implies space for CrossView Pro in your execution environment. Refer to section Building Your Executable in chapter Overview. If this condition persists, please contact the TASKING Technical Support staff for assistance.

I don’t have symbols for this procedure

You will need to re-compile, assemble, link and locate with the proper debugging options before using this command. See section Building Your Executive in chapter Overview for details.

I have no source file for this address

The program counter holds an address which is outside all the address ranges that CrossView Pro knows about. This may happen if program execution has reached a file that was not compiled with the -g generate debug symbols switch.

I need a linenumber

The go g command requires a line number. Enter a line number and the command will be executed.

Illegal address for Emulator Hardware Breakpoint

The address specified is out of emulator hardware breakpoint memory range. Verify the address and retry.

Illegal argument ("0") to 'p' command

You must specify a number greater than 0 for the p command, which prints the specified number of lines.

Illegal argument to 'command' command: 'argument'

You have passed an illegal argument to the specified command. Refer to chapter Command Reference for legal arguments.

Illegal argument to ct: 'argument'

You have passed an illegal argument to the C-trace command. Refer to chapter Command Reference for legal arguments.
Illegal data monitor command

You have passed an illegal argument to the \texttt{m} data monitor command. Legal commands are:

\begin{itemize}
  \item \texttt{m exp} to set up monitoring
  \item \texttt{id m d} to delete monitoring of a specific expressions
  \item \texttt{m d} to delete monitoring of all expressions
\end{itemize}

Illegal third arg to set: 'argument'

The \texttt{set} command may have only two arguments: the name by which the macro is known and the command string to be executed when the macro is invoked. Enclose the command string in quotes, separating the individual commands with semicolons. Refer to chapter \textit{Command Reference} for more information.

Improper floating point format length

You have specified a format length that is inconsistent with floating numbers. Legal lengths are 4 and 8 bytes.

Improper integer format length

You have specified a format length that is inconsistent with integer numbers. Legal length are 1, 2, and 4 bytes. You may also choose \texttt{b}, \texttt{s}, or \texttt{l} for 1, 2, and 4 byte integers.

Improper string format length

You have specified a format length that is inconsistent with character strings. Choose a positive number.

Input buffer overflow

CrossView Pro is over-running the input buffer. Contact your system administrator to either increase the input buffer or lower the communication line baudrate.

Input communications buffer overflow on COM port

CrossView Pro is over-running the input buffer. Contact your system administrator to either increase the input buffer or lower the communication line baudrate.
Input from stdin longer than max–input–size characters: input–string

Command truncated

The input data is longer than the input buffer, therefore the data was truncated at max–input–size. Try to reduce the input data and/or commands.

Internal error while setting an instruction level breakpoint

If this error condition persists, please contact the TASKING Technical Support staff for assistance.

Invalid assertion maintenance command

You have entered an illegal assertion command. Valid commands are:

- **a a** to activate assertions
- **a d** to delete assertions
- **a s** to suspend assertions

Invalid value for uplevel break.

You have entered an illegal value for an uplevel break. The form of the command is exp bU or exp bU, where exp determines how many returns from functions should occur before the break. Execute the t command to find out how many levels down in the stack you are, then choose an appropriate value for the uplevel break. See chapter Command Reference for more information.

Invoking procedure calls not allowed while emulator is running in the background

The target is running, this command is not allowed unless the target is stopped. See the st command.

Macro Expansion error: expansion looping

CrossView Pro looped 50 times while trying to expand this macro without completing the expansion. Check the logic of the macro arguments. It may need to be corrected or simplified.

Macro Expansion error: expansion too large

The macro expansion exceeds 200 commands. The macro must be simplified.
**Macro Expansion error: missing ’(’**
See the command reference page or use the help command to review macro command syntax.

**Macro Expansion error: missing ’)’**
See the command reference page or use the help command to review macro command syntax.

**Macro Expansion error: missing ’,’**
See the command reference page or use the help command to review macro command syntax.

**Macro Expansion error: not enough args**
See the command reference page or use the help command to review macro command syntax.

**Macro Expansion error: out of space**
There is not enough memory to expand the macro. Eliminate one or more unused macros before adding a new one.

**Maximum trace size is: max–trace–size**
CrossView Pro can perform C tracing only up to max–trace–size source lines. Choose a number less than max–trace–size with the ct command.

**Missing { after if command**
The required format for the if command is: 

```
if exp {commands}
```

**Missing file name or ‘screen’**
The *sio* command was missing a required parameter for setting up a simulated i/o stream. See chapter Command Reference for command definition and format.

**Missing format character**
You did not specify a display format type with your command. Either remove ’/’ from the command, or add a format character.

**Missing prompt string**
You did not specify a prompt string with the *sio* command. Either remove *p* from the *sio* command, or add a prompt string.
Must supply 'b' or 'f'

The color command requires a value of f for foreground or b for background to modify the screen color.

Must supply 'r', 'w' or 'b'

Both the data range (bd) and data (bd) breakpoint commands require the type of data modification to generate a break condition. Use r for read, w for write, and b for both read/write. Please see chapter Command Reference for more information.

Must supply data to be monitored

You did not specify a variable or expression to the m monitor command. Please provide a variable or expression to be monitored, for example, m myvar.

Must supply second address with bd command.

The bd command requires two addresses. Either specify an upper limit if you want to break anywhere in memory range, or use the bd command if you want to break on an individual address.

Negative /baudrate value ignored. (VAX) or Negative baud rate (–S) value ignored.

The baudrate specified was a negative value. Please specify a legal value or use the default.

Negative /TIMEOUT value ignored. (VAX) or Negative timeout interval (–I) value ignored.

The timeout value specified was negative. Please specify a legal timeout value or use the default.

No child process

The CrossView Pro internal data structure containing user information about child processes is not as expected. Please contact the TASKING Technical Support staff for assistance.

No current file

Undefined special variable, $file; probably due to debugging where no symbols are present.
No current line number

Undefined special variable, \$line; probably due to debugging where no symbols are present.

No current procedure

Undefined special variable, \$proc; probably due to debugging where no symbols are present.

No host memory

There is not enough space in memory to execute this command. Check whether you have unnecessary processes running in the background or resident in memory.

No host memory for command

There is not enough space in memory to execute this command. Check whether you have unnecessary processes running in the background or resident in memory.

No macros to save; file not created

CrossView Pro found no macros to save, therefore the \texttt{save} command did not create a file.

No Match – pattern

CrossView Pro did not find the specified \texttt{pattern} in its search of this file. Check your spelling or case-sensitivity. Use the \texttt{Z} command to toggle case-sensitivity if necessary.

No memory space

There is not enough host memory to execute this command. Check whether you have unnecessary processes running in the background or resident in memory.

No more hardware breakpoints available

The target system uses hardware breakpoints to support the data breakpoint function. To continue, you must explicitly delete a data breakpoint before placing a new one.

No more room for directories (> max-dir-size)

You can reference no more that \texttt{max-dir-size} directories for source files.
No more SIO windows, I/O to command window.

Only four SIO streams can be displayed simultaneously in the SIO window. Subsequent SIO streams' output will be displayed in the command window.

No name of symbol file specified

CrossView Pro cannot deduce the name of a symbol file. No filename was given to the N command and no symbol file was currently loaded.

No playback name specified

Give the name of the playback file to be used for this session.

No process

CrossView Pro only allows one process to be debugged at the same time.

No such breakpoint

The breakpoint number was incorrect. List breakpoints with the lb command to find the correct breakpoint.

No such field name "name" for "<structure | union> name"

The field name is not recognized for the specified structure or union. Check the spelling of field name. The /t format will show you the names and types of a particular structure’s or union’s fields.

No Such Line

CrossView Pro can not find the specified line number in any of its known files. Please check the source window or a source listing for legal line numbers.

No such procedure, "name".

CrossView Pro does not recognize name as a procedure name. Check the spelling and whether the file was compiled/assembled/linked/located for debugging. Check that the file is in the appropriate directory.

No such procedure or file name: procedure

CrossView Pro does not recognize procedure as a procedure or file name. Check the spelling and whether the file was compiled/assembled/linked/located for debugging. Check that the file is in the appropriate directory.
No such PSW register state
Check register name and selected target.

No such register
The target processor does not have a register with that name.

No such sr reg state
Check register name and selected target.

No such stream
The stream you tried to delete does not exist. Check the stream number, correct, and retry.

No symbols – unable to determine end–of–procedure
CrossView Pro has no symbol information for this procedure. To facilitate debugging this procedure, you must compile, assemble, link and locate with the appropriate switches. Refer to the Overview chapter for details.

No symbols available in active procedures.
To get symbol information you must compile, assemble, link, and locate with the appropriate switches. Refer to the Overview chapter for details.

No symbols for that procedure
To get symbol information you must compile, assemble, link, and locate with the appropriate switches. Refer to the Overview chapter for details.

No User or System special variable matches prefix name
The string argument of the ls command did not match any user or system special defined variables. Check spelling and case-sensitivity and retry. You may also enter ls to print out all the user and system special defined variables.

Not enough memory available to start up windows. Either use the –nw (no window) option or remove resident programs from memory.
CrossView Pro has detected that there is not enough host memory to execute the windowing software. You may need to use the –nw option to start up CrossView Pro in line mode. Check whether you have unnecessary processes running in the background or resident in memory.
Not enough memory to execute shell command.

The attempt to create a child process for the shell command failed due to the lack of host memory. Check whether you have unnecessary processes running in the background or resident in memory.

Not enough memory to start window mode

CrossView Pro has detected that there is not enough host memory to execute the windowing software. You may need to use the –nw option to start up CrossView Pro in line mode. Check whether you have unnecessary processes

Not enough space

CrossView Pro has detected a general error due to lack of host memory. Check whether you have unnecessary processes running in the background or resident in memory.

Not in known territory. Could not set breakpoint.

CrossView Pro’s current location is not in a file or procedure that it knows about. The breakpoint request can not be performed.

Not in window mode

The command issued requires CrossView Pro windows to be active. Use the WW command and repeat the previous command.

Not that many levels active on the stack.

A stack level was specified that does not exist. Execute the t command to determine levels on the stack. See chapter Command Reference for more information.

Oops called with sig = signal–number

CrossView Pro has received a signal that it can not handle. Continuing from this point may result in a fatal process condition. If this condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Placement of the breakpoint handler must be in one of the restart vectors. Choose a value from 0 to 7.
Try again. (Hit <cr> to exit)?

The specified placement for the breakpoint handler was not valid for this target. CrossView Pro is requesting a valid location.


Procedure "**name**" is not active on the stack.

The procedure **name** was not found on the current stack. Execute the **t** command to list functions which are active on the stack.

Procedure '**name**' is not at that stack depth

The procedure **name** was not found on the specified stack. Execute the **t** command to list functions which are active on the stack.

Procedure "**procedure**" is not active

The procedure **procedure** was not found on the current stack. Execute the **t** command to list functions which are active on the stack or **lp** for list of procedures known to CrossView Pro.

Program not completely loaded

An error occurred during loading a symbol file. Check what caused the problem (illegal filename or file format). You may retry to load a symbol file.

Prompt too long (>

Choose a prompt of no more than **max-number** characters.

Ran out of memory reading symbol file into memory

Reduce the size of the symbol file by re-compiling only the "interesting" files with the **-g** debug switch.

Read I/O request could not be queued

VMS detected an error for a read I/O queue which CrossView Pro can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Readprompt I/O request could not be queued

VMS detected an error for a read I/O queue which CrossView Pro can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Redo: line too large

Limit line length to fewer than 256 characters.
Result type too large for command line call.
A command line function call must pass the result back in a register. The specified function does not. You cannot call functions whose return value is greater than an integer, for instance floating point types and structures.

Result type undefined
Type casting from the expression or variable to the result type was not possible.

Second address smaller than first
When specifying a range of addresses for a data breakpoint, the second address must be higher than the first.

Sim I/O request too long (> max–number bytes)
The I/O request exceeds the maximum length.

Simulated I/O stream out of range
Choose a stream value between 0 and 7.

Sorry, the ”v” command is not supported on this host
No visual editor is available on this host.

Stream already active
Either choose another stream, or deactivate this one before re-assigning it.

String constant is missing ending ”
String constants must be delimited with double quotes: ”

Subtracting 2 pointers not allowed
You cannot subtract two pointers in an expression. If you intended to subtract from a pointer, make sure that the argument is a value, not another pointer.

Symbol file is either unreadable or too short
The symbol file is not an absolute IEEE–695 file, or the file format is not correct, or the file is not an IEEE–695 file at all.
Symbol file is not formatted correctly
The symbol file is not intended for the type of microprocessor you are using.

Symbol not in current procedure
There is no symbol by this name in the current procedure. Check the spelling of the symbol name.

The 'command' command accepts no args
The command *command* does not accept any arguments. See chapter Command Reference for more information on *command*.

The window would be too large; Total lines must not be greater than *max-size*
The window size options specified would create a window that would have exceeded the screen size. Retry with corrected window size options.

There is insufficient information to do a structure dump
CrossView Pro cannot uniquely identify the structure or part of the structure to be dumped.

There is no associated source.
The program counter holds an address which is outside all the address ranges that CrossView Pro knows about. This may happen if program execution has reached a file that was not compiled with the `-g` debug switch.

There is no available source line for the current address.
*$pc= address*
CrossView Pro is reporting that the current position has no associated source line. This may happen if you are trying to debug a routine that was not compiled with `-g` debug switch or are trying to debug a runtime library routine.

This does not appear to be a struct or a union
The data entered is not recognizable as a structure or union. Check the specified variable.
**Timed read I/O request could not be queued**

VMS reported a condition on a timed read i/o request that CrossView Pro could not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

**Too many args to unset: 'argument'**

You may specify only one macro at a time, for example, `unset name`, or you may remove all macros at once with `unset`.

**Too many assertions (>max–number)**

The maximum number of assertions allowed is `max–number` as shown in the error message. Remove a previous assertion before trying to add one, or reinvoke CrossView Pro with the `–a` option to increase the maximum number of assertions.

**Too many breakpoints (> max_number)**

The maximum number of breakpoints allowed is `max–number` as shown in the error message. You must explicitly delete a breakpoint before adding any new ones. Alternatively, you could re–invoke CrossView Pro with the `–b` option to increase the maximum number of breakpoints.

**Too many locals (> max–number)**

Eliminate some existing locals or reinvoke CrossView Pro with the `–s` switch to increase the number of locals allowed.

**Too many modules**

The symbol file describes an application that was constructed from more than 1818 modules.

**Too many processes (> max–number)**

CrossView Pro allows only one process to be debugged.

**Too many streams (> max–number)**

The maximum number of I/O streams, `max–number`, has been reached. You must eliminate an I/O stream before adding a new one.

**Trace size is required**

The required format of the command is `exp ct`, where `exp` is the number of statements to trace. Re–enter the command with a value for `exp`.
**Type 'r', to run program from power–on conditions or 'c' to continue with current program pointer**

This is to inform you that command \( r \) is not implemented and that you should used \( r \) or \( c \).

**Type of command–line–expression is too complex**

The command line function returns a data type that CrossView Pro cannot handle. An example would be a function returning a structure.

**Unexpected breakpoint type 'type'**

CrossView Pro has encountered a breakpoint with an unknown type attribute. Verify the previous break commands and re–try. If the condition persists, please contact the TASKING Technical Support staff for assistance.

**Unknown command ‘command’ (<number>)**

CrossView Pro does not recognize \( command \), and has echoed the command number for Technical Support purposes. Please check the spelling and retry. If the condition persists, please contact the TASKING Technical Support staff for assistance.

**Unknown data monitor id ‘number’**

The monitor number \( number \) that you tried to delete does not exist. Use the \( M \) command to list currently monitored variables.

**Unknown data size**

Valid data sizes are 1, 2, 4, or 8 bytes.

**Unknown display mode**

See chapter *Accessing Code and Data*, for a list of display mode options.

**Unknown name ’name’**

Variable \( name \) is not in scope or is undefined.

**Unknown procedure ”name”**

The function \( name \) does not exist in any file that CrossView Pro knows about. The file containing \( name \) may not have been compiled with the \( -g \) debug switch.
Unknown macro 'name'

CrossView Pro does not recognize the macro name as given. Please check the spelling. You may list all current macros by using the set command with no arguments, or display the Macro window for currently defined macros.

Unknown window

CrossView Pro does not recognize the window name as given. See chapter Command Reference for valid window arguments.

Unsupported format type (parameter)

Supported types are c (character), x (hex), and o (octal).

Value number is not defined for this enum.

The member specified was not part of the enumerated set. Please check the spelling and verify that the correct enum was used.

Value exceeds depth of stack.

A stack level was specified that does not currently exist. Please check the value and retry. Check the stack window for valid stack levels, or execute a t command (trace stack) to determine the depth of the stack.

VMS error : cannot establish handler for signals

CrossView Pro on VMS could not establish proper error handlers. If the condition persists, please contact the TASKING Technical Support staff for assistance.

VMS error : cannot establish pasteboard

CrossView Pro on VMS can not establish the running environment. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

VMS error : cannot establish virtual keyboard

CrossView Pro on VMS can not establish the running environment. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.
VMS error code = number\ Attempt to get message text fail.

CrossView Pro on VMS received an error while attempting to provide an error diagnostic message from the host error message library. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Warning: NULL pointer dereference

The expression contained a null pointer dereference. Check the expression for possible errors, or verify that the pointer should in fact be null.

Warning: pointer dereference with invalid segment selector.

The pointer is addressing invalid memory and the dereference may report unexpected data results. Check the initialization of the pointer or verify that it has been set correctly.

Warning: too few parameters.

The command given was not invoked with the proper number of arguments. CrossView Pro will supply the command with defaults which may or may not produce the result you expected.

Warning: Using file–b instead of file–a

CrossView Pro could not find file–a, or file–a’s status was such that CrossView Pro could not use it. If file–b is not correct, check file–a spelling and its directory.

Warning: X=Y: X is x–size bytes and Y is y–size bytes

The assignment of two different size variables may cause unexpected results. Please correct the condition if possible. This condition is common when assigning string variables where string y is shorter than string x.

Warning: X=Y: X is x–size words and Y is y–size words

The assignment of two different size variables may cause unexpected results. Please correct the condition if possible. This condition is common when assigning string variables where string y is shorter than string x.
Warning: CrossView comment terminated by end of command line

*source–command–line*

The playback file has a comment that was not terminated. It is by default terminated, but if the next line was the continuation of the comment, then unexpected results may occur. Please terminate comment strings on each line to avoid this warning.

Windows not enabled; use WW to enable

The command issued can only be used when windows are enabled.

Write I/O request could not be queued

CrossView Pro received a condition that it could not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Write–only register. Value may not be valid.

CrossView Pro set a write–only register but has no way of verifying the correctness of the register contents.

Wrong storage class for data breakpoint

You may not set a data breakpoint at the address of a register variable or special variables.

CrossView could not disassemble the emulator’s trace buffer because the address information in the buffer is incorrect.

The trace buffer may be corrupted. Re–check the commands leading to this condition, and retry. If the condition persists, please contact the TASKING Technical Support staff for assistance.

**XVW error – message**

or

**XVW Fatal error – message**

These messages are generated by internal conditions that should not normally occur. The *message* is usually encrypted and should be brought to the attention of the TASKING staff. Please contact the TASKING Technical Support staff for assistance.
**XVW:main – Cannot continue, incomplete initialization.**

CrossView Pro’s initialization was interrupted and could not be completed. Please re-start CrossView Pro, and if the condition persists, contact the TASKING Technical Support staff for assistance.

**You can’t goto a line outside of the current procedure**

The specified line number is outside the current procedure. Change the line number to one within the procedure or enter the correct procedure before executing this command.

**You may not assign from a host system string/array**

The expression given performs an assignment that CrossView Pro can not perform at this time.

**You may not assign from a void function**

The expression attempts to assign a variable from a void function. Please check the return value of the function and verify that you are referencing the correct function.

**You may not assign more than max–size bytes to a special variable**

An attempt was made to assign greater than the maximum number of bytes to a special variable. Check the expression for errors, and check the variable’s spelling.

**You may not assign to a constant**

The value of a constant cannot be changed. Check the name that you have specified.

**You may not mix assignment of a scalar and an aggregate**

An attempt was made to assign incompatible types of data. Please check the data types and retry.

**You need to supply a program name.**

CrossView Pro requires a program name to debug on the invocation line.
15.1 WHAT THIS CHAPTER COVERS

This chapter defines terms common to CrossView Pro and source–level embedded systems debugging. Italicized items in definitions are also glossary entries.

15.2 GLOSSARY TERMS

A

absolute file. The IEEE-695 file (.abs) that contains symbolic debug information and the final executable code of the target system.

active window. The window last selected by the user in CrossView Pro that commands operate on as a default. An active window’s title appears in a different color (on color monitors) or inverse video (on monochrome).

assertion. A command or set of commands to be executed before every line of source code, assessing the application state on validity. Assertions are especially useful in tracking down hard to find bugs when other methods fail. Individual assertions may either be active or suspended. See also assertion mode.

assertion mode. A mode of CrossView Pro operation under which assertions will be executed. Before CrossView Pro executes a source line of code, it assesses all assertions active. Since CrossView Pro is single stepping, breakpoints will not be effective. As long as there is at least one assertion active, CrossView Pro operates in assertion mode. A program running in assertion mode will be stopped when an asserted command executes the x (exit assertion mode) command.

B

background mode. A target dependent feature in CrossView Pro that lets the execution environment run and at the same time allows you to enter a reduced set of CrossView Pro commands, for example to monitor memory contents.
bias. A value added to program code addresses to tell CrossView Pro where the application has actually been loaded into memory. The bias can be set in the Load Application dialog or with the -n startup option.

breakpoint. A mechanism for stopping target program execution, for example at a particular line of code (see code breakpoint), when a memory address is accessed (see data breakpoint), or at a return from a function (see up-level breakpoint). There are two general kinds of breakpoints. Hardware, which the emulator or on-chip debug support sets in its circuitry, and software, which are special instructions placed in user code. Since the number of simultaneous hardware breakpoints is limited in number, CrossView Pro uses both kinds by default. Other types of breakpoints are for example instruction count breakpoint, cycle count breakpoint, timer breakpoint and sequence breakpoint. See also probe point.

breakpoint window. A CrossView Pro dialog displaying all breakpoints, and any attached commands.

c
C

C-trace window. A CrossView Pro window keeping a record of the most recently executed C or machine statements.

cache. Some microprocessors keep a copy of the most recently executed instructions in on-chip memory to speed-up execution.

code breakpoint. A breakpoint that halts program execution when a particular line of code is reached. A code breakpoint can have a command list. A breakpoint can be set on a line of source code or at the address of a machine instruction. See also count.

code coverage. See coverage.

command window. A CrossView Pro window that gives access to CrossView Pro via a command line interface with history.

command list. A series of CrossView Pro commands and/or C (assignment) statements attached to a code or data breakpoint, executed when the breakpoint is hit.

count. The number of times a breakpoint must be hit to finally stop execution. Breakpoints are created with a count of 1. The C command may be used to change the count of a breakpoint.
**coverage.** With **code coverage** the source line is marked for each source code line that is executed. Through code coverage you can find executed and non–executed areas of the application program. **Data coverage** allows you to verify which memory locations, i.e. which variables, are accessed during program execution. Additionally, you can see stack and heap usage. The availability of this feature depends on the execution environment.

**cycle count breakpoint.** A breakpoint that halts program execution after a specified number of CPU cycles. A cycle count breakpoint can have a command list.

**current function.** The function that is currently being executed. The current function is always at level 0 on the stack. Also stored in the CrossView Pro special variable $PROCEDURE$.

**data breakpoint.** A breakpoint that halts program execution when a particular memory address (or an address within a particular range) is written to, read from, or both. A data breakpoint may have a command list and a count.

**data coverage.** *See coverage.*

**data monitoring.** CrossView Pro allows you to monitor expressions and variables in the Data window. CrossView Pro updates their values whenever execution stops.

**data window.** A CrossView Pro window displaying the values of monitored expressions.

**diagnostic output.** Program output designed for debugging purposes. With CrossView Pro, probe points and data monitoring can be used for diagnostic output, eliminating the need for intrusive and annoying printf calls compiled into code.

**disassembly window.** A CrossView Pro window showing a part of the disassembled program space. It also displays other information such as the current execution position, viewing position and installed breakpoints.

**dot operand.** The period character "." used in an expression to represent the last value CrossView Pro calculated. The dot operand is useful as shorthand.
**embedded system.** Computer(s) executing an application program built to run in (semi) real–time. An embedded system usually is part of a larger, non–computer system, hence the term "embedded." The TASKING product line is designed for embedded systems programming.

**emulator.** A device used to monitor and control various aspects of a microprocessor's operation. An emulator usually is built around two chips, the target microprocessor and a controlling chip. The controller chip can start and stop the target chip’s program execution, and can examine and change registers and memory. An emulator can be connected via a probe to a hardware prototype to fully emulate the behavior of the target chip. See ROM monitor.

**execution position.** The source line to be executed next. See viewing position.

---

**File System Simulation (FSS).** A facility to redirect all C library file I/O operations on the target, to the host system via CrossView Pro. File system simulation is often used to provide input to an application for which no hardware I/O is available yet and to log test results.

**format.** The manner in which CrossView Pro displays addresses and data; for instance, hexadecimal, character and octal are different formats. You may include special format codes when specifying variables.

---

**hardware breakpoint.** See breakpoint.

**help window.** A window explaining the use of CrossView Pro windows and dialogs and summarizing the syntax and function of CrossView Pro commands.

**history mechanism.** A facility for modifying and executing previous CrossView Pro commands.
**host system.** The computer system on which CrossView Pro is run. The host system is connected to the target system, usually with an RS–232 cable.

**image part.** This is the downloadable part of the absolute file that contains the executable code of the target program. See also absolute file.

**instruction count breakpoint.** A breakpoint that halts program execution when a number of instructions have been executed. An instruction count breakpoint can have a command list.

**interrupt key.** The key that interrupts ongoing processes. On many systems this is `ctrl–C`.

**I/O Simulation.** A technique to intercept input and output for debugging purposes. I/O Simulation is often used for testing a program before the actual input and output hardware devices are present. See also stream.

**local variable.** A variable that can only be referenced from within its defining function.

**low-level breakpoint.** A code breakpoint placed on an individual machine instruction. Low–level breakpoints can be set with the `break code address` command.

**macro.** A user–created shorthand for a CrossView Pro command sequence. Macros can accept parameters and can be saved to a file.

**main().** The function where a C program’s execution begins. See also system startup code.

**MAU.** See minimum addressable unit.
**memory map.** The configuration of an emulator’s memory that specifies which addresses are read-only, and which addresses are read/write. With many emulators, you must first set up a memory map before using CrossView Pro, for example via transparency commands.

**minimum addressable unit.** For a given processor, the amount of memory located between an address and the next address. It is not necessarily equivalent to a word or a byte. Abbreviated MAU.

**monitoring.** See data monitoring.

---

**object language.** A representation for target machine instructions, with the ability to represent either relocatable or absolute address locations.

**on-line help.** A complete summary of all CrossView Pro commands and individual descriptions available while CrossView Pro is running.

**on-line tutorial.** A playback file supplied with CrossView Pro that demonstrates CrossView Pro’s capabilities.

**output buffer.** The location in memory where CrossView Pro directs I/O simulation output. See also I/O Simulation.

---

**patch.** A technique to alter program flow (without recompiling the source code) with CrossView Pro commands and/or C expressions. With CrossView Pro, it is possible to use breakpoints to alter program flow by patching in new code or moving the execution position around existing code.

**pop-up window.** A window that appears in certain situations that overlaps the current display. Pop-up windows usually contain information (like a command definition) that need not be continuously displayed.

**probe.** A part of an emulator that can be inserted in place of the target chip in the actual embedded systems hardware.

**probe point.** A special kind of breakpoint. When a probe point breakpoint is hit, the associated commands are executed and program execution is continued.
profiling. For each source code line that is executed, the timing information is given.

quiet command. A Q instruction at the start of the command list of a breakpoint suppressing the default display of function: line number: source file.

record & playback. The ability to save CrossView Pro commands (and, if desired, Command window output) to a file. CrossView Pro can play back simple text files consisting solely of CrossView Pro commands.

register window. A CrossView Pro window showing the contents of the target microprocessor’s registers.

reserved special variables. Special variables ($LINE, $PROCEDURE, $FILE) whose values CrossView Pro maintains to reflect the current status of the debugging session. See also special variables.

ROM monitor. A program which supervises or controls, at an elementary level, the overall operation of an embedded system. Because of the limited hardware features of most boards containing ROM monitors, some CrossView Pro features may not be supported. See also emulator.

RS-232 cable. A cable that exchanges asynchronous data between the host and target systems.

scope. The extent to which a variable can be referred to. Global variables are always in scope; local variables are only in scope when their defining function is the current function.

select. To make a window active.

sequence breakpoint. A breakpoint that halts program execution when breakpoints are hit in a specified sequence. A sequence breakpoint can have a command list.
**single stepping.** Executing a source statement or a machine instruction then halting. Single stepping lets you observe a program executing in stop-motion, to observe registers, variables and program flow.

**skidding.** When a microprocessor executes a few instructions after a data breakpoint halts execution. On some microprocessors, execution may not stop until all instructions in its pipeline have been executed. It is important to realize therefore that a target program may not halt at the precise instruction where the data breakpoint occurred.

**software breakpoint.** See breakpoint.

**source level debugger.** A debugger capable of correlating source code and variable names with object code. CrossView Pro is a source level debugger.

**source window.** A CrossView Pro window displaying the high-level language program code. It also displays such information as the current execution position, viewing position and installed breakpoints.

**special variable.** A variable independent of the target program that CrossView Pro maintains for the user’s benefit. Special variables start with a $ and are defined when first mentioned. CrossView Pro also maintains **reserved special variables** that contain information about the state of the debugging session.

**stack depth.** The level that a particular return address from a function resides on the stack. The current function is always at stack depth zero.

**stack traceback.** An operation in which CrossView Pro reads the return addresses and passed parameters off the stack to reconstruct program flow.

**stack window.** A CrossView Pro window showing the function calls on the stack, with the values of the parameters passed to them.

**startup options.** Special command line switches passed to CrossView Pro when the debugger is first loaded. These options control items such as the number of assertions allowed, or can perform various actions such as to start recording screen output to a file.

**stream.** A particular input or output data path for I/O simulation. Per method, File System Simulation, File I/O or Debug Instrument I/O, a unique stream numbering scheme is used.

**switches.** See startup options.
symbolic debugger. A type of debugger generally limited to dealing with global, non-dynamic variables. Symbolic debuggers know nothing of the data types; they translate global names and global subroutines into addresses. See also source level debugger.

symbol information. The necessary information for CrossView Pro to correlate object code with source code. The symbol information is part of the absolute file. See also absolute file.

system startup code. A run-time library routine written in assembly language source that initializes the target environment before calling main(). See also main().

target communication. The low-level communication between the host and the target system. For the most part, CrossView Pro handles target communications, allowing the programmer to concentrate on the high-level information.

target microprocessor. The chip on which the target program runs.

target system. The targeted microprocessor where the embedded application runs.

terminal window. A CrossView Pro window containing all the input and output streams directed to the screen. CrossView Pro can display several windows at a time.

timer breakpoint. A breakpoint that halts program execution after a specified number of seconds or timer ticks. A timer breakpoint can have a command list.

trace buffer. A target-resident buffer that contains the most recent instructions executed by the target microprocessor. CrossView Pro uses this buffer to deduce a C-trace.

transparency mode. The mode in which CrossView Pro passes user input directly to the emulator. Transparency mode is often used when setting up memory maps.
**up-level breakpoint.** A code breakpoint set at the return from a function at a specified stack depth.

**viewing position.** The line of source code currently being viewed. This line contains the dashed line cursor. Some commands operate by default on the viewing position. The viewing position and the execution position are initially the same, but you may adjust each individually.
1 INTRODUCTION

This appendix discusses Globetrotter Software’s Flexible License Manager and how it is integrated into the TASKING toolchain. It also contains descriptions of the Flexible License Manager license administration tools that are included with the package, the daemon log file and its contents, and the use of daemon options files to customize your use of the TASKING toolchain.

2 LICENSE ADMINISTRATION

2.1 OVERVIEW

The Flexible License Manager (FLEXlm) is a set of utilities that, when incorporated into software such as the TASKING toolchain, provides for managing access to the software.

The following terms are used to describe FLEXlm concepts and software components:

feature A feature could be any of the following:
• A TASKING software product.
• A software product from another vendor.

license The right to use a feature. FLEXlm restricts licenses for features by counting the number of licenses for features in use when new requests are made by the application software.

client A TASKING application program.

daemon A process that “serves” clients. Sometimes referred to as a server.

vendor daemon
The daemon that dispenses licenses for the requested features. This daemon is built by an application’s vendor, and contains the vendor’s personal encryption code. Tasking is the vendor daemon for the TASKING software.
license daemon
The daemon process that sends client processes to the correct vendor daemon on the correct machine. The same license daemon is used by all applications from all vendors, as this daemon neither performs encryption nor dispenses licenses. The license daemon processes no user requests on its own, but forwards these requests to other daemons (the vendor daemons).

server node A computer system that is running both the license and vendor daemon software. The server node will contain all the dynamic information regarding the usage of all the features.

license file An end-user specific file that contains descriptions of the server nodes that can run the license daemons, the various vendor daemons, and the restrictions for all the licensed features.

The TASKING software is granted permission to run by FLEXlm daemons; the daemons are started when the TASKING toolchain is installed and run continuously thereafter. Information needed by the FLEXlm daemons to perform access management is contained in a license data file that is created during the toolchain installation process. As part of their normal operation, the daemons log their actions in a daemon log file, which can be used to monitor usage of the TASKING toolchain.

The following sections discuss:

- Installation of the FLEXlm daemons to provide for access to the TASKING toolchain.
- Customizing your use of the toolchain through the use of a daemon options file.
- Utilities that are provided to assist you in performing license administration functions.
- The daemon log file and its contents.

For additional information regarding the use of FLEXlm, refer to the chapter *Software Installation*. 
2.2 PROVIDING FOR UNINTERRUPTED FLEXlm OPERATION

TASKING products licensed through FLEXlm contain a number of utilities for managing licenses. These utilities are bundled in the form of an extra product under the name SW000057. TASKING products themselves contain two additional files for FLEXlm in a flexlm subdirectory:

- Tasking: The Tasking daemon (vendor daemon).
- license.dat: A template license file.

If you have already installed FLEXlm (e.g. as part of another product) then it is not needed to install the bundled SW000057. After installing SW000057 on UNIX the directory /usr/local/flexlm will contain two subdirectories, bin and licenses. After installing SW000057 on Windows the directory c:\flexlm will contain the subdirectory bin. The exact location may differ if FLEXlm has already been installed as part of a non-TASKING product but in general there will be a directory for executables such as bin. That directory must contain a copy of the Tasking daemon shipped with every TASKING product. It also contains the files:

- lmgrd: The FLEXlm daemon (license daemon).
- lm*: A group of FLEXlm license administration utilities.

Next to it, a license file must be present containing the information of all licenses. This file is usually called license.dat. The default location of the license file is in directory c:\flexlm for Windows and in /usr/local/flexlm/licenses for UNIX. If you did install SW000057 then the licenses directory on UNIX will be empty, and on Windows the file license.dat will be empty. In that case you can copy the license.dat file from the product to the licenses directory after filling in the data from your "License Information Form".

Be very careful not to overwrite an existing license.dat file because it contains valuable data.

Example license.dat:

```
SERVER HOSTNAME HOSTID PORT
DAEMON Tasking /usr/local/flexlm/bin/Tasking
FEATURE SW008002-32 Tasking 3.000 EXPDATE NUSERS PASSWORD SERIAL
```
After modifications from a license data sheet (example):

SERVER elliott 5100520c 7594
DAEMON Tasking /usr/local/flexlm/bin/Tasking
FEATURE SW008002-32 Tasking 3.000 1-jan-00 4 0B1810310210A6894 "123456"

If the license.dat file already exists then you should make sure that it contains the DAEMON and FEATURE lines from your license data sheet. An appropriate SERVER line should already be present in that case. You should only add a new SERVER line if no SERVER line is present. The third field of the DAEMON line is the pathname to the Tasking daemon and you may change it if necessary.

The default location for the license file on Windows is:

    c:\flexlm\license.dat

On UNIX this is:

    /usr/local/flexlm/licenses/license.dat

If the pathname of the resulting license file differs from this default location then you must set the environment variable LM_LICENSE_FILE to the correct pathname. If you have more than one product using the FLEXlm license manager you can specify multiple license files by separating each pathname (\lfpath) with a ‘;’ (on UNIX also ‘:’) :

Windows:

    set LM_LICENSE_FILE=\lfpath;\lfpath;...

UNIX:

    setenv LM_LICENSE_FILE \lfpath;\lfpath;...

If you are running the TASKING software on multiple nodes, you have three options for making your license file available on all the machines:

1. Place the license file in a partition which is available (via NFS on Unix systems) to all nodes in the network that need the license file.

2. Copy the license file to all of the nodes where it is needed.

3. Set LM_LICENSE_FILE to "port@host", where host and port come from the SERVER line in the license file.
When the main license daemon `lmgrd` already runs it is sufficient to type the command:

```
lmreread
```

for notifying the daemon that the `license.dat` file has been changed. Otherwise, you must type the command:

```
lmgrd >/usr/tmp/license.log &
```

Both commands reside in the `flexlm/bin` directory mentioned before.

### 2.3 DAEMON OPTIONS FILE

It is possible to customize the use of TASKING software using a daemon options file. This options file allows you to reserve licenses for specified users or groups of users, to restrict access to the TASKING toolchain, and to set software timeouts. The following table lists the keywords that are recognized at the start of a line of a daemon options file.

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESERVE</td>
<td>Ensure that TASKING software will always be available to one or more users or on one or more host computer systems.</td>
</tr>
<tr>
<td>INCLUDE</td>
<td>Specify a list of users who are allowed exclusive access to the TASKING software.</td>
</tr>
<tr>
<td>EXCLUDE</td>
<td>Specify a list of users who are not allowed to use the TASKING software.</td>
</tr>
<tr>
<td>GROUP</td>
<td>Specify a group of users for use in the other commands.</td>
</tr>
<tr>
<td>TIMEOUT</td>
<td>Allow licenses that are idle for a specified time to be returned to the free pool, for use by someone else.</td>
</tr>
<tr>
<td>NOLOG</td>
<td>Causes messages of the specified type to be filtered out of the daemon’s log output.</td>
</tr>
</tbody>
</table>

*Table A–1: Daemon options file keywords*

In order to use the daemon options capability, you must create a daemon options file and list its pathname as the fourth field on the DAEMON line for the `Tasking` daemon in the license file. For example, if the daemon options were in file `/usr/local/flexlm/Tasking.opt` (UNIX), then you would modify the license file DAEMON line as follows:

```
DAEMON Tasking /usr/local/Tasking /usr/local/flexlm/Tasking.opt
```
A daemon options file consists of lines in the following format:

- `RESERVE number feature {USER | HOST | DISPLAY | GROUP} name`
- `INCLUDE feature {USER | HOST | DISPLAY | GROUP} name`
- `EXCLUDE feature {USER | HOST | DISPLAY | GROUP} name`
- `GROUP name <list_of_users>`
- `TIMEOUT feature timeout_in_seconds`
- `NOLOG {IN | OUT | DENIED | QUEUED}`
- `REPORTLOG file`

Lines beginning with the sharp character (#) are ignored, and can be used as comments. For example, the following options file would reserve one copy of feature SWxxxxxx–xx for user “pat”, three copies for user “lee”, and one copy for anyone on a computer with the hostname of “terry”; and would cause QUEUED messages to be omitted from the log file. In addition, user “joe” and group “pinheads” would not be allowed to use the feature SWxxxxxx–xx:

```
GROUP pinheads moe larry curley
RESERVE 1 SWxxxxxx–xx USER pat
RESERVE 3 SWxxxxxx–xx USER lee
RESERVE 1 SWxxxxxx–xx HOST terry
EXCLUDE SWxxxxxx–xx USER joe
EXCLUDE SWxxxxxx–xx GROUP pinheads
NOLOG QUEUED
```

3 LICENSE ADMINISTRATION TOOLS

The following utilities are provided to facilitate license management by your system administrator. In certain cases, execution access to a utility is restricted to users with root privileges. Complete descriptions of these utilities are provided at the end of this section.

**lmcksum**

Prints license checksums.

**lmdiag** (Windows only)

Diagnoses license checkout problems.

**lmdown**

Gracefully shuts down all license daemons (both lmgrd all vendor daemons, such as Tasking) on the license server.
**lmgrd**
The main daemon program for FLEXlm.

**lmhostid**
Reports the hostid of a system.

**lmremove**
Removes a single user’s license for a specified feature.

**lmreread**
Causes the license daemon to reread the license file and start any new vendor daemons.

**lmstat**
Helps you monitor the status of all network licensing activities.

**lmswitchr**
Switches the report log file.

**lmver**
Reports the FLEXlm version of a library or binary file.

**lmtools** *(Windows only)*
This is a graphical Windows version of the license administration tools.
3.1 LMCKSUM

Name

lmcksum – print license checksums

Synopsis

lmcksum [ -c license_file ] [ -k ]

Description

The lmcksum program will perform a checksum of a license file. This is useful to verify data entry errors at your location. lmcksum will print a line–by–line checksum for the file as well as an overall file checksum.

The following fields participate in the checksum:

- hostid on the SERVER lines
- daemon name on the DAEMON lines
- feature name, version, daemon name, expiration date, # of licenses, encryption code, vendor string and hostid on the FEATURE lines
- daemon name and encryption code on FEATURESET lines

Options

- -c license_file
  Use the specified license_file. If no -c option is specified, lmcksum looks for the environment variable LM_LICENSE_FILE in order to find the license file to use. If that environment variable is not set, lmcksum looks for the file c:\flexlm\license.dat (Windows), or /usr/local/flexlm/licenses/license.dat (UNIX).

- -k
  Case–sensitive checksum. If this option is specified, lmcksum will compute the checksum using the exact case of the FEATURE’s and FEATURESET’s encryption code.
3.2 LMDIAG (Windows only)

Name

lmdiag – diagnose license checkout problems

Synopsis

lmdiag [ -c license_file ] [ -n ] [ feature ]

Description

lmdiag (Windows only) allows you to diagnose problems when you cannot check out a license.

If no feature is specified, lmdiag will operate on all features in the license file(s) in your path. lmdiag will first print information about the license, then attempt to check out each license. If the checkout succeeds, lmdiag will indicate this. If the checkout fails, lmdiag will give you the reason for the failure. If the checkout fails because lmdiag cannot connect to the license server, then you have the option of running ”extended connection diagnostics”.

These extended diagnostics attempt to connect to each port on the license server node, and can detect if the port number in the license file is incorrect. lmdiag will indicate each port number that is listening, and if it is an lmgrd process, lmdiag will indicate this as well. If lmdiag finds the vendor daemon for the feature being tested, then it will indicate the correct port number for the license file to correct the problem.

Parameters

feature Diagnose this feature only.

Options

- c license_file
  Diagnose the specified license_file. If no -c option is specified, lmdiag looks for the environment variable LM_LICENSE_FILE in order to find the license file to use. If that environment variable is not set, lmdiag looks for the file c:\flexlm\license.dat (Windows), or /usr/local/flexlm/licenses/license.dat (UNIX).

- n
  Run in non–interactive mode; lmdiag will not prompt for any input in this mode. In this mode, extended connection diagnostics are not available.
3.3 LMDOWN

Name
Lmdown – graceful shutdown of all license daemons

Synopsis
Lmdown [ -c license_file ] [ -q ]

Description
The Lmdown utility allows for the graceful shutdown of all license
daemons (both lmgrd and all vendor daemons, such as Tasking) on all
nodes. You may want to protect the execution of Lmdown, since shutting
down the servers causes users to lose their licenses. See the -p option in
Section 3.4, Lmgrd.

Lmdown sends a message to every license daemon asking it to shut down.
The license daemons write out their last messages to the log file, close the
file, and exit. All licenses which have been given out by those daemons
will be revoked, so that the next time a client program goes to verify his
license, it will not be valid.

Options
- c license_file
Use the specified license_file. If no -c option is specified,
Lmdown looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, Lmdown looks for the
file c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat (UNIX).

- q
Quiet mode. If this switch is not specified, Lmdown asks for
confirmation before asking the license daemons to shut
down. If this switch is specified, Lmdown will not ask for
confirmation.

lmgrd, lmstat, lmreread
3.4 LMGRD

Name

lmgrd – flexible license manager daemon

Synopsis

lmgrd [-c license_file] [-l logfile] [-p] [-t timeout] [-s interval]

Description

lmgrd is the main daemon program for the FLEXlm distributed license management system. When invoked, it looks for a license file containing all required information about vendors and features. On UNIX systems, it is strongly recommended that lmgrd be run as a non-privileged user (not root).

Options

- c license_file
  Use the specified license_file. If no -c option is specified, lmgrd looks for the environment variable LM_LICENSE_FILE in order to find the license file to use. If that environment variable is not set, lmgrd looks for the file c:\flexlm\license.dat (Windows), or /usr/local/flexlm/licenses/license.dat (UNIX).

- l logfile
  Specifies the output log file to use. Instead of using the -l option you can use output redirection (> or >>) to specify the name of the output log file.

- p
  Restricts usage of lmdown, lmreread, and lmrremove to a FLEXlm administrator who is by default root. If there is a UNIX group called "lmadmin" then use is restricted to only members of that group. If root is not a member of this group, then root does not have permission to use any of the above utilities.

- t timeout
  Specifies the timeout interval, in seconds, during which the license daemon must complete its connection to other daemons if operating in multi-server mode. The default value is 10 seconds. A larger value may be desirable if the daemons are being run on busy systems or a very heavily loaded network.
\textbf{\texttt{-s interval}}  Specifies the log file timestamp \textit{interval}, in minutes. The default is 360 minutes. This means that every six hours \texttt{lmgrd} logs the time in the log file.

\texttt{lmdown, lmstat}
3.5 **LMHOSTID**

**Name**

*lmhostid* – report the *hostid* of a system

**Synopsis**

*lmhostid*

**Description**

*lmhostid* calls the FLEXlm version of *gethostid* and displays the results.

The output of *lmhostid* looks like this:

```
lmhostid - Copyright (C) 1989, 1999 Globetrotter Software, Inc.
The FLEXlm host ID of this machine is "1200abcd"
```

**Options**

*lmhostid* has no command line options.
3.6 LMREMOVE

Name

**Imremove** – remove specific licenses and return them to license pool

Synopsis

```
Imremove [ -c license_file ] feature user host [ display ]
```

Description

The **Imremove** utility allows the system administrator to remove a single user’s license for a specified feature. This could be required in the case where the licensed user was running the software on a node that subsequently crashed. This situation will sometimes cause the license to remain unusable. **Imremove** will allow the license to return to the pool of available licenses.

**Imremove** will remove all instances of “user” on node “host” on display “display” from usage of “feature”. If the optional `-c file` is specified, the indicated file will be used as the license file. Since removing a user’s license can be disruptive, execution of **Imremove** is restricted to users with root privileges.

Options

`-c license_file`

Use the specified `license_file`. If no `-c` option is specified, **Imremove** looks for the environment variable `LM_LICENSE_FILE` in order to find the license file to use. If that environment variable is not set, **Imremove** looks for the file `c:\flexlm\license.dat` (Windows), or `/usr/local/flexlm/licenses/license.dat` (UNIX).
3.7 **LMREREAD**

**Name**

*lmrerc* – tells the license daemon to reread the license file

**Synopsis**

```
lmrerc [-c license_file]
```

**Description**

*lmrerc* allows the system administrator to tell the license daemon to reread the license file. This can be useful if the data in the license file has changed; the new data can be loaded into the license daemon without shutting down and restarting it.

The license administrator may want to protect the execution of *lmrerc*. See the `-p` option in Section 3.4, lmgrd for details about securing access to *lmrerc*.

*lmrerc* uses the license file from the command line (or the default file, if none specified) only to find the license daemon to send it the command to reread the license file. The license daemon will always reread the file that it loaded from the original path. If you need to change the path to the license file read by the license daemon, then you must shut down the daemon and restart it with that new license file path.

You cannot use *lmrerc* if the `SERVER` node names or port numbers have been changed in the license file. In this case, you must shut down the daemon and restart it in order for those changes to take effect.

*lmrerc* does not change any option information specified in an options file. If the new license file specifies a different options file, that information is ignored. If you need to reread the options file, you must shut down (lmdown) the daemon and restart it.

**Options**

- `-c license_file`
  
  Use the specified `license_file`. If no `-c` option is specified, *lmrerc* looks for the environment variable `LM_LICENSE_FILE` in order to find the license file to use. If that environment variable is not set, *lmrerc* looks for the file `license.dat` in the default location.
3.8 **LMSTAT**

**Name**

**lmstat** – report status on license manager daemons and feature usage

**Synopsis**

```
lmstat [ -a ] [ -A ] [ -c license_file ] [ -f feature ]
[ -l regular_expression ] [ -s [server] ] [ -S [daemon] ] [ -t timeout ]
```

**Description**

License administration is simplified by the `lmstat` utility. **lmstat** allows you to instantly monitor the status of all network licensing activities. **lmstat** allows a system administrator to monitor license management operations including:

- Which daemons are running
- Users of individual features
- Users of features served by a specific **DAEMON**

**Options**

- `-a` Display all information.
- `-A` List all active licenses.
- `-c license_file`
  
  Use the specified `license_file`. If no `-c` option is specified, `lmstat` looks for the environment variable `LM_LICENSE_FILE` in order to find the license file to use. If that environment variable is not set, `lmstat` looks for the file `c:\flexlm\license.dat` (Windows), or `/usr/local/flexlm/licenses/license.dat` (UNIX).
- `-f feature`
  
  List all users of the specified `feature(s)`.
- `-l regular_expression`
  
  List all users of the features matching the given `regular_expression`.
- `-s [server]`
  
  Display the status of the specified `server` node(s).
- `-S [daemon]`
  
  List all users of the specified `daemon`'s features.
\textbf{-t timeout} \hspace{1em} Specifies the amount of time, in seconds, \texttt{lmstat} waits to establish contact with the servers. The default value is 10 seconds. A larger value may be desirable if the daemons are being run on busy systems or a very heavily loaded network.
3.9 LMSWITCHR (Windows only)

Name
Lmswitchr – switch the report log file

Synopsis
Lmswitchr [ -c license_file ] feature new-file

or:
Lmswitchr [ -c license_file ] vendor new-file

Description
Lmswitchr (Windows only) switches the report writer (REPORTLOG) log file. It will also start a new REPORTLOG file if one does not already exist.

Parameters

feature Any feature this daemon supports.
vendor The name of the vendor daemon (such as Tasking).
new-file New file path.

Options

-c license_file
Use the specified license_file. If no -c option is specified, lmswitchr looks for the environment variable LM_LICENSE_FILE in order to find the license file to use. If that environment variable is not set, lmswitchr looks for the file c:\flexlm\license.dat (Windows), or /usr/local/flexlm/licenses/license.dat (UNIX).
3.10 LMVER

Name

**Imver** – report the FLEXlm version of a library or binary file

Synopsis

**Imver filename**

Description

The **Imver** utility reports the FLEXlm version of a library or binary file.

Alternatively, on UNIX systems, you can use the following commands to get the FLEXlm version of a binary:

```
strings file | grep Copy
```

Parameters

*filename* — Name of the executable of the product.
3.11 LICENSE ADMINISTRATION TOOLS FOR WINDOWS

3.11.1 LMTOOLS FOR WINDOWS

For the 32 Bit Windows Platforms, an `lmtools.exe` Windows program is provided. It has the same functionality as listed in the previous sections but is graphically-oriented. Simply run the program (Start | Programs | TASKING FLEXlm | FLEXlm Tools) and choose a button for the functionality required. Refer to the previous sections for information about the options of each feature. The command line interface is replaced by pop-up dialogs that can be filled out. The central EDIT field is where the license file path is placed. This will be used for all other functions and replaces the "`-c license_file`" argument in the other utilities.

The HOSTID button displays the hostid’s for the computer on which the program is running. The TIME button prints out the system’s internal time settings, intended to diagnose any time zone problems. The TCP Settings button is intended to fix a bug in the Microsoft TCP protocol stack which has a symptom of very slow connections to computers. After pressing this button, the system will need to be rebooted for the settings to become effective.
3.11.2 FLEXLM LICENSE MANAGER FOR WINDOWS

`lmgrd.exe` can be run manually or using the graphical Windows tool. You can start this tool from the FLEXlm program folder. Click on Start | Programs | TASKING FLEXlm | FLEXlm Tools.

From the Control tab you can start, stop, and check the status of your license server. Select the Setup tab to enter information about your license server.
Select the Control tab and click the Start button to start your license server. \texttt{lmgrd.exe} will be launched as a background application with the license file and debug log file locations passed as parameters.

If you want \texttt{lmgrd.exe} to start automatically on NT, select the Use NT Services check box and \texttt{lmgrd.exe} will be installed as an NT service. Next, select the Start Server at Power–UP check box.

The Licenses tab provides information about the license file and the Advanced tab allows you to perform diagnostics and check versions.
4 THE DAEMON LOG FILE

The FLEXlm daemons all generate log files containing messages in the following format:

\[ \text{mm/dd hh:mm (DAEMON name) message} \]

Where:

- **mm/dd hh:mm** Is the month/day hour:minute that the message was logged.
- **DAEMON name** Either “license daemon” or the string from the DAEMON line that describes your daemon.
  
  In the case where a single copy of the daemon cannot handle all of the requested licenses, an optional “\_” followed by a number indicates that this message comes from a forked daemon.

- **message** The text of the message.

The log files can be used to:

- Inform you when it may be necessary to update your application software licensing arrangement.
- Diagnose configuration problems.
- Diagnose daemon software errors.

The messages are grouped below into the above three categories, with each message followed by a brief description of its meaning.
4.1 INFORMATIONAL MESSAGES

Connected to node
This daemon is connected to its peer on node node.

CONNECTED, master is name
The license daemons log this message when a quorum is up and everyone has selected a master.

DEMO mode supports only one SERVER host!
An attempt was made to configure a demo version of the software for more than one server host.

DENIED: N feature to user (mm/dd/yy hh:mm)
user was denied access to N licenses of feature. This message may indicate a need to purchase more licenses.

EXITING DUE TO SIGNAL mm
EXITING with code mm
All daemons list the reason that the daemon has exited.

EXPIRED: feature
feature has passed its expiration date.

IN: feature by user (N licenses) (used: d:bb:mm:ss)
N licenses by virtue of the fact that his server died.

License Manager server started
The license daemon was started.
Lost connection to host

A daemon can no longer communicate with its peer on node host, which can cause the clients to have to reconnect, or cause the number of daemons to go below the minimum number, in which case clients may start exiting. If the license daemons lose the connection to the master, they will kill all the vendor daemons; vendor daemons will shut themselves down.

Lost quorum

The daemon lost quorum, so will process only connection requests from other daemons.

MASTER SERVER died due to signal nnn

The license daemon received fatal signal nnn.

MULTIPLE xxx servers running. Please kill, and restart license daemon

The license daemon has detected that multiple copies of vendor daemon xxx are running. The user should kill all xxx daemon processes and re–start the license daemon.

OUT: feature by user (N licenses) (mm/dd/yy hh:mm)

user has checked out N licenses of feature at mm/dd/yy hh:mm

Removing clients of children

The top–level daemon logs this message when one of the child daemons dies.

RESERVE feature for HOST name
RESERVE feature for USER name

A license of feature is reserved for either user name or host name.

REStarted xxx (internet port nnn)

Vendor daemon xxx was restarted at internet port nnn.

Retrying socket bind (address in use)

The license servers try to bind their sockets for approximately 6 minutes if they detect address in use errors.
Selected (EXISTING) master node
This license daemon has selected an existing master (node) as the master.

SERVER shutdown requested
A daemon was requested to shut down via a user-generated kill command.

[NEW] Server started for: feature-list
A (possibly new) server was started for the features listed.

Shutting down xxx
The license daemon is shutting down the vendor daemon xxx.

SIGCHLD received. Killing child servers
A vendor daemon logs this message when a shutdown was requested by the license daemon.

Started name
The license daemon logs this message whenever it starts a new vendor daemon.

Trying connection to node
The daemon is attempting a connection to node.
4.2 CONFIGURATION PROBLEM MESSAGES

hostname: Not a valid server host, exiting
This daemon was run on an invalid hostname.

hostname: Wrong hostid, exiting
The hostid is wrong for hostname.

BAD CODE for feature-name
The specified feature name has a bad encryption code.

CANNOT OPEN options file “file”
The options file specified in the license file could not be opened.

Couldn’t find a master
The daemons could not agree on a master.

license daemon: lost all connections
This message is logged when all the connections to a server are lost, which often indicates a network problem.

lost lock, exiting
Error closing lock file
Unable to re-open lock file
The vendor daemon has a problem with its lock file, usually because of an attempt to run more than one copy of the daemon on a single node. Locate the other daemon that is running via a ps command, and kill it with kill -9.

NO DAEMON line for daemon
The license file does not contain a DAEMON line for daemon.

No “license” service found
The TCP license service did not exist in /etc/services.

No license data for “feat”, feature unsupported
There is no feature line for feat in the license file.
No features to serve!
A vendor daemon found no features to serve. This could be caused by bad data in the license file.

UNSUPPORTED FEATURE request: feature by user
The user has requested a feature that this vendor daemon does not support. This can happen for a number of reasons: the license file is bad, the feature has expired, or the daemon is accessing the wrong license file.

Unknown host: hostname
The hostname specified on a SERVER line in the license file does not exist in the network database (probably /etc/hosts).

lm_server: lost all connections
This message is logged when all the connections to a server are lost. This probably indicates a network problem.

NO DAEMON lines, exiting
The license daemon logs this message if there are no DAEMON lines in the license file. Since there are no vendor daemons to start, there is nothing to do.

NO DAEMON line for name
A vendor daemon logs this error if it cannot find its own DAEMON name in the license file.
4.3 DAEMON SOFTWARE ERROR MESSAGES

**accept: message**

An error was detected in the `accept` system call.

**ATTEMPT TO START VENDOR DAEMON xxx with NO MASTER**

A vendor daemon was started with no master selected. This is an internal consistency error in the daemons.

**BAD PID message from nnm: pid: xxx (msg)**

A top–level vendor daemon received an invalid PID message from one of its children (daemon number xxx).

**BAD SCONNECT message: (message)**

An invalid “server connect” message was received.

**Cannot create pipes for server communication**

The `pipe` call failed.

**Can’t allocate server table space**

A `malloc` error. Check swap space.

**Connection to node TIMED OUT**

The daemon could not connect to `node`.

**Error sending PID to master server**

The vendor server could not send its PID to the top–level server in the hierarchy.

**Illegal connection request to DAEMON**

A connection request was made to DAEMON, but this vendor daemon is not DAEMON.

**Illegal server connection request**

A connection request came in from another server without a DAEMON name.

**KILL of child failed, errno = nnn**

A daemon could not kill its child.
No internet port number specified
A vendor daemon was started without an internet port.

Not enough descriptors to re-create pipes
The “top–level” daemon detected one of its sub–daemon’s death. In trying to restart the chain of sub–daemons, it was unable to get the file descriptors to set up the pipes to communicate. This is a fatal error, and the daemons must be re–started.

read: error message
An error in a read system call was detected.

recycle_control BUT WE DIDN’T HAVE CONTROL
The hierarchy of vendor daemons has become confused over who holds the control token. This is an internal error.

return_reserved: can’t find feature listhead
When a daemon is returning a reservation to the “free reservation” list, it could not find the listhead of features.

select: message
An error in a select system call was detected.

Server exiting
The server is exiting. This is normally due to an error.

SHELLO for wrong DAEMON
This vendor daemon was sent a “server hello” message that was destined for a different DAEMON.

Unsolicited msg from parent!
Normally, the top–level vendor daemon sends no unsolicited messages. If one arrives, this message is logged. This is a bug.

WARNING: CORRUPTED options list (o->next == 0)
Options list TERMINATED at bad entry
An internal inconsistency was detected in the daemon’s option list.
5 FLEXLM LICENSE ERRORS

FLEXlm license error, encryption code in license file is inconsistent

Check the contents of the license file using the license data sheet for the product. Correct the license file and run the lmr command. However, do not change the last (fourth) field of a SERVER line in the license file. This cannot have any effect on the error message but changing it will cause other problems.

license file does not support this version

If this is a first time install then follow the procedure for the error message:

FLEXlm license error, encryption code in license file is inconsistent

because there may be a typo in the fourth field of a FEATURE line of your license file. In all other cases you need a new license because the current license is for an older version of the product.

Replace the FEATURE line for the old version of the product with a FEATURE line for the new version (it can be found on the new license data sheet). Run the lmr command afterwards. You can have only one version of a feature (previous versions of the product will continue to work).

FLEXlm license error, cannot find license file

Make sure the license file exists. If the pathname printed on the line after the error message is incorrect, correct this by setting the LM_LICENSE_FILE environment variable to the full pathname of the license file.

FLEXlm license error, cannot read license file

Every user needs to have read access on the license file and at least execute access on every directory component in the pathname of the license file. Write access is never needed. Read access on directories is recommended.

FLEXlm license error, no such feature exists

Check the license file. There should be a line starting with:

FEATURE swiiiiii-jj
where "iiiiii" is a six digit software code and "jj" is a two digit host code for identifying a compatible host architecture. During product installations the product code is shown, e.g. SW008002, SW019002. The number in the software code is the same as the number in the product code except that the first number may contain an extra leading zero (it must be six digits long).

The line after the license error message describes the expected feature format and includes the host code. Correct the license file using the license data sheet for the product and run the `lmreread` command. There is one catch: do not add extra SERVER lines or change existing SERVER lines in the license file.

**FLEXlm license error, license server does not support this feature**

If the LM_LICENSE_FILE variable has been set to the format `number@host` then see first the solution for the message:

FLEXlm license error, no such feature exists

Run the `lmreread` program to inform the license server about a changed license data file. If `lmreread` succeeds informing the license server but the error message persists, there are basically three possibilities:

1. The license key is incorrect. If this is the case then there must be an error message in the log file of `lmgrd`. Correct the key using the license data sheet for the product. Finally rerun `lmreread`. The log file of `lmgrd` is usually specified to `lmgrd` at startup with the `-l` option or with `>`.  

2. Your network has more than one FLEXlm license server daemon and the default license file location for `lmreread` differs from the default assumed by the program. Also, there must be more than one license file. Try one of the following solutions on the same host which produced the error message:

   - type:
     
     `lmreread -c /usr/local/flexlm/licenses/license.dat`

   - set LM_LICENSE_FILE to the license file location and retry the `lmreread` command.

   - use the `lmreread` program supplied with the product SW000098, Flexible License Manager. SW000098 is bundled with all TASKING products.
3. There is a protocol version mismatch between \texttt{lmgrd} and the daemon with the name “Tasking” (the vendor daemon according to FLEXlm terminology) or there is some other internal error. These errors are always written to the log file of \texttt{lmgrd}. The solution is to upgrade the \texttt{lmgrd} daemon to the one supplied in SW0000/C0057/C0056, the bundled Flexible License Manager product.

On the other hand, if \texttt{lmrerd} complains about not being able to connect to the license server then follow the procedure described in the next section for the error message "Cannot read license file data from server". The only difference with the current situation is that not the product but a license management utility shows a connect problem.

\textbf{FLEXlm license error, Cannot read license file data from server}

This indicates that the program could not connect to the license server daemon. This can have a number of causes. If the program did not immediately print the error message but waited for about 30 seconds (this can vary) then probably the license server host is down or unreachable. If the program responded immediately with the error message then check the following if the \texttt{LM_LICENSE_FILE} variable has been set to the format \texttt{number@host}:

- is the number correct? It should match the fourth field of a \texttt{SERVER} line in the license file on the license server host. Also, the host name on that \texttt{SERVER} line should be the same as the host name set in the \texttt{LM_LICENSE_FILE} variable. Correct \texttt{LM_LICENSE_FILE} if necessary.

In any case one should verify if the license server daemon is running. Type the following command on the host where the license server daemon (\texttt{lmgrd}) is supposed to run.

On SunOS 4.x:

\begin{verbatim}
ps wwax | grep lmgrd | grep -v grep
\end{verbatim}

On HP-UX or SunOS 5.x (Solaris 2.x):

\begin{verbatim}
ps -ef | grep lmgrd | grep -v grep
\end{verbatim}

If the command does not produce any output then the license server daemon is not running. See below for an example how to start \texttt{lmgrd}. 

\begin{verbatim}

\end{verbatim}
Make sure that both license server daemon (**lmgrd**) and the program are using the same license data. All TASKING products use the license file `/usr/local/flexlm/licenses/license.dat` unless overruled by the environment variable **LM_LICENSE_FILE**. However, not all existing **lmgrd** daemons may use the same default. In case of doubt, specify the license file pathname with the `-c` option when starting the license server daemon. For example:

```
   lmgrd -c /usr/local/flexlm/licenses/license.dat \
           -l /usr/local/flexlm/licenses/license.log &
```

and set the **LM_LICENSE_FILE** environment variable to the license.dat pathname mentioned with the `-c` option of **lmgrd** before running any license based program (including **lmread**, **lmstat**, **lmdown**). If **lmgrd** and the program run on different hosts, transparent access to the license file is assumed in the situation described above (e.g. NFS). If this is not the case, make a local copy of the license file (not recommended) or set **LM_LICENSE_FILE** to the form `number@host`, as described earlier.

If none of the above seems to apply (i.e. **lmgrd** was already running and **LM_LICENSE_FILE** has been set correctly) then it is very likely that there is a TCP port mismatch. The fourth field of a SERVER line in the license file specifies a TCP port number. That number can be changed without affecting any license. However, it must never be changed while the license server daemon is running. If it has been changed, change it back to the original value. If you do not know the original number anymore, restart the license server daemon after typing the following command on the license server host:

```
   kill PID
```

where **PID** is the process id of **lmgrd**.
6 FREQUENTLY ASKED QUESTIONS (FAQS)

6.1 LICENSE FILE QUESTIONS

I've received FLEXlm license files from 2 different companies. Do I have to combine them?

You don't have to combine license files. Each license file that has any 'counted' lines (the 'number of licenses' field is >0) requires a server. It's perfectly OK to have any number of separate license files, with different lmgrd server processes supporting each file. Moreover, since lmgrd is a lightweight process, for sites without system administrators, this is often the simplest (and therefore recommended) way to proceed. With v6+ lmgrd/lmdown/lmreread, you can stop/reread/restart a single vendor daemon (of any FLEXlm version). This makes combining licenses more attractive than previously. Also, if the application is v6+, using 'dir/*.lic' for license file management behaves like combining licenses without physically combining them.

When is it recommended to combine license files?

Many system administrators, especially for larger sites, prefer to combine license files to ease administration of FLEXlm licenses. It's purely a matter of preference.

Does FLEXlm handle dates in the year 2000 and beyond?

Yes. The FLEXlm date format uses a 4-digit year. Dates in the 20th century (19xx) can be abbreviated to the last 2 digits of the year (xx), and use of this feature is quite widespread. Dates in the year 2000 and beyond must specify all 4 year digits.

6.2 FLEXLM VERSION

Which FLEXlm versions does TASKING deliver?

For Windows we deliver FLEXlm v6.1 and for UNIX we deliver v2.4.
I have products from several companies at various FLEXlm version levels. Do I have to worry about how these versions work together?

If you’re not combining license files from different vendors, the simplest thing to do is make sure you use the tools (especially lmgrd) that are shipped by each vendor.

lmgrd will always correctly support older versions of vendor daemons and applications, so it’s always safe to use the latest version of lmgrd and the other FLEXlm utilities. If you’ve combined license files from 2 vendors, you must use the latest version of lmgrd.

If you’ve received 2 versions of a product from the same vendor, you must use the latest vendor daemon they sent you. An older vendor daemon with a newer client will cause communication errors.

Please ignore letters appended to FLEXlm versions, i.e., v2.4d. The appended letter indicates a patch, and does NOT indicate any compatibility differences. In particular, some elements of FLEXlm didn’t require certain patches, so a 2.4 lmgrd will work successfully with a 2.4b vendor daemon.

I’ve received a new copy of a product from a vendor, and it uses a new version of FLEXlm. Is my old license file still valid?

Yes. Older FLEXlm license files are always valid with newer versions of FLEXlm.

6.3 WINDOWS QUESTIONS

What Windows Host Platforms can be used as a server for Floating Licenses?

The system being used as the server (where the FLEXlm License Manager is running) for Floating licenses, must be Windows NT. The FLEXlm License Manager does not run properly with Windows 95/98.

Why do I need to include NWlink IPX/SPX on NT?

This is necessary for either obtaining the Ethernet card address, or to provide connectivity with a Netware License server.
6.4 TASKING QUESTIONS

How will the TASKING licensing/pricing model change with License Management (FLEXlm)?

TASKING will now offer the following types of licenses so you can purchase licenses based upon usage:

<table>
<thead>
<tr>
<th>License</th>
<th>Description</th>
<th>Pricing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Locked</td>
<td>This license can only be used on a specific system. It cannot be moved to</td>
<td>The pricing for this license will be the</td>
</tr>
<tr>
<td></td>
<td>another system.</td>
<td>current product pricing.</td>
</tr>
<tr>
<td>Floating</td>
<td>This license requires a network (license server and a TCP/IP (or IPX/SPX)</td>
<td>The pricing for this license will be 50%</td>
</tr>
<tr>
<td></td>
<td>connection between clients and server) and can be used on any host system</td>
<td>higher than the node locked license.</td>
</tr>
<tr>
<td></td>
<td>(using the same operating system) in the network.</td>
<td></td>
</tr>
</tbody>
</table>

How does FLEXlm affect future product ordering?

For all licenses, node locked or floating, you must provide information that is used to create a license key. For node locked licenses we must have the HOST ID. Floating licenses require the HOST ID and HOST NAME. The HOST ID is a unique identification of the machine, which is based upon different hardware depending upon host platform. The HOST NAME is the network name of the machine.

TASKING Logistics CANNOT ship ANY orders that do not include the HOST ID and/or HOST NAME information.

What if I do not know the information needed for the license key?

We have a software utility (tkhostid.exe) which will obtain and display the HOST ID so a customer can easily obtain this information. This utility is available from our web site, placed on all product CDs (which support FLEXlm), and from technical support. If you have already installed FLEXlm, you can also use lmhostid.

- In the case of a Node locked license, it is important that the customer runs this utility on the exact machine he intends to run the TASKING tools on.
In the case of a **Floating License**, the `tkhostid.exe` (or `Imhostid`) utility should be run on the machine on which the FLEXlm license manager will be installed, e.g. the server. The HOST NAME information can be obtained from within the Windows Control Panel. Select "Network", click on "Identification", look for "Computer name".

**How will the “locking” mechanism work?**

- For node locked licenses, FLEXlm will first search for an ethernet card. If one exists, it will lock onto the number of the ethernet card. If an ethernet card does not exist, FLEXlm will lock onto the hard disk serial number.
- For floating licenses, the ethernet card number will be used.

**What happens if I try to move my node locked license to another system?**

The software will not run.

**What does linger-time for floating licenses mean?**

When the TASKING product starts to run, it will try to obtain a license from the license server. The license server keeps track of the number of licenses already issued, and grants or denies the request. When the software has finished running, the license is kept by the license server for a period of time known as the “linger-time”. If the same user requests the TASKING product again within the linger-time, he is granted the license again. If another user requests a license during the linger-time, his request is denied until the linger-time has finished.

**What is the length of the linger-time for floating licenses?**

The length of the linger-time for both the PC and UNIX floating licenses is 5 minutes.

**Can the linger-time be changed?**

Yes. A customer can change the linger-time to be larger (but not shorter) than the time specified by TASKING.

**What happens if my system crashes or I upgrade to a new system?**

You will need to contact Technical Support for temporary license keys due to a system crash or to move from one system to another system. You will then need to work with your local sales representative to obtain a permanent new license key.
6.5 USING FLEXLM FOR FLOATING LICENSES

Does FLEXlm work across the internet?
Yes. A server on the internet will serve licenses to anyone else on the internet. This can be limited with the 'INTERNET=' attribute on the FEATURE line, which limits access to a range of internet addresses. You can also use the INCLUDE and EXCLUDE options in the daemon option file to allow (or deny) access to clients running on a range of internet addresses.

Does FLEXlm work with Internet firewalls?
Many firewalls require that port numbers be specified to the firewall. FLEXlm v5 Imgrd supports this.

If my client dies, does the server free the license?
Yes, unless the client’s whole system crashes. Assuming communications is TCP, the license is automatically freed immediately. If communications are UDP, then the license is freed after the UDP timeout, which is set by each vendor, but defaults to 45 minutes. UDP communications is normally only set by the end–user, so TCP should be assumed. If the whole system crashes, then the license is not freed, and you should use ‘Imremove’ to free the license.

What happens when the license server dies?
FLEXlm applications send periodic heartbeats to the server to discover if it has died. What happens when the server dies is then up to the application. Some will simply continue periodically attempting to re–checkout the license when the server comes back up. Some will attempt to re–checkout a license a few times, and then, presumably with some warning, exit. Some GUI applications will present pop–ups to the user periodically letting them know the server is down and needs to be re–started.

How do you tell if a port is already in use?
99.44% of the time, if it’s in use, it’s because Imgrd is already running on the port – or was recently killed, and the port isn’t freed yet. Assuming this is not the case, then use ‘telnet host port’ – if it says "can’t connect", it’s a free port.
**Does FLEXlm require root permissions?**

No. There is no part of FLEXlm, **lmgrd**, vendor daemon or application, that requires root permissions. In fact, it is strongly recommended that you do not run the license server (**lmgrd**) as root, since root processes can introduce security risks.

If **lmgrd** must be started from the root user (for example, in a system boot script), we recommend that you use the `su` command to run **lmgrd** as a non-privileged user:

```
su username -c"/path/lmgrd -c /path/license.dat \ -l /path/log"
```

where `username` is a non-privileged user, and `path` is the correct paths to **lmgrd**, `license.dat` and debug log file. You will have to ensure that the vendor daemons listed in `/path-to-license/license.dat` have execute permissions for `username`. The paths to all the vendor daemons in the license file are listed on each DAEMON line.

**Is it ok to run lmgrd as 'root' (UNIX only)?**

It is not prudent to run any command, particularly a daemon, as root on UNIX, as it may pose a security risk to the Operating System. Therefore, we recommend that **lmgrd** be run as a non-privileged user (not 'root'). If you are starting **lmgrd** from a boot script, we recommend that you use

```
su username -c"umask 022; /path/lmgrd \ -c /path/license.dat -l /path/log"
```

to run **lmgrd** as a non-privileged user.

**Does FLEXlm licensing impose a heavy load on the network?**

No, but partly this depends on the application, and end-user's use. A typical checkout request requires 5 messages and responses between client and server, and each message is < 150 bytes.

When a server is not receiving requests, it requires virtually no CPU time. When an application, or **lmstat**, requests the list of current users, this can significantly increase the amount of networking FLEXlm uses, depending on the number of current users. Also, prior to FLEXlm v5, use of 'port@host' can increase network load, since the license file is down-loaded from the server to the client. 'port@host' should be, if possible, limited to small license files (say < 50 features). In v5, 'port@host' actually improves performance.
**Does FLEXlm work with NFS?**

Yes. FLEXlm has no direct interaction with NFS. FLEXlm uses an NFS–mounted file like any other application.

**Does FLEXlm work with ATM, ISDN, Token–Ring, etc.?**

In general, these have no impact on FLEXlm. FLEXlm requires TCP/IP or SPX (Novell Netware). So long as TCP/IP works, FLEXlm will work.

**Does FLEXlm work with subnets, fully–qualified names, multiple domains, etc.?**

Yes, although this behavior was improved in v3.0, and v6.0. When a license server and a client are located in different domains, fully–qualified host names have to be used. A fully–qualified hostname is of the form:

```
node.domain
```

where `node` is the local hostname (usually returned by the 'hostname' command or `uname -n`) `domain` is the internet domain name, e.g. 'globes.com'.

To ensure success with FLEXlm across domains, do the following:

1. Make sure the fully–qualified hostname is the name on the SERVER line of the license file.

2. Make sure ALL client nodes, as well as the server node, are able to 'telnet' to that fully–qualified hostname. For example, if the host is locally called 'speedy', and the domain name is 'corp.com', local systems will be able to logon to speedy via 'telnet speedy'. But very often, 'telnet speedy.corp.com' will fail, locally.
   
   Note that this telnet command will always succeed on hosts in other domains (assuming everything is configured correctly), since the network will resolve speedy.corp.com automatically.

3. Finally, there must be an 'alias' for speedy so it's also known locally as speedy.corp.com. This alias is added to the /etc/hosts file, or if NIS/Yellow Pages are being used, then it will have to be added to the NIS database. This requirement goes away in version 3.0 of FLEXlm.

If all components (application, lmgrd and vendor daemon) are v6.0 or higher, no aliases are required; the only requirement is that the fully–qualified domain name, or IP–address, is used as a hostname on the SERVER, or as a hostname in LM_LICENSE_FILE port@host, or @host.
**Does FLEXlm work with NIS and DNS?**

Yes. However, some sites have broken NIS or DNS, which will cause FLEXlm to fail. In v5 of FLEXlm, NIS and DNS can be avoided to solve this problem. In particular, sometimes DNS is configured for a server that’s not currently available (e.g., a dial-up connection from a PC). Again, if DNS is configured, but the server is not available, FLEXlm will fail.

In addition, some systems, particularly Sun, SGI, HP, require that applications be linked dynamically to support NIS or DNS. If a vendor links statically, this can cause the application to fail at a site that uses NIS or DNS. In these situations, the vendor will have to relink, or recompile with v5 FLEXlm. Vendors are strongly encouraged to use dynamic libraries for libc and networking libraries, since this tends to improve quality in general, as well as making NIS/DNS work.

On PCs, if a checkout seems to take 3 minutes and then fails, this is usually because the system is configured for a dial-up DNS server which is not currently available. The solution here is to turn off DNS.

Finally, hostnames must NOT have periods in the name. These are not legal hostnames, although PCs will allow you to enter them, and they will not work with DNS.

**We’re using FLEXlm over a wide-area network. What can we do to improve performance?**

FLEXlm network traffic should be minimized. With the most common uses of FLEXlm, traffic is negligible. In particular, checkout, checkin and heartbeats use very little networking traffic. There are two items, however, which can send considerably more data and should be avoided or used sparingly:

- `lmstat -a` should be used sparingly. `lmstat -a` should not be used more than, say, once every 15 minutes, and should be particularly avoided when there’s a lot of features, or concurrent users, and therefore a lot of data to transmit; say, more than 20 concurrent users or features.

- Prior to FLEXlm v5, the ‘port@host’ mode of the `LM_LICENSE_FILE` environment variable should be avoided, especially when the license file has many features, or there are a lot of license files included in `LM_LICENSE_FILE`. The license file information is sent via the network, and can place a heavy load. Failures due to ‘port@host’ will generate the error `LM_SERVNOREADLIC` (~61).
APPENDIX B

INTERPROCESS COMMUNICATION

TASKING
1 COM INTERFACE

1.1 INTRODUCTION

CrossView Pro provides a COM object interface on MS-Windows platforms. The purpose of the COM object interface is to make the command-line interface of the command window available to the outside world. Simultaneously, a callback mechanism is provided which allows the outside world to tap into events that occur within CrossView Pro (for example a breakpoint hit message). This is achieved by a COM connection point interface to which multiple programming languages can connect.

The CrossView Pro COM object can be used in programming languages like Python, Visual C++ or Visual Basic. Applications that are COM clients can also make full use of the CrossView Pro COM object interface. COM is a binary reusable object technology, linked tightly to MS-Windows. COM is closely related to ActiveX and Automation. ActiveX consists of a set of predefined interfaces to be implemented in a COM object and used to create plugable GUI components. Automation is a similar set of predefined COM interfaces, but with a wider range of applications than ActiveX.

1.2 USING THE COM OBJECT INTERFACE

1.2.1 RUN-TIME ENVIRONMENT

The CrossView Pro COM object executes as an out-of-process server. Only one client per instantiated CrossView Pro COM object can connect. Each CrossView Pro executable has a unique identification (so-called UUID or GUID), independent of the version number. This is especially important for Visual Basic which stores the TypeLib UUID. This requires recompilation if the UUID changes across different versions of the same CrossView Pro executable.

1.2.2 COMMAND LINE OPTIONS

To prevent initialization dialogs at CrossView Pro startup (for example a dialog to specify which CPU type you use), you can use several command-line options which you can specify via the Init() method.
Use the following options instead of startup dialogs:

- **-tcfg file** Specifies a target configuration file which contains, among other things, the GDI module to be loaded among other things. This overrules the filename specified in `xvw.ini`.

- **-C cpu** Specifies the CPU type.

- **-D device_type, opt1[opt2]** Specifies communications parameters such as communication port and baud rate.

- **-G path** Specifies the startup directory for CrossView Pro

- **-ini** Specifies the `xvw.ini` file.

Section 4.4, *Startup Options* in Chapter *Using CrossView Pro*

### 1.2.3 STARTUP DIRECTORY

The startup directory of CrossView Pro determines where the `xvw.ini` file is written. When CrossView Pro is invoked via its COM interface on MS-Windows, the startup directory is usually `C:\WINNT\system32`. You can change the location of the `xvw.ini` file with the `-G` command line option. This feature is useful when you are using two different CrossView Pro instances simultaneously.
1.3 COM INTERFACES

The following interfaces are provided with CrossView Pro:

ICommandLine
Default interface; provides CrossView Pro command interpreter access.

ICommandLineEvents
Connection point; provides the events output stream of CrossView Pro. Works as a callback.

1.3.1 ACTIVATING THE COM OBJECT

Command line options are passed to CrossView Pro via the Init() method. It is necessary to call the Init() method before you can use the CrossView Pro COM object. CrossView Pro does not start as COM object, until after you have actually called the Init() method. If you do not need to pass any options, invoke Init() with an empty string.

Registering the server
Before you can use the COM object, you must register it in the MS-Windows Registry. Run CrossView Pro from the command line as follows:

xfw56x -RegServer

Similarly, you can remove the COM object from the Registry:

xfw56x -UnRegServer

To avoid the popup message when registering, two more command line options are available that are useful when you use batch files:

-RegServerS Same as -RegServer, but without message
-UnregServerS Same as -UnregServer, but without message box
1.3.2 METHODS

This section lists the methods that are supported by the CrossView Pro COM object’s default interface ' ICommandLine'. The data types and return values are expressed as COM base types. For example, BSTR is a wide-character UNICODE string type, which is the same type as Visual Basic strings.

Init()

```c
void Init(BSTR CommandLineOptions)
```

Passes command line options to the CrossView Pro COM. It is necessary to call the `Init()` method before you can use the CrossView Pro COM object. If you do not need to pass any options, invoke `Init()` with an empty string.

*CommandLineOptions*  
The string with the command line options. The options are written as on a regular command line.

The list of supported command-line options can be found in the CrossView Pro User Manual.

See Section 4.4, *Startup Options* in Chapter *Using CrossView Pro* for a complete overview of all available command line options.

Execute

```c
BOOLEAN Execute(BSTR Command, long SequenceNumber, BSTR *Result)
```

Passes a command to CrossView Pro, executes it and returns TRUE or FALSE after the command has been executed.

*Command*  
The command to be executed by CrossView Pro.

*SequenceNumber*  
A number that is unique for each command. You can use this number to distinguish the output in the events stream. If you do not use this, specify a value of 0.
**Result**

The textual output of the command window, encapsulated in an annotated format. SeeCmdAnnotatedOutput in section 1.4 Events for the format description. Specify NULL if you do not want any output.

**Returns:** TRUE on success, FALSE on error.

**ExecuteNoWait**

```c
BOOLEAN ExecuteNoWait(BSTR Command,
                         long SequenceNumber)
```

Queues a command for execution and returns TRUE if FALSE after the command has been passed but before it is executed.

**Command**  The command to be executed by CrossView Pro.

**SequenceNumber**

A number that is unique for each command. You can use this number to distinguish the output in the events stream. If you do not use this, specify a value of 0.

**Returns:** TRUE if the command is successfully passed, FALSE on error.

**Halt**

```c
void Halt(void)
```

Halts the execution of the current command.

### 1.3.3 IMPLEMENTATION DETAILS

A multi-threading (MTA) type of appartment is used with a free-threading model, for example, ThreadModel=Free. However, each CLSID can have its own distinct ThreadingModel. Only one client can connect to a COM object instance of CrossView Pro. Each next CoCreateInstance() will result in a new CrossView Pro COM object instance being created.

Be aware that DLLs are not supposed to call CoInitialize themselves. Once the concurrency model for a thread is set, it cannot be changed. A call to CoInitialize on an apartment that was previously initialized as multithreaded will fail and return RPC E CHANGED MODE.
Typically, the COM library is initialized on a thread only once. Subsequent calls to CoInitialize or CoInitializeEx on the same thread will succeed, as long as they do not attempt to change the concurrency model, but will return S_FALSE. To close the COM library gracefully, each successful call to CoInitialize or CoInitializeEx, including those that return S_FALSE, must be balanced by a corresponding call to CoUninitialize. However, the first thread in the application that calls CoInitialize(0) or CoInitializeEx(COINIT_APARTMENTTHREADED) must be the last thread to call CoUninitialize(). If the call sequence is not in this order, then subsequent calls to CoInitialize on the STA will fail and the application will not work.

Because there is no way to control the order in which in-process servers are loaded or unloaded, it is not safe to call CoInitialize, CoInitializeEx, or CoUninitialize from the DllMain function.

So, take care when establishing more CLSIDs in a GDI module.

1.4 EVENTS

CrossView Pro provides an events source, into which a client can tap via a COM connection point. Examples of events are "reporting which breakpoint has been hit" and "symbols have been loaded". Currently the following events are defined. Each event is terminated by a newline character. Prepare your client for new events, basically by ignoring unrecognized ones.

CommandInterpreterBusy

The debugger’s command interpreter is executing a command line, or a GUI operation is in progress. A command line can comprise multiple target execution commands, so arbitrary Running and Stopped events may occur before the command line has been finished. An example for using this event is the disabling of menu entries in your tool.

You can send multiple CommandInterpreterBusy events without the CommandInterpreterReady counterpart. New commands can be send to the debugger after this event has been issued, but they will be queued until the debugger is ready for new command input.
Interprocess Communication

**CommandInterpreterReady**

The entire command line or GUI operation has either been executed completely or aborted. You can send multiple CommandInterpreterReady events without the CommandInterpreterBusy counterpart.

**CommandCanceledByUser**

The entire command line or GUI operation has can be canceled by the user, usually via the Halt button.

In case of DDE, the CrossView Pro command queue will be emptied. The command queue of all other IPCs, for example COM, will be preserved. This has been designed for the multi-core debugger which relies on commands submitted by the multi-core debug system always being executed, even if the user hits the Halt button.

Note that every command can be canceled this way, even when asking a variable’s value. Often no value will be returned at all, because Halt aborted the evaluation.

**HaltButtonPressed**

Tells that the user has pressed the Halt button. This is necessary because in CrossView Pro Halt means stop executing the current command line. If an external client needs to know this too, the Halt button must be reported explicitly. If not, only when the Halt button actually is hit during a command line execution, cancellation is the case, and reported via an event. If the command line just finished, nothing is being done, so needs to be canceled, hence no cancellation is reported either.

An example would be a client interpreting breakpoint hits and issuing continue commands to resume execution. If the halt button should also stop the client from doing this, the HaltButtonPressed event must be used.

**Running**

Started executing the target.

**RunningInBackground**

Started target execution in background mode. This is usually a mode in which a restricted set of operations can be performed, for example read from a memory location.

**Stopped cause**

Stopped target execution. The cause is reported. Possible causes:
STEP A single step of any kind was finished. Be aware that when using single-step, the debugger does not report any breakpoints the program counter arrives at.

BREAKPOINT "name"
Breakpoint name was hit. This includes cycle breakpoints, time elapsed or number of instructions types. Breakpoints that the user has set are reported as well. Nameless breakpoints are reported using as name #number#, where number is the CrossView Pro administration number. If no name or number is known, NAMELESS BREAKPOINT will be used.

ASSERTION number
Assertion number was hit.

UNKNOWN The process has stopped. The cause is unknown or cannot be described with one of the previous reasons. One of the causes may be that the user pressed the Halt button.

More causes may be added in the future.

Reset
Hardware reset command has been executed by the debugger.

ResetProgram
Software reset of the program command has been executed by the debugger.

ViewedLineNrChanged number
The line being displayed changed to the specified one. If the source window is closed, or the cursor is not in a file but somewhere in assembly, this event will not be sent.

SourceFileChanged "filename"
The debugger displays an other source file. An empty file name """) will be sent if no source is being displayed at all.

DidLoadSymbols "filename"
The symbols of an application have been loaded.
**DidAddSymbols** "filename"

An application's symbols have been added to the ones already present.

**DidDownloadImage** "filename"

The code and data image of an application has been downloaded into target memory.

**DestroyedAllSymbols** "filename"

The symbol table of the application **filename** has been destroyed.

**BreakpointsChanged**

The list of breakpoints changed (for example when a breakpoint was added).

**AssertionsChanged**

Either the list of assertions or assertion mode changed (for example when an assertion was added). Note that the assertion numbering can be entirely altered when an assertion is removed.

**MenuEntrySelected** "id-string"

The menu entry **id-string** was selected by the user. Only menu entries created with the AddDDMenuEntry or AddCOMMenuEntry command are reported.

**CmdAnnotatedOutput**<\n> annotated-output

Provides the command window output in an annotated form.

The first line indicates the error status and says OK, ERROR or NOT EXECUTED. The second line has the form SEQ:sequence_number, where the sequence number is either 0 or the number specified with the command. Although the sequence number is optional (it may be omitted in some commands) this line is always present. The next lines are either output or error messages. A label indicates the type (OUTPUT or ERROR) and the number of lines that follow.
Example

ERROR
SEQ: 9284
OUTPUT:1
Hello World
ERROR:1
No such name: xy

The reason behind this event is the inevitable merging of all data streams into one when TCP/IP server is provided next to for example the DDE server.

Quit

The debugger is about to terminate. This is not necessarily the last event, nor is it guaranteed that a CommandInterpreterReady event was send before. The quit event may not be send at all, due to technical restrictions.

1.5 COM EXAMPLES

1.5.1 PYTHON EXAMPLES

To use COM objects for Python, you must first install the Python interpreter and the Win32COM extensions. You can use the Python interpreter distributed with the TASKING EDE. Or you can download the Python interpreter from http://www.python.org (May 2001) or use win32all.exe from http://aspn.activestate.com/ASPN/Downloads/ActivePython/Extensions/Win32all (May 2001).

Synchronous Calls

Replace all occurrences of Xfw<targ> in the example below by the name of your CrossView Pro executable to make the text applicable.

#
# Example without events callback
#

import win32com.client
# Python 1.4 requires "import ni" first.
class Xfw\targ>:  
    "Xfw\targ> via COM wrapper class"
    def __init__(self, cmdline_options = ""):  
        try:  
            self.COMobject = win32com.client.Dispatch("Xfw\targ>.CommandLine")  
            self.COMobject.Init(cmdline_options)
        except Exception,e:  
            print '(Is the Xfw\targ> COM object installed,  
                   using "xfw\targ>.exe -RegServer"?)'
            raise e
    
    def Execute(self, text, sequence_number = 0):  
        result = self.COMobject.Execute(text, sequence_number)
        
        # convert Unicode to Python string
        retval = (result[0], str(result[1]))
        return retval

    test_xfw\targ>_com_object():
        xvw = Xfw\targ>(r"–sd c:\testdir")
        
        (success, result) = xvw.Execute("echo Hello from Python")
        print "received", result
        
        (success, result) = xvw.Execute("l d")
        print "success="",success
        print result
        (success, result) = xvw.Execute("++$hoi")
        print result
        (success, result) = xvw.Execute("++$hoi")
        print result
        (success, result) = xvw.Execute("++$hoi")
        print result
        del xvw

        if __name__ == "__main__":  
            test_xfw\targ>_com_object()
Events Callback

#
# Example with Events callback
#

import win32com.client
# Python 1.4 requires "import ni" first.
import win32ui

import re

seen_ready_event = 0

class xvw_events:
    def OnCrossViewEvent(self, strUnicode):
        global seen_ready_event
        print "CrossViewEvent: " + str(strUnicode)
        if (re.match("CommandInterpreterReady.*", str(strUnicode))):
            seen_ready_event = 1

class Xfw<targ>:
    def __init__(self, cmdline_options = ":"):  
        self.COMobject.Init(cmdline_options)

    def Execute(self, text, sequence_number = 0):
        result = self.COMobject.Execute(text, sequence_number)

        # convert Unicode to Python string
        retval = (result[0], str(result[1]))

        return retval

if __name__ == "__main__":
    xvw = Xfw<targ>("–sd testdirl")

    print xvw.Execute("’hello Python’;hool++")

    while seen_ready_event == 0:
        win32ui.PumpWaitingMessages(0, -1)

    print "terminating"

    del xvw
Interprocess Communication

Python Makepy Utility
In the examples above Python will load the type info dynamically from the
COM object. This is called 'dynamic' binding or 'late' binding in
PythonCOM jargon. However, PythonCOM also provides a mechanism to
generate a Python module which contains this type info and thus speeds
up the loading process. This is called early binding in the PythonCOM
package.
Python uses the makepy utility to support early-bound automation.
Makepy is a Python script that translates the COM type library to a Python
module which wraps the COM object's interfaces. Once you use the
makepy utility, early binding for the objects is automatically supported.
There's no need to do anything special to take advantage of the early
binding.
Advantages:
• Method invocation is faster.
• Constants defined in the type library are available via the COM
interface module.
• It allows much better support for advanced parameter types. Especially
parameters declared by COM as BYREF can only be used with makepy
wrapped objects.
Disadvantages:
• The makepy wrapper script depends on the COM object to be wrapped
by makepy. Generation can be automated.
• The module that is generated by makepy, can be large. The file
generated for Microsoft Excel for example, is about 800 Kb.
To speed up starting a Python script that loads the CrossView Pro COM
object, you can generate a Python module with makepy.py:
cd ...\python20\win32com\client
python makepy.py ...\xfw<targ>.exe

This script will place a module in the win32com\gen_py subdirectory.
For more information on COM programming with Python refer to Python
Programming on Win32 - Help for Windows Programmers (Mark

• • • • • • • •

B–15


1.5.2 VISUAL BASIC EXAMPLES

Replace all occurrences of \texttt{Xfw\{targ\}} in the example below by the name of your CrossView Pro executable to make the text applicable.

\textit{Synchronous Calls}

This example demonstrates plain commands being executed in CrossView Pro, without receiving any events from CrossView Pro.

```
Dim Xvw As Object
Dim Result As String

' here we invoke the PowerPC \texttt{\xvw\{\}}
' replace xfw\{targ\} by your executable name
Set Xvw = CreateObject("Xfw\{targ\}.CommandLine")
Call Xvw.init(""

Call Xvw.Execute("1", Result, 0)
MsgBox Result

End
```

\textit{Events Callback}

Visual Basic provides a special feature, \texttt{WithEvents}, to connect to the connection point of a COM interface. It is also available in VBA 5.0. You must use \texttt{WithEvents} in a variable declaration. There is a catch, however: you can only use it in a class module (including form modules) and it must appear in the declaration section. You cannot declare a variable using \texttt{WithEvents} in the body of a procedure. For this example, first select \texttt{Xfw\{targ\}} type library in the Project References dialog:

1. In Microsoft Word or Microsoft Excel, start the Visual Basic editor and go to Tools|References or:

   In Visual Basic, go to Project|References.

   Note that VBA differs from VB. See the Word example for VBA.

2. Search and check the CrossView COM Interface Type Library entry.
Option Explicit

Public WithEvents Xvw As Xfw<targ>

Private Sub Form_Load()
    Dim Result As String

    Set Xvw = CreateObject("Xfw<targ>.CommandLine")
    Call Xvw.Init("")

    Call Xvw.Execute("echo Hello", Result, 0)
End Sub

Private Sub Xvw_CrossViewEvent(ByVal EventText As String)
    MsgBox "Called back with: " & EventText
End Sub

1.5.3  WORD EXAMPLES

Here is an example of connecting to CrossView Pro PowerPC. It starts xfw<targ> and shows all messages that CrossView Pro sends to Word. Visual Basic for Applications provides a special feature, WithEvents, to connect to the connection point of a COM interface. You must use WithEvents in a variable declaration. There is a catch, however: You can only use it in a class module (including form modules) and it must appear in the declaration section. You cannot declare a variable using WithEvents in the body of a procedure.

Replace all occurrences of Xfw<targ> in the example below by the name of your CrossView Pro executable to make the text applicable. To add the example to Word:

1. Start the Visual Basic editor and go to Tools|References
2. Search and check the CrossView COM Interface Type Library entry
3. Insert a class module, via the menu bar: Insert|Class Module
4. Change its name to clsXfw<targ> in the properties pane
5. Paste the following text:
6. Insert a module, via the menu bar: Insert | Module

7. Paste the following text:

```
, 
' Module testXfw<targ>
, 
Option Explicit

Dim oXfw<targ>1 As New clsXfw<targ>

' run automatically when your Addin loads 
' and your Addin will automatically load when Word 
loads.
Public Sub AutoExec()
    Set oXfw<targ>1.oXfw<targ> = New Xfwppc
    call oXfw<targ>1.oXfw<targ>.Init("")
End Sub
```
1.5.4 EXCERPT OF THE MIDL DEFINITION

The 'ICommandLine' interface is dual, the 'ICommandLineEvents' connection point interface is not. Replace all occurrences of Xfw\text{<target>} in the example below by the name of your CrossView Pro executable to make the text applicable.

```csharp
interface ICommandLine
{
    HRESULT Init([in] BSTR CommandLine);

    HRESULT Execute([in] BSTR Command,
        [in] long SequenceNumber,
        [out] BSTR *Result,
        [out, retval] VARIANT_BOOL *Ok);

    HRESULT Halt(void);
    HRESULT ExecuteNoWait([in] BSTR Command,
        [in] long SequenceNumber,
        [out, retval] VARIANT_BOOL *Ok);
};

tool CrossViewLibXfw\text{<target>}
{
    dispinterface _ICommandLineEvents
    {
        methods: void CrossViewEvent([in] BSTR);
    };

coclass Xfw\text{<target>}
{
    [default] interface ICommandLine;
    [default, source] dispinterface _ICommandLineEvents;
};
};
```
2 DDE SERVER INTERFACE

2.1 INTRODUCTION

CrossView Pro offers an Interprocess Communications (IPC) option using the Microsoft Windows Dynamic Data Exchange (DDE) interface for external control of CrossView Pro. The DDE interface offers direct access to the CrossView Pro command interpreter. Via the DDE interface you can execute every CrossView Pro command that you can access via the regular CrossView Pro command window, and retrieve the output produced by the executed command.

2.2 DDE ITEMS AND TOPICS

DDE function calls always return, whether they succeed or fail. They do not report application command errors. Retrieve and interpret the cmdoutput item or cmdannotatedoutput item to check for errors.

Help

Topic
  System

Item
  Help

Operations
  Request, Advise

Description
  Returns a brief overview of the topics and items in ASCII text format.
**cmdoutput**

**Topic**

Command

**Item**

cmdoutput

**Operations**

Request, Advise

**Description**

Retrieves all command window output of the last executed command via the Command topic. This item empties itself after it has been requested.
cmdannotatedoutput

Topic
Command

Item
cmdannotated output

Operations
Request, Advise

Description
The first line indicates the error status and says OK, ERROR or NOT_EXECUTED. The second line has the form SEQ:sequence_number, where the sequence number is either 0 or the number specified with the execext command. Although the sequence number is optional (it may be omitted in some commands) this line is always present. The next lines are either output or error messages. A label indicates the type (OUTPUT or ERROR) and the number of lines that follow.

Example

ERROR
SEQ: 9284
OUTPUT:1
Hello World
ERROR:1
No such name: xy
execext

**Topic**

Command

**Item**

execext:options:string

**Operations**

Execute

**Description**

Passes the specified string without interpreting it to CrossView Pro's command interpreter (see also Command\cmdannotatedoutput). The execext prefix is part of the entire command string: it makes a distinction between the various commands. For example exec, execext or halt, received via the Command topic.

**Options**

- **wait=yesno** yesno is 1 or 0. If you specify wait=1 is, the execext command blocks the DDE transaction until CrossView Pro has finished executing the command. Issue the Halt command in this case via a second conversation. Be aware of the time limitation imposed by the DDE interface. It can wait for a period of 25 days. Use exec combined with either waiting for an Advise on the cmdoutput item, or with interpreting the event item to handle very long lasting commands. When you do not specify a value, 1 is assumd by default.

- **seq=number** A unique number to identify a command's specific result in the stream of events output via the event item. See the event item and cmdannotatedoutput item for more details.

- **silent=yesno** yesno is 1 or 0. If 1, the command window output will be suppressed. See section 2.5.5 Using CrossView Pro as Pure Server for the gus command. When you do not specify a value, 1 is assumd by default.

**Example**

execext:seq=424564,wait:echo test
exec

Topic
   Command

Item
   exec

Operations
   Execute

Description
   Passes the specified string without interpreting it to CrossView Pro’s command interpreter (see also Command\cmdoutput).

   A major difference with regular MS–Windows applications is the immediate acknowledge of a command, before it has been completed. This is because the sender does not have to wait for the answer and can perform other tasks meanwhile. For example, you are able to issue a \textit{halt} command to stop the debugger.

   To simulate wait–till–completion command execution, wait until the cmdoutput item is assigned to the command’s output via an Advisory link event, or interpret the event item.

   The \texttt{exec}: prefix is part of the entire command string: it makes a distinction between the various commands. For example, \texttt{exec, execext} or \texttt{halt}, received via the Command topic.
halt

**Topic**
Command

**Item**
halt

**Operations**
Execute

**Description**
Forces CrossView Pro to stop target execution. You can issue the command via a second conversation.
**event**

**Topic**
Command

**Item**
event

**Operations**
Advise

**Description**
Reports event occurrences to the client, asynchronously. An event is reported by a string. To ensure capturing all events, use an Advise link. CrossView Pro only keeps the last event.

Request is not meant to be used; it can only be used after establishing an Advise link.
result

Topic
Command

Item
result:name

Operations
Execute

Description
The name that you specify provides a serve as DDE requestable item to obtain a message which describes the reason why a DDE command failed to execute. It does not return the CrossView Pro error message. It is always deleted after it has been requested.

The result: prefix is part of the entire command string; it makes a distinction between the various commands. For example, exec, execext or halt, received via the Command topic.

2.3 DDE EVENTS

2.3.1 PACKET FORMAT

Each event is wrapped in a record and one DDE message contains one or more of these records. This means that multiple events can be received simultaneously in one DDE transaction. This is done because DDE can lose ("combines") events when XTYPF ACKREQ mode is selected, and because this channel will be redirected to TCP/IP in the future for portable IPC support in CrossView Pro.

To handle events with more than one line, a header (not a newline) is used to distinguish between the individual events. The header format is:

EVENT: number-of-characters<newline>

So you must always split events that arrive in one DDE message. An example of such a multi-event DDE message is:
EVENT: 27
SourceFileChanged "demo.c"
EVENT: 23
ViewedLineNrChanged 93
EVENT: 27
Stopped BREAKPOINT "input"
EVENT: 24
CommandInterpreterReady
EVENT: 79
CmdAnnotatedOutput
OK\r
OUTPUT:1\r
Error breakpoint name 'input' is not unique!\r

For an overview of all available events, see section 1.4 Events

2.4 CROSSVIEW PRO DDE SPECIFIC OPTIONS AND COMMANDS

2.4.1 COMMAND LINE OPTIONS

--ddeservername=name

This command line option specifies a unique DDE server name. This way it is easier to distinguish between multiple instances of the same debugger.

If you do not use this option, the server name is the name of the CrossView executable. To distinguish between multiple DDE servers with the same name, you must connect to all DDE servers using DdeConnectLists() and obtain distinguishing information.

2.4.2 COMMANDS

With regard to DDE support, the following commands are available to enhance integration support.

AddDDEMenuEntry

Syntax:
AddDDEMenuEntry "label","id-string" [AlwaysEnabled]
Creates a menu entry with given label and id-string. The label also specifies the path from the main menu bar, for example:

```
AddDDEMenuEntry "Options|CaseTool|Configure...", 
                  "config-menu-entry"
```

An entry cannot be removed or replaced once it has been created. Neither is there support for enabling or disabling entries via this interface, this is somewhat problematic, since we are communicating across an asynchronous interface, so the disable may not be executed immediately.

*AlwaysEnabled* is either 1 (true) or 0 (false, default). CrossView Pro by default disables the menu entry when the command window disallows entering a command, for example when running an application.

To define the shortcut character of a menu entry, place a `&` before the character. The shortcut character will be underlined. To add a separator line in the menu, start the next menu entry with a `+`. The separator line will precede this menu entry. For example:

```
"&Options|&CaseTool|+&Reset"
```

### 2.5 EXAMPLES

#### 2.5.1 EVALUATING AN EXPRESSION

To get the value of an expression, pass it to the command interpreter. The syntax of the returned value is:

```
identifier = value
```

The *value* can even be a complete structure or union. For example, execute via the Command topic:

```
execext:main
```

The returned string could look like:

```
main = 0x0
```
### 2.5.2 READING TARGET MEMORY

You can retrieve target memory either via requesting a variable's value, or with the `dump` command. The `dump` command can dump both byte (MAU) sized hex values or C type values, for example long or double. The resulting output must be interpreted to get the values.

The basic syntax of the returned values for plain MAU size hex dumps is:

```
address: value value ASCII-dump
```

The basic syntax of the returned values for formatted dumps is:

```
address = value value
```

For example, execute via the Command topic a hex dump command:

```
execext:dump main,#16
```

The returned text could be:

```
0x2000: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 .......
```

For example, execute via the Command topic a formatted dump command, requesting 16bit integers:

```
execext:dump data1,#16,d2
```

The returned text could be:

```
0x2000 = 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
0x2010 = 0 0 0 0 0 0 0 0 0 0 0
```

The number of values per line differs. This depends on both the size and type of the values, as well as the architecture of the processor that is connected to the debugger.
2.5.3 WRITING INTO TARGET MEMORY

To write to target memory, use one of the following three methods.

1. Assign a value to a variable.

2. Use one of the the mF or mf commands.

   For example, the following stores the byte (MAU) sized values 1 2 3 4 5 in memory starting at memory location 0x2000.

   \[0x2000 \text{ mF 1, 2, 3, 4, 5}\]

3. Write into memory using a type cast.

   For example:

   \[*(\text{long}*)0x2000 = 0x12345\]
2.5.4 REQUESTING CURRENT FILE AND LINE NUMBER

To determine the location of the source window cursor position, request the following special variables:

$FILE The file in which the source window cursor position is. If the position is outside any file, the error message 'No current file' is returned.

$PROCEDURE The name of the function in which the source window cursor position is. If the position is outside any function, the error message 'No current function' is returned.

$LINE The line number of the cursor in the source window. If the position is outside any file, the error message 'No current line' is returned.

You can also use the command “ls” to get all special variables, including the ones above. If a variable is not set, it is not included in the list, or set with the error message as described above.

To make sure the cursor is at the current execution position, precede the L command before requesting the variable. For example, issue:

L; $FILE; $PROCEDURE; $LINE

Error messages appear when a variable fails.

To obtain the current execution positions, you can also interpret the result of the L command directly.

2.5.5 USING CROSSVIEW PRO AS PURE SERVER

To have CrossView Pro act as server only, updating windows can be turned off with the command gus on. This inhibits all windows from being updated, except for the command window. Note that also the GUI does not refresh anymore.

Also the execext:silent=1:... command via DDE inhibits the command window output.
1 INTRODUCTION

CrossView Pro uses a so-called “register definition file” (`regcpu.dat`) that specifies the register name to register number mapping for CrossView Pro. In case a register is a memory mapped register, the register number specifies the register’s memory address.

Register definition files for the DSP56xxx family derivatives are included in the package.

If you use another derivative you can use the register manager to create new register definition files.

2 INVOCATION

CrossView Pro has a user definable set of special function registers (SFRs). The registers are read by CrossView Pro from a binary file (`regcpu.dat`) specified by the `cpu_type` field in `xvw.ini` or a target configuration file (*.cfg):

```
    cpu_type: 563xx
```

`cpu` is 563xx by default for the DSP563xx/DSP566xx, but you can overrule the CPU type (and thus the `regcpu.dat` file) to be used by CrossView Pro with the `-C` option. The tool for generating this binary file from a text file is the Register Manager `rm56` for the DSP5600x or `rm563` for the DSP563xx/DSP566xx. In this appendix `rm563` refers to both `rm56` and `rm563` unless explicitly stated otherwise.

The invocation syntax for `rm56` and `rm563` is the same:

```
    rm563     [ register-file [register-file]... ] [o outfile]
    rm563     -?
    rm563     -V
```

When you use a UNIX shell (Bourne shell, C-shell), arguments containing special characters (such as '(' and '?') must be enclosed with " " or escaped. The `-?` option in the C-shell becomes "-?" or `-\?".
The optional register-file (or several files) contains the user definition of SFRs (Special Function Registers). The syntax of this text file is described in the next section. The rm563 tool always generates a fixed set of registers in the binary output file. If no register-file is supplied, only this set is generated. A list of the fixed set can be found in the section Fixed Register Set.

The –o outfile option lets you specify the name of the generated binary register definition file. If this option is omitted, the default outfile name is reg.dat.

The –? option causes rm563 to print a tiny manual, and the –V option prints the version header only.

### 3 SYNTAX OF A REGISTER FILE

The syntax of a register file is quite simple. Comments start with a semi–colon (;) and end at the end of the line. The only directive allowed in the register file is EQU.

**Register file syntax:**

```
name  equ  address  [; Comments]
```

**Field Values:**

- **name**: A unique register name. If a name is multiply defined an error is issued. If a fixed name is redefined, a warning is issued and the redefinition is ignored.

- **address**: A DSP56xxx address

**Examples:**

```
BCR  equ  x:$FFFE ; Port A Bus Control Register
RX   equ  x:$FFEF ; Serial Receive Data Register
```
4 FIXED REGISTER SET

The following registers are always defined by \textbf{rm563}. Redefinition results in a warning, and the redefinition is ignored.

<table>
<thead>
<tr>
<th>Name</th>
<th>Number</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>0</td>
<td>16–bit program counter</td>
</tr>
<tr>
<td>SR</td>
<td>1</td>
<td>16–bit status register</td>
</tr>
<tr>
<td>MR</td>
<td>2</td>
<td>mode register</td>
</tr>
<tr>
<td>CCR</td>
<td>3</td>
<td>condition code register</td>
</tr>
<tr>
<td>OMR</td>
<td>4</td>
<td>operation mode register</td>
</tr>
<tr>
<td>SP</td>
<td>5</td>
<td>stack pointer register (hardware)</td>
</tr>
<tr>
<td>LA</td>
<td>6</td>
<td>loop address register</td>
</tr>
<tr>
<td>LC</td>
<td>7</td>
<td>loop counter register</td>
</tr>
<tr>
<td>SSL</td>
<td>8</td>
<td>low order 16 bits of stack data</td>
</tr>
<tr>
<td>SSH</td>
<td>9</td>
<td>high order 16 bits of stack data</td>
</tr>
<tr>
<td>X</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>X0, X1</td>
<td>11, 12</td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Y0, Y1</td>
<td>14, 15</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>A0 ... A2</td>
<td>17 ... 19</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>B0 ... B2</td>
<td>21 ... 23</td>
<td></td>
</tr>
<tr>
<td>R0 ... R7</td>
<td>24 ... 31</td>
<td></td>
</tr>
<tr>
<td>R7</td>
<td>31</td>
<td>USP</td>
</tr>
<tr>
<td>N0 ... N7</td>
<td>32 ... 39</td>
<td></td>
</tr>
<tr>
<td>M0 ... M7</td>
<td>40 ... 47</td>
<td></td>
</tr>
<tr>
<td>FP</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>UFP</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>USP</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>EP</td>
<td>52</td>
<td>563xx/566xx DSP family</td>
</tr>
<tr>
<td>EMR</td>
<td>53</td>
<td>563xx DSP family</td>
</tr>
<tr>
<td>VBA</td>
<td>54</td>
<td>563xx/566xx DSP family</td>
</tr>
<tr>
<td>SC</td>
<td>55</td>
<td>563xx/566xx DSP family</td>
</tr>
<tr>
<td>SZ</td>
<td>56</td>
<td>563xx/566xx DSP family</td>
</tr>
<tr>
<td>CCNT</td>
<td>–</td>
<td></td>
</tr>
</tbody>
</table>
Table C-1: Fixed Register Set

<table>
<thead>
<tr>
<th>Name</th>
<th>Number</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICNT</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>FAST_MODE</td>
<td>–</td>
<td>563xx/566xx DSP family</td>
</tr>
</tbody>
</table>

PC, OMR, SP, LA, LC, SSL, SSH
The standard DSP56xxx PCU registers.

SR, CCR, MR
The status register, condition code register and mode register.

EMR
DSP563xx extended mode register (part of SR).

VBA
The vector base address register (DSP563xx/DSP566xx).

X ... X1, Y ... Y1, A ... A2, B ... B2
The standard DSP56xxx ALU registers.

R0 ... R7, N0 ... N7, M0 ... M7
The standard DSP56xxx AGU registers.

EP, SC, SZ
DSP563xx/DSP566xx stack extension registers.

FP, USP, UFP
The frame pointer, user stack pointer and user frame pointer.
All debugger pseudo registers for walking the system stack or accessing the user stack used by reentrant functions of the c56 compiler.

CCNT
The CycleCount register. The number of execution cycles is recorded in the CCNT register. The cyclecount register is not an on-chip register, nor a memory location on the target system, but a CrossView Pro internal data structure that can be accessed as if it is an ordinary register. The CCNT register is 32 bits wide.

ICNT
The Instruction Count register. The number of instructions executed is recorded in the ICNT register. This register is a CrossView Pro internal data structure that can be accessed as if it is an ordinary register. The ICNT register is 32 bits wide.

FAST_MODE
A pseudo-register to switch the accuracy of the DSP563xx and DSP566xx simulators and achieve a much higher simulation speed.
5 DSP56XXX FAMILY DERIVATIVES

The CrossView Pro package for the DSP56xxx family contains a number of register files (reg*.def) and the corresponding binary register definition files (reg*.dat) in the etc directory. You can create your own version of an existing file or build a new one for a derivative which is not (yet) supported.

For instance, to create a binary version for a DSP56302, type:

```
rm563  reg56302.def  -o reg56302.dat
```

Then start CrossView using `–C 56302`, or enter 56302 in the CPU type field of the Target | Settings dialog.

The following rules are used to find the reg*.dat files:

1. Look if the files are present in the current directory
2. Look in the etc subdirectory of your product tree.

6 DSP56XXX REGISTER SET

For the DSP5600x CrossView uses reg5600x.dat by default, for the DSP563xx/DSP566xx this is reg563xx.dat. These default files are generated by the register manager when no input file is specified.

Examples:

```
rm56   –o reg5600x.dat
rm563  –o reg563xx.dat
```

or you can rename the default output name reg.dat.
APPENDIX

SOUND SUPPORT

(MS-Windows)
You can have sound effects being played when a predefined event in CrossView Pro occurs. You can configure the sound in the Sound settings of the Control Panel of MS-Windows. Similar to assigning a sound to a system event, you can assign a sound to a CrossView Pro event.

Currently the following events are supported:

- Breakpoint hit
- File has been downloaded
- CrossView Pro has started execution
- CrossView Pro is exiting
- Run command/button
- Step command/button
- StepOver command/button
- Halt command/button
- Symbols Loaded
- Fatal (system) error occurred
- Non-fatal error

**How to add sound support**

1. Firstly all events must be specified to MS-Windows. You can do this by adding the following lines to the Registry under:

   My Computer\HKEY_CURRENT_USER\AppEvents\EventLabels\n
   Use `regedit` to start the registry editor.

   ```
   snd_xvw_bphit        "XVW Breakpoint Hit"
   snd_xvw_download     "XVW Program Download"
   snd_xvw_start        "XVW Start"
   snd_xvw_exit         "XVW Exit"
   snd_xvw_run          "XVW Run"
   snd_xvw_step         "XVW Step Into"
   snd_xvw_stepover     "XVW Step Over"
   snd_xvw_stop         "XVW Stop"
   snd_xvw_syms_load    "XVW Load Symbols"
   snd_xvw_syserror     "XVW syserror"
   snd_xvw_uerror       "XVW uerror"
   ```

2. You must also add the same list of keys (without values) to

   My Computer\HKEY_CURRENT_USER\AppEvents\Schemes\Apps\.Default\n
3. Now go and start the Sound settings in your Control Panel. Here you can assign a sound to each event. You can also assign None to an event, which prevents CrossView Pro from playing a sound if that specific event occurs.
4. For the sound effects to become operational, you also have to edit the xvw.ini file. You can do this using any editor, e.g. the Windows 
notepad command. Add the following line at an arbitrary line to your xvw.ini file:

    sound_effects: TRUE

It is also possible to disable the sound effects by changing this line into:

    sound_effects: FALSE

Now all sound effects are disabled.
ADDENDUM

SIMULATOR

TASKING
1 INTRODUCTION

This addendum contains information specific to the simulator version of CrossView Pro for the DSP56xxx.

2 EXECUTABLE NAME

The following CrossView Pro executable is delivered with the package (for PC with .exe extension):

xfw56x  CrossView Pro Debugger Simulator.

3 SUPPORTED FEATURES

Except for the restrictions mentioned in the next section, the simulator version of the debugger cleanly supports all the standard features of CrossView Pro, including single stepping, code breakpoints, data breakpoints, trace support, C expression evaluation and record/playback capability. With respect to setting breakpoints the simulator version of the debugger is capable of supporting all breakpoint types, including separate data–read and data–write breakpoints.

Because this is a simulator version, you do not have to setup a serial communication at startup, as with an emulator.

3.1 CYCLE AND INSTRUCTION COUNTERS

In addition to the standard features of CrossView Pro, the simulator version executes the DSP56xxx instruction set and can perform cycle counting and instruction counting. For this purpose the simulator has a cycle counter and an instruction counter. These counters can be monitored in the register window where they are shown as 'CCNT' and 'ICNT', respectively, and they can also be accessed through the registers $ccnt and $icnt.
3.2 SIMULATION SPEED

To switch the accuracy of the DSP563xx and DSP566xx simulators and achieve a much higher simulation speed you can use the pseudo-register fast_mode. By default it is set to 0, but it can be changed in the register window or on the debugger command line:

\$fast_mode=value

The values of this register represent:

- 0 – cycle accurate simulation, peripheral emulation
- 1 – instruction accurate simulation, peripheral emulation
- 2 – instruction accurate simulation only

Changing the value of this register must be done before starting to execute (simulate) code. Simulation results are incorrect when it is changed during simulation. Once set to a value other than zero it cannot be reset anymore. Of course, closing the simulator program and rerunning it will reset the register again. In the instruction accurate mode the simulator will lose cycle accuracy only in very uncommon cases, like with program instructions that are partly in internal memory and partly in external memory. For most common jobs a setting of 2 is all that is needed, and the around tenfold speed improvement is certainly worth the small decrease in accuracy.

3.3 COVERAGE

The simulator traces all memory access performed during program execution. This feature can be switched on or off. If you are not interested in coverage information you should turn off this feature because gathering coverage data will slow down the execution speed of the simulator. The simulator differentiates between data read, data write and instruction fetch. CrossView Pro shows the gathered coverage data through various windows and dialogs.
4 RESTRICTIONS

Facilities for background mode are absent in the simulator version of CrossView Pro. As a consequence, the CrossView Pro commands CB, st, u, ubgw and wt for background mode, are not available. Because this is a simulator version, the >& command to record target communication and the o command for transparency mode are not available. Also, the simulator version of the debugger does not support command line function calling.

5 SIMULATOR CONFIGURATION FILE

The simulator configuration files "sim*.cfg" describe the available simulator configurations. A configuration file is a text file and can be edited with any text editor. CrossView Pro searches for the simulator configuration file in the current directory and in the etc directory.

On startup CrossView Pro selects the configuration indicated by the Target | Settings dialog or with the -tcfg command line option and reads the simulator configuration file in memory. This configuration can be selected using the filename or the full name (title field) of the configuration.

Empty lines, lines consisting of only white space are allowed. Comments start at an exclamation–sign (!) and end at the end of the line. Lines that start with the special notation '!' are script lines that are executed by CrossView Pro.

An information line has the following synopsis:

    ![comment] field : field-value

field       one of the keywords described below
field-value the value assigned to the field
comment     optional comment
The fields listed in the configuration file are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>The full name of the configuration. This name will be displayed in the Target configuration field of the Target Settings dialog.</td>
</tr>
<tr>
<td>cpu_type</td>
<td>The name of the CPU. You can specify multiple CPU type separated by white space. This also determines the name of the register file regcpu.dat in the etc directory.</td>
</tr>
<tr>
<td>debug_instrument_module</td>
<td>The name of the Debug Instrument (using GDI) used for debugging.</td>
</tr>
<tr>
<td>target_dependent_module</td>
<td>The name of the target specific module needed for your DSP56xxx derivative.</td>
</tr>
<tr>
<td>radm</td>
<td>The name of the Debug Instrument (using KDI) used for RTOS aware debugging. (optional).</td>
</tr>
</tbody>
</table>

Notes:
- Fields not required for the target can be omitted.
- CrossView Pro searches for the *.cfg files in the current directory and in the etc directory.
1 INTRODUCTION

CrossView Pro for the Motorola DSP56xxx family is designed to support both the Motorola ADS (Application Development System) and the Motorola EVM (Evaluation Module) target boards. The Motorola DSPs have a common dedicated serial port called OnCE™ (On Chip Emulator). On the 3xx/6xx series, the OnCE™ port is accessible through the JTAG (Joint Test Action Group) protocol.

For running CrossView Pro the following parts, delivered by Motorola are required:

- a target board
- a device driver
- a Command Converter (on-board, parallel, PCI, SoftBox)

For connection of the target board to the host computer you can use:

- a Host Computer Interface Card (ISA or PCI)
- a parallel cable

Figure Emu–1 shows a typical example how these components are tied together.

*Figure Emu–1: Target board connection example*

**ADS ISA card connection**

On Windows NT and UNIX the device driver interfaces directly with the Host Computer Interface Card. CrossView Pro uses the device driver to communicate with the interface card. On Windows 95, CrossView Pro directly interfaces on the Host Computer Interface Card.
This interface card is connected to the Command Converter via a connection cable. The Command Converter is usually mounted on top of the target board. The command converter converts host commands to the OnCE™.

**PCI card / JTAG connection**

The PCI interface card is connected to the JTAG Target Interface Module via a 25-pin extension cable. The Target Interface Module is connected via a 14-pin JTAG ribbon cable to the target board. The command converter is present on the PCI card and uses the JTAG protocol to communicate with the OnCE™.

**EVM serial connection**

On an EVM board a microcontroller or DSP is used which communicates via RS–232 to the host computer and via OnCE™ to the target DSP. This microcontroller/DSP runs a debug monitor which translates commands received via RS–232 from the host to OnCE™ commands for the DSP and vice versa. For the DSP56002, the RS232 communication speed is fixed to 19200 baud by this debug monitor. The DSP563xx/6xx can use communication speeds up to 230 kbaud.

For the 3xx/6xx, the OnCE commands are sent using the JTAG protocol. On the 3xx/6xx EVM boards a Command Converter is present, which runs a debug monitor that converts commands received via RS–232 to JTAG commands. The communication speed can be set in a dialog or on the command line.

For connecting to the serial debug port of the DSP563xx and DSP566xx EVM boards, the serial port cable must have the DTR line connected. On these boards, DTR is used to reset the command converter DSP from the debugger. As a minimum, RX, TX, ground and DTR must be connected.

**EVM parallel connection**

For connecting to the parallel debug port of the DSP563xx and DSP566xx EVM boards, you need a full parallel port extension cable. A 25-pin serial port cable or a lap–link cable is not suitable for this purpose.

**SB–56K and SB–USB**

Domain Technologies’ SB–56K and SB–USB are separate command converters that communicates with the computer through an RS–232 or USB interface respectively. They offer a JTAG port to which you can connect your DSP.
2 INSTALLATION

The installation of CrossView Pro is described in the chapter *Software Installation* in this manual.

**ADS**

For installation of the ADS hardware and the device drivers for UNIX, please see the chapter *Hardware Preparation and Installation* in the Application Development System Reference Manual delivered by Motorola with your ADS.

**EVM**

For installation of the EVM hardware refer to the hardware documentation supplied with the EVM board.

3 ADS VERSIONS

CrossView Pro is tested with the ADS Command Converter versions 3.0, 4.0, 4.6, 5.0, 6.0, 6.1 and 7.0. When CrossView Pro determines an unknown version of the Command Converter, a warning will be issued. Although CrossView Pro may work with different versions, it is not guaranteed.

Restriction:

Currently, CrossView Pro can only access one target board (device #0) per command converter board.

4 MOTOROLA DSP DIFFERENCES

CrossView Pro for the Motorola DSP56xxx family supports the DSP5600x, DSP563xx and DSP566xx DSPs. Different CrossView Pro packages exist for each core. The derivatives of each core are supported by means of register files, described in the appendix *Register Manager* in this manual. The names of the CrossView Pro executables are the same for each package. No differences exist in the functionality of CrossView Pro for the various Motorola DSPs. The CrossView Pro manual is common for the various Motorola DSPs.
5 EXECUTABLE NAME

The following CrossView Pro executable is delivered with the package (for PC with .exe extension):

*xfw56x*  CrossView Pro Debugger for all members of the DSP56xxx family.

6 RESTRICTIONS

Facilities for background mode are absent for the DSP56xxx target boards. As a consequence, the CrossView Pro commands *CB, st, u, ubgw* and *wt* for background mode, are not available. Due to the binary command interface between the debugger and the target board, the >& command to record target communication and the *o* command for transparency mode are not available. Also Coverage and Profiling are not supported. As a consequence, the CrossView Pro commands *ce, cd, covinfo, pe, pd, proinfo, cproinfo, nc, nu, pc,* and *pU* are not available.

Command line function calls are not supported. This is because when functions using a static stack frame are accessed during execution of a command line function call the stack of the application could be corrupted. This is caused by side effects of the overlay mechanism.

Menu and dialog items related to the mentioned commands are disabled (grayed out).

**Hardware breakpoints**

For the DSP5600x it is possible to have one data breakpoint, which is set using the breakpoint register of the OnCE. This data breakpoint can also be set in ROM.

For the DSP563xx/DSP566xx it is possible to have either two data breakpoints, or one data range breakpoint because this is supported by the OnCE on the DSP563xx/DSP566xx.

The number of code breakpoints is limited by the internal CrossView Pro limit (default 200). You can change this limit in the **Initialization** tab of the dialog box called by the menu option **File | Options...** Code breakpoints can only be set in RAM because for setting breakpoints, CrossView Pro writes a DEBUG instruction on each breakpoint location. This restriction also affects single stepping because CrossView Pro may want to set a temporary breakpoint for stepping.
The size of the trace buffer of the OnCE limits the number of instructions in the Trace window.

7 REGISTERS AND RESET

This section describes which registers writes are performed when an EVM or SB–56K system reset occurs (the \texttt{rst} command) or on a program reset (the \texttt{prst} command). For the ADS a system reset depends on the "true" hardware reset.

The following registers are written (in this sequence, for the targets mentioned):

\begin{verbatim}
  $SR  = 0x000300        (DSP5600x)
  $SR  = 0xc00300        (DSP563xx)
  $SR  = 0x0300          (DSP566xx)
\end{verbatim}

For the DSP563xx/6xx SR is written twice in order to be sure to also set the high byte (which is inaccessible in 16 bit mode).

\begin{verbatim}
  $SP  = 0               (All targets)
  $SC  = 0               (DSP563xx/6xx)
  $OMR = 0               (All targets)
  $M0 .. $M7 = 0xffff    (DSP5600x and DSP566xx)
  $M0 .. $M7 = 0xffffff  (DSP563xx)
\end{verbatim}

For DSP5600x:

\begin{verbatim}
  _X:0xffff = 0;      /* IPR: Interrupt Priority Register */
\end{verbatim}

For DSP563xx:

\begin{verbatim}
  _X:0xffffffff = 0;   /* IPRC: Interrupt Priority Register Core */
  _X:0xfffffffe = 0;   /* IPRP: Interrupt Priority Register Peripherals */
  _X:0xffffffec = 0;   /* DCR0: DMA Control Register 0 */
  _X:0xffffffe8 = 0;   /* DCR1: DMA Control Register 1 */
  _X:0xffffffe4 = 0;   /* DCR2: DMA Control Register 2 */
  _X:0xffffffe0 = 0;   /* DCR3: DMA Control Register 3 */
  _X:0xffffffdc = 0;   /* DCR4: DMA Control Register 4 */
  _X:0xffffffd8 = 0;   /* DCR5: DMA Control Register 5 */
\end{verbatim}
For DSP566xx:

```c
_X:0xffff = 0;  /* IPRC: Interrupt Priority Register Core */
_X:0xfffe = 0;  /* IPRP: Interrupt Priority Register Peripherals */
_X:0xffec = 0;  /* DCR0: DMA Control Register 0 */
_X:0xffe8 = 0;  /* DCR1: DMA Control Register 1 */
_X:0xffe4 = 0;  /* DCR2: DMA Control Register 2 */
_X:0xffe0 = 0;  /* DCR3: DMA Control Register 3 */
_X:0xffdc = 0;  /* DCR4: DMA Control Register 4 */
_X:0xffd8 = 0;  /* DCR5: DMA Control Register 5 */
```

8 MEMORY CONFIGURATION FOR THE DSP563XX/6XX

The DSP563xx has an on-chip memory controller, which has to be configured to be able to utilize the external memory on a target board. To download an application in this memory, the controller must be configured before downloading. CrossView Pro configures the memory controller with the values found in some special equate symbols. These symbols are defined in the startup assembly module that is linked to your application. CrossView Pro will use the R_xxxvVALUE symbols in the order listed below to set up the external memory configuration.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>R_SRVALUE</td>
<td>SR</td>
</tr>
<tr>
<td>R_OMRVALUE</td>
<td>OMR</td>
</tr>
<tr>
<td>R_AAR0VALUE</td>
<td>AAR0</td>
</tr>
<tr>
<td>R_AAR1VALUE</td>
<td>AAR1</td>
</tr>
<tr>
<td>R_AAR2VALUE</td>
<td>AAR2</td>
</tr>
<tr>
<td>R_AAR3VALUE</td>
<td>AAR3</td>
</tr>
<tr>
<td>R_BCRVALUE</td>
<td>BCR</td>
</tr>
<tr>
<td>R_DCRVALUE</td>
<td>DCR</td>
</tr>
</tbody>
</table>

*Table Emu–1: Symbols for the ADS563xx or EVM563xx*

For the EVM566xx only the symbols R_SRVALUE, R_OMRVALUE and R_BCRVALUE are available.
Example (default hardware configuration values for DSP56301):

```
R_AAR0VALUE  equ $000839
R_AAR1VALUE  equ $010839
R_AAR2VALUE  equ $000000
R_AAR3VALUE  equ $08053A
R_BCRVALUE   equ $1FFFE1
R_DCRVALUE   equ $20280A
R_OMRVALUE   equ $000000
R_SRVALUE    equ $C80300
```

global R_SRVALUE, R_OMRVALUE, R_AAR0VALUE,
       R_AAR1VALUE, R_AAR2VALUE, R_AAR3VALUE, R_BCRVALUE,
       R_DCRVALUE

In EDE you can select the target hardware configuration as follows:

1. From the **Project** menu, select **Project Options**...

   *The Project Options dialog appears.*

2. Expand the **Linker/Locator** entry and select **Control File**.

3. In the **Target** list, select a target configuration.

### 9 COMMUNICATION SETUP

The configuration files "*.cfg" describe the available target board configurations. A configuration file is a text file and can be edited with any text editor. CrossView Pro searches for the configuration file in the current directory and in the `etc` directory.

On startup CrossView Pro selects the configuration indicated by the **Target** | **Settings** dialog or with the `-tcfg` command line option and reads the configuration file in memory. This configuration can be selected using the filename or the full name (title field) of the configuration.

Empty lines, lines consisting of only white space are allowed. Comments start at an exclamation-sign (`!`) and end at the end of the line. Lines that start with the special notation `!>:` are script lines that are executed by CrossView Pro.

An information line has the following synopsis:

```
[! comment] field : field-value
```
**field**  one of the keywords described below

**field-value**  the value assigned to the field

**comment**  optional comment

The **fields** listed in the configuration file are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>The full name of the configuration. This name will be displayed in the Target configuration field of the Target Settings dialog.</td>
</tr>
<tr>
<td>cpu_type</td>
<td>The name of the CPU. You can specify multiple CPU type separated by white space. This also determines the name of the register file regcpu.dat in the etc directory.</td>
</tr>
<tr>
<td>debug_instrument_module</td>
<td>The name of the Debug Instrument (using GDI) used for debugging. See table below.</td>
</tr>
<tr>
<td>target_dependent_module</td>
<td>The name of the target specific module needed for your DSP56xxx derivative.</td>
</tr>
<tr>
<td>radm</td>
<td>The name of the Debug Instrument (using KDI) used for RTOS aware debugging. (optional).</td>
</tr>
</tbody>
</table>

*Table Emu-2: Fields in configuration files*

Notes:
- Fields not required can be omitted.
- CrossView Pro searches for the *.cfg files in the current directory and in the etc directory.

The following table shows an overview of the available configuration files.
**Configuration File** | **Debug Instrument** | **Connection** | **Target**
--- | --- | --- | ---
ads560.cfg  
ads563.cfg  
ads566.cfg  
ads665.cfg | adsxxx6x.dll  
ntaxxxx6x.dll | ISA | ADS command converter
pci563.cfg  
pci665.cfg | adsxxx6x.dll  
ntaxxxx6x.dll | PCI | PCI command converter
par563.cfg | adsxxx6x.dll  
ntaxxxx6x.dll | Parallel | Parallel on board / external cmd converter
usb560.cfg  
usb563.cfg  
usb566.cfg | usbxxx.dll | USB | SB–56K serial command converter
sb560.cfg  
sb563.cfg  
sb566.cfg | sbxxx.dll | RS–232 | SB–USB Univ. serial bus cmd converter
evm563.cfg  
evm566.cfg | evmxxx.dll | EVM on board cmd converter
sim560.cfg  
sim563.cfg  
sim566.cfg  
sim665.cfg | simxxx.dll | Simulator

Table Emu–3: Overview of configuration files

### 9.1 Creating a Target Configuration File for a JTAG Chain

It is possible to debug multiple DSPs on a JTAG chain. You have to make your own target configuration file to use this feature in CrossView Pro.

1. Go to the directory etc of your product installation directory.
2. Edit the file mul563.cfg (Windows 95/98) or mul563nt.cfg (Windows NT/2000).
3. Make the following changes:
   - Define the JTAG chains by adding a number of lines with the following format:
     
     ```
     target_config_item.i : add_jtag_def CHAIN_ELEM_DEF
     ```
One line for each element on the JTAG chain is required, starting with the element with TDI connected to the CC (Command Converter). "$i" must be 0 for the first line and increment by 1 for each following line. The \texttt{CHAIN_ELEM_DEF} is a comma separated list of definitions:

\begin{verbatim}
cc=N   \hspace{1cm} (CC number, $N = 0, ..., 7$ are supported)
tms=0 \hspace{1cm} (currently only tms=0 is supported)
cpu=CPU\_TYPE \hspace{1cm} (a cpu type supported by the debug instrument)
ir=LENGTH \hspace{1cm} (define the Instruction Register length of a non-recognized JTAG chain element)
\end{verbatim}

A line must contain either a \texttt{cpu} or an \texttt{ir} definition, but not both. The defaults are:

\begin{verbatim}
cc=0,tms=0
\end{verbatim}

So,

\begin{verbatim}
target_config_item.0: add_jtag_def cpu=56302
target_config_item.1: add_jtag_def cpu=56302
target_config_item.2: add_jtag_def cpu=56301
\end{verbatim}

is equivalent to

\begin{verbatim}
target_config_item.0: add_jtag_def cc=0,tms=0,cpu=56302
target_config_item.1: add_jtag_def cc=0,tms=0,cpu=56302
target_config_item.2: add_jtag_def cc=0,tms=0,cpu=56301
\end{verbatim}

The definitions above define the chain attached to CC0, and define the CPUs 0:56302, 1:56302 and 2:56301. These CPUs will be displayed in the Target Settings dialog. They can also be selected using the \texttt{ec} command, \texttt{2 ec} would select the 56301.

- Add \texttt{n_target_config_items}: $N$

  defining the number of \texttt{target_config_item.\_i} lines added. In the example $N$ would be 3.

- Set the default CC and CPU type by modifying the lines

\begin{verbatim}
!> cpu_type = \{cpu_type.{current_em_type}\} | "56301"
!> gdi_execution_environment =
  \{gdi_execution_environment.{current_em_type}\} | "ISA"
!> gdi_features_config_item =
  \{gdi_features_config_item.{current_em_type}\} | "56301"
\end{verbatim}
to, for example,

```
!> cpu_type = {cpu_type.(current_em_type)} | "56302"
!> gdi_execution_environment =
  {gdi_execution_environment.(current_em_type)} | "ucc0"
!> gdi_features_config_item =
  {gdi_features_config_item.(current_em_type)} | "0:56302"
```

4. Now you can select the file mul563.cfg in the target configuration dialog or select it from the command line:

```
xfw56x -tcfg mul563.cfg
```

**Known Restrictions**

- The 'reset' command resets the whole JTAG chain and puts the whole chain in 'debug' mode, not only the selected device.
- A selected target must be stopped using the Halt button before a next target can be selected.
- Command Converter selection is only possible by using the Execution Environment field in the Target Settings dialog.
- All CPUs on the chain that are to be accessed in a single session must belong to the same family.
- Using the ec command, the processor register description will not be reloaded, for this the Target Settings dialog must be used.
- Changing the processor family using the Target Settings dialog generally requires an 'exit' and 'restart' from CrossView Pro. Passing the required target configuration file on the command line using the -tcfg option is recommended.
10 HARDWARE BREAKPOINTS

DSP563xx/DSP566xx

The target hardware breakpoint logic can be set directly using the following emulator command:

```
  o set_hw_break {d p x y}{=} ! |<|> hex OMLR0[r w x]
  [ { } & < |>]{=} ! |<|> hex OMLR1[r w x] [hex OMBC ]
```

The combinator and setting of bp1 are optional, as is the count.

Address bus select:

- d = DMA
- p = P
- x = X
- y = Y

Comparator mode select:

= = equal
! = not equal
< = less than
> = greater than

Access mode select:

- = breakpoint disabled
r = read
w = write
x = read or write

Combinator logic:

| = bp0 or bp1
& = bp0 and bp1
< = bp0 before bp1
> = bp0 after bp1

If you select a data breakpoint in CrossView Pro, this will override the settings specified by the emulator command.

The breakpoint is cleared with the command:

```
  o clear_hw_break
```
Examples:

- Breakpoint at \_P:0x104 read:
  \[\text{o set\_hw\_break p=104r}\]
- Breakpoint at range \_X:0x100–0x200 (inclusive) on write access:
  \[\text{o set\_hw\_break x>ffw&<201w}\]
- Breakpoint at the fifth read on \_Y:0x200–0x300 (inclusive):
  \[\text{o set\_hw\_break y>1ffr&<301r}\]

**DSP5600x**

For the DSP5600x the target hardware breakpoint emulator command is a bit different:

\[\text{o set\_hw\_break \{\{f|r|a|e\} \{p|x|y\}\{r|w|x\}\} hex\_OMLLR} \quad \text{[\-hex\_OMULR]} \quad \text{[:hex\_OMBC]}\]

If OMULR is not specified, it will be equal to OMLLR.

- \(f\) = any P fetch
- \(r\) = any P read
- \(a\) = any P access
- \(e\) = executed fetches only

See the family manual for details.

Examples:

- Executed \_P:0x104:
  \[\text{o set\_hw\_break e104}\]
- Breakpoint at range \_X:0x100–0x200 (inclusive) on write access:
  \[\text{o set\_hw\_break xw100–200}\]
- Breakpoint at the fifth read on \_Y:0x200–0x300 (inclusive):
  \[\text{o set\_hw\_break yr200–300:4}\]

**Restrictions**

- The argument of \text{set\_hw\_break} is case insensitive. No spaces are allowed in this argument.
- The mechanism used to implement the hardware breakpoints bypasses CrossView’s internal breakpoint administration, so this type of breakpoint cannot be used as a complex breakpoint.
• No symbolic addresses can be used in the `set_hw_break` command. As a workaround, the address of a symbol can be retrieved first, and then be used in the command.

• The counts specified with the hardware breakpoints are reset on each target go. When software breakpoints are used that resume execution, as is the case with File System Simulation, the original count is reprogrammed in the hardware. In this situation the moment the breakpoint occurs can be later than the actual event count (only if the programmed count is not zero).

• Due to internal chip behavior, the exact cause of a hardware breakpoint stop requires interpretation by the user. Instruction prefetches and delayed stores cause the chip to stop on earlier or later executed instructions, respectively. This is hardware behavior that is almost impossible to compensate in the debugger.
Symbols

. (period) operand, 3–21
! command, 13–20
? command, 5–15, 13–22
&o operator, 3–20
@format code, 3–14
—ddeservername, B–28
—timeout, 9–10
/ command, 5–15, 13–21
/format code, 3–14
^ command, 13–31
< command, 13–23
<< command, 13–24
> command, 13–25
>& command, 13–29
>> command, 13–27
displaying two-dimensional, 6–16
viewing contents of, 3–17, 6–16
as563, 1–12
assembler, 1–12
assembly window
  hexadecimal display, 3–10
  intermixed assembly, 3–11
  pipeline, 3–11
  source merge limit, 3–11
assertion mode, 7–28, 15–3
assertions, 1–5, 7–28, 15–3
activating, 7–28
activating and suspending, 7–31
assertion mode, 7–28
debugging with, 7–33
define or modify assertion, 13–33
defining, 7–29
deleting, 7–32
editing, 7–31
quit assertion mode, 13–174
statistics, 7–35
toggle mode, 13–32
AssertionsChanged, B–11
autosrc, 6–20

A

A command, 13–32
a command, 13–33
absolute file, 15–3
accelerator bar, 4–24
accelerator button, 4–11, 4–24
accessing code and data, 6–1
AddDDEMenuEntry, B–28
adding files to a project, 1–34
address bias, set, 13–138
addresses
  in expressions, 3–20
  specifying format of, 6–17
ADS, versions, Emu–5
application
  debugging, 1–23
  executing, 1–21
ar563, 1–12
argument of a function, 3–10
arrays
  display address of, 6–6
  display character, 3–17, 6–6

B

B command, 13–35
b command, 13–36
background color, 2–9
background mode, 11–28, 15–3
assertions, 11–33
leaving, 11–31
local and global variables, 11–32
manual refresh, 11–29
refresh limitations, 11–32
running a program, 11–30
stack, 11–32
starting, 11–30
stopping a program, 11–31
updating windows, 11–28
waiting, 11-31
bank switching, 6-17
batch mode, 9-10
batch processing, 9-10
bB command, 13-37
bb command, 13-38
bc command, 13-39
bCYC command, 13-40
bcyc command, 13-41
bD command, 13-42
bd command, 13-44
bdis command, 13-46
bena command, 13-47
bl command, 13-48
bi command, 13-49
bias, 15-4
binary constants, 3-5
binary notation, 3-5
bINST command, 13-50
binst command, 13-51
break command, 13-52
breakpoint toggle, 4-23, 7-4
breakpoints, 1-4, 7-1, 13-52, 15-4
and diagnostic output, 7-27
and multi-line statements, 7-5
and multiple statements, 7-5
and statistical information, 7-27
attaching macros to, 7-21
code, 7-3
commands associated with, 7-18
conditionals, 7-21
count, 15-4
count of, 7-3
cycle count, 7-3, 13-40, 13-41
data, 7-7
data breakpoints over a range of addresses, 7-11
delete, 13-80
delete all, 13-79
deleting, 7-16
disable, 7-17, 13-46
emulator mode, 7-6
enable, 7-17, 13-47
for loops, 7-6
function, permanent, 13-38
hardware, Emu-6, Emu-14
instruction count, 7-3, 13-50, 13-51
list, 13-35
listing, 7-8
low-level, 15-7
name, 7-3
names, 7-13
patching code with, 7-25
permanent, 7-4
permanent low-level, 13-49
task aware, 13-59
permanent up-level, 13-64
probe point, 1-5, 7-4
quiet reporting of, 7-22
reset count, 7-3, 7-14
sequence, 7-15
set at beginning of function, 13-37
set count, 13-39
setting, 1-21, 7-8
from command window, 7-10
from menu, 7-9
from source window, 7-9
from stack window, 7-10
setting the count of, 7-14
strings, 7-22
system startup code, 7-7
task aware
code, 13-57
permanent low-level, 13-59
temporary low-level, 13-58
temporary, 7-4, 7-12
temporary low-level, 13-48
task aware, 13-58
temporary up-level, 13-62
time, 13-60, 13-61
timer, 7-3
up-level, 7-22
while loops, 7-6
BreakpointsChanged, B-11
bt command, 13-57
btI command, 13-58
bti command, 13–59
bTIM command, 13–60, 13–61
bU command, 13–62
bu command, 13–64
bufa command, 13–66
bufd command, 13–67

COM methods
  Execute, B–6
  ExecuteNoWait, B–7
  Halt, B–7
  Init(), B–6

COM object interface, B–3
  activating, B–5
  events, B–8
  examples, B–12
  methods, B–6
  using, B–3

command history, displaying recent
  commands, 9–18

command language, 3–1

command line, batch processing, 9–10

command line options, 4–5

Command Window, 4–21
  displaying data in, 6–10
  opening, 1–25

CommandCanceledByUser, B–9

CommandInterpreterBusy, B–8

CommandInterpreterReady, B–9

commands
  multiple, 3–19
  syntax, 4–3

comments, 3–19

communication setup, 1–18, Emu–9

compare application, 1–20, 13–81

compiler, 1–12
  C++, I–12

conditional command execution, 13–112

conditional keywords, 3–22

configuration file, Sim–5

configure CrossView Pro, 1–18

constants, 3–4
  binary, 3–5
  character, 3–6
  character constants in C, 3–7
  floating point, 3–5
  hexadecimal, 3–5
  long integer, 3–5

C

  character constants, 3–7
  compiler, 1–12
  C command, 5–12, 13–68
  C trace, 1–5, 13–76
  C++, compiler, 1–12
  c563, 1–12
  cache, debugging with, 15–4
  case sensitivity, 3–23, 13–175
  casting values, 3–17, 6–16
  CB command, 13–69
  cc563, 1–12
  cd command, 13–70
  ce command, 13–71
  character codes, 6–14
  character codes table, 3–7
  character constants, 3–6
  circular buffer, 3–18, 6–8
  clear command, 13–72
  close a file I/O stream, 13–113
  CmdAnnotatedOutput, B–11
  cmdannotatedoutput, B–22
  cmdoutput, B–21

  code breakpoints
    See also breakpoints
    set breakpoint, 13–36
    task aware, 13–57

  code coverage, 1–6
  color, windows, 2–9
  color offset, 11–17
  color settings, 2–9

  COM interfaces, B–5
octal, 3–5
strings, 3–6
continue execution, 5–9
control operations, 4–38
control program, 1–12
coverage, 1–6, 11–5, 15–5, Sim–4
disable, 11–5, 13–70
enable, 11–5, 13–71
information, 13–73
marker, 4–23, 7–4
memory window, 4–28
next covered block, 13–139
next not covered block, 13–140
previous covered block, 13–145
previous not covered block, 13–150
source window, 4–24
covinfo command, 13–73
cp563, 1–12
cproinfo command, 13–74
CPU, reserved variable, 3–11
CPU selection, 4–7
cpu selection, 13–91, 13–92
cpu_type, 1–17, Sim–6
creating a makefile, 1–35
CrossView
and command line options, 4–5
before starting, 1–14
command files, 4–6
command language, 3–1
command line batch processing, 9–10
command reference, 13–1
commands summary, 13–4, 13–15
configure execution environment, Emu–9
customizing, 4–17
desktop, 4–11
executable name, Sim–3, Emu–6
exiting, 1–26
features, 1–3
features of the execution environment, Sim–3
how it works, 1–10
invoking, 4–4
invoking graphical version, 1–15
memory configuration, Emu–8
output, 1–25
restrictions of execution
environment, Sim–5, Emu–6
sound support, D–1
source level debugging, 1–8
special features, 11–1
starting, 4–4
state of, 13–111
using, 4–1
CrossView Pro
debugger, 1–12
debugging environment, 1–8
documentation, 1–7
target settings, 1–16
using windows, 1–4
windows, 1–4
CrossView Pro workspace, 1–26
cr command, 13–76
cr i command, 13–77
cr r command, 13–78
cursor, 5–3
CXL script, 4–37
supplied scripts, 11–13
syntax, 11–19
CXL syntax, 11–19
base types, 11–21
compound types, 11–22
predefined functions, 11–22
cycle count, breakpoints, 7–3
cycle counter, Sim–3
cyclecount register, C–6
D
D command, 13–79
d command, 13–80
data
displaying, 6–1
enumerated, 6–5
list data monitors, 13–126
data analysis, 11–11
add update commands, 13–103
bufa, 13–66
bufd, 13–67
clear sequence of update commands, 13–104
close window, 13–105
create window, 13–102
graph, 13–102
graph debug, 13–106
graph_add_update, 13–103
graph_clear_updates, 13–104
graph_close, 13–105
graph_debug, 13–106
graphbm, 13–107
graphmn, 13–108
graphp, 13–109
memget, 13–130
position window, 13–109
rawmemget, 13–154
supplied scripts, 11–13
update, 13–171
update window, 13–171
Data Analysis Window, 4–36
toolbar, 4–36
data breakpoints
set at an address, 13–44
set over range of addresses, 13–42
data coverage, 1–6, 4–28
data monitoring, 1–5, 15–5
removing expressions, 6–13
Data Window, 1–5, 4–29, 6–12
toolbar, 4–31
dcmp command, 13–81
DDE command line options,
——ddeservername, B–28
DDE commands, AddDDEMenuEntry, B–28
DDE events, B–27
DDE items
cmdannotatedoutput, B–22
cmdoutput, B–21
event, B–26
exec, B–24
execext, B–23
halt, B–25
Help, B–20
result, B–27
DDE server interface, B–20
debug instrument, 13–14
save/restore state, 13–83
debug instrument I/O, 10–9
debug_instrument_module, 1–18,
Sim—6
debugger, starting, 1–33
debugging
and optimized code, 3–8
assembly language, 12–3
code without symbols, 5–14
environment, 1–8
interrupts, 12–3, 12–4
multiple programs, 12–3
notes about, 12–1
source-level, 1–8
viewing source while, 1–21
debugging an application, 1–23
derivatives, C–7
desktop, 4–11
DestroyedAllSymbols, B–11
DidAddSymbols, B–11
DidLoadSymbols, B–11
DidAddSymbols, B–11
DidDownloadImage, B–11
DidLoadSymbols, B–10
dis command, 13–84
disassemble memory, 13–84
disassembly, 6–19
window, 15–5
display, customizing, 4–17
display formats, set default, 13–96
dn command, 13–85
dnm command, 13–86
documentation, 1–7
dot operand, 6–12
download a file, 13–85
  into memory space, 13–86
download image, 13–125
downloading, files to the execution environment, 1–19
DSP differences, Emu–5
dump, 3–17, 6–16
dump command, 13–87
Dy command, 13–79
e command, 5–14, 13–89
eC command, 13–91
ec command, 13–92
 Echo command, 13–93
 echo string to terminal, 13–19
EDE, 1–28
  build an application, 1–32
  load files, 1–30
  open a project, 1–30
  select a CPU, 1–32
  select a toolchain, 1–29
  start a new project, 1–34
  starting, 1–28
edit source, 4–25
ei command, 13–94
embedded development environment.
  See EDE
embedded system, 15–6
emulator communication setup, 1–18
emulator mode, 1–9
environment variable
  LD_LIBRARY_PATH, 2–7
  LM_LICENSE_FILE, 2–17, A–6
  PATH, 2–4, 2–6
  UIDPATH, 2–7
error messages, alphabetical listing of, 14–1
errors, FLEXlm license, A–33
Esc key, 4–21
et command, 13–95
evaluate expression, 13–16
event, B–26
events, B–8, B–27
  AssertionsChanged, B–11
  BreakpointsChanged, B–11
  CmdAnnotatedOutput, B–11
  CommandCanceledByUser, B–9
  CommandInterpreterBusy, B–8
  CommandInterpreterReady, B–9
  DestroyedAllSymbols, B–11
  DidAddSymbols, B–11
  DidDownloadImage, B–11
  DidLoadSymbols, B–10
  HaltButtonPressed, B–9
  MenuEntrySelected, B–11
  Quit, B–12
  Reset, B–10
  ResetProgram, B–10
  Running, B–9
  RunningInBackground, B–9
  SourceFileChanged, B–10
  Stopped, B–9
  ViewedLineNrChanged, B–10
example
  starting EDE, 1–28
  using EDE, 1–28
  using the control program, 1–35
  using the makefile, 1–37
exec, B–24
execext, B–23
executable, building for CrossView, 1–28
Execute, B–6
ExecuteNoWait, B–7
executing an application, 1–21
execution control commands, summary of, 13–8
execution environment, Sim-1
   connecting to CrossView, 4-6
downloading files to, 1-19
execution position, 5-3
   changing the, 5-5
definition of, 15-6
sync with viewing position, 5-7
exit, 4-19
exponential notation, 3-6
expression evaluator, 1-4
expressions, 3-3
   C character codes, 3-7
   character constants, 3-6
evaluating, 6-11
evaluation precision, 3-4
floating point constants, 3-5
   format of, 3-14
   monitoring, 6-12
   removing monitored, 6-13
show, 4-29
   special expressions, 3-21
   specifying variables in, 3-9
   strings, 3-6
   watch, 4-29
extension language, 11-19
eye diagram, 11-19

F
f command, 13-96
FAQ, FLEXlm, A-37
fast_mode register, C-6, Sim-4
FFT power spectrum, 11-15
   combined with phase, 11-18
   multi, 11-15
   multi in lines, 11-16
   multi in lines and grid, 11-16
FFT waterfall, 11-15
file system simulation, 10-7, 15-6
close a stream, 13-98
libraries, 10-8
redirect output to a file, 13-99
redirection, 10-8, 13-97
summary of commands, 13-13
filenames, 2-3
Flexible License Manager, A-1
FLEXlm, A-1
daemon log file, A-25
daemon options file, A-7
FAQ, A-37
frequently asked questions, A-37
license administration tools, A-8
   for Windows, A-22
license errors, A-32
floating license, 2-11
floating point constants, 3-5
format codes, 3-5
formats, for variables, 6-14
formatting expressions, 3-14
frame pointer, 3-11
   user, 3-12
FSS
   redirection, 10-8
   summary of commands, 13-13
FSS command, 13-97
FSS_stdio_close, 13-98
FSS_stdio_open, 13-99
functions, 3-22
   listing all, 6-10
   listing local variables and parameters of, 6-25

G
g command, 5-5, 13-100
GDI, 1-8, 9-12
   logging, 9-13, 9-15, 9-16
getting started, 1-14
gi command, 5-6, 13-101
global variables, 3-8
glossary, 15-1
graph command, 13-102
graph_add_update command, 13–103
graph_clear_updates command, 13–104
graph_close command, 13–105
graph_debug command, 13–106
graphm command, 13–107
graphmn command, 13–108
graphp command, 13–109
GUI update suppress, 13–110
GUS command, 13–110

H

Halt, B–7
halt, B–25
halt execution, 5–9
HaltButtonPressed, B–9
hardware breakpoints, Emu–6, Emu–14
Help, B–20
help
  on-line, 1–7, 4–39
  summary of help commands, 13–14
hexadecimal disassembly, 3–10
hexadecimal notation, 3–5
history mechanism, 15–6
hostid, determining, 2–18
hostname, determining, 2–19

I

I command, 13–111
I/O simulation, 1–5
defined, 15–7
disable streams, 10–7
enable streams, 10–7
file system simulation, 10–7
redirecting streams, 10–6
setting up streams, 10–4
terminal windows, 4–34
if command, 13–112
image part, 15–7
in-situ editing, 6–7, 6–30
Init(), B–6
input/output simulation, 10–1
defined, 15–7
  summary of commands, 13–12
installation, Emu–5
licensing, 2–11
instruction count breakpoints, 7–3
instruction count register, C–6
instruction counter, Sim–3
integers, 3–4
  binary, 3–5
  hexadecimal, 3–5
  integral promotion, 3–5
  long, 3–5
  negative, 3–4
  octal, 3–5
integral promotion, 3–5
intermixed source and disassembly, 6–20
interprocess communication, B–1
interrupt key, 15–7
interrupts, debugging with, 12–3
ios_close command, 13–113
ios_open command, 13–114
ios_read command, 13–116
ios_readf command, 13–117
ios_rewind command, 13–118
ios_wopen command, 13–119
ios_write command, 13–120
ios_writef command, 13–121

J

JTAG, creating configuration file, Emu–11
jump to cursor, 5–5

K

kernel support, 1–7, 11–4
Index

keyboard mappings, 10–10
keywords
  circular buffer (_circ), 3–18, 6–8
  memory address space, 3–18, 6–17
keywords, conditional, 3–22–3–24

L

L command, 13–122
l command, 13–123
label, in disassembly, 6–19
language, 3–1
lc563, 1–12
LD_LIBRARY_PATH, 2–7
librarian, 1–12
license
  floating, 2–11
  node-locked, 2–11
  obtaining, 2–11
license file
  default location, A–6
  location, 2–17
licensing, 2–11
line command, 13–18
line numbers, 3–11
linker, 1–12
listing, 13–123
lk563, 1–12
LM_LICENSE_FILE, 2–17, A–6
lmcksum, A–10
lmdiag, A–11
lmdown, A–12
lmgrd, A–13
lmhostid, A–15
lmremove, A–16
lmreread, A–17
lmstat, A–18
lmswitchr, A–20
lmver, A–21
load command, 13–125
load symbol file, 13–125, 13–137
local variables, 3–8
  and the stack, 3–8
  auto-watch, 4–31
locator, 1–12
logging, 9–12
  command window output, 13–27
  commands and screen output, 9–14
debugger-emulator I/O, 13–29
define, 13–159
defining, 8–3
delete definition, 13–170
deleting, 8–8
echo command, 13–93
expanding, 8–5
listing, 8–5
parameters of, 8–9
reading from a file, 8–7
redefining, 8–5, 8–10
save, 13–158
saving to a file, 8–6
summary of commands, 13–12
summary of commands, 13–11
using the toolbox, 8–11
main() function, 15–7
make utility, 1–12
makefile
   automatic creation of, 1–35
   updating, 1–35
makepy utility, B–15
MAU (minimum addressable unit), 15–7
mcp command, 13–129
memget command, 13–130
memory
   copy, 13–129
   disassembly, 13–84
   displaying, 6–15
   dump, 13–87
   fill, 13–133
   search, 13–135
   single fill, 13–132
memory access, tracing, 1–6
memory configuration, Emu–8
memory dump, 3–17, 6–16
memory map, 4–6, 15–8
memory space, 3–18, 6–17
memory space attribute, 6–8
Memory Window, 4–27
   setup, 4–28
   toolbar, 4–28
menu, 4–13
   local popup, 4–14
menu bar, 4–11
MenuEntrySelected, B–11
mF command, 13–132
mf command, 13–133
minimum addressable unit, 15–8
mk563, 1–12
monitor data, 13–126
monitors, 13–127
more, 3–11
ms command, 13–135
MS–Windows
   installing CrossView, 2–3
   requirements, 2–4
multi FFT power spectrum, 11–15
   in lines, 11–16
   in lines and grid, 11–16
multiple DSPs, Emu–11

N
N command, 13–137
n command, 13–138
nC command, 13–139
node–locked license, 2–11
nU command, 13–140

O
o command, 13–141
object reader, 1–12
octal constants, 3–5
octal notation, 3–5
open a file I/O stream, 13–114, 13–119
operators, 3–19
   order of precedence, 3–20
   using addresses, 3–20
opt command, 13–142
optimization, and debugging, 3–8
options, display or set, 13–142
output paging mechanism, 3–11
overview, 1–1

P
P command, 13–143
p command, 13–144
packet format, B–27
patches, 15–8
   and breakpoints, 7–25
PATH, 2–4, 2–6
pC command, 13–145
pd command, 13–146
pe command, 13–147
performing timing analysis, 1–6
pipeline, 3–11
playback, 9–7
  calling other playback files, 9–9
  quitting, 9–9
  setting the type of, 9–8
  startup options, 9–17
  summary of commands, 13–11
playback mode, 1–7
  continuous, 13–23
  single step, 13–24
pointer, 3–17, 6–8
  display character, 3–17, 6–6
pointer qualifier, 6–8
pr563, 1–12
precision, evaluating expressions, 3–4
print source lines, 13–143, 13–144
probe point, 1–5, 7–4, 15–8
problems
  common, 1–26
  communicating with CrossView, 4–9
profiling, 1–6, 11–7, 15–9
  code range, 1–6, 11–8
  cumulative, 11–7
  cumulative information, 13–74
  disable, 11–9, 13–146
  enable, 11–9, 13–147
  function, 11–7
  functions, 1–6
  hardware with timer, 11–10, 11–11
  information, 13–148
program builder, 1–12
program counter, 3–11, 5–7, 13–68
  g command (change), 13–100
  gi command (change), 13–101
  inside function, 3–10
program development, 1–12
program execution
  controlling, 5–1
  notes about, 5–14
program reset, 13–149
proinfo command, 13–148
project files, adding files, 1–34
prst command, 13–149
pseudo-assembly, 6–20
pU command, 13–150

Q

Q command, 13–151
q command, 13–152
quiet breakpoint recording, 13–151
Quit, B–12
quit debugger, 13–152

R

R command, 5–8, 13–153
radm, 1–18, Sim–6
rawmemget command, 13–154
read from an I/O stream, 13–116
  formatted, 13–117
record, commands only, 13–25
record and playback, 9–1
  definition of, 15–9
record mode, 1–7
recording
  checking status, 9–5
  close file for, 9–6
  entering comments, 9–4
  example, 9–6
  resume, 9–5
  start, 9–3
  startup options, 9–17
  stop, 9–6
  summary of commands, 13–11
  suspend, 9–4
refresh windows, 13–169
reg.dat, C–4
reg5600x.dat, C–7
reg563xx.dat, C–7
register file syntax, C–4
register manager, C–1
register set
  DSP56xxx family, C–7
fixed, C–5
Register Window, 4–26, 6–29
setup, 6–29
registers, 3–12
displaying the contents of, 6–10
reset values, Emu–7
special variable, 3–11
Reset, B–10
reset program, 5–8, 13–149
reset target system, 13–153, 13–155
ResetProgram, B–10
resource file, 2–7
result, B–27
return address, 6–22
rewind an I/O stream, 13–118
rm563, C–3
rst command, 13–155
RTOS aware debugging, 11–4
Running, B–9
RunningInBackground, B–9

S
S command, 5–11, 13–156
s command, 13–157
save command, 13–158
save on exit, 4–19
scoping rules and variables, 3–9
scroll bar, 4–11
search
backwards for string, 13–22
forward for string, 13–21
summary of commands, 13–15
searching, 5–14–5–16
for a function, 5–14
for a source line, 5–16
for a string, 5–15
section, overlayable, 6–22
serial ports, 4–6
set command, 13–159
Si command, 5–12, 13–161
si command, 5–12, 13–162
signal analysis, 4–36
simulation, I/O, 1–5
simulation speed, Sim–4
simulator, Sim–1
simulator configuration, selecting,
Sim–5, Emu–9
simulator configuration file, Sim–5
single stepping, 1–5, 5–9–5–10
at machine level, 5–12–5–16
defined, 15–10
into, 5–10
into function calls, 13–157
into functions, 5–10
machine level into functions, 13–162
machine level over functions, 13–161
over, 5–11
over function calls, 13–156
over functions, 5–11
sizeof() function, 6–7
skidding, 15–10
software installation
MS–Windows, 2–3
UNIX, 2–5
Windows 95/NT, 2–3
sound support, D–1
source directory, change, 13–172
source level debugging, 1–8
source line, jump to, 5–16
source merge limit, 3–11
source positioning, 5–3
Source Window, 4–23
change execution position, 5–5
change viewing position, 5–4
controlling program execution,
5–8–5–16
edit source, 4–25
searching in, 5–14–5–16
single stepping, 5–9
sync execution and viewing positions,
5–7
toolbar, 4–24
source window, line numbers, 3–11
SourceFileChanged, B–10
special function register, 3–12
special function registers, C–3
special variables, 3–10, 15–10
reserved, 15–9
user-defined, 3–13
st command, 13–163
stack, 6–21
begin of, 6–23
end of, 6–23
local variables, 3–8
organization of, 6–21
system, 6–22
user, 6–22
stack pointer, 3–11
user, 3–12
stack trace, 13–164, 13–165
Stack Window, 4–32, 6–23
toolbar, 4–33
startup options, 4–5
definition, 15–10
list of, 4–7
static variables, 3–8
status bar, 4–11
stop target execution, 13–163
Stopped, B–9
storage classes, 3–7
string command, 3–21
strings, 3–6
structures
assignment, 6–8
viewing, 6–5
style codes, 3–15
symbol information, 15–11
symbolic disassembly, 6–19
symbols, in disassembly, 3–11
synchronize execution and viewing
positions, 5–7, 13–122
system stack, 6–22
system startup code, 15–11

T

T command, 13–164
t command, 13–165
Tab key, 4–21
target communication, 15–11
target configuration file, 1–17, Sim–5
target program counter, 13–69
target settings, 1–16
target state, 13–14
target system, 1–8
target_dependent_module, 1–18, Sim–6
task selection, 13–95
td command, 13–166
te command, 13–167
Terminal Window, 4–34
keyboard mappings, 10–10
setup, 4–35
timer breakpoints, 7–3
title, 1–17, Sim–6
toolbar, 4–11
data analysis window, 4–36
data window, 4–31
memory window, 4–28
source window, 4–24
stack window, 4–33
toolbox, 8–11
trace
C, 13–76
disable, 13–166
disassembled, 13–77
enable, 13–167
instruction level, 6–28
raw, 6–28, 13–78
source level, 6–27
trace buffer, 15–11
Trace Window, 4–33, 6–27
instruction level, 13–77
raw, 13–78
source level, 13–76
traceback mode, 1–5
transparency mode, 1–9, 11–3, 13–141
and CrossView startup, 4–6
defined, 15–11
entering, 11–3
one-shot commands, 11–3
startup options, 11–3
trigraph sequence, 3–7
troubleshooting, 1–26, 4–9

specifying in expressions, 3–9
static variables, 3–8
user–defined special variables, 3–13
ViewedLineNrChanged, B–10
viewing position, 3–10, 5–3
changing the, 5–4–5–7
defined, 15–12
establish, 13–89
establish at address, 13–94
sync with execution position, 5–7

wait for target completion, 13–173
waiting, 11–31
window update
reactivate, 13–110
suppress, 13–110
windows, 4–20
active, 4–15, 15–3
automatic switching between source
and assembly, 3–11
closing, 4–15
command window, 4–21
customizing, 4–17
data analysis window, 4–36
data window, 4–29
data window, 4–29
help window, 4–37
memory window, 4–27
opening, 4–14
pop-up, 4–37
register window, 4–26
selecting, 4–15
source positioning, 5–3
source window, 4–23
stack window, 4–32
terminal windows, 4–34
toolbox, 4–37
trace window, 4–33
Windows 95/NT, installing CrossView, 2–3
workspace file (.cws), 1–26

variables, 3–7
and case sensitivity, 3–23
and scoping rules, 3–9
casting, 3–7
changing, 6–7
determining the size of, 6–7
formats of, 6–14
global, 6–10
global variables, 3–8
local, 15–7
local variables, 3–8
scope, 15–9
special, 15–10
special variables, Pages, 3–10

U
u command, 13–168
ubgw command, 13–169
UIDPATH, 2–7
UNIX, installing CrossView on, 2–5
unset command, 13–170
update command, 13–171
update windows, 13–168, 13–169
updating makefile, 1–35
use command, 13–172
user defined functions, 1–7
user stack, 6–22, 6–23
using EDE, 1–28

W
wait for target completion, 13–173
waiting, 11–31
window update
reactivate, 13–110
suppress, 13–110
windows, 4–20
active, 4–15, 15–3
automatic switching between source
and assembly, 3–11
closing, 4–15
customizing, 4–17
data analysis window, 4–36
data window, 4–29
data window, 4–29
help window, 4–37
memory window, 4–27
opening, 4–14
pop-up, 4–37
register window, 4–26
selecting, 4–15
source positioning, 5–3
source window, 4–23
stack window, 4–32
terminal windows, 4–34
toolbox, 4–37
trace window, 4–33
Windows 95/NT, installing CrossView, 2–3
workspace file (.cws), 1–26
x command, 13-174
x Resources, 2-8
X Widgets, CrossView Motif, 2-8
X Windows
Motif environment, 2-7
resources, 2-8

write to an I/O stream, 13-120
formatted, 13-121

x-t plotting, 11-13
x-y plotting, 11-14

xwwprof, 12-4
xwwprof_start, 11-11
xwwprofiss_start, 12-4
xwwiss_buffer, 12-4

Z command, 13-175